<table>
<thead>
<tr>
<th>Chapter</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>What's new in SFC?</td>
<td>1</td>
</tr>
<tr>
<td>Introduction</td>
<td>2</td>
</tr>
<tr>
<td>Getting started</td>
<td>3</td>
</tr>
<tr>
<td>Essentials of SFC</td>
<td>4</td>
</tr>
<tr>
<td>Starting and working</td>
<td>5</td>
</tr>
<tr>
<td>Creating the project structure</td>
<td>6</td>
</tr>
<tr>
<td>Creating, configuring and managing SFCs</td>
<td>7</td>
</tr>
<tr>
<td>Adapting the properties of charts, types and instances</td>
<td>8</td>
</tr>
<tr>
<td>Configuring messages</td>
<td>9</td>
</tr>
<tr>
<td>Configuring the characteristics</td>
<td>10</td>
</tr>
<tr>
<td>Configuring sequential control systems</td>
<td>11</td>
</tr>
<tr>
<td>Standard interface and chart I/Os</td>
<td>12</td>
</tr>
<tr>
<td>Compiling SFC charts and SFC types</td>
<td>13</td>
</tr>
<tr>
<td>Downloading to the AS</td>
<td>14</td>
</tr>
<tr>
<td>Behavior of the sequential control system in the AS</td>
<td>15</td>
</tr>
<tr>
<td>Testing and commissioning sequential control systems</td>
<td>16</td>
</tr>
<tr>
<td>Documenting programs</td>
<td>17</td>
</tr>
<tr>
<td>Configuring parameter controls</td>
<td>18</td>
</tr>
<tr>
<td>Tips &amp; Tricks</td>
<td>19</td>
</tr>
</tbody>
</table>
Legal information

Warning notice system

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are graded according to the degree of danger.

**DANGER**
indicates that death or severe personal injury **will** result if proper precautions are not taken.

**WARNING**
indicates that death or severe personal injury **may** result if proper precautions are not taken.

**CAUTION**
with a safety alert symbol, indicates that minor personal injury can result if proper precautions are not taken.

**CAUTION**
without a safety alert symbol, indicates that property damage can result if proper precautions are not taken.

**NOTICE**
indicates that an unintended result or situation can occur if the relevant information is not taken into account.

If more than one degree of danger is present, the warning notice representing the highest degree of danger will be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to property damage.

Qualified Personnel

The product/system described in this documentation may be operated only by personnel qualified for the specific task in accordance with the relevant documentation, in particular its warning notices and safety instructions. Qualified personnel are those who, based on their training and experience, are capable of identifying risks and avoiding potential hazards when working with these products/systems.

Proper use of Siemens products

Note the following:

**WARNING**
Siemens products may only be used for the applications described in the catalog and in the relevant technical documentation. If products and components from other manufacturers are used, these must be recommended or approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and maintenance are required to ensure that the products operate safely and without any problems. The permissible ambient conditions must be complied with. The information in the relevant documentation must be observed.

Trademarks

All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication may be trademarks whose use by third parties for their own purposes could violate the rights of the owner.

Disclaimer of Liability

We have reviewed the contents of this publication to ensure consistency with the hardware and software described. Since variance cannot be precluded entirely, we cannot guarantee full consistency. However, the information in this publication is reviewed regularly and any necessary corrections are included in subsequent editions.

Siemens AG
Industry Sector
Postfach 48 48
90026 NÜRNBERG
GERMANY

ASED3710074-01
© 10/2011
Copyright © Siemens AG 2011.
Technical data subject to change
# Table of contents

1. What's new in SFC? .................................................................................................................................. 9
2. Introduction ........................................................................................................................................ 11
3. Getting started .................................................................................................................................. 15
   3.1 How to work with SFC in overview ................................................................................................. 15
   3.2 How to create an SFC Chart in overview ......................................................................................... 17
   3.3 How to create an SFC type in overview ......................................................................................... 20
   3.4 How to create an SFC instance in overview .................................................................................... 22
4. Essentials of SFC ................................................................................................................................ 25
   4.1 SFC in the STEP 7 environment ..................................................................................................... 25
   4.2 SFC and plant hierarchy ................................................................................................................. 26
   4.3 SFC and Other Target Systems ..................................................................................................... 26
   4.4 Configuration limits of the SFC ..................................................................................................... 27
   4.5 Uses and functionality of SFCs ..................................................................................................... 28
      4.5.1 What is an SFC Chart? .............................................................................................................. 28
      4.5.2 What is an SFC Chart and SFC Type Compared? .................................................................... 30
      4.5.3 SFC Chart and SFC Type Compared ....................................................................................... 33
      4.5.4 Ex .............................................................................................................................................. 34
      4.5.5 Elements ................................................................................................................................... 36
      4.5.6 What is a Step? ........................................................................................................................ 39
      4.5.7 What is a Sequence? ............................................................................................................... 40
      4.5.8 What is a Loop? ..................................................................................................................... 41
      4.5.9 What is a Jump? ..................................................................................................................... 42
      4.5.10 What is a Text? .................................................................................................................... 43
   4.6 SFC elements .................................................................................................................................. 36
      4.6.1 What is a sequencer? ............................................................................................................... 36
      4.6.2 What are Sequencer Elements? ............................................................................................... 37
      4.6.3 What is a Step? ........................................................................................................................ 39
      4.6.4 What is a Transition? .............................................................................................................. 40
      4.6.5 What is a Sequence? ............................................................................................................... 41
      4.6.6 What is a Loop? ..................................................................................................................... 42
      4.6.7 What is an Alternative Branch? ............................................................................................... 43
   5. Starting and working .......................................................................................................................... 47
      5.1 Working with the SFC Editor ....................................................................................................... 47
      5.2 How to start the SFC Editor ....................................................................................................... 47
      5.3 Multiuser engineering ............................................................................................................... 48
      5.4 Navigating in the SFC ................................................................................................................ 48
         5.4.1 How to Navigate in the SFC .................................................................................................. 48
      5.5 User interface and operator input ............................................................................................... 50
         5.5.1 Elements of the User Interface ............................................................................................ 50
         5.5.2 Dialog boxes ......................................................................................................................... 54
# Table of contents

5.6  Working with the mouse.................................................................................................. 55
5.6.1 Working with the Mouse............................................................................................. 55
5.7  Working with the keyboard........................................................................................... 56
5.7.1 Working with the Keyboard......................................................................................... 56
5.7.2 Shortcut keys for menu commands .............................................................................. 56
5.7.3 Shortcuts for Menu Commands.................................................................................. 57
5.7.4 Navigating in the Menu Bar and Menus with the Keyboard................................. 58
5.7.5 Navigating in Dialog Boxes with the Keyboard....................................................... 59
5.7.6 Navigating in Texts with the Keyboard...................................................................... 60
5.7.7 Selecting Text with the Keyboard ........................................................................... 60
5.7.8 Keyboard Shortcuts in the Sequencer........................................................................ 61
5.7.9 Opening Help with the Keyboard ............................................................................. 61
5.7.10 Changing the Window Section.................................................................................. 61
5.8  Default colors .................................................................................................................. 62
5.8.1 Default Colors ........................................................................................................... 62
5.9  Data backup in the SFC Editor ....................................................................................... 63
5.9.1 Data Backup in the SFC Editor ................................................................................. 63

6  Creating the project structure......................................................................................... 65
6.1  How to create a project structure.................................................................................. 65

7  Creating, configuring and managing SFCs..................................................................... 67
7.1  Overview of Creating, Configuring and Managing SFCs............................................. 67
7.2  Creating an SFC chart .................................................................................................... 69
7.2.1 How to Create an SFC Chart...................................................................................... 69
7.3  Creating an SFC type and creating an SFC instance................................................... 70
7.3.1 How to create an SFC type ....................................................................................... 70
7.3.2 How to Create an SFC Instance................................................................................ 71
7.4  Configuring an SFC chart ............................................................................................. 72
7.4.1 Basics for configuring an SFC chart ......................................................................... 72
7.4.2 Configuration Changes in the SFC Chart ................................................................ 74
7.5  Configuring the SFC type and SFC instance ............................................................... 75
7.5.1 Type/instance concept of SFC.................................................................................. 75
7.5.2 Configuring the SFC type......................................................................................... 75
7.5.3 Configuration changes in the SFC type..................................................................... 78
7.5.4 Configuring the SFC Instance.................................................................................. 79
7.5.5 Configuration Changes in the SFC Instance............................................................. 81
7.6  Opening .......................................................................................................................... 82
7.6.1 How to Open SFC Charts or SFC Types................................................................. 82
7.6.2 How to Open SFC Instances..................................................................................... 83
7.7  Copying .......................................................................................................................... 84
7.7.1 Copying and Moving SFC Charts.............................................................................. 84
7.7.2 Copying and moving SFC types................................................................................ 85
7.7.3 Copying and Moving SFC Instances........................................................................ 86
7.8  Deleting .......................................................................................................................... 87
7.8.1 How to Delete SFC Charts and SFC Types............................................................. 87
7.8.2 How to Delete SFC Instances.................................................................................. 87
# Table of contents

8 Adapting the properties of charts, types and instances .................................................................................. 89
  8.1 How to Adapt Chart Properties ........................................................................................................... 89
  8.2 How to Adapt Type Properties .......................................................................................................... 91
  8.3 How to update SFC Types .................................................................................................................. 92
  8.4 How to Adapt Instance Properties ..................................................................................................... 93

9 Configuring messages .................................................................................................................................. 95
  9.1 How to configure messages in the SFC ............................................................................................... 95

10 Configuring the characteristics ................................................................................................................. 97
  10.1 Using the characteristics editor and the interface editor .................................................................. 97
  10.2 Characteristics of the SFC type ....................................................................................................... 98
  10.3 Note on Subsequent Modifications to Control Strategies ............................................................... 100
  10.4 How to configure note texts and position texts .............................................................................. 101
  10.5 Inputs/Outputs for Characteristics .................................................................................................. 102
  10.6 Block contacts .................................................................................................................................. 103
  10.7 Attributes for characteristics ........................................................................................................ 104

11 Configuring sequential control systems .................................................................................................. 109
  11.1 How to Configure Sequential Control Systems ................................................................................. 109
  11.2 Creating the sequencer topology ...................................................................................................... 111
  11.2.1 How to create a sequencer topology ............................................................................................ 111
  11.2.2 How to Configure Multiple Sequencers ....................................................................................... 112
  11.2.3 Overview of Inserting/Creating SFC Elements ........................................................................... 116
  11.2.4 How to Create a Sequence ........................................................................................................... 117
  11.2.5 How to Create and Edit a Simultaneous Branch ......................................................................... 118
  11.2.6 How to Create and Edit an Alternative Branch ........................................................................... 120
  11.2.7 How to Create and Edit a Loop .................................................................................................... 121
  11.2.8 How to Create and Edit a Jump .................................................................................................... 122
  11.2.9 How to Create and Edit a Text Field ............................................................................................. 124
  11.3 Managing SFC elements .................................................................................................................... 126
    11.3.1 Selecting SFC elements .............................................................................................................. 126
      11.3.1.1 How to Select with a Mouse Click ....................................................................................... 126
      11.3.1.2 How to Select with the Keyboard ......................................................................................... 127
      11.3.1.3 How to Select with the Lasso ............................................................................................. 127
      11.3.1.4 How to Select Steps and Transitions for Editing .................................................................. 128
    11.3.2 Copying, moving and deleting SFC elements .............................................................................. 129
      11.3.2.1 How to Copy SFC Elements ............................................................................................... 129
      11.3.2.2 How to copy object properties of SFC elements .................................................................. 131
      11.3.2.3 How to Move SFC Elements ............................................................................................. 132
      11.3.2.4 Deleting SFC Elements ...................................................................................................... 133
    11.4 Editing in the properties dialog ........................................................................................................ 134
      11.4.1 How to edit sequencer properties ............................................................................................ 134
      11.4.2 Editing the steps ......................................................................................................................... 136
      11.4.2.1 How to Edit a Step .............................................................................................................. 136
      11.4.2.2 How to Edit Actions in a Step ............................................................................................. 139
Table of contents

11.4.2.3 How to edit addresses in a step .......................................................... 141
11.4.2.4 Valid Entries for Addresses ................................................................. 144
11.4.2.5 How to Filter Block Inputs/Outputs ..................................................... 146
11.4.2.6 How to access structures ................................................................. 147
11.4.3 Editing transitions ............................................................................ 149
11.4.3.1 How to Edit the Transition ................................................................. 149
11.4.3.2 Formulating the Conditions of a Transition ........................................ 151
11.4.3.3 How to edit addresses in a transition ............................................... 152
11.4.3.4 How to Edit OS Comments in a Transition ........................................ 154
11.4.4 Shared addresses and valid data types .............................................. 156
11.4.4.1 Shared addresses ............................................................................ 156
11.4.4.2 Absolute addressing ...................................................................... 156
11.4.4.3 How to perform symbolic addressing .............................................. 157
11.4.4.4 Valid data types ............................................................................ 158
11.5 Specifying runtime properties ............................................................... 159
11.5.1 Runtime Properties of an SFC ............................................................. 159
11.5.2 How to Edit the Run Sequence ............................................................ 160
11.5.3 Runtime Attributes for Runtime Groups and SFCs ............................. 161

12 Standard interface and chart I/Os ............................................................. 163

12.1 Standard interface of the SFC chart ....................................................... 163
12.1.1 Inputs/Outputs of the SFC Chart Standard Interface ............................ 163
12.1.2 Standard interface of the SFC chart ..................................................... 163
12.1.3 Meanings in the table ...................................................................... 169
12.1.4 Inputs/Outputs of the SFC Chart Sorted According to Usage .......... 170
12.2 Standard interface of the SFC type ........................................................ 171
12.2.1 Standard Interface of the SFC Type .................................................... 171
12.2.2 Inputs/outputs of the SFC type standard interface ............................... 172
12.2.3 Inputs/Outputs of the SFC Type Sorted According to Usage ............ 178
12.2.4 "Inputs/Outputs" Interface Expansions ............................................... 178
12.2.5 "Characteristics" interface parameter assignments ............................. 179
12.2.5.1 "Characteristics" Interface Parameter Assignments ......................... 179
12.2.5.2 Characteristic: "Control strategies" ................................................... 179
12.2.5.3 Characteristic for note texts ............................................................... 180
12.2.5.4 Characteristic for position texts ....................................................... 180
12.2.6 "Characteristics" interface expansions ............................................... 181
12.2.6.1 "Characteristics" Interface Expansions ........................................... 181
12.2.6.2 "Setpoints" characteristic ................................................................. 182
12.2.6.3 Meaning and usage of setpoints ...................................................... 191
12.2.6.4 "Process values" characteristic ......................................................... 195
12.2.6.5 "Control values" characteristic ......................................................... 195
12.2.6.6 "Parameters" characteristic .............................................................. 195
12.2.6.7 "Bit Memory" Characteristic .............................................................. 196
12.2.6.8 "Timers" characteristic .................................................................. 196
12.2.6.9 "Block contacts" characteristic ........................................................ 197
12.3 SFC inputs/outputs sorted by usage ..................................................... 198
12.3.1 Operating modes (SFC inputs/outputs) ............................................... 198
12.3.2 Commands and operating states (SFC inputs/outputs) ...................... 200
12.3.3 Execution options (SFC inputs/outputs) ............................................. 208
12.3.4 Group displays and group acknowledgements (SFC inputs/outputs) ... 210
12.3.5 Data from sequencers and steps to be processed (SFC inputs/outputs) . 210
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>12.3.6 BATCH parameters (SFC inputs/outputs)</td>
<td>212</td>
</tr>
<tr>
<td>12.3.7 Continuous mode (SFC inputs/outputs)</td>
<td>213</td>
</tr>
<tr>
<td>12.3.8 Error handling (SFC inputs/outputs)</td>
<td>213</td>
</tr>
<tr>
<td>12.3.9 Messages (SFC inputs/outputs)</td>
<td>217</td>
</tr>
<tr>
<td>12.3.10 Control words (SFC inputs/outputs)</td>
<td>218</td>
</tr>
<tr>
<td>12.3.11 Status words (SFC inputs/outputs)</td>
<td>219</td>
</tr>
<tr>
<td>12.3.12 System parameters (SFC inputs/outputs)</td>
<td>224</td>
</tr>
<tr>
<td>12.3.13 Reserves (SFC inputs/outputs)</td>
<td>224</td>
</tr>
<tr>
<td>13 Compiling SFC charts and SFC types</td>
<td>225</td>
</tr>
<tr>
<td>13.1 Overview of compiling charts, types, and instances</td>
<td>225</td>
</tr>
<tr>
<td>13.2 Settings for Compiling/Downloading</td>
<td>227</td>
</tr>
<tr>
<td>13.3 How to compile</td>
<td>228</td>
</tr>
<tr>
<td>13.4 Overview of the Blocks Generated during Compilation</td>
<td>229</td>
</tr>
<tr>
<td>13.5 Consistency check</td>
<td>231</td>
</tr>
<tr>
<td>14 Downloading to the AS</td>
<td>233</td>
</tr>
<tr>
<td>14.1 How to download programs</td>
<td>233</td>
</tr>
<tr>
<td>14.2 Reaction of the SFC at deactivation before downloading changes only</td>
<td>237</td>
</tr>
<tr>
<td>15 Behavior of the sequential control system in the AS</td>
<td>239</td>
</tr>
<tr>
<td>15.1 Sequential control systems in the AS</td>
<td>239</td>
</tr>
<tr>
<td>15.2 Specifying the runtime behavior</td>
<td>241</td>
</tr>
<tr>
<td>15.2.1 Runtime behavior of the sequential control system</td>
<td>241</td>
</tr>
<tr>
<td>15.2.2 Operating modes</td>
<td>242</td>
</tr>
<tr>
<td>15.2.3 Step Control Modes</td>
<td>242</td>
</tr>
<tr>
<td>15.2.4 Execution Options</td>
<td>245</td>
</tr>
<tr>
<td>15.2.5 Operating states</td>
<td>247</td>
</tr>
<tr>
<td>15.2.5.1 Operating States</td>
<td>247</td>
</tr>
<tr>
<td>15.2.5.2 Operating state logic for SFC (SFC OSL)</td>
<td>248</td>
</tr>
<tr>
<td>15.2.5.3 Continuous Mode</td>
<td>253</td>
</tr>
<tr>
<td>15.2.5.4 Diagram of the State Changes for SFC OSL</td>
<td>254</td>
</tr>
<tr>
<td>15.2.5.5 Operating state logic for sequencers (sequencer OSL)</td>
<td>256</td>
</tr>
<tr>
<td>15.2.5.6 Diagram of the State Changes for Sequencer OSL</td>
<td>258</td>
</tr>
<tr>
<td>15.3 Processing the SFC in the AS</td>
<td>259</td>
</tr>
<tr>
<td>15.3.1 Executing an SFC</td>
<td>259</td>
</tr>
<tr>
<td>15.3.2 Processing an SFC after CPU stop and restart</td>
<td>262</td>
</tr>
<tr>
<td>15.3.3 Commands</td>
<td>264</td>
</tr>
<tr>
<td>15.3.4 Start Requirements of an SFC (Chart/Instance)</td>
<td>266</td>
</tr>
<tr>
<td>15.3.5 Behavior when multiple commands are queued</td>
<td>267</td>
</tr>
<tr>
<td>15.3.6 Processing the SFC elements</td>
<td>268</td>
</tr>
<tr>
<td>15.3.6.1 Runtime Phases of a Step</td>
<td>268</td>
</tr>
<tr>
<td>15.3.6.2 Executing a Step and Transition</td>
<td>269</td>
</tr>
<tr>
<td>15.3.6.3 Executing a Simultaneous Branch</td>
<td>271</td>
</tr>
<tr>
<td>15.3.6.4 Executing an Alternative Branch</td>
<td>272</td>
</tr>
<tr>
<td>15.3.6.5 Executing a Loop</td>
<td>273</td>
</tr>
<tr>
<td>15.3.6.6 Executing a Jump</td>
<td>273</td>
</tr>
</tbody>
</table>
# Table of contents

15.4 Changing the control strategy and setpoints .............................................................. 275  
15.4.1 Changing the Control Strategy and Setpoints for an SFC Instance ........................................ 275  
15.4.2 Tracking the Control Strategy and Setpoints in AUTO Mode ........................................... 277  

16 Testing and commissioning sequential control systems ......................................................... 279  
16.1 Operator control and monitoring during testing ............................................................... 279  
16.2 Display in Test mode ......................................................................................................... 284  
16.3 States of the Steps and Transitions .................................................................................. 288  
16.4 Icons for Operating States .............................................................................................. 289  
16.5 Properties of a step during testing ................................................................................... 290  
16.6 Properties of a transition during testing .......................................................................... 292  
16.7 Properties of a sequencer during testing ......................................................................... 294  

17 Documenting programs ....................................................................................................... 297  
17.1 Documenting SFCs .......................................................................................................... 297  
17.2 Chart reference data ....................................................................................................... 299  
17.3 Logs ................................................................................................................................ 301  
17.4 Defining Footers .............................................................................................................. 302  

18 Configuring parameter controls .......................................................................................... 305  
18.1 Parameter Control .......................................................................................................... 305  
18.2 How to configure the runtime .......................................................................................... 306  
18.3 Execution with Different Parameter Sets ......................................................................... 307  
18.4 Example of a Recipe Data Block ..................................................................................... 309  

19 Tips & Tricks ....................................................................................................................... 311  
19.1 Configuring SFC calls ..................................................................................................... 311  
19.2 Converting Older Projects ............................................................................................. 312  

Index ................................................................................................................................... 315
What's new in SFC?

Enhancements/changes in V8.0

Version V8.0 contains the following enhancements or changes compared to version V7.1.2:

- In V8.0, several minor bugs were fixed and improvements were made in SFC.

Enhancements/changes in V7.1.2

Version V7.1.2 contains the following enhancements or changes compared with version V7.1:

- In V7.1.2, several minor bugs were fixed and improvements were made in SFC.
What's new in SFC?
What is SFC?

SFC (Sequential Function Chart) enables you to graphically configure and commission sequential control systems. The sequential control systems are transferred to an automation system and executed there. A sequential control system allows state-driven or event-driven execution of production processes based on sequencers.

You can use sequential control systems to describe the manufacturing specifications of products as event-driven processes (recipes), for example.

The sequential control system controls the basic automation functions created with CFC via operating and state changes and processes them selectively.

SFC provides two independent variants of sequential control systems for different application scenarios:

- SFC chart
- SFC type with SFC instances

SFC chart

A SFC chart contains the following:

- A standardized interface for controlling the SFC through the user program or by the operator
- Up to 8 sequencers for formulating the sequential control system ("gray sequencer")

The sequential control system accesses the basic automation blocks and signals directly and is therefore not reusable.
SFC type/SFC instance

An SFC type contains the following:

- A standardized interface for controlling the SFC through the user program or by the operator
- Up to 32 sequencers for formulating the sequential control system ("gray sequencer")

You can also expand the interface ("gray interface"). The SFC type accesses only its own interface and can therefore be used as often as required as an SFC instance.

An SFC instance is derived from an SFC type and initially has properties identical to those of the SFC type. You can adapt the SFC type to the SFC instance to a limited extent on an instance-specific basis through changes in the CFC or SFC.
Criteria for selecting SFC chart or SFC type

You use an **SFC chart** when you need a sequential control system that is to be used once and will control multiple sub areas of the production plant.

You use an **SFC type** when you need a sequential control system that is to be used more than once and has SFC instances that will each control their own sub area of the production plant. Central changes to an SFC type are automatically forwarded to all SFC instances.

You can use the following criteria in the order given to decide if an SFC chart or an SFC type is required:

- Sphere of action
- Reuse
- Changeability

Example of decision making:

If the sphere of action is large but the sequential control system is to be used more than once, you still may need to realize the sequential control system as an SFC chart in certain circumstances. Reuse is then only possible in the form of copies. In this case, you cannot make changes from a central location.

If the sphere of action is small, you can use either an SFC chart or an SFC type. Here, the decision depends on the ability to reuse and to change.

What is a sequential control system?

A sequential control system allows the structuring of production processes by breaking them down into consecutive steps. The steps define the actions to be executed and therefore the operations required in the production plant, for example:

- Switch on motor
- Open valve

The passage from one step to the next triggers a transition with a defined step enabling condition, for example:

- Temperature achieved
- Reactor empty
What are sequencers?

You can use sequencers as a higher-level structuring tool that defines state or event-triggered sub-sequences, for example:

- Sequence for production
- Sequence for holding
- Sequence for error handling

You specify the state or event that is to trigger execution of the sequencer in the start condition of the sequencer. The sequencer itself is formulated as a series of steps and transitions.

A sequential control system contains at least one sequencer. In the initial state, its start condition is set so that the sequencer is processed when the sequential control system is in the "active" state (condition: RUN = TRUE).

Where are sequential control systems used?

Typical applications of sequential control systems involve batch processing plants. But you can also use sequential control systems for continuously operating plants, for example, for:

- Startup and shutdown operations
- Operating point changes
- State changes when faults occur

You can use sequential control systems in the following plant levels:

- Device control level (for example, opening a valve or starting a motor)
- Group control level (for example, dosing, stirring, heating, or filling)
- Unit level (for example, tanks, mixers, scales, reactors)
- Plant level (synchronization of units and common resources, for example, routing)

You can use SFC charts at all levels, while SFC types are generally used on the group control and unit levels since requirements for reusability at the higher levels are unlikely.

Note

The SFC editor is a tool for creating and testing sequential control systems.

In this documentation, the term "SFC" refers to the chart, type, instance or editor depending on the context.
Getting started

3.1 How to work with SFC in overview

Operating principle

1. You create your sequential control system using graphic tools in the SFC editor. You place the elements of the SFC in the sequencer according to fixed rules. You do not need to be aware of details such as algorithms or the assignment of machine resources but can concentrate solely on the technological aspects of your configuration.

2. After creating the sequencers as a series of steps and transitions, you proceed to configure the object properties of SFC, sequencers, steps and transitions, and formulate the respective properties there. You configure the following:
   - Operating parameters of the SFC
   - Start conditions of the sequencers
   - Actions of the steps
   - Step enabling conditions of the transitions

3. When this configuration is complete, you compile the executable machine code with SFC, download it to the AS, and test it with the SFC test functions.

SFC chart

If you have never before worked with the SFC editor, it is best to begin with an SFC chart. In this way, you will require an understanding of the following topics:

- Creating, configuring, compiling and downloading a sequential control system
- How the sequential control system works in the AS
- How to use commands (such as Start and Abort) in a sequential control system in test mode
SFC type and SFC instance

Once you know how to implement a sequential control system with an SFC chart, you can begin to work with the SFC type and SFC instance. You can then decide which of the two sequential control systems is better suited for the specific task.

The SFC type and SFC instance introduce new aspects of working with sequential control systems. With the SFC chart, you can start working directly because an SFC chart can be generated and then compiled, downloaded and tested immediately.

With an SFC type, you create the sequential control system independent of a specific application in the form of a template so that it can be used more than once.

Then you create an SFC instance, adapt it to the individual application and interconnect to the basic automation blocks.

A standard interface must be available for the SFC type in order to interconnect an SFC instance with the basic automation. You can expand this interface to include new inputs/outputs or create the required inputs/outputs technologically as characteristics of the SFC type.

You then compile the program, download it to the AS, and test the SFC instance. This also tests the SFC type indirectly.

Additional information

For further information on this topic, see the following sections:
How to create an SFC Chart in overview (Page 17)
How to create an SFC type in overview (Page 20)
How to create an SFC instance in overview (Page 22)
3.2 How to create an SFC Chart in overview

Introduction

The steps for configuring SFC charts are presented in order below.

Procedure

1. **Create the project structure**

   Create a project structure in the SIMATIC Manager in which you configure CFC/SFC charts.

   For further information on this subject, refer to the section How to create a project structure (Page 65)

2. **Adapt the chart properties**

   You can change the general properties (name, author, comment), adapt the operating parameters and change the version.

   By setting the operating parameters, you specify the behavior of the sequential control system, such as operating mode (MANUAL, AUTO), step control mode (T, O, T and C, etc.) and other execution options (cyclic operation, time monitoring or autostart).

   In the chart properties, you can change the option that the chart is to be transferred to the OS.

   For further information on this subject, refer to the section How to Adapt Chart Properties (Page 89)

3. **Runtime properties**

   The runtime properties of an SFC chart specify how this SFC chart fits in the time sequence of the processing within the overall structure of the target system. You can change the runtime properties in the window of the sequence editor for the CFC.

   For further information on this subject, refer to the section Runtime Properties of an SFC (Page 159)

4. **Create the sequencers**

   The newly created SFC already contains one sequencer (RUN). You create additional sequencers in the tab of the currently selected sequencer using the shortcut menu or you copy sequencers from the templates of the SFC Library.

   For further information on this subject, refer to the section How to Configure Multiple Sequencers (Page 112)

5. **Configure the sequencer properties**

   For each sequencer, you configure the start condition and, as an option, the action for preprocessing and postprocessing and the OS comment, if needed.

   For further information on this subject, refer to the section How to edit sequencer properties (Page 134)
6. **Create the topology of the sequencers**

   You configure sequential control systems in the SFC editor by inserting the steps and transitions for one or more sequencers and adding additional elements as necessary.

   For further information on this subject, refer to the section
   How to create a sequencer topology (Page 111)

7. **Configure the steps (in the object properties dialog box)**

   You formulate actions in steps. The actions contain statements that change the values of block inputs and of shared addresses or that enable and disable runtime groups or other SFC charts.

   For further information on this subject, refer to the section
   How to Edit a Step (Page 136)

8. **Configure the transitions (in the object properties dialog box)**

   You formulate conditions in the transitions to read the following:
   - The values of the block I/Os and shared addresses.
   - The state (such as on/off) of runtime groups or other SFC charts.

   When the conditions of a specified logic operation are met, the next step becomes active in the execution of the SFC and its actions are executed.

   For further information on this subject, refer to the section
   How to Edit the Transition (Page 149)

9. **Compile and download the program**

   When you compile the current chart folder, an executable user program is generated (compile entire program) that you can then download to the target system (CPU).

   For further information on this topic, see the following sections:
   Overview of compiling charts, types, and instances (Page 225)
   How to download programs (Page 233)

10. **Test the program**

    After compiling and downloading, you test the program in process mode or in laboratory mode. Using the SFC test functions, you can run the sequential control system in various operating modes and step control modes and monitor and modify the values of addresses in the CPU. You can also influence the most important operating modes (e.g., STOP, Clear/Reset, RUN, for example) of the CPU.

    For further information on this subject, refer to the section
    Operator control and monitoring during testing (Page 279)

**Note**

Prior to compiling (Item 9), you must interconnect the external view of the SFC chart or the SFC instance (of the SFC type) for AUTO mode in the CFC chart.

For further information on this subject, refer to the section
External View of the SFC Chart (Page 34)
Tips

The following tips may help you:

- In the "SFC Library", you can access the "ChartStates" SFC chart with the menu command SFC Library > Blocks+Templates > Templates. This already contains several sequencers for state-oriented processing of the sequential control system. You can copy this chart and use it as an example.

- If you want to focus initially on learning the steps from creation to testing of a sequential control system, you should compile, download and test the "ChartStates" SFC chart (or a newly created SFC chart) without any modifications. The SFC chart is processed in MANUAL mode. In this way, you can monitor and influence the processing of the SFC chart in test mode with the available test functions.

- To stop the SFC chart from being processed "too quickly" in the automation system, you can move the SFC chart in the run sequence, for example, to the "OB32" task. Select the menu command Debug > Test Settings and select a suitable monitoring cycle for the test settings in the SFC.
3.3 How to create an SFC type in overview

Introduction

The steps for configuring SFC types are presented in order below:

Procedure

1. Create the project structure

Create a project structure in the SIMATIC Manager in which you can configure CFC/SFC charts and SFC types.

For further information on this subject, refer to the section How to create a project structure (Page 65)

Note:
You can also create an SFC type in a library.

2. Create the SFC type

In the Component View of SIMATIC Manager, insert an SFC type as a new object in the chart folder. The SFC type is entered in the block catalog of CFC.

Tip: In the "SFC Library", you can access the "TypeStates" SFC type with the menu command SFC Library > Blocks+Templates > Templates. The SFC type already contains several sequencers for state-oriented processing of the sequential control system. You will also find the “TypeCtrlStrategy” SFC type. It contains a control strategy-oriented processing of the sequential control system. You can copy these templates and change them to suit your purposes.

For further information on this subject, refer to the tips in the section Configuring the SFC type (Page 75)

3. Adapt the SFC properties

You can change the general properties (name, author, family, FB number, comment), adapt the operating parameters and change the version.

By setting the operating parameters, you specify the behavior of the sequential control system, such as operating mode (MANUAL, AUTO), step control mode (T, O, T and O, for example) and other execution options (such as cyclic operation, time monitoring or autostart).

For further information on this subject, refer to the section How to Adapt Type Properties (Page 91)

4. Create the interface

The SFC type already has a standard interface that usually must be extended for the interconnections of SFC instances with the basic automation.

You can find additional information in the SFC online help, in sections Standard Interface of the SFC Type (Page 171), "Inputs/Outputs" Interface Expansions (Page 178), "Characteristics" Interface Expansions (Page 181).
5. **Optional: Configure the characteristics**

You use the Characteristics editor for the technological configuration of the interface. In the Characteristics editor, you define characteristics and insert control strategies, setpoints, process values or block contacts, for example.

For further information on this subject, refer to the section **Characteristics of the SFC type** (Page 98)

6. **Create the sequencers**

Open the SFC type. The newly created SFC already contains one sequencer (RUN). You create additional sequencers in the tab of the currently selected sequencer with the shortcut menu or you copy sequencers from the templates in the SFC Library (SIMATIC Manager). You can copy these templates and adapt them to suit your purposes.

For further information on this subject, refer to the section **How to Configure Multiple Sequencers** (Page 112)

7. **Configure the sequencer properties**

For each sequencer, you configure the start condition and, as an option, the action for preprocessing and postprocessing and the OS comment, if needed.

For further information on this subject, refer to the section **How to edit sequencer properties** (Page 134)

8. **Create the topology of the sequencers**

You configure sequential control systems in the SFC editor by inserting the steps and transitions for one or more sequencers and adding additional elements as necessary.

For further information on this subject, refer to the section **How to create a sequencer topology** (Page 111)

9. **Configure the steps (in the "Object Properties" dialog box)**

You formulate actions in steps. The actions contain statements that change the values of inputs of the interface of the SFC type.

For further information on this subject, refer to the section **How to Edit a Step** (Page 136)

10. **Configure the transitions (in the "Object Properties" dialog box)**

You formulate conditions in the transitions to read the values of I/Os from the interface of the SFC type. When the conditions of a specified logic operation are met, the next step becomes active in the execution of the SFC and its actions are executed.

For further information on this subject, refer to the section **How to Edit the Transition** (Page 149)

11. **Create the SFC instances**

For further information on this subject, refer to the section **How to create an SFC instance in overview** (Page 22)
3.4 How to create an SFC instance in overview

Introduction

The steps for configuring SFC instances are presented in order below:

Procedure

1. **Open the CFC chart**
   
   Open the CFC chart in which you want to interconnect an SFC instance to the basic automation blocks.
   
   Place the SFC type in the chart from the CFC block catalog or from a library and thereby generate an SFC instance.
   
   For additional information on this subject, refer to the section How to Create an SFC Instance (Page 71)

2. **Specify the SFC instance properties**
   
   Change the general properties (name, comment) in the object properties of the SFC instance in the CFC, as required.
   
   For additional information on this subject, refer to the section How to Adapt Instance Properties (Page 93)

3. **Adapt the operating parameters and options of the instance**
   
   In the CFC, open the SFC instance and adapt the operating parameters in the "Properties" dialog box. These parameters determine the runtime behavior in the AS.
   
   As an option, select which of the control strategies specified by the SFC type are to be used for the SFC instance.
   
   For additional information on this subject, refer to the section How to Adapt Instance Properties (Page 93)

4. **Assign parameters and interconnect the interface of the SFC instance**
   
   You assign parameters for the SFC instance in CFC using the object properties or in SFC using the "I/Os" Interface editor.
   
   In CFC, you interconnect the inputs/outputs of the SFC instance to the inputs/outputs of the CFC blocks or to shared addresses.
5. **Compile and download the program**

When you compile the current chart folder, an executable user program is generated (compile entire program) that you can then download to the target system (CPU).

For additional information on this topic, see the following sections:
- Overview of compiling charts, types, and instances (Page 225)
- How to download programs (Page 233)

6. **Test the program**

After compiling and downloading, you can test the program in process mode or in laboratory mode. Using the test functions, you run the sequential control system online in various operating modes and step control modes and monitor and modify the values of addresses. You can also influence the most important operating modes (STOP or RUN, for example) of the CPU.

For additional information on this subject, refer to the section Operator control and monitoring during testing (Page 279).
Getting started

3.4 How to create an SFC instance in overview
4.1 SFC in the STEP 7 environment

Configuration environment

SIMATIC Manager is used as the graphic user interface for all target systems and it is used to coordinate the tools and objects. It manages tools and data and is used, among other things, to create and modify a project structure (CPU, CFC/SFC charts) and to start the SFC editor.

The figure shows how SFC fits into the STEP 7 and PCS 7 environment.

Key:

<table>
<thead>
<tr>
<th>Object</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>PH (Plant Hierarchy)</td>
<td>Software packages of the process control system (PCS 7)</td>
</tr>
<tr>
<td>IEA (Import/Export Assistant)</td>
<td></td>
</tr>
<tr>
<td>PO (process object view)</td>
<td></td>
</tr>
<tr>
<td>WinCC</td>
<td>Operator control and monitoring system in PCS 7 (here with the add-on package for SFC Visualization)</td>
</tr>
</tbody>
</table>
4.2 SFC and plant hierarchy

Use of an SFC in the plant hierarchy

The plant hierarchy (PH) allows charts to be arranged and managed not only from the point of view of running them on a CPU, but also according to technological or plant criteria (for example, an SFC chart for device control, group control, or unit control).

If the SFC chart was assigned to a plant hierarchy folder, the path of the plant hierarchy is added to the chart name. You thus use the naming scheme of your plant as the criteria for arranging charts in the project.

Note

You cannot assign SFC types to a hierarchy folder in the plant view since they themselves are not relevant to execution (from the perspective of the process to be automated).

Additional information

You can find additional information on the plant hierarchy in the online help for PH.

4.3 SFC and Other Target Systems

SFC and other target systems

This *SFC for S7* documentation contains a considerable amount of information that is only relevant for the S7 target system. To avoid needing to point this out in each individual case, the most important topics and functions that are irrelevant or are handled different for other target systems are listed below.

- Symbolic addressing
- Shared addresses
- Program-controlled enabling/disabling of charts
4.4 Configuration limits of the SFC

The SFC has the following configuration limits:

<table>
<thead>
<tr>
<th>Object</th>
<th>Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sequencers per SFC chart</td>
<td>≤ 8</td>
</tr>
<tr>
<td>Sequencers per SFC type</td>
<td>≤ 32</td>
</tr>
<tr>
<td>Steps per sequencer</td>
<td>2 - 255</td>
</tr>
<tr>
<td>Instructions per action</td>
<td>≤ 50</td>
</tr>
<tr>
<td>Transitions per sequencer</td>
<td>1 - 255</td>
</tr>
<tr>
<td>Conditions per transition / start condition</td>
<td>≤ 16</td>
</tr>
</tbody>
</table>
4.5 Uses and functionality of SFCs

4.5.1 What is an SFC Chart?

Use and functionality

An SFC chart is a sequential control system that normally controls a larger section of a plant and is only used once since the same control task does not occur again in the plant.

To this end, the SFC chart has a set of properties and a standardized interface for controlling the SFC through the user program or by the operator. The sequential control system accesses the basic automation blocks and signals directly and is therefore not reusable.

To configure the sequential control system, you must know the mechanisms for processing an SFC and its sequencers in the AS.

You will find more information on this subject in the following sections:

Sequential control systems in the AS (Page 239)
Runtime behavior of the sequential control system (Page 241)
Operating States (Page 247)
Operating state logic for SFC (SFC OSL) (Page 248)
Executing an SFC (Page 259)
Properties

The properties of the SFC chart include the following elements:

- Name, author and comment as descriptive data
- The operating parameters for the AS that determine the execution in the AS (for example, operating mode, step control mode, execution options).

You will find more information on this subject in the following sections:
- Operating modes (Page 242)
- Step Control Modes (Page 242)
- Execution Options (Page 245)

Runtime behavior of the sequential control system (Page 241)

You can also specify whether operator control and monitoring of the SFC chart on the OS is to be possible ("Transfer chart to OS for visualization" check box). You require the "SFC Visualization" add-on package on the OS for this purpose.

You can configure the message properties and the footer data of the SFC chart as additional properties.

Control

The standard interface of the SFC chart contains the required inputs/outputs for the following tasks:

- Controlling the SFC chart in AUTO mode via the user program
- Operator control and monitoring of the SFC chart in MANUAL mode by the operator

Control of the SFC chart in AUTO mode is realized in the external view of the SFC chart.

You will find more detailed information on the external view in the section:
- External View of the SFC Chart (Page 34)

You will find more information on the SFC chart in the following sections of the online help:
- Inputs/Outputs of the SFC Chart Standard Interface (Page 163)
- Standard interface of the SFC chart (Page 163)
- Inputs/Outputs of the SFC Chart Sorted According to Usage (Page 170)

Sequencers

The actual sequential control system is formulated with the sequencers.

The SFC chart allows configuration of up to 8 sequencers for formulating the control function (in the figure this is the "gray sequencer").

You will find more information on sequencers in the following sections:
- What is a sequencer? (Page 36)
- What is an SFC type/SFC instance? (Page 30)
- SFC Chart and SFC Type Compared (Page 33)
4.5.2 What is an SFC type/SFC instance?

SFC type

An SFC type is a sequential control system that normally controls a smaller sub area of a plant (unit or section of a plant, whereby the control task occurs repeatedly in similar form in the plant. For this reason, with the SFC type the sequential control system is created as a type-defined template apart from a specific application. Once it is created, you can use the SFC type repeatedly by generating SFC instances from it.

The SFC type contains a standardized interface to allow control of the SFC from the user program or by the user and allows configuration of up to 32 sequencers for formulating the control function ("gray sequencer"). The interface can also be expanded by the user (interface with "gray background" in figure). The SFC type accesses only its own interface and can therefore be used as often as required as an SFC instance.

SFC instance

An SFC instance is derived from an SFC type and initially has properties identical to those of the SFC type. You can adapt the SFC instance to a limited extent on an instance-specific basis in CFC or SFC. Only after interconnecting the SFC instance with blocks and signals of basic automation do you have an executable sequential control system.
Properties of an SFC type and an SFC instance

The properties of the SFC type and SFC instance include the name and comment as descriptive data. The SFC type has the additional properties author, version and family and FB number as information for the compilation. Both for the SFC type and the SFC instance, you can specify the operating parameters for the AS that determine the execution in the AS (for example, operating mode, step control mode or execution options).

You will find more information on this subject in the following sections:

- Operating modes (Page 242)
- Step Control Modes (Page 242)
- Execution Options (Page 245)
- Runtime behavior of the sequential control system (Page 241)

You can also set additional options and specify whether the SFC type and SFC instance are relevant for SIMATIC BATCH and which of the defined control strategies will be enabled for use with the SFC type or SFC instance. As additional properties, you can configure the message properties and the footer data of the SFC type and SFC instance.

SFC instances can be made available on the OS (default: Yes), so that operator control and monitoring of the SFC instances can be performed on the OS with the "SFC Visualization" add-on package. If you do not want SFC instances to be available on the OS, you need to clear the "OCM possible" check box in the object properties for the instance.

The standard interface of the SFC type includes the inputs/outputs needed to control an SFC instance from the user program in AUTO mode or for operator control and monitoring of the SFC instance by the user in MANUAL mode.

You will find detailed information on the standard interface in the section:

- Standard Interface of the SFC Type (Page 171)

To interconnect an SFC instance with the basic automation, you usually need to expand the interface for the SFC type. You can do this by adding new inputs/outputs directly for the interface of the SFC type or by creating the necessary inputs/outputs technologically as characteristics of the SFC type. We recommend this procedure.

You will find more information on the interface in the following sections:

- "Characteristics" Interface Parameter Assignments (Page 179)
- "Characteristics" Interface Expansions (Page 181)
- "Inputs/Outputs" Interface Expansions (Page 178)

The actual sequential control system is formulated with the sequencers.

You will find more information on sequencers in the section:
- What is a sequencer? (Page 36)

To configure the sequential control system, you must know the mechanisms for processing an SFC and its sequencers in the AS.
You can find additional information about this in the following sections:

- Sequential control systems in the AS (Page 239)
- Runtime behavior of the sequential control system (Page 241)
- Operating States (Page 247)
- Operating state logic for SFC (SFC OSL) (Page 248)
- Executing an SFC (Page 259)
### 4.5.3 SFC Chart and SFC Type Compared

#### Common features

An SFC chart and an SFC type have the following common features:

- Standard interface for external control of the SFC (MANUAL/AUTO)
- Sequencers for formulating the control function of the SFC

#### Differences

An SFC chart and an SFC type differ as follows:

<table>
<thead>
<tr>
<th>SFC chart</th>
<th>SFC type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Direct access to basic automation</td>
<td>Access to basic automation by means of interface</td>
</tr>
<tr>
<td>Can be used once</td>
<td>Can be used more than once</td>
</tr>
<tr>
<td>Can be modified locally</td>
<td>Can be modified centrally</td>
</tr>
<tr>
<td>Interface cannot be expanded</td>
<td>Interface can be expanded</td>
</tr>
<tr>
<td>Maximum of 8 sequencers can be configured</td>
<td>Maximum of 32 sequencers can be configured</td>
</tr>
</tbody>
</table>
4.5.4 External View of the SFC Chart

Display

The external view of the SFC chart represents the SFC chart in a CFC chart as a block with its interface. To distinguish it from CFC blocks and nested charts, the external view has the "SFC chart" icon in the header.

![SFC Chart Display](image-url)
Purpose

In the external view, you can assign parameters for and interconnect the interface of the SFC chart for AUTO mode so that the status of the SFC chart can be determined and the control signals can be derived from it for the SFC chart. This allows you to influence the processing of the SFC chart via the user program. If the SFC chart is used in MANUAL mode, only the inputs/outputs that are also processed in MANUAL mode are relevant in the external view.

Interconnection

You can provide the inputs/outputs with textual interconnection and/or interconnect them with compatible inputs/outputs of other objects or with shared addresses. You make all interconnections in the sheet bar. You cannot place any object, such as blocks, in this window.

Properties

You can open the object properties for the entire interface or for each individual I/O in the header of the external view. The Run Sequence window opens in the runtime properties box.

You will find more information on the interface in the sections:
- Standard interface of the SFC chart (Page 163)
- Inputs/Outputs of the SFC Chart Sorted According to Usage (Page 170)
4.6 SFC elements

4.6.1 What is a sequencer?

Sequencers enable status-dependent and event-driven execution in the SFC.

When it is created, each sequencer is given a consecutive number. This number is required for the "programmed target steps" and to interpret the outputs of the SFC in the CFC view.

An SFC chart can include a maximum of 8 sequencers and an SFC type a maximum of 32 sequencers, which can be controlled by defining different start conditions.

One sequencer at a time is displayed in the working window of the SFC. You switch to another sequencer via the tab at the lower edge of the window.

When you create a new SFC chart/type, a sequencer with the name "RUN" and the start condition RUN=TRUE is created automatically (Note: This corresponds to a chart of V5.x). The start conditions are formulated like transition conditions. For additional information, refer to the section What is a Transition? (Page 40). An empty start condition – in contrast to the transition – is evaluated as FALSE, in other words, the sequencer is never executed.

In addition to this start condition, each sequencer also contains the "Priority" attribute (1 – 255) that is used to specify the start order if the conditions of several sequencers are satisfied simultaneously (in the "Start Condition" tab of the "Sequencer Properties" dialog box). If the conditions of multiple sequencers with the same priority are met simultaneously, the position of the sequencer in the tab determines the order of processing in the CPU (similar to the alternative branch; you will find information on this in the section Executing an Alternative Branch (Page 272)).

You can also configure an additional action for each sequencer. Each action consists of the following:

- **Preprocessing**: actions to be executed in every cycle after the sequencer has started and before the steps and transitions are processed
- **Postprocessing**: actions to be executed in every cycle after the steps and transitions are processed

This, for example, allows you to make pre-settings or to pass on the results of the sequencer execution.

You will find more information on configuring sequencers in the section How to Configure Multiple Sequencers (Page 112)
4.6.2 What are Sequencer Elements?

Sequence path elements

An SFC chart consists of 1 to 8 sequencers (What is a sequencer? (Page 36)) and an SFC type of 1 to 32 sequencers, each with a series of sequence path elements (basic elements). This includes the following elements:

- Step
- Transition

There is another element outside a sequence (can be freely positioned):

- Text

The remaining elements are structures that are made up of different basic elements:

- Sequence
- Simultaneous branch
- Alternative branch
- Loop
- Jump

Identification of "Step" and "Transition"

The identification characteristic of the basic elements, step and transition, is a name that is unique within the sequencer. When the element is created, the editor enters a consecutive number that you can change to a name with a maximum of 16 characters. This name must not consist exclusively of numbers. The original number is retained for the element and is displayed in the object properties in the "Number" box. This is required for the "programmed target steps" and to interpret the outputs of the SFC in the CFC view.

You can use the optional comment, for example, to provide a text description of the respective functionality. A comment can take up several lines and contain up to 80 characters, however, only 16 characters are displayed to the right of the chart element.

If you position the cursor on the step or the comment, you can see a tooltip displaying the name with a maximum of 16 characters and a comment with up to 50 characters.

Resources

When programming and assigning parameters for steps, transitions, start condition and preprocessing and postprocessing in SFCs, you can access the interface of the SFC, the CFC block inputs/outputs, the runtime groups, other SFCs, and all shared addresses of the user program. With the textual interconnections, you can also access objects that do not yet exist. When you configure steps and transitions in SFC types, it is only possible to use the SFC type's own interface inputs/outputs in addition to the textual interconnections.
**Screen display**

The elements of an SFC are shown on the screen as follows:

- All the elements of a sequencer, including the links are displayed in white with black print in the unselected and unedited state.
- Selected elements, including the links are displayed in blue.
- Edited steps or transitions (whose object properties have been changed) are displayed in gray with black print.

**Note**

The colors indicated here are the default settings, some of which can be modified.

For additional information, see: Default Colors (Page 62).
4.6.3 What is a Step?

Step

The step is a control entity for processing the assigned actions in the AS. You can configure up to three actions (Initialization, Processing, Termination) for each step.

Action

An action is a series of statements formulated as follows:

- Assignments for assigning parameters of CFC blocks or shared resources, for example:
  
  - Setpoint temp := 100
  - XYZ.pump.on := TRUE

- Enabling or disabling of an SFC or a runtime group, for example:
  
  - SFC_1.INTOFF := TRUE
  - ABL_1.EN := FALSE

Step types

You can use one start step, a maximum of 253 normal steps, and one final step in each sequencer. When a sequencer is created, one start step, one final step and one transition are created automatically. These three basic elements form the initial state of a sequencer that you can then adapt by adding further chart elements.

The start step is activated at the start of the sequencer and the associated actions are executed according to the status of the successor transition. The final step does not have a successor transition; all actions are processed exactly once.

You cannot copy, cut or delete the start step or final step. This ensures that a sequencer always contains one (and only one) start step and final step.

All steps besides the start step and final step are normal steps.
4.6.4 What is a Transition?

Transition

A transition contains the conditions with which a sequential control system passes control from one step to the next. Several conditions can be logically combined using Boolean operators. The result of the logic operation determines whether the next step is enabled.

| Name | Comment |

Transition condition

The result of a transition condition in an SFC chart is derived from a Boolean expression that is formed by logic operations on the values of the following elements:

- Shared addresses
- Textual interconnections
- CFC block inputs/outputs
- Runtime group state
- SFC chart status

In SFC types, only the inputs/outputs of the SFC type’s own interface can be used in addition to the textual interconnections.

During compilation, an empty transition is pre-assigned the default value TRUE. This pre-assignment is necessary because while the formulation of a condition is optional, the AS requires a defined value as a step enabling condition.

If several transitions are valid simultaneously, for example, in the alternative branch, for a loop or jumps), the system automatically assigns priority from left to right in descending order.
4.6.5 What is a text?

Text

You can use the “Text” chart element to insert any static text (free text) you require in a chart.

The text box can contain one-line or multiple-line character strings. For example, this allows you to insert descriptive texts into the SFC during the analysis phase that can later be replaced by automation functions.

Free texts are not embedded in the topological sequencer structure. If you change the topology, the text boxes are not repositioned; they maintain their position.

4.6.6 What is a Sequence?

Sequence

A sequence is a series of steps and transitions that can be created with a selectable length and inserted in the sequential control system.

Sequencer

A closed sequence forms one sequencer in a sequential control system, for example between the divergence and convergence of a simultaneous or alternative branch. The entire sequencer is also designated as a sequencer in SFC. It runs from the start step to the final step.
### 4.6.7 What is a Simultaneous Branch?

**Simultaneous branch**

If the execution is to be split into two or more sequencers that are to be executed at the same time, the simultaneous branch is used.

A simultaneous branch consists of at least two sequencers that are processed at the same time.

A simultaneous branch is always preceded by a transition or an alternative branch. The simultaneous branches end in a simultaneous convergence that is always followed by a transition or alternative branch.

The successor transition executes only when all actions of the steps at the end of every associated sequencer have been executed (apart from the "termination" action) and the step enabling condition is fulfilled (synchronization).

![Diagram of simultaneous branch](image)

**Key:**

1. Sequencer
2. Successor transition
4.6.8 What is an Alternative Branch?

Alternative branch

If the execution is to be split up into two or more sequencers but only one of these sequencers is to be executed, an alternative branch is used.

An alternative branch consists of at least two sequencers, of which only one will be processed depending on the state of the first transitions in the individual sequencers. The sequencer whose transition is fulfilled first is selected. If more than one transition is fulfilled simultaneously, the sequencer furthest left with a fulfilled transition is executed.

The alternative branch can only be preceded and followed by a step or a simultaneous branch.

Key:

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>(1)</td>
<td>Sequencer</td>
</tr>
<tr>
<td>(2)</td>
<td>Next step</td>
</tr>
</tbody>
</table>
4.6.9 What is a Loop?

Loop

If a section of the sequencer is to be executed again contingent on a transition, a loop is used.

A loop consists of a sequence and a return path with a transition that encloses a sequence. The start of the loop must be immediately following a step and the return path must converge again immediately before a step.

The transition of the return path is processed chronologically after the successor transition. If the successor transition and the return path transition are fulfilled at the same time, the step or simultaneous branch located after the successor transition is processed.

Note

Return paths out of or into simultaneous or alternative branches are not possible.
### 4.6.10 What is a Jump?

#### Jump

A jump can be used, contingent on a transition condition, to continue the execution of the sequencer at any step within the same sequencer.

A jump always leads immediately out of the sequence following a step (origin of the jump). Several jumps are also possible.

- **Key:**
  - (1) Jump origin
  - (2) Jump
  - (3) Jump destination
  - (4) Successor transition

A jump consists of an initiating transition and an arrow with the jump destination information. The jump destination specification is the name of the step at which the execution is continued when the transition is fulfilled. If the jump destination is still unknown, the name is "???".

The transition of the jump is processed chronologically after the successor transition.

If the successor transition and one or more jump transitions are fulfilled at the same time, the step (or simultaneous branch) located after the successor transition is executed.

The origin and destination of a jump must always be a step.

---

**Note**

Be aware of the possible consequences during execution in the AS when working with jumps to or from a sequencer of a simultaneous branch.

*You will find more detailed information in the section: How to Create and Edit a Jump (Page 122).*
Starting and working

5.1 Working with the SFC Editor

SFC Editor

You create your sequential control system using graphic tools in the SFC Editor by specifying actions and step enabling conditions. The elements of the SFC are positioned in the sequencer according to fixed rules. You do not need to be aware of details such as algorithms or the assignment of machine resources; you can concentrate solely on the technological aspects of your configuration.

After creating the sequencers as a series of steps and transitions, you proceed to configure the object properties of SFC, sequencers, steps and transitions. You configure the operating parameters of the SFC, the start conditions of the sequencers as well as the actions of the steps and the step enabling conditions of the transitions.

After configuration, you compile the executable machine code with SFC, download it to the CPU, and test it with the SFC test functions.

5.2 How to start the SFC Editor

Introduction

You can call the CFC editor directly or via the SIMATIC Manager.

Starting via the SIMATIC Manager:

Double-click the icon of the SFC chart you want to open.
The SFC Editor starts and opens the chart.

Starting via the Windows Desktop:

Double-click on the icon of the desired SFC chart on your desktop.
or
Select the program listing in the Start menu with the menu command Start > SIMATIC > STEP 7 > SFC.
5.3 Multiuser engineering

Configuring in the network

Multiuser engineering of projects or multiprojects is basically possible, and allows you to configure, test and commission target systems from different remote locations or from a PC network (multiuser engineering).

You will find detailed information about multi-user engineering and its consequences in the "CFC for SIMATIC S7" help in: Configuring in the network

5.4 Navigating in the SFC

5.4.1 How to Navigate in the SFC

Introduction

There are several ways in which you can navigate in an SFC.

Changing the display size

- Select one of the menu commands View > Zoom > Zoom In / Zoom Out / Normal Size / Zoom Factor
  This allows you to change the size of the displayed SFC elements - and therefore also the visible section of the window.
  or
- Use the button in the toolbar to zoom in and zoom out

Changing the displayed section

You can change the displayed section as follows:

- Using the scroll bars
- With the View > Center menu command or by clicking the button
- by dragging the SFC elements over the window border (automatic scrolling of the window section)
- Changing the Window Section (Page 61)
Switching between sequencers

If the SFC consists of several sequencers, you can switch from one sequencer to another as follows:

- Using the tabs in the bottom horizontal scroll bar
- Using the menu commands **Edit > Go To > Next Sequencer**
  or **Edit > Go To > Previous Sequencer**
5.5 User interface and operator input

5.5.1 Elements of the User Interface

SFC Editor

The SFC Editor is a Windows application consisting of the following elements:

- Frame window with title bar
- Menu bar
- Toolbar
- Status bar
- At least one working window

You execute functions and operator inputs using menu commands (menu bar, shortcut menu) and in dialog boxes as needed.

It is generally advisable and more efficient to manipulate functions and objects using the mouse. Most operations can be also performed using the keyboard.
5.5 User interface and operator input

Windows

Within the SFC Editor, you can open as many windows as you wish (within the limits of Windows). Each window contains the view of an SFC (chart or type). You can also open several windows for the same SFC. The window in the foreground is always the active working window. This means that the menus and buttons in the toolbar always apply to this window.

A scroll bar is located at the lower border of the window, which you can use to move the content in the visible area of the window.

This bar also contains the tabs with which you can switch between the sequencers of the chart.

Title bar

The title bar of the SFC window contains the name "SFC" and the buttons that you normally find in Windows applications. If you display the SFC maximized to the full screen display, the name also appears in the title bar of the SFC window, since the title bar of the working window is no longer displayed. The title bar of the online window can be distinguished from the title bar of the offline window by the different colored background and/or the text (can be specified in the SIMATIC Manager using the menu command Options > Customize > "View" tab).

Menu bar in the SFC window

The menu bar of the SFC window is always visible below the title bar. There are two different combinations of menus depending on whether or not an SFC is open.

- If no SFC is open, the window is displayed with an empty editing area and the menu bar is limited to four menus (SFC, View, Options, Help).
- If at least one SFC is open, the complete menu bar is displayed with all menu titles.
- If several charts are open, the commands of the menu bar relate to the active window.

<table>
<thead>
<tr>
<th>Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(1)</td>
<td>Element Bar</td>
</tr>
<tr>
<td>(2)</td>
<td>Title bar</td>
</tr>
<tr>
<td>(3)</td>
<td>Menu bar</td>
</tr>
<tr>
<td>(4)</td>
<td>Toolbar</td>
</tr>
<tr>
<td>(5)</td>
<td>Status bar</td>
</tr>
<tr>
<td>(6)</td>
<td>Tab</td>
</tr>
<tr>
<td>(7)</td>
<td>Scroll bar</td>
</tr>
<tr>
<td>(8)</td>
<td>Working window</td>
</tr>
</tbody>
</table>
Starting and working

5.5 User interface and operator input

Menu

A menu is a group of functions that can be selected and activated in the menu bar. Menu commands that are not applicable in a particular situation are displayed in gray and cannot be selected.

Opening a menu

You open menus by clicking the menu title or, using the keyboard, by typing the underlined character in the menu title while holding down the ALT key.

If you hold down the left mouse button, you can move through the menu bar and open and close the menus one after the other (browsing).

Shortcut menu

By right-clicking in the current context, you can display a shortcut menu containing frequently needed commands from the menu bar. You obtain a different shortcut menu with the following objects:

- Free area
- SFC element
- "Properties" dialog box in the editing window
- "Properties" dialog box for the selected line outside the editing window

Icons in the toolbar

The icons in the toolbar can be used to start some of the most important functions from the menus.

Depending on the current state of the editor, only the command icons that can be applied in a specific situation are activated.

If you hold the hover the mouse pointer over an icon in the toolbar for a short time, the tooltip for the button is displayed. The status bar displays a more detailed description of the function of the button.

When you click the question mark icon, the cursor changes its appearance. You can now click a button, a menu command or an object in a chart. Help on the selected element will appear.
Icons in the element bar

The icons on the element bar represent the functions of the "Insert" menu.

<p>| | | | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Key:

(1) Activate selection
(2) Insert step + transition
(3) Insert simultaneous sequence
(4) Insert alternative sequence
(5) Insert loop
(6) Insert jump
(7) Insert text

Positioning the toolbar and element bar

You can freely position the toolbar and element bar any place on the desktop, as is usual in Windows. Press the left mouse button at any free space on the bar and drag it to the desired location. The arrangement of the icons is either horizontal or vertical depending on the position of the bar.

If you position the toolbar or element bar in the working area away from the edge, it is displayed as a dialog box with a "Close" button.

If you close the toolbar or element bar, you can display it again with the menu command View > Toolbar or View > Element Bar.

Status bar

The status bar is located at the bottom edge of the SFC window and displays important information.

The left part of the status bar displays contextual information, for example explanations of menu commands, operator prompts or error messages.

The right part of the status bar displays current information such as the current location of an element. In test mode (online), the operating state of the CPU is displayed and also visualized by a color (red = STOP, green = RUN)

Optional layout

While the menu bar is always visible, you can toggle the display of the toolbar, element bar and status bar on or off, for example to make more room on your screen. You can specify what is displayed by selecting the appropriate command in the "View" menu.
5.5 User interface and operator input

5.5.2 Dialog boxes

Operator control

When you activate some functions, a dialog box opens. Here, you can make settings and selections for the function you have activated. In the dialog boxes of modal dialogs, you cannot make selections or entries outside the box. You must first close the dialog box by clicking "OK" or "Cancel". The dialog boxes for "Properties" and "Browse", on the other hand, remain on the user interface while you continue to edit the sequencer topology or select other menu functions (except for activating test mode: here, the dialog boxes are closed).

Layout

Some dialog boxes contain tabs. This means that several pages (tabs) are cascaded on the screen. You can navigate from tab to tab as necessary.

To make configuration more convenient, some dialog boxes not only offer standard buttons (such as OK, Cancel, Help), they also have buttons with useful functions.

In the "Object Properties" dialog, you can use the buttons

within the sequencer to access the next element of the selected element type (step or transition) without having to open and close the box again each time. The jumps to the base elements are in the logical order and not the geometrical order.

With:

→ in a simultaneous or alternative branch, you jump from left to right to the first element of the next sequencer.

← you jump from right to left to the last element of the sequencer further left.

↓ you move from top to bottom in a sequencer. When a simultaneous or alternative branch is reached, only the left sequencer is executed.

↑ you move from bottom to top in a sequencer. When a simultaneous or alternative branch is reached, only the right sequencer is executed.
5.6 Working with the mouse

5.6.1 Working with the Mouse

Mouse and pointer

The main tool for working with the SFC Editor is the mouse. You can perform most operations with the mouse, in particular those for selecting, moving, and inserting chart elements. In some situations, the mouse pointer changes its appearance and may take the shape of an arrow, hand or hourglass.

In addition to the standard pointer in insert mode, the SFC Editor also uses the icons of the chart elements to be inserted, as they are displayed in the toolbar or element bar. The icons also have a small cross to enable exact positioning (top left). This additional cross is referred to as a positioning crosshair in the following.

For move or copy functions, the positioning crosshair also appears along with a hand icon when a position is reached where the element is permitted.

Autoscrolling

When moving elements in a chart, you can scroll the displayed window if the insertion position of the element is not currently visible. Holding down the left mouse button, drag the object to the edge of the window so that the positioning crosshair is on the inner (horizontal or vertical) line of the window frame. The window is then scrolled until the limit of the chart is reached or until you pull the positioning crosshair away from the edge of the window.

Shortcuts using the mouse

- Object properties: Double-click on a step or transition:
- Move: Select SFC elements + drag:
- Copy and paste: Select SFC elements + <Ctrl> + drag
- Select all elements in the lasso: "Lasso" (press mouse button and drag)

Tooltips for steps and transitions

Instead of opening the object properties to get specific information, you can also do the following:
- Step: If you position the mouse pointer on a step, the name, number and – when available – the run times, comments and acknowledgement information are displayed.
- Transition: If you position the mouse pointer on a transition, the name, number and – when available – the comments are displayed.


5.7 Working with the keyboard

5.7.1 Working with the Keyboard

Working with the keyboard

You can also perform most functions with the keyboard. You can find additional information about this in the following sections:

- Shortcut keys for menu commands (Page 56)
- Shortcuts for Menu Commands (Page 57)
- Navigating in the Menu Bar and Menus with the Keyboard (Page 58)
- Opening Help with the Keyboard (Page 61)
- Navigating in Dialog Boxes with the Keyboard (Page 59)
- Navigating in Texts with the Keyboard (Page 60)
- Selecting Text with the Keyboard (Page 60)
- Keyboard Shortcuts in the Sequencer (Page 61)

5.7.2 Shortcut keys for menu commands

Shortcut keys for menu commands

You can call every menu command via an appropriate key combination with the <Alt> key.

Press the following keys in the order shown:

- <Alt>
- The letter underlined in the menu name you require (for example, <Alt+S> for the "SFC" menu - if the "SFC" menu is included in the menu bar). The menu opens.
- The underscored letter in the name of the required menu command (for example, <N> for the menu command "New").

If this involves a command with additional submenus, these will also be opened. Repeat the actions above until you have selected a complete menu command by typing in the relevant letters.

The menu command is executed after you have entered the last letter of the shortcut key.

Examples

<table>
<thead>
<tr>
<th>Menu commands</th>
<th>Shortcut key</th>
</tr>
</thead>
<tbody>
<tr>
<td>SFC &gt; New</td>
<td>&lt;Alt+S+N&gt;</td>
</tr>
<tr>
<td>Options &gt; Customize &gt; Colors</td>
<td>&lt;Alt+O+C+C&gt;</td>
</tr>
</tbody>
</table>
### 5.7.3 Shortcuts for Menu Commands

#### Shortcuts for menu commands

<table>
<thead>
<tr>
<th>Menu command</th>
<th>Menu</th>
<th>Function</th>
<th>Shortcut key</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>SFC</td>
<td>Create a new chart</td>
<td>&lt;Ctrl+N&gt;</td>
</tr>
<tr>
<td>Open</td>
<td></td>
<td>Open chart</td>
<td>&lt;Ctrl+O&gt;</td>
</tr>
<tr>
<td>Close</td>
<td></td>
<td>Close chart</td>
<td>&lt;Ctrl+F4&gt;</td>
</tr>
<tr>
<td>Check consistency</td>
<td></td>
<td>Check the consistency of the charts in the chart folder</td>
<td>&lt;Ctrl+Alt+K&gt;</td>
</tr>
<tr>
<td>Compile</td>
<td></td>
<td>Compile charts in the chart folder</td>
<td>&lt;Ctrl+B&gt;</td>
</tr>
<tr>
<td>Print</td>
<td></td>
<td>Print chart</td>
<td>&lt;Ctrl+P&gt;</td>
</tr>
<tr>
<td>Exit</td>
<td></td>
<td>Exit the SFC Editor</td>
<td>&lt;Alt+F4&gt;</td>
</tr>
<tr>
<td>Cut</td>
<td>Edit</td>
<td>Cut selected objects</td>
<td>&lt;Ctrl+X&gt;</td>
</tr>
<tr>
<td>Copy</td>
<td></td>
<td>Copy selected objects</td>
<td>&lt;Ctrl+C&gt;</td>
</tr>
<tr>
<td>Paste</td>
<td></td>
<td>Paste copied/cut objects</td>
<td>&lt;Ctrl+V&gt;</td>
</tr>
<tr>
<td>Delete</td>
<td></td>
<td>Delete selected objects</td>
<td>&lt;Del&gt;</td>
</tr>
<tr>
<td>Copy object properties</td>
<td></td>
<td>Copy object properties for step/transition</td>
<td>&lt;Ctrl+Shift+C&gt;</td>
</tr>
<tr>
<td>Paste object properties</td>
<td></td>
<td>Paste copied object properties in step/transition</td>
<td>&lt;Ctrl+Shift+V&gt;</td>
</tr>
<tr>
<td>Select all</td>
<td></td>
<td>Select all objects in the chart</td>
<td>&lt;Ctrl+A&gt;</td>
</tr>
<tr>
<td>Find</td>
<td></td>
<td>Search for SFC elements</td>
<td>&lt;Ctrl+F&gt;</td>
</tr>
<tr>
<td>Object properties</td>
<td></td>
<td>Open the &quot;Properties – Step/Transition&quot; dialog</td>
<td>&lt;Alt+Return&gt;</td>
</tr>
<tr>
<td>Go to, Next sequencer</td>
<td></td>
<td>Go to the sequencer that is after the current sequencer</td>
<td>&lt;Ctrl+PgDn&gt;</td>
</tr>
<tr>
<td>Go to, Previous sequencer</td>
<td></td>
<td>Go to the sequencer that is before the current sequencer</td>
<td>&lt;Ctrl+PgUp&gt;</td>
</tr>
<tr>
<td>Run sequence</td>
<td></td>
<td>Open &quot;Run Sequence&quot;</td>
<td>&lt;Ctrl+F11&gt;</td>
</tr>
<tr>
<td>Select + Paste</td>
<td>Paste</td>
<td>Switch on selection mode (cursor as arrow)</td>
<td>&lt;Esc&gt;</td>
</tr>
<tr>
<td>Step + [Transition]</td>
<td></td>
<td>Activate insert mode for step + transition</td>
<td>&lt;Ctrl+1&gt;</td>
</tr>
<tr>
<td>Simultaneous branch</td>
<td></td>
<td>Activate insert mode for simultaneous sequence</td>
<td>&lt;Ctrl+2&gt;</td>
</tr>
<tr>
<td>Alternative branch</td>
<td></td>
<td>Activate insert mode for alternative sequence</td>
<td>&lt;Ctrl+3&gt;</td>
</tr>
<tr>
<td>Loop</td>
<td></td>
<td>Activate insert mode for loop</td>
<td>&lt;Ctrl+4&gt;</td>
</tr>
<tr>
<td>Jump</td>
<td></td>
<td>Activate insert mode for jumps</td>
<td>&lt;Ctrl+5&gt;</td>
</tr>
</tbody>
</table>
**Menu command** | **Menu** | **Function** | **Shortcut key**
--- | --- | --- | ---
Text box |  | Activate insert mode for text boxes | <Ctrl+6>

Download | CPU | Download current program to the CPU | <Ctrl+L>

Module information |  | Display status of the current CPU | <Ctrl+D>

Operating mode |  | Display/change the operating mode of the CPU | <Ctrl+I>

Test mode | Debug | Activate/deactivate test mode | <Ctrl+T>

Overview | View | Select overview display | <Ctrl+U>

Details |  | Select display at the last set zoom level | <Ctrl+Shift+U>

Zoom, Zoom in |  | Enlarge size of display | <Ctrl+Num + *)>

Zoom, Zoom out |  | Reduce size of display | <Ctrl+Num - *)>

Zoom, Normal size |  | Display in normal size (100%) | <Ctrl+Shift+N>

Update |  |  | <F5>

Settings, Display | Options | Open the "Layout" dialog box | <Ctrl+Alt+E>

Chart reference data |  | Open "Chart reference data" | <Ctrl+Alt+R>

Symbol table |  | Open the symbol table | <Ctrl+Alt+T>

Arrange, Cascade | Window | Cascade windows | <Shift+F5>

Arrange, Horizontally |  | Tile windows from top to bottom | <Shift+F2>

Arrange, Vertically |  | Tile windows from left to right | <Shift+F3>

Context-sensitive help | Help | If there is a current context, for example, a selected menu command, the relevant help topic is opened. Otherwise the contents page is displayed. | <F1>

*) "Num +" / "Num –" indicates the plus/minus keys on the numeric keypad

### 5.7.4 Navigating in the Menu Bar and Menus with the Keyboard

**Navigating in the menu bar and menus with the keyboard**

<table>
<thead>
<tr>
<th>Function</th>
<th>Shortcut key</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move to the menu bar</td>
<td>&lt;F10&gt;</td>
</tr>
<tr>
<td>Move to the pop-up menu</td>
<td>&lt;Shift+F10&gt;</td>
</tr>
</tbody>
</table>
5.7 Working with the keyboard

<table>
<thead>
<tr>
<th>Function</th>
<th>Shortcut key</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select the menu containing the underscored character X</td>
<td>&lt;Alt+X&gt;</td>
</tr>
<tr>
<td>Select a menu command</td>
<td>Underlined character in the menu command</td>
</tr>
<tr>
<td>Move one menu command to the left</td>
<td>&lt;Left&gt;</td>
</tr>
<tr>
<td>Move one menu command to the right</td>
<td>&lt;Right&gt;</td>
</tr>
<tr>
<td>Move one menu command up</td>
<td>&lt;Up&gt;</td>
</tr>
<tr>
<td>Move one menu command down</td>
<td>&lt;Down&gt;</td>
</tr>
<tr>
<td>Activate the selected menu command</td>
<td>&lt;ENTER&gt;</td>
</tr>
<tr>
<td>Deselect menu or return to text</td>
<td>&lt;Esc&gt;</td>
</tr>
</tbody>
</table>

5.7.5 Navigating in Dialog Boxes with the Keyboard

Navigating in dialog boxes with the keyboard

<table>
<thead>
<tr>
<th>Function</th>
<th>Shortcut key</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move to the next text box (left to right and top to bottom)</td>
<td>&lt;Tab&gt;</td>
</tr>
<tr>
<td>Move one text box back</td>
<td>&lt;SHIFT+Tab&gt;</td>
</tr>
<tr>
<td>Move to the next line</td>
<td>&lt;Ctrl+Down&gt;</td>
</tr>
<tr>
<td>Move to the previous line</td>
<td>&lt;Ctrl+Up&gt;</td>
</tr>
<tr>
<td>Previous address</td>
<td>&lt;Ctrl+Left&gt;</td>
</tr>
<tr>
<td>Next address or in steps in the last address of the last line: Next line on next page</td>
<td>&lt;Ctrl+Right&gt;</td>
</tr>
<tr>
<td>Focus on line with this digit (single)</td>
<td>&lt;Ctrl+Number&gt;</td>
</tr>
<tr>
<td>Next page (with transitions and start condition of the sequencers)</td>
<td>&lt;PAGE DOWN&gt;</td>
</tr>
<tr>
<td>Previous page (with transitions and start condition of the sequencers)</td>
<td>&lt;PAGE UP&gt;</td>
</tr>
<tr>
<td>Move to the next tab</td>
<td>&lt;Ctrl+PAGE DOWN&gt;</td>
</tr>
<tr>
<td>Move to the previous tab</td>
<td>&lt;Ctrl+PAGE Up&gt;</td>
</tr>
<tr>
<td>To first address</td>
<td>&lt;Ctrl+Home&gt;</td>
</tr>
<tr>
<td>To last address</td>
<td>&lt;Ctrl+End&gt;</td>
</tr>
<tr>
<td>Activate/deactivate OS comment in line with this digit (single)</td>
<td>&lt;Ctrl+Alt+Number&gt;</td>
</tr>
<tr>
<td>Move to text box that contains the underscored character X</td>
<td>&lt;Alt+X&gt;</td>
</tr>
<tr>
<td>Move the cursor in a selection list</td>
<td>Arrow keys</td>
</tr>
<tr>
<td>Open a selection list</td>
<td>&lt;Alt+Down&gt;</td>
</tr>
<tr>
<td>Select or deselect an object in a list</td>
<td>&lt;Space&gt;</td>
</tr>
<tr>
<td>Confirm the entries and close the dialog box (&quot;OK&quot; button)</td>
<td>&lt;ENTER&gt;</td>
</tr>
<tr>
<td>Close the dialog box without saving changes (&quot;Cancel&quot; button)</td>
<td>&lt;Esc&gt;</td>
</tr>
</tbody>
</table>
5.7 Working with the keyboard

5.7.6 Navigating in Texts with the Keyboard

Navigating in texts with the keyboard

<table>
<thead>
<tr>
<th>Function</th>
<th>Shortcut key</th>
</tr>
</thead>
<tbody>
<tr>
<td>One line up or one character to the left in a text consisting of only one line</td>
<td>&lt;Up&gt;</td>
</tr>
<tr>
<td>One line down or one character to the right in a text consisting of only one line</td>
<td>&lt;Down&gt;</td>
</tr>
<tr>
<td>One character to the right</td>
<td>&lt;Right&gt;</td>
</tr>
<tr>
<td>One character to the left</td>
<td>&lt;Left&gt;</td>
</tr>
<tr>
<td>One word to the right</td>
<td>&lt;Ctrl+Right&gt;</td>
</tr>
<tr>
<td>One word to the left</td>
<td>&lt;Ctrl+Left&gt;</td>
</tr>
<tr>
<td>To the beginning of the line</td>
<td>&lt;Home&gt;</td>
</tr>
<tr>
<td>To the end of the line</td>
<td>&lt;End&gt;</td>
</tr>
<tr>
<td>To the previous page</td>
<td>&lt;Page Up&gt;</td>
</tr>
<tr>
<td>To the next page</td>
<td>&lt;Page Down&gt;</td>
</tr>
<tr>
<td>To the beginning of the text</td>
<td>&lt;Ctrl+Home&gt;</td>
</tr>
<tr>
<td>To the end of the text</td>
<td>&lt;Ctrl+End&gt;</td>
</tr>
</tbody>
</table>

5.7.7 Selecting Text with the Keyboard

Selecting text with the keyboard

<table>
<thead>
<tr>
<th>Function</th>
<th>Shortcut key</th>
</tr>
</thead>
<tbody>
<tr>
<td>One character to the right</td>
<td>&lt;Shift+Right&gt;</td>
</tr>
<tr>
<td>One character to the left</td>
<td>&lt;Shift+Left arrow&gt;</td>
</tr>
<tr>
<td>One word to the right</td>
<td>&lt;Ctrl+Shift+Right&gt;</td>
</tr>
<tr>
<td>One word to the left</td>
<td>&lt;Ctrl+Shift+Left arrow&gt;</td>
</tr>
<tr>
<td>Text to beginning of line</td>
<td>&lt;Shift+Home&gt;</td>
</tr>
<tr>
<td>Text to end of line</td>
<td>&lt;Shift+End&gt;</td>
</tr>
<tr>
<td>One line up</td>
<td>&lt;Shift+Up&gt;</td>
</tr>
<tr>
<td>One line down</td>
<td>&lt;Shift+Down&gt;</td>
</tr>
<tr>
<td>To the previous page</td>
<td>&lt;Shift+Page Up&gt;</td>
</tr>
<tr>
<td>To the next page</td>
<td>&lt;Shift+Page Down&gt;</td>
</tr>
<tr>
<td>To the beginning of a file</td>
<td>&lt;Ctrl+Shift+Home&gt;</td>
</tr>
<tr>
<td>To the end of a file</td>
<td>&lt;Ctrl+Shift+End&gt;</td>
</tr>
</tbody>
</table>
5.7.8 Keyboard Shortcuts in the Sequencer

Keyboard shortcuts in the sequencer

- <Up> selects the previous SFC element in the sequence
- <Down> selects the next SFC element in the sequence
- <Left> selects the SFC element further left in the sequence
- <Right> selects the SFC element further right in the sequence

5.7.9 Opening Help with the Keyboard

Opening Help

<table>
<thead>
<tr>
<th>Function</th>
<th>Shortcut key</th>
</tr>
</thead>
<tbody>
<tr>
<td>Opens Help.</td>
<td>&lt;F1&gt;</td>
</tr>
<tr>
<td>If there is a current context, for example, a selected menu command, the relevant help topic is opened. Otherwise the table of contents will be displayed.</td>
<td></td>
</tr>
<tr>
<td>Close the Help window and return to the SFC Editor</td>
<td>&lt;Alt+F4&gt;</td>
</tr>
</tbody>
</table>

5.7.10 Changing the Window Section

Changing the window section

<table>
<thead>
<tr>
<th>Function</th>
<th>Shortcut key</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scroll window section up</td>
<td>&lt;Page Up&gt;</td>
</tr>
<tr>
<td>Scroll window section down</td>
<td>&lt;Page Down&gt;</td>
</tr>
<tr>
<td>Scroll window section right</td>
<td>&lt;Ctrl+Page Up&gt;</td>
</tr>
<tr>
<td>Scroll window section left</td>
<td>&lt;Ctrl+Page Down&gt;</td>
</tr>
<tr>
<td>To top of window</td>
<td>&lt;Ctrl+Home&gt;</td>
</tr>
<tr>
<td>To bottom of window</td>
<td>&lt;Ctrl+End&gt;</td>
</tr>
<tr>
<td>To left edge of window</td>
<td>&lt;Home&gt;</td>
</tr>
<tr>
<td>To right edge of window</td>
<td>&lt;End&gt;</td>
</tr>
</tbody>
</table>
5.8 Default colors

5.8.1 Default Colors

<table>
<thead>
<tr>
<th>Defaults</th>
<th>Option</th>
<th>Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>Selection</td>
<td>Blue</td>
<td></td>
</tr>
<tr>
<td>Step/transition parameters assigned [name]</td>
<td>Black</td>
<td></td>
</tr>
<tr>
<td>Step/transition no parameters [object]</td>
<td>White</td>
<td></td>
</tr>
<tr>
<td>Step/transition no parameters [name]</td>
<td>Black</td>
<td></td>
</tr>
<tr>
<td>Step/transition [comment]</td>
<td>Black</td>
<td></td>
</tr>
<tr>
<td>Step/transition selected [name]</td>
<td>White</td>
<td></td>
</tr>
<tr>
<td>Step ACTIVE [object]</td>
<td>Green</td>
<td></td>
</tr>
<tr>
<td>Step ACTIVE [name]</td>
<td>Black</td>
<td></td>
</tr>
<tr>
<td>Step EXECUTED [object]</td>
<td>Dark green</td>
<td></td>
</tr>
<tr>
<td>Step EXECUTED [name]</td>
<td>White</td>
<td></td>
</tr>
<tr>
<td>Step HELD [object]</td>
<td>Yellow</td>
<td></td>
</tr>
<tr>
<td>Step HELD [name]</td>
<td>Black</td>
<td></td>
</tr>
<tr>
<td>Step ERROR [Object]</td>
<td>Red</td>
<td></td>
</tr>
<tr>
<td>Step ERROR [name]</td>
<td>Yellow</td>
<td></td>
</tr>
<tr>
<td>Transition FALSE [object]</td>
<td>Red-brown</td>
<td></td>
</tr>
<tr>
<td>Transition FALSE [name]</td>
<td>White</td>
<td></td>
</tr>
<tr>
<td>Transition TRUE [object]</td>
<td>Dark green</td>
<td></td>
</tr>
<tr>
<td>Transition TRUE [name]</td>
<td>White</td>
<td></td>
</tr>
<tr>
<td>Operator Prompt</td>
<td>Gray</td>
<td></td>
</tr>
<tr>
<td>Error confirmation</td>
<td>Red</td>
<td></td>
</tr>
</tbody>
</table>

Defaults that cannot be changed:

- Textual interconnection [object] | Yellow
- Textual interconnection [name] | Black
- Step INACTIVE [object] | *)
- Step INACTIVE [name] | *)
- Transition INACTIVE [object] | **) 
- Transition INACTIVE [name] | **) 

Windows default:

(Modify with the right mouse button on Desktop: Properties > Display > Extended > Element: Selected elements)

- Background of the tab ID for tabs with content | Blue

*) Color is identical to the color for the unselected step and cannot be changed
**) Color is identical to the color for the unselected transition and cannot be changed
5.9 Data backup in the SFC Editor

5.9.1 Data Backup in the SFC Editor

Data backup in the SFC Editor

All changes made in the SFC Editor are saved immediately - there is therefore no other save option in SFC. This means that you can no longer undo or cancel changes in the SFC Editor by closing the editor without saving. This does not apply for the configuration of sequences, steps, and transitions in the properties dialog box. There you can "discard" changes.

To back up your data, copy the entire program folder to a backup project. You can then revert to old versions at any time. This also allows you to archive your complete configuration.
Starting and working

5.9 Data backup in the SFC Editor
Creating the project structure

6.1 How to create a project structure

Optional procedures

Use the SIMATIC Manager to create a project. The following options are available in the SIMATIC Manager for creating a project:

- **PCS 7 Wizard**
  With the PCS 7 Wizard, you create a single project or multiproject in the Plant view and in the Component view. In addition to the actual project, a multiproject also includes a master data library.

- **STEP 7 Wizard**
  With this wizard you create a STEP 7 project with the following elements:
  - The SIMATIC station
  - The CPU
  - The S7 program
  - The block folder

- **Menu commands**
  With the menu commands you create a new project and insert all the required components.

We recommend the procedure using the **PCS 7 Wizard** (point 1) because it is both faster and is less liable to errors.

You can select the PCS 7 Wizard or the STEP 7 Wizard in the SIMATIC Manager in the "Wizards" tab with the menu command **Options > Settings**.

Creating a project with the PCS 7 Wizard

1. Start the PCS 7 Wizard (if it does not start automatically) with the menu command **File > 'New Project' Wizard**.
2. Follow the steps in the wizard.
   In the dialog "Which objects will be used in the project?", the "SFC chart" option in the "AS objects" box is set by default.

The hardware configuration is made largely automatically and only the CPUs permitted for PCS 7 are available to you.
Creating the project structure

6.1 How to create a project structure
7.1 Overview of Creating, Configuring and Managing SFCs

Overview

You can create new charts and types, open them for editing, and modify their properties in SIMATIC Manager and in the SFC Editor. You can copy and delete charts and types only in the SIMATIC Manager. You copy and delete instances in the relevant CFC chart.

The SFC chart can be displayed in CFC in its external view, allowing the SFC to be controlled by CFC interconnections. The external view displays the SFC like a block; in other words, with the standard interface.

Requirement for creating SFC charts and SFC types

In the SIMATIC Manager, the desired project structure must be created.

Each newly created chart or type is assigned a default name, which you can later change. If you change the name, the system checks to ensure that it is unique in the CPU. Note the following when assigning names:

- The names of SFC charts can contain a maximum of 22 characters.
- The names of SFC types can contain a maximum of 16 characters. Although you can enter 24 characters in the properties, when the instances are created, only 16 characters are permitted.
- The following characters are illegal: " % . / \" 

You will find more information on creating project structures, charts and types in the sections:

- How to create a project structure (Page 65)
- How to Create an SFC Chart (Page 69)
- How to create an SFC type (Page 70)
Requirements for creating SFC instances

You create an SFC instance from an SFC type. The following requirements must be met:

- The SFC type that you want to use as an instance is located in the chart folder of the current S7 program.
- The CFC chart in which you want to insert and interconnect the instance is open.
- The same naming convention as that for the SFC type applies, but you can only use 16 characters for the instance name.

You will find more information on creating instances in the section: How to Create an SFC Instance (Page 71)

You will find more information on handling charts in the sections:
- How to Adapt Chart Properties (Page 89)
- How to Adapt Type Properties (Page 91)
- How to Adapt Instance Properties (Page 93)
- Copying and Moving SFC Charts (Page 84)
- Copying and Moving SFC types (Page 85)
- Copying and Moving SFC Instances (Page 86)
- How to Delete SFC Charts and SFC Types (Page 87)
- How to Delete SFC Instances (Page 87)
7.2 Creating an SFC chart

7.2.1 How to Create an SFC Chart

Introduction

You create a new SFC chart in the following ways:

- in the Component view, Plant view or Process Object view of the SIMATIC Manager
- in the SFC Editor

Creating a chart in the SIMATIC Manager

1. In the Component view of the SIMATIC Manager, select the project (the SIMATIC station, the CPU, the S7 program) and the chart folder.
   
   If the chart is to be assigned to a plant hierarchy folder, select the project and the hierarchy folder from the Plant view or Process Object view.

2. Open a chart folder in the Component view or select a hierarchy folder in the Plant view or Process Object view.

3. Insert a chart into the chart folder or the hierarchy folder with the menu command Insert > S7 Software > SFC.
   
   The chart is given a default name by the system, for example SFC(1), which you can change.

Creating a chart in the SFC Editor

1. Select the menu command SFC > New.. in the SFC.
   
   The "New" dialog box opens.

2. Select the project (the SIMATIC station, the CPU, the S7 program) and the chart folder in the dialog box.

3. If the chart is to be assigned to a plant hierarchy folder, select the project and the hierarchy folder in the "Plant view" or "Process Object view"

4. Select "SFC" from the drop-down list box in the "Object type" box.

5. Enter a chart name in the "Object name" box.

6. Click "OK"

   A new window opens with the chart (1 sequencer, initial state).
7.3 Creating an SFC type and creating an SFC instance

7.3.1 How to create an SFC type

Introduction

You create a new SFC type in the following ways:

- In the Component view of the SIMATIC Manager
- In the SFC Editor

Creating a type in the SIMATIC Manager

1. Open the chart folder in the Component view of the SIMATIC Manager.
2. Select the menu command Insert > S7 Software > SFC Type.

   The SFC type is inserted into the chart folder.

Creating a type in the SFC Editor

1. Select the menu command SFC > New.

   The "New" dialog box opens.

2. Select the project (the SIMATIC station, the CPU, the S7 program) and the chart folder in the dialog box.

3. Select "SFC type" from the drop-down list box in the "Object type" box.
4. Enter a chart name in the "Object name" box.
5. Click "OK".

   A new window opens with the SFC type (a sequencer in the initial state).

Result

The type is given a default name by the system, for example SFC_Type(1), which you can change. The next free FB number is automatically reserved for the SFC type and the type template (FB 247) is copied to the block folder with this number. This allows you to configure messages and instances for the type once it is created without having to compile the type. The FB number can be modified later in the object properties dialog box.

When you first create an SFC type, the blocks required for compilation and for execution in the AS are copied to the current program and then managed in the ES. The blocks are included in the supplied block library.

Note

SFC types cannot be assigned to a hierarchy folder in the plant view since they themselves are not relevant to execution (from the perspective of the process to be automated).
7.3 Creating an SFC type and creating an SFC instance

7.3.2 How to Create an SFC Instance

Introduction

The SFC types available in the chart folder are displayed in the CFC block catalog. They are either in the "All blocks" directory and in the directory of the family, if they are assigned to a family, otherwise, they are in the "Other blocks" directory.

You can also insert SFC types in the CFC chart from the libraries (for example, SFC library or master data library).

Procedure

In CFC, drag the SFC type into the CFC chart from the block catalog or from a library.

Result

The SFC instance is represented like a CFC instance block. If there is not enough space to position the SFC instance, it is displayed as an "overlapping block" (light gray and without visible inputs/outputs). After moving them to a free position in the chart, the overlapping blocks are displayed as normal blocks again.

You can rename, assign parameters for, and interconnect the SFC instance in the CFC chart.
7.4 Configuring an SFC chart

7.4.1 Basics for configuring an SFC chart

Introduction

In SFC, there is initially the "SFC chart" object type along with the "SFC type" object type. The SFC chart allows the definition of sequential control systems using a predefined interface and process signals to the plant being automated. The SFC chart must first be compiled and it is then downloaded to the automation system where it is executed.

Basics of configuration

The SFC chart has an interface that is created when the SFC chart is generated and includes the standard interface derived from the SFC chart template (block @SFC_RTS). This is required to provide SFC system functionality (operating modes, operating states, step control modes, etc.) at the interface of the SFC chart.

You cannot move or delete the elements of the standard interface. Neither can you add new elements to the standard interface. You can edit the initial value, comments, and attributes.

During configuration, you can use the interface I/Os and any required process signals to formulate step assignments or the transition and start conditions. Here, textual interconnections are also possible.

The SFC chart is therefore not self-contained and can only be used once. If you wish to reuse the SFC chart, copy the SFC chart and adapt it fully to the "new environment" because the process signals used must usually be replaced by others.

For more detailed information on creating an SFC chart, refer to the section: How to create an SFC Chart in overview (Page 17).

You can set or change the following in the "Properties" dialog box:

- The "General" properties (name, author, comment, OS comment).
- The "AS operating parameters" (default settings: Step control mode, Operating mode, Command Output, Cyclic operation, Time monitoring and the start options: Autostart, Use default operating parameters when SFC starts)
- The option whether or not the SFC chart is available on the OS for operator control and monitoring

Runtime properties

An SFC chart is inserted in the run sequence in order to determine when the SFC chart is to be processed in the automation system.

You can find additional information about this in the section: Runtime Properties of an SFC (Page 159).
7.4 Configuring an SFC chart

Messages
You have the option of configuring seven messages requiring acknowledgment for an SFC chart in the SFC Editor (menu command SFC > Message...). The SFC chart itself requires the remaining available messages (one message requiring acknowledgment and one that does not).

You can find additional information about this in the section: How to configure messages in the SFC (Page 95)

Footer
You can configure an optional footer for an SFC chart.

You can find additional information about this in the section: Defining Footers (Page 302)

Copying, moving, deleting
You can copy, move, or delete SFC charts in the SIMATIC Manager.

You can find additional information about this in the following sections:
- Copying and Moving SFC Charts (Page 84)
- How to Delete SFC Charts and SFC Types (Page 87)

The attributes required for the SFC chart (for example, S7_m_c) are preset.

Compiling and downloading
The SFC chart is compiled in the "Compile Program" context and downloaded in the "Download to CPU" context.

You can find additional information about this in the following sections:
- Overview of compiling charts, types, and instances (Page 225)
- How to download programs (Page 233)

Testing
In the SFC test mode, the execution of the SFC is made dynamic and can be influenced with the test functions.

You can find additional information about this in the section: Operator control and monitoring during testing (Page 279)
7.4 Configuring an SFC chart

7.4.2 Configuration Changes in the SFC Chart

Description

You can change the topology (step/transition sequences, jump destinations) or the configured steps/transitions in the SFC chart. The changes do not take effect until the chart has been compiled and downloaded.

Following a topology change, you can download inactive sequencers at any time. You need to disable the SFC chart to download active sequencers.

You can download changes in the step and transition configuration at any time even if the SFC chart is currently being processed in the automation system.

The basic rule is that changes in the SFC chart that prevent or restrict a download of changes in RUN mode can be made only after the user has confirmed a prompt.

Further procedure

After completing the changes, you must compile and download the OS to ensure that the current data are available on the OS.
7.5 Configuring the SFC type and SFC instance

7.5.1 Type/instance concept of SFC

Overview of SFC type and SFC instance

The type/instance concept was introduced in SFC V6.0. This makes it possible to create sequential control system types that generate SFC instances when placed in a CFC chart.

The SFC type is not executable on its own. Like a function block type, an SFC type must be placed in a CFC chart to obtain a sequence-relevant object, in this case, an SFC instance. To execute an SFC instance, both the SFC type and the SFC instance are downloaded to the automation system.

You can find additional information in the section: Configuring the SFC type (Page 75)

7.5.2 Configuring the SFC type

Introduction

The SFC contains the SFC type* object type, in addition to the "SFC chart" object type. The SFC type allows the definition of sequential control systems including an interface. The sequential logic of the SFC type is based only on the interface I/Os of the SFC type. This is why the SFC type cannot access all process signals, in contrast to the SFC chart.

Overview of configuring the SFC type

The SFC type has an interface corresponding to the SFC chart. It is created when an SFC type is generated and already contains the SFC type standard interface, derived from the SFC type template "@SFC_TYPETEMPLATE" (FB 247). The standard interface is required to provide SFC system functionality (for example, operating modes, operating states, step control modes, etc.) at the interface of the SFC type.

You can add additional inputs/outputs to the standard interface in the Interface editor and additional characteristics in the Characteristics editor.

Note: The number of inputs is limited to 800 for the SFC type.

You will find more information on characteristic in the section: Using the characteristics editor and the interface editor (Page 97)

You cannot move or delete the elements of the standard interface or the characteristics. You can change the initial value, comments, and attributes.

Explicitly created elements can be manipulated as required.
During configuration, you can only use the interface inputs/outputs to formulate step assignments or the transition and start conditions. Addresses in assignments or conditions are therefore always references to inputs/outputs of the interface. Here, textual interconnections are also possible. This means the SFC type is self-contained since there is no external access from the SFC type that bypasses the interface.

There are two ways of creating and changing an SFC type:

- **Creating and changing in a library**
  This has the advantage that the master for the SFC type is always in the library and that the test project can still run until a new version of the SFC type is adopted.

- **Creating and changing in a project**
  This has the advantage that every change to the SFC type can be checked immediately since you are working directly with the master.

You can find additional information in the section: How to create an SFC type in overview (Page 20)

### Configuring runtime properties

An SFC type does not have any runtime properties, since it is not relevant to execution of the program. An SFC type cannot be inserted in the run sequence.

### Configuring messages

You can configure seven messages that must be acknowledged and five that do not require acknowledgment for an SFC type. The SFC type itself requires the remaining available messages (one message for each message type and 10 status messages for SIMATIC BATCH).

You can find additional information about this in the section: How to configure messages in the SFC (Page 95)

### Configuring footers

You can configure one footer for an SFC type.

You can find additional information about this in the section: Defining Footers (Page 302)

### Compile/download

The SFC type is compiled in the "Compile program" context and downloaded to the CPU in the "Download to CPU" context.

You will find more information on this subject in the following sections:

- Overview of compiling charts, types, and instances (Page 225)
- How to download programs (Page 233)
Tips

The following tips may help you:

- In the "SFC Library", you can find the "TypeStates" SFC type with the menu command SFC Library > Blocks+Templates > Templates. This already contains several sequencers for state-oriented processing of the sequential control system. You will also find the "TypeCtrlStrategy" SFC type containing control strategy-oriented processing of the sequential control system. You can copy these templates and change them to suit your purposes.

- When creating an SFC type for SIMATIC BATCH, remember the following points:
  - In Properties > Operating Parameters AS for the SFC type, you need to select the "AUTO" mode, otherwise the control commands from SIMATIC BATCH will have no effect (this also applies to the SFC instances).
  - In Properties > Options, you have to set one of the categories, "EOP" or "EPH", otherwise the SFC type remains "invisible" to SIMATIC BATCH.
  - If you wish to use the "Continuous mode" of the SFC, you have to set inputs/outputs ENASTART=1 and SELFCOMP=0. You must take into account the READY_TC input/output when configuring the start condition for sequencers (this also applies to SFC instances).

For additional information, refer to the section: Start Requirements of an SFC (Chart/Instance) (Page 266)
7.5.3 Configuration changes in the SFC type

Effects of the modified SFC type

Modifications to the interface of the SFC type are transferred to the SFC instances immediately. Changes to the interface include adding and deleting I/Os and changing data types. You can only download the SFC type and its instances during RUN mode of the automation system if all the SFC instances of this SFC type are disabled or if you temporarily disable the SFC instances during downloading. The instances are disabled during the download following operator confirmation and restarted after the download, again following operator confirmation. The execution of the instance then depends on the process state and on the configuration of the instances (especially the start conditions).

Note

If you perform the download with the SIMATIC Manager function "Compile and Download Objects" and the SFCs need to be disabled for this, the SFCs will not be disabled. In this case, the download will not be performed and an error message is entered in the log.

While changes are being downloaded, the SFC instances cannot be processed in the automation system and the SFC instances cannot be accessed via the interconnections in the CFC.

You do not have to disable the SFC instances to rename I/Os and characteristics or to change units and limits.

Changes in the topology (step/transition sequence, jump destination) and the step or transition configurations are made in the SFC type and do not become effective in the SFC instances until they are compiled and downloaded. You can download inactive sequencers following changes to the topology at any time. If you want to download active sequencers following changes to the topology, you must first disable the SFC instances before downloading. You can download changes to the step and transition configuration at any time even if SFC instances of the SFC type are currently being processed in the automation system.

After changing the configuration, you need to compile the OS to ensure that the current data are available on the OS.

Effects on SFC instances in the CFC

If you change an SFC type and the instances belonging to it are open in the CFC, you will have to update (View > Update or F5) the CFC and therefore the SFC instances after compiling and downloading the changes. If the CFC is in test mode, you must leave this mode before performing the update.

Effects on SFC instances in the SFC

If you want to change an SFC type and the instances belonging to it are opened in the SFC and are in test mode, you must leave this mode before changing the type. After making the change and compiling and downloading the change, you will have to update the SFC instances (View > Update or F5). You can then re-enable test mode.
7.5.4 Configuring the SFC Instance

Introduction

An SFC instance is derived from an SFC type. The SFC type is first inserted into a CFC chart similar to a function block type in the CFC. The SFC instances are therefore always assigned to one CFC chart and are addressed using the chart. SFC instances are displayed as blocks, same as CFC instances; in other words, their interface is visible in the CFC chart.

SFC instances are not displayed in the SIMATIC Manager since they can only be addressed via the CFC chart. With the assignment of the CFC chart to the plant hierarchy, the SFC instances contained are also indirectly assigned to the plant hierarchy.

Creating and handling

SFC instances are created by placing an SFC type in the CFC chart. The SFC types in the chart folder are displayed in the CFC "Blocks" catalog (in "All blocks" and in the folder of the family if they are assigned to a family, otherwise in the "Other blocks" folder). You can also insert SFC types from the libraries (for example, SFC library, master data library) in the CFC chart.

You can configure and interconnect an SFC instance similar to a CFC instance.

SFC instances are handled in the same way as CFC instances in the CFC chart in which they are placed.

Runtime properties

The runtime properties of an SFC instance are identical to the runtime properties of CFC block instances.

Messages

You can configure the messages of an SFC instance in SFC (menu command SFC > Message...) and in CFC using the "Object Properties" dialog box.

Opening and testing

You can open SFC instances in the CFC chart. The SFC opens and the first sequencer is displayed. You cannot change the sequencer. In SFC test mode, the execution of the instance is made dynamic and can be influenced in the same way as in SFC charts.
Creating, configuring and managing SFCs

7.5 Configuring the SFC type and SFC instance

Copying, moving, deleting

You can copy/move SFC instances in the CFC chart or between CFC charts.
You delete SFC instances in the CFC chart or indirectly by deleting the CFC chart in the SIMATIC Manager.

You will find more information on this subject in the following sections:

Copying and Moving SFC Instances (Page 86)
How to Delete SFC Instances (Page 87)

Configuration

The configuration options for SFC instances in the SFC are limited compared to SFC types. The interface and the sequencers cannot be changed in the SFC instance since they are specified identically for all instances based on the SFC type. However, you can change the parameters (initial value and comments) of the interface I/Os for each specific instance.

You can make the following settings in the "Properties" dialog box:

- "General" properties (name, comment).
- "AS operating parameters" (these are the default settings: Step control mode, Operating mode, Command output, Cyclic operation, Time monitoring and the start options: Autostart, Use default operating parameters when SFC starts).
- The "options" for SIMATIC BATCH (category, allow operator instructions) cannot be modified here; the configured control strategies can be enabled or disabled here for the instance.

You can open the "Properties" dialog box as follows:

1. Select the SFC instance in the CFC.
2. Open the shortcut menu and select the menu command **Open**
   The SFC instance opens in the SFC.
3. Select the menu command **SFC > Properties...**
   The "Properties SFC Instance" dialog box opens.

Note

When using SIMATIC BATCH, SFC instances may not be changed at a later time.
Compiling/downloading

SFC instances are compiled in the “Compile program” context and downloaded to the CPU in the “Download to CPU” context.

You will find more information on this subject in the following sections:
- Overview of the Blocks Generated during Compilation (Page 229)
- Overview of compiling charts, types, and instances (Page 225)
- How to download programs (Page 233)

Tips:
- You can use the "SFC Visualization" add-on package on the OS for operator control and monitoring of the SFC instances (and SFC charts). You also use “SFC Visualization” to perform the necessary configuration steps for SFC operator control and monitoring.

You can find additional information on SFC Visualization in the SFC Visualization for S7 manual or the "Options" folder of the WinCC online help.

7.5.5 Configuration Changes in the SFC Instance

Description

Due to the limited configuration options for SFC instances, any changes you make directly in the SFC instances can be downloaded at any time, even if the SFC instances are currently being processed in the automation system.

Further procedure

After completing the changes, you must compile and download the OS to ensure that the current data are available on the OS.
7.6 Opening

7.6.1 How to Open SFC Charts or SFC Types

Introduction

You can open an SFC chart or an SFC type in both the SIMATIC Manager and SFC Editor.

Opening an SFC chart or SFC type in the SFC Editor

1. Select the menu command SFC > Open in the SFC Editor.
2. Select the project (the SIMATIC station, the CPU, the S7 program) and the chart folder containing the SFC chart or SFC type you want to open.
3. Select the "SFC" object type for the chart or the "SFC type" for the type.
4. Click the chart or type you want to open in the right window of the dialog box.
5. Click "OK". The window with the SFC chart or SFC type opens.

Note
The "SFC" menu displays the last four objects edited (SFC charts and/or SFC types) as menu commands. If you select one of these menu commands, the corresponding object opens.

Opening an SFC plan or SFC type in the SIMATIC Manager

1. Select the menu command View > Component View in the SIMATIC Manager and then select the project and the chart folder in the S7 program.
2. Open the chart folder.
3. Double-click on the SFC chart or the SFC type in the right window. The SFC Editor starts (if not already started) and the chart or type is displayed in an SFC Editor window.

Note
If the project is assigned a plant hierarchy, you can also open SFC charts in the Plant view or Process Object view in the SIMATIC Manager. In this case, you open the hierarchy folder that contains the chart instead of the chart folder.

SFC types are not included in the plant hierarchy since they are not relevant to execution from a technological perspective.
7.6 Opening

7.6.2 How to Open SFC Instances

Introduction

You can only open SFC instances in the CFC chart.

Procedure

1. Select the SFC instance in the respective CFC chart.
2. Select the Edit > Open menu command.
   The SFC Editor starts (if it is not already started) and the SFC instance is displayed in a window of the SFC Editor. The displayed topology is determined by the associated SFC type.
7.7 Copying

7.7.1 Copying and Moving SFC Charts

Overview of copying and moving

You can copy charts with the SIMATIC Manager. You can transfer tested partial or complete structures from one CPU to another CPU or even within a single CPU. Existing references are not lost if the relevant charts are copied together at one time.

You can not only copy individual charts but also an entire chart folder with all the charts it contains.

You can also move charts across CPUs. The information contained in the section "Copying/moving across CPUs" applies to moving.

Copying within the CPU (in the chart folder)

Note the following when copying within the CPU:

- Interconnections and cross-accesses between CFC charts and between SFC and CFC charts are also copied if the charts involved are copied at the same time.
- Chart names must be unique in a chart folder; it may be necessary to rename files.
- Special considerations when copying SFC charts:
  - All SFC statements and SFC transition conditions that access uncopied blocks in CFC charts will continue to access the original blocks.
  - All SFC statements and SFC transition conditions that access global resources (via symbolic addresses of the symbol list) will continue to access these resources.

Copying/moving across CPUs

When copying/moving charts across CPUs, remember the following points:

- Interconnections
  Interconnections to shared addresses and to runtime groups are not copied unless you copy a complete program folder including user program, chart folder and symbol table.

- Block Types
  Unless all the block types are identical in the destination CPU (name, block I/Os), the copy/move function is rejected. You must then first copy the relevant block types to the block folder of the destination CPU and import them into a CFC of the destination chart folder.
7.7 Copying

- **Task**
  A task with the same name is used to insert the copied/moved blocks. The system does not check whether the tasks with the same name on both CPUs actually have the same properties. If a task with the same name does not exist on the destination CPU, copying/moving is rejected. You must then configure a task with the same name. If the destination system is an S7 CPU, the task is an OB number; any name in the symbol table will be considered as a comment and has no relevance.

- **Chart names, block names**
  Since CFC block names are unique within a chart, it is not necessary to rename them. It may be necessary to rename charts, however.

- **Special consideration when copying/moving SFC charts**
  All SFC statements and SFC transition conditions that access global resources (via symbolic addresses of the symbol list) access the same resources on the target CPU. If these resources do not exist on the destination CPU, they are automatically converted to textual interconnections (see above).

You will find more information on textual interconnections in the CFC documentation in the section Working with textual interconnections

### 7.7.2 Copying and moving SFC types

**Copying SFC types**

The runtime objects associated with the SFC type are also copied. If the SFC type is not up-to-date because the time stamp of the FB is older than the time stamp of the SFC type, you receive a message. If there is an SFC type with an identical name in the destination folder, it is overwritten following an acknowledgment prompt and any deviating properties for the existing type are passed to the SFC instances.

**Moving SFC types**

You can only move an SFC type when there are no SFC instances for the SFC type in the source. The runtime objects associated with the SFC type are also moved. If there is an SFC type with an identical name in the destination folder, it is overwritten following an acknowledgment prompt and any deviating properties for the existing type are passed to the SFC instances.
7.7.3 Copying and Moving SFC Instances

Introduction
You can copy or move SFC instances within a CFC chart, between CFC charts or indirectly by copying/moving the CFC chart in the SIMATIC Manager. The runtime objects associated with the SFC instance are also copied or moved.

Copying SFC instances
You can copy an SFC instance within a CFC chart or between CFC charts in the same chart folder. If you copy a CFC chart within a chart folder, the SFC instance is also copied. The runtime objects associated with the SFC instance are also copied.

If you copy an SFC instance between CFC charts from different chart folders or copy a CFC chart to a different chart folder, the SFC type is also copied.

Moving SFC instances
If you move an SFC instance between CFC charts in the same chart folder, the SFC instance is moved and the associated runtime objects are retained.

If you move an SFC instance between CFC charts from different chart folders or move a CFC chart to a different chart folder, the SFC type is also copied or moved.
7.8 Deleting

7.8.1 How to Delete SFC Charts and SFC Types

Deleting an SFC chart or SFC type

You delete SFC charts and SFC types in the SIMATIC Manager.
You can only delete SFC types if there are no SFC instances for the SFC type.
If there are instances for an SFC type, a message will appear indicating this.
The runtime objects associated with the SFC type are thereby also deleted.

Procedure

1. Select the SFC chart or SFC type in the Component view of the SIMATIC Manager.
2. Press the <Del> key.

7.8.2 How to Delete SFC Instances

Deleting an SFC instance

You delete SFC instances in the associated CFC chart or indirectly by deleting the CFC chart in the SIMATIC Manager.
The runtime objects associated with the SFC instance are thereby also deleted.

Procedure

1. Select the SFC instance in the CFC chart.
2. Press the <Del> key.
Creating, configuring and managing SFCs

7.8 Deleting
Adapting the properties of charts, types and instances

8.1 How to Adapt Chart Properties

Introduction
You can view and change the properties of the current SFC chart (SFC Editor) or any SFC chart in the chart folder (in the SIMATIC Manager). The chart properties are displayed in a dialog box with several tabs.

Opening the dialog box of the chart properties

In the SFC Editor
1. Open the SFC chart.
2. Select the menu command SFC > Properties….
   The dialog box of the properties opens.

In the SIMATIC Manager
1. Select the SFC chart in the SIMATIC Manager.
2. Select the menu command Edit > Object Properties….
   The dialog box of the properties opens.

Tabs
You can modify the chart properties in the following tabs.

• General information
   Use this tab to enter or modify the chart name, the author and the comment and to enable or disable the write protection. When write protection is enabled, the chart cannot be unintentionally changed with the SFC Editor or interface editor.

• Operating parameters AS
   You can set the following options in this tab.
   - Defaults for the initial state of the chart: "Step control mode", "Operating mode", "Command output", "Cyclic operation" and "Time monitoring".
   - SFC startup following an CPU restart
     The options are "Initialize SFC" or "Retain SFC state." This allows you to determine if the SFC should start with the data it had before the CPU stop or if it should be initialized again following a restart of the CPU.
   - Start options of the chart: "Autostart" and "Use default operating parameters when SFC starts".
Adapting the properties of charts, types and instances

8.1 How to Adapt Chart Properties

- **OS**
  
  If the "Transfer chart to OS for visualization" check box is selected, the SFC chart is transferred to the OS automatically with the next OS compilation.

- **Version**
  
  The major and minor versions can be set separately with the cursor keys. Version change is disabled for write-protected charts. You can set versions from 0.0001 to 255.4095. A new chart always starts with version number 0.0001. No number less than the previously saved version can be set.

  Use "Data version" to obtain information on the software version used to create the chart.

  When versioning is enabled in the properties of the project, the dialog box is opened automatically with the "Version" tab after a chart has been changed and the chart has been closed.

  Data version:

  This tab displays the software version used to create or most recently modify the program. The data version does not depend on the product version. The data version is determined by the database and shows the current version of your data structure.
8.2 How to Adapt Type Properties

Opening the dialog box

In the SFC Editor, select the menu command SFC > Properties... or the shortcut menu command Object Properties... in the chart folder of the SIMATIC Manager for the selected SFC type.

The dialog box of the properties opens.

Tabs

You can modify the type properties in the following tabs.

- **General information**
  
  Use this tab to enter or modify the type name, the author, the family, the FB number, the comment and to enable or disable the write protection. When write protection is enabled, the chart cannot be unintentionally changed with the SFC Editor or the characteristics and interface editors.

- **Operating parameters AS**
  
  You can perform the following actions in this tab:
  
  - Set the defaults for the initial state of the SFC instances that are generated from this type. "Step control mode", "Operating mode", "Command output", "Cyclic operation" and "Time monitoring".
  
  - Enable or disable the start options for the SFC instances: "Autostart" and "Use default operating parameters when SFC starts".
  
  - SFC startup after CPU restart
    
    This includes the "Initialize SFC" and "Retain SFC state" options. This allows you to determine if the SFC should start with the data it had before the CPU stop or if it should be initialized again following a restart of the CPU.
Adapting the properties of charts, types and instances

8.3 How to update SFC Types

- **Options**
  You can perform the following actions in this tab:
  - Classification of the SFC type for SIMATIC BATCH in the "Category" box:
    "None": There is no classification (type is ignored by SIMATIC BATCH).
    "EOP": The SFC type is classified as "Operation type".
    "EPH": The SFC type is classified as "Phase type".
  - Allow operator instructions to enable input of values in the operator dialog on the OS.
  - **Control Strategy Selection**
    This box contains all control strategies configured for the SFC type (maximum of 32).
    Select the respective check box to enable control strategies of the SFC type as default for the SFC instances. This applies to all SFC instances that are already in the project - as long as the default value has not been changed in the instance - and for all the SFC instances yet to be generated. The control strategy selection can be modified for the individual instances.
  - **SIMATIC IT**
    Use the "MES-relevant" check box to decide whether or not the information of the SFC instances is transferred to the enterprise levels MIS/MES when requested.

- **Version**
  The major and minor versions can be set separately with the cursor keys. Version change is disabled for write-protected SFC types. You can set versions from 0.0001 to 255.4095. A new SFC type always starts with version number 0.0001. No number less than the previously saved version can be set.
  Use "Data version" to obtain information on the software version used to create the chart.
  When versioning is enabled in the properties of the project, the dialog box is opened automatically with the "Version" tab after a type has been changed and the window has been closed.
  Data version:
  This tab displays the software version used to create or most recently modify the program. The data version does not depend on the product version. The data version is determined by the database and shows the current version of your data structure.

8.3 How to update SFC Types

**Updating in multi-project**
SFC types can be updated in a multi-project. The procedure is the same as when updating block types of CFC.
You will find more detailed information about this in the CFC documentation under How to Update Block Types/SFC Types
8.4 How to Adapt Instance Properties

Opening the dialog box

1. Highlight the SFC instance in the CFC and select the Edit > Open menu command. The SFC instance opens in the SFC Editor.
2. Select the menu command SFC > Properties... for the opened SFC instance in the SFC Editor. The dialog box of the properties opens.

Tabs

You can modify the SFC instance properties in the following tabs.

- **General information**
  
  This tab is used to enter or modify the instance name and the comment. All other properties (see SFC type) can be read but not modified. The "Write-protected" check box indicates if the CFC chart is write-protected. In this case, you have read-only rights for the SFC instance.

- **Operating parameters AS**
  
  In this tab, you can change the operating parameters for the SFC instance (see SFC type).
8.4 How to Adapt Instance Properties

- **Options**
  In this tab, you can view and change the options set for the SFC type:
  - SIMATIC BATCH "Category" (view only)
    "None": There is no classification.
    "EOP": The SFC type is classified as "Operation type".
    "EPH": The SFC type is classified as "phase type".
  - SIMATIC BATCH "Allow operator instructions" (view only)
    Values can be input in the operator dialog box on the OS when this option is set.
  - Control strategy (cannot be changed if write protection is enabled)
    This box contains all control strategies configured for the SFC type (maximum of 32).
    The control strategies adopted from the SFC type are selected. You can change the selection for each SFC instance. You can select a new control strategy or deselect an existing assignment.
    Note: If you change the control strategy selection for an SFC instance, all subsequent changes to the control strategy selection for the SFC type are no longer applied automatically for this SFC instance.
  - SIMATIC IT
    The "MES-relevant" check box determines whether or not the information of this SFC instance is transferred to the MIS/MES enterprise levels when requested.

- **Version**
  In the "Version" box, you always see the version of the associated SFC type. The version cannot be changed in the SFC instance.
  Data version:
  This tab displays the software version used to create or most recently modify the program. The data version does not depend on the product version. The data version is determined by the database and shows the current version of your data structure.
Configuring messages

9.1 How to configure messages in the SFC

Configuring Messages in the SFC

Select the menu command SFC > Message... in the SFC Editor to configure the messages. You can configure specific message texts for each SFC chart/SFC type/SFC instance. You can change the message texts in a dialog box (for example, to distinguish messages in different charts/types).

Configuration limits

You can configure the following number of messages for one SFC chart:
- Seven messages requiring acknowledgment
You can configure the following number of messages for one SFC type or one SFC instance:
- Seven messages requiring acknowledgment
- Five message that do not require acknowledgment
The SFC type itself requires the remaining available messages (one message for each message type and 10 status messages for SIMATIC BATCH).

The reserved message events have default texts:
- "Step runtime exceeded"
- "Operator prompt"
- 10 status messages for SIMATIC BATCH (only with SFC type-instance)
  - "Run"
  - "Completed"
  - "Held"
  - "Aborted"
  - "Ready to complete"
  - "Stopped"
  - "Error"
  - "MANUAL"
  - "Not released for SIMATIC BATCH"
  - "Runtime exceeded"
Step runtime exceeded

The "step error" event is a process control message that must be acknowledged and is signaled along with 3 associated values using the message block ALARM_8P. The remaining seven available messages (SFC type/instance only) and associated values can be assigned as required.

There are also inputs/outputs at the standard interfaces that can be used to trigger the messages (SIG_2 ... SIG_8), including the associated values AUX_PR04 ... AUX_PR10 (for SFC type/instance). You can use these inputs/outputs with interconnections in the actions of the steps or with direct block interconnections.

Operator prompt

The operator prompt is a message that does not require acknowledgment and that is signaled in an SFC chart with the NOTIFY message block and in an SFC type with NOTIFY_8P message block.

You can find a table of the I/Os used for the messages in the interface under: Messages (SFC inputs/outputs) (Page 217).

Note

When configuring messages, remember that the messages of ALARM_8P can only be assigned message classes requiring acknowledgment.
10.1 Using the characteristics editor and the interface editor

Characteristics editor/interface editor

You use the characteristics editor for the technological configuration of the interface for an SFC type. You can only work with the editor if an SFC type is open in SFC.

You define the interface inputs/outputs of the SFC type as follows:

- Directly in the interface editor:
  Call this editor with the menu command View > Inputs/Outputs or with the button

- In the characteristics editor
  Call with the menu command View > Characteristics or the button

The interface editor and the characteristics editor box are displayed alternatively. This means that it is not possible to define technological characteristics and interface inputs/outputs at the same time. You can define characteristics and inputs/outputs in any order.

Note

You define individual inputs/outputs in the interface editor. These are available in addition to the inputs/outputs defined in the characteristics editor. These inputs/outputs are unknown to the characteristics editor and cannot be handled there.

Setpoints, for example, are created and assigned values during the definition of characteristics. From this definition, the characteristics editor generates the required inputs/outputs, which are displayed in the interface editor after it is opened and can be used to configure the sequential logic. You cannot change the I/Os generated by the characteristics editor in the interface editor (except system attributes, initial value, comment).

You can group inputs/outputs only in the characteristics editor. These groups are taken into account during compilation in the applicable plausibility checks and status and message processing. The values (such as setpoints) required for visualization/operator control on an OS station that are displayed with the SFC type faceplate are configured in the characteristics editor.

You will find more detailed information on the characteristics editor in the section: Characteristics of the SFC type (Page 98)
## 10.2 Characteristics of the SFC type

### Characteristics

A characteristic is the technology-oriented functionality of an SFC type that is described by a set of attributes (for example, I/O name, data type, initial value or high limit).

The following characteristics are available for creating the type:

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control strategies</td>
<td>Control strategies are used for structuring of an SFC type as required for process control. You define control strategies in the characteristics editor in order to use them in configuring sequencers (for heating or cooling, for example). The control strategy can be set by the operator or by a higher-level controller (for example, SIMATIC BATCH). Control strategies are optional. You can find additional information in the section: [Note on Subsequent Modifications to Control Strategies](Page 100)</td>
</tr>
<tr>
<td>Setpoints</td>
<td>Setpoints control the SFC type or are used by it to control underlying automation functions. Setpoints can be set by the operator or by a higher-level controller (SIMATIC BATCH, for example). A setpoint is assigned to the control strategies that exist when it is created. You can change the assignment individually for each control strategy.</td>
</tr>
<tr>
<td>Process values</td>
<td>Process values control the SFC type based on process signals (for example, the value for the fill level).</td>
</tr>
<tr>
<td>Control values</td>
<td>Control values are used by the SFC type to control external logic.</td>
</tr>
<tr>
<td>Parameters</td>
<td>Parameters modify the behavior of the SFC type. For example, you can use parameters to select alternative branches or to configure start conditions.</td>
</tr>
<tr>
<td>Bit memory</td>
<td>Bit memory is the local data memory of the SFC instances belonging to the SFC type. You can temporarily store data here and reuse it later. The data are retained until they are overwritten or deleted.</td>
</tr>
<tr>
<td>Timers</td>
<td>Timer objects are used to configure time-driven sequences in an SFC type. Timer objects can be used locally for a step or applied overall to multiple steps and sequencers. Timed routines are started in steps, stopped, and the elapsed time queried in transitions or start conditions. You can vary timed sequences with a variety of modes (for example, pulse, extended pulse, on delay, retentive on delay, off delay).</td>
</tr>
<tr>
<td>Note texts</td>
<td>Note texts are used to display information relating to execution that may require action on the part of the operator. A note text is displayed on the OS in the SFC faceplate and can be acknowledged there. For more information on this subject, refer to the section: [How to configure note texts and position texts](Page 101)</td>
</tr>
</tbody>
</table>
### Configuring the characteristics

#### 10.2 Characteristics of the SFC type

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Block contacts</td>
<td>Block contacts represent blocks of the basic automation. When a block contact is created, inputs/outputs of the block to be represented are created in the interface of the SFC type. When configuring the SFC type, you can use these inputs/outputs to represent the block that will later be interconnected with an SFC instance. Additional information is available in the sections: Inputs/Outputs for Characteristics (Page 102) Block contacts (Page 103).</td>
</tr>
<tr>
<td>Position texts</td>
<td>Position texts are used to display the current progress in execution or the status of execution of the SFC. A position text is displayed on the OS in the SFC faceplate. For more information, refer to the section: How to configure note texts and position texts (Page 101).</td>
</tr>
</tbody>
</table>

### Additional information

You can find additional information in the following sections:

- Inputs/Outputs for Characteristics (Page 102)
- Attributes for characteristics (Page 104)
10.3 Note on Subsequent Modifications to Control Strategies

Notes

Control strategies that have already been used, for instance in:

- Start conditions
- Transitions
- Assignment to setpoints
- Control strategy release

Should not be deleted or moved in the characteristics editor, otherwise the control strategies will be renumbered. This also applied for control strategies that you copy from an SFC type into a different SFC type.

The numbers of the control strategies in the existing utilization are not adapted. For this reason, accesses and other mechanisms that reference these numbers no longer function as originally intended.

Example

You no longer want to use the control strategy with number "2" and delete it.

The control strategies are renumbered. The previous control strategy "3" is given the number "2", control strategy "4" is given the number "3", etc.

If you no longer want to use a control strategy, do not delete the control strategy; rather, rename it as "not used", for example. The numbering and functionality of the other control strategies is then retained.
10.4 How to configure note texts and position texts

Procedure from configuration up to using the note texts

1. The note texts are configured in the characteristics editor and each text is assigned a unique number. When the text is created, the editor first assigns the next available number but this number can be changed to any other number (as long as it is unique among all the note texts) (value range: 1 to 32767). The numbering can also include gaps.

Before a note text can be displayed in the SFC faceplate, the OPTIPNO I/O containing the relevant note text number must be assigned in a step suitable for the note text.

2. The OS can be activated after compiling and downloading the AS and compiling and downloading the OS.

3. You can prepare and start the SFC instance ("Prepared values" view of the faceplate) once the faceplate for the SFC instance is open.

When the step used in item 1 is executed, the faceplate displays the note text.

4. The note text can be acknowledged with the "O" button, whereby the dialog box for operator confirmation is displayed.

5. When the operator action is confirmed (by clicking the "Yes" button), an operating message is generated on the OS and the OPTIPNO output is reset to "0" in the block.

The value change of OPTIPNO from "x" to "0" can be interpreted as an acknowledgment if the SFC type does not trigger this change itself by assigning a value to OPTIPNO in a step.

Note: The displayed text is either the comment for the note text or, if the comment was not configured, the name.

Procedure from configuration to using the position texts

The procedure for position texts corresponds to the procedure for note texts with the following differences:

- The associated block I/O is called "POSINO".
- Steps 4 and 5 are omitted.

Notes

Note the following:

- The display of note and position texts does not cause a message to be generated and is not documented in the message system. The acknowledgment of a note text, on the other hand, is documented as an operating message.
- When copying instruction texts and position texts from an SFC type and inserting in a different SFC type the numbers are reassigned. If usages already exist in steps, transitions and sequences and chains then you must check these numbers and correct them if necessary.
10.5 Inputs/Outputs for Characteristics

Inputs/outputs for characteristics

There are predefined descriptions of the required inputs/outputs for use in defining the interface inputs/outputs or I/O elements of a characteristic.

The required interface inputs/outputs or terminal elements for the "Control strategies", "Note texts" and "Position texts" characteristics are already contained in the standard interface of an SFC type.

For the other characteristics, the names of the individual I/O elements are made up of the I/O names configured in the characteristic and a fixed part.

Additional information

For further information, refer to the following sections:

"Characteristics" Interface Parameter Assignments (Page 179)
"Characteristics" Interface Expansions (Page 181)
Standard Interface of the SFC Type (Page 171)
Block contacts (Page 103)
Attributes for characteristics (Page 104)
10.6 Block contacts

Block contacts

If you want to use block contacts to connect the basic automation blocks, specify the inputs/outputs relevant for the connection to an SFC type in the block types.

To do this, the "S7_contact=true" system attribute must be set for the block I/O in the creation language of the block type. The technological blocks from the PCS 7 Library are prepared accordingly. You can adapt the inputs/outputs in the supplied block types to your project conditions.

Connections between SFC types via block contacts are not supported.

Note

If you subsequently add or change system attribute "S7_contact" for the I/O of a block type that is used as a block contact in the SFC type, this has no effect on the block inputs/outputs of the SFC type.

If you want these changes to be adopted for the SFC type, note the following:

• Import the changed block type in the CFC with the menu command **Options > Block Types**. All block instances of the type are updated during the import.

• Update the block contacts in the SFC with the menu command **Options > Block Contacts**. This menu command applies the changes to the interface of the SFC type and to all SFC instances.

By defining an instance of the "block contact" characteristic in the characteristics editor, the selected block inputs/outputs are created accordingly in the SFC type. The IN I/Os of the block type are created as OUT I/Os in the SFC type. The OUT I/Os of the block type are created as IN I/Os in the SFC type. The IN_OUT I/Os of the block type are created as OUT I/Os in the SFC type.

This allows you to interconnect a specific CFC instance of the block type to the corresponding inputs/outputs of an SFC instance. An instance of the "block contact" characteristic is therefore always assigned to exactly one block type. You must enter the relevant block type in the "Block" column in the right window pane. The block type must be present in the ES data management.

This procedure enables you to configure, commission, and visualize basic automation blocks independently. As a result, you can configure SFC types based on block contacts and interconnect them later to the basic automation blocks.
### 10.7 Attributes for characteristics

Attributes for characteristics

In the following table you can see the attributes available for configuring the characteristics along with their meaning.

**Assignment of the attributes to characteristics**

<table>
<thead>
<tr>
<th>Characteristics</th>
<th>Control strategy</th>
<th>Set points</th>
<th>Process values</th>
<th>Control values</th>
<th>Parameters</th>
<th>Bit memory</th>
<th>Timers</th>
<th>Note texts</th>
<th>Block contacts</th>
<th>Position texts</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attributes</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Display name</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Number</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>x</td>
<td>x</td>
<td></td>
</tr>
<tr>
<td>Standard</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Data type</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td>x</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Input/output name</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
<td>x</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Comment</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>&lt;Setpoint&gt;</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Initial value</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
<td>x</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Text length</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td>x</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Precision</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td>x</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Unit</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Low limit</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>High limit</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Text0</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Text1</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Enumeration</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Archive</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Test</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Setpoint ID</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Proc val ID</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Material</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tracking ID</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Block</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>x</td>
</tr>
<tr>
<td>Faceplate</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>x</td>
</tr>
<tr>
<td>Transfer ID</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Transfer counter</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Meaning of the attributes

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name is a designator for the characteristic that must be unique among all characteristics of a type. It can contain a maximum of 24 characters and cannot contain spaces or special characters (exception: &quot;.&quot;). The name is irrelevant for the interface I/Os.</td>
</tr>
<tr>
<td>Display name</td>
<td>By default, the display name is the same as the name and is transferred to WinCC when you compile the OS. The display names can only be modified on the type. The display name cannot be translated until after the display name has been changed and is then included in the transfer to WinCC for the respective language when the OS is compiled.</td>
</tr>
<tr>
<td>Number</td>
<td>The number uniquely identifies the corresponding characteristic. With control strategies, the number is managed by the system and assigned consecutively from 1 to 32 according to the position in the characteristics editor. The control strategy &lt;no&gt; is assigned bit &lt;no-1&gt; in the SELCS I/O of the SFC type. This bit is set if the corresponding control strategy has been configured. With an SFC type and SFC instance, the bit is deleted when the corresponding control strategy is not to be used (selection with the menu command SFC &gt; Properties &gt; Options: Control strategy selection). The next available number is used for note and position texts. However, you can replace the number with any other number of your choice as long as it is unique and in the range of 1 to 32767.</td>
</tr>
<tr>
<td>Standard</td>
<td>&quot;Standard&quot; indicates the control strategy that will be used when starting the SFC instance with prepared values.</td>
</tr>
<tr>
<td>Data type</td>
<td>Permitted data types for characteristics are BOOL, INT, DINT, REAL, and STRING. For setpoints, the data types PI and PO are also available and basically represent a REAL setpoint with the addition of the &quot;Material&quot; and &quot;Tracking ID&quot; attributes. Enumerations can be assigned to the data types DEST, SOURCE, VIA and TKEY. Depending on the characteristic and its data type, other boxes can either be edited or are locked.</td>
</tr>
<tr>
<td>I/O name</td>
<td>The I/O name is required to generate the interface I/Os belonging to the characteristic. The I/O name is derived from the characters of the name. You can change the I/O name. The following limits apply:</td>
</tr>
<tr>
<td></td>
<td>Setpoints and counters: max. 16 characters</td>
</tr>
<tr>
<td></td>
<td>Block contacts: max. 10 characters</td>
</tr>
<tr>
<td></td>
<td>All other characteristics max. 24 characters</td>
</tr>
<tr>
<td></td>
<td>When the interface I/Os are created, several I/Os are generated depending on the characteristic. A suffix is appended to the I/O name so that the I/Os are named uniquely. The maximum lengths of the I/O names result from the different ways of generating interface I/Os. With setpoints and timers, the system limits the suffix to a maximum of 8 characters. With block contacts, the length of the suffix depends on the block being used. No suffix is appended to the other characteristics so that the I/O name can contain a maximum of 24 characters.</td>
</tr>
<tr>
<td>Comment</td>
<td>You can use comments to describe the characteristic in greater detail. The comment can contain a maximum of 80 characters and include any special characters.</td>
</tr>
<tr>
<td>&lt;Setpoint&gt;</td>
<td>Setpoint selection for the &quot;Control strategy&quot; characteristic. Name of each created setpoint is displayed as a column. This allows you to assign the required setpoint to the control strategy by selecting the corresponding column. The assignment of setpoint to control strategy is stored in the &quot;&lt;setpoint&gt;-I/O name&gt;_CS&quot; I/O for each setpoint. The coding is the same as for the SELCS I/O; in other words, control strategy &lt;no&gt; is assigned bit &lt;no-1&gt;. This bit is set if the setpoint is assigned to the control strategy; in other words, it is required to run the control strategy.</td>
</tr>
<tr>
<td>Initial value</td>
<td>The initial value corresponds to the value of the characteristic when no current value is available. The attribute can be changed in the SFC instance.</td>
</tr>
<tr>
<td>Text length</td>
<td>With the STRING data type, the text length defines the maximum length of the string (number of characters: 1 to 254).</td>
</tr>
</tbody>
</table>
### Configuring the characteristics

#### 10.7 Attributes for characteristics

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Precision</td>
<td>With the REAL, PI, and PO data types, the precision defines the number of decimal places to be displayed (0 to 7).</td>
</tr>
<tr>
<td>Unit</td>
<td>With the INT, DINT, REAL, PI, and PO data types, a unit can be defined. This is stored as system attribute &quot;S7_unit&quot; for the interface I/Os. The attribute can be changed in the SFC instance. The units are included as a basic set in the ES data management and can be added to or modified in SIMATIC Manager as &quot;shared declarations&quot;.</td>
</tr>
<tr>
<td>Low limit</td>
<td>With the INT, DINT, REAL, PI, PO, DEST, SOURCE, VIA, and TKEY data types, a low limit can be defined for the range of values. This is stored in the &quot;&lt;I/O name&gt;_LL&quot; I/O. The attribute can be changed in the SFC instance.</td>
</tr>
<tr>
<td>High limit</td>
<td>With the INT, DINT, REAL, PI, PO, DEST, SOURCE, VIA, and TKEY data types, a high limit can be defined for the range of values. This is stored in the &quot;&lt;I/O name&gt;_HL&quot; I/O. The attribute can be changed in the SFC instance.</td>
</tr>
<tr>
<td>Text0</td>
<td>With the BOOL data type, this is used to specify the value identifier for the value FALSE. This attribute is stored as system attribute &quot;S7_string_0&quot; for the interface I/Os. The input field is only available when the data type is BOOL and when &lt;none&gt; is set in the &quot;Enumeration&quot; column. The attribute can be changed in the SFC instance.</td>
</tr>
<tr>
<td>Text1</td>
<td>With the BOOL data type, this is used to specify the value identifier for the value TRUE. This attribute is stored as system attribute &quot;S7_string_1&quot; for the interface I/Os. The input field is only available when the data type is BOOL and when &lt;none&gt; is set in the &quot;Enumeration&quot; column. The attribute can be changed in the SFC instance.</td>
</tr>
<tr>
<td>Enumeration</td>
<td>With the BOOL, INT, DINT, DEST, SOURCE and VIA data types, you can assign an enumeration. This is stored as system attribute &quot;S7_enum&quot; for the interface I/Os. The enumeration is defined in the SIMATIC Manager in the &quot;Shared declarations&quot;. You can select the name of the enumeration for the attribute from a drop-down list box. The attribute can be changed in the SFC instance. If a listing is assigned to a block parameter of an SFC instance, you can select any number of additional listings from the shared declarations later. Note: If &quot;S7_enum&quot; is used, the &quot;S7_string_0&quot; and &quot;S7_string_1&quot; system attributes are ignored.</td>
</tr>
<tr>
<td>Archive</td>
<td>From the drop-down list box, you can select whether the current value of the &quot;&lt;I/O name&gt;_AO&quot; output is to be archived in WinCC, is not to be archived, or is to be transferred to the long-term archive. The attribute can be changed in the SFC instance. An archive tag is created when the OS is compiled so that the value is transferred to the archive.</td>
</tr>
<tr>
<td>Test</td>
<td>This selects the characteristic that is to be provided for manual testing (manufacturing instruction) in the batch report of SIMATIC BATCH.</td>
</tr>
<tr>
<td>Setpoint ID</td>
<td>You use the ID number to specify if the characteristic value is to be saved for logging. If the ID is greater than 0, the setpoint or process value is also made available for an external program. You can make processing in an external application easier if you assign unique ID numbers to the characteristic values. You can assign ID numbers from 0 to 32767.</td>
</tr>
<tr>
<td>Material</td>
<td>With the PI and PO data types, you can enter a material identifier.</td>
</tr>
<tr>
<td>Tracking ID</td>
<td>With the data types PI, PO, you can enter a numeric ID to identify the material.</td>
</tr>
<tr>
<td>Block</td>
<td>This attribute contains the name of the block type represented by the block contact. When the interface I/Os are generated, the interface I/Os for which system attribute &quot;S7_contact=true&quot; is set are adopted in the SFC type from the block type. The names of the interface I/Os of the block type are appended as suffixes to the I/O names of the block contact. Inputs and in/outs of the block type become outputs of the SFC type. Outputs of the block type become inputs of the SFC type.</td>
</tr>
<tr>
<td>Faceplate</td>
<td>Here you can select the parameters that will be displayed in the parameter view of the SFC faceplate.</td>
</tr>
</tbody>
</table>
### Attributes for Characteristics

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transfer ID</td>
<td>This ID is the unique ID of an individual transfer in SIMATIC BATCH. It is part of the transfer key (data type, TKEY) and assigned by an MES application.</td>
</tr>
<tr>
<td>Transfer counter</td>
<td>This attribute shows the loop repetition number of the transfer phases in SIMATIC BATCH. It is part of the transfer key (data type TKEY) and is assigned by an MES application.</td>
</tr>
</tbody>
</table>

**Additional information**

You can find additional information about the I/Os and characteristics in the following sections:

- "Characteristics" Interface Parameter Assignments (Page 179)
- "Characteristics" Interface Expansions (Page 181)

You will find more detailed information about the system attributes in the STEP 7 online help under:

System Attributes for Block Interfaces
11.1 How to Configure Sequential Control Systems

Requirements

Before you can configure sequential control systems, you must first create the required basic automation functions with CFC and/or STEP 7 tools. At the same time, the AS blocks to be used in the SFC charts or SFC types are also inserted. Automation functions that do not yet exist can be added as needed and then used in the SFC.

Procedure

When configuring a sequential control system (SFC chart or SFC type), proceed as follows:

- Create the sequencer topology with the required number of sequencers and the required layout of SFC elements.
- Configure the start condition, the preprocessing and the postprocessing in the "Properties" dialog box for the sequencers.
- Configure the actions and conditions in the "Properties" dialog box for the steps and transitions.

Color ID

The objects of the sequential control system are displayed in different colors depending on their current state. The elements of an unselected sequential control system, for example, are displayed in "white" (parameters not assigned) or "gray" (parameters assigned) and in "blue" when they are selected.

You can select your own color scheme for specific elements using the menu command Options > Customize > Colors....

When you open the object properties then the tab IDs of the tab that do not have any entries have the standard background color of the dialog box. For a tab with content the background of the tab ID is marked in the color that is set in the Windows properties for the display (right mouse button on desktop: Properties > Display > Extended > Element: Selected Element).
Textual interconnections

If you delete CFC blocks that access the SFC, these accesses will be configured as textual interconnections (text of the address is marked in yellow).

You can complete a textual interconnection as soon as the connection partner is available again in the chart folder. The textual interconnection will then become a real interconnection.

To complete a textual interconnection, select either the menu command **Options > Make Textual Interconnection** or select the "Make textual interconnection" check box in the "Compile" dialog box.
11.2 Creating the sequencer topology

11.2.1 How to create a sequencer topology

Sequencer display

In its initial state, the new SFC consists of one sequencer; however, this can be extended up to a maximum of 8 (SFC chart) or 32 (SFC type) sequencers. You create each sequencer in its own working window. A tab is created for every working window at the bottom of the screen. The tab shows the name of the sequencer (for example, RUN or SEQ1). You can switch to the individual sequencers using these tabs.

A newly created sequencer (menu command Insert > Sequencer > ...) is inserted at a selected position in the SFC in its initial state consisting of an initial step, transition and final step.

For further information, refer to the section: How to Configure Multiple Sequencers (Page 112)

If you insert or delete SFC elements in the sequencer, its layout is changed automatically according to predefined rules. These rules determine the spacing between elements, the extension of steps and transitions, or the alignment of alternative branches. You can change these layout rules at any time using the menu command Options > Settings > Layout...

You can center the entire sequencer topology in the window. You can zoom into and zoom out of the display as required using the zoom functions. The changes are made in percentage increments that are determined by the zoom factor.

Adding elements

If you want to add additional elements to the SFC, select the icon of the required element to be created in the element bar.

The cursor changes its appearance from an arrow to the selected icon with a positioning crosshair. Position the cross at the desired located to insert the sequencer element. The position of insertion is marked by a green line. Left click on the insertion position. The inserted elements are highlighted in color.

Syntax rules

The sequencer topology is formed by the sequences of steps and transitions. The fundamental rule of the sequencer topology is that a step (S) must be followed by a transition (T) and a transition must always be followed by a step (sequence: S-T-S or T-S-T). The editor automatically adheres to the rules.

Example:

If you insert a simultaneous branch after a transition and before a step in a sequencer, a transition is automatically created between the simultaneous branch and the step.
11.2 Creating the sequencer topology

11.2.2 How to Configure Multiple Sequencers

Introduction

An SFC can contain several sequencers that can be used for different applications. By specifying different start conditions, you can arrange for a specific sequencer to start when a particular event occurs. You can, for example, configure a separate sequencer for every operating state (idle, active, or error, for example) or for every control strategy (heating, cooling, or tempering, for example).

Note

Predefined sequencers are already available for various standard scenarios. These sequencer templates are available in the "SFC Library".

You can copy these templates and adapt them to suit your purposes.

Grouping of sequences into a sequencer

If the processing sequences for the "Run" state and the "Holding", "Held" and "Resuming" states are to be grouped into one sequencer as alternative branches, you must set the RUNHOLD input of the SFC to FALSE. After the "Hold" command, the SFC sequencer is aborted (the currently active step and the END step are run through) and following each status change, the SFC sequencer is run through again. The SFC sequencer is started again following the "Resume" command.

If RUNHOLD = TRUE, the sequencer change mechanism no longer works because the SFC sequencer is held. The held SFC sequencer cannot be (re)started in the statuses "Holding", "Held" and "Resuming". The held SFC sequencer is resumed in the held step following the "Resume" command.

Start conditions of the sequencers

The first sequencer of an SFC has the condition "<SFCName>.RUN=Run" in an SFC chart or "RUN=Run" in an SFC type. The start condition of every other sequencer added is empty and therefore unfulfilled; in other words, it is never processed. In contrast to newly created transitions that are always fulfilled, a new sequencer must always be given a defined start condition with the menu command Sequencer Properties > "Start Condition" tab.

Since it is possible that several start conditions can be satisfied at the same time, you can assign different priorities to the individual sequencers with the menu command Sequencer Properties > "General" tab, Priority: 1 to 255).

Formulate the start condition of a sequencer so that the status of the operating state logic is checked and the appropriate sequencer is executed when the SFC is in the corresponding state. You can also formulate any other conditions to suit your purposes.

When configuring start conditions, follow the same procedure as for configuring transitions. You will find detailed information on this subject in the sections:

- Formulating the Conditions of a Transition (Page 151)
- How to edit addresses in a transition (Page 152)
- How to Edit OS Comments in a Transition (Page 154)
Examples

Example 1:
Configure a sequencer with a start condition that queries one of the control strategies of the SFC. The formulation is, for example, "QCS=Heat". If the SFC is set to this control strategy, the sequencer is executed and is not dependent on the operating state of the SFC.

Example 2:
Configure a sequencer with the start condition "<SFCName>.IDLE=Idle". This sequencer is executed if the operating state is "Idle".

Example 3:
Any process status can also be queried for the start condition. To do this, interconnect the process status to the external signal "LOCKERROR" (input of the SFC). The SFC changes to "Error" state if the problem occurs. Also configure a sequencer for handling the problem whose start condition is "<SFCName>.ERROR=Error AND <process status>=1", for example.

Example 4:
As an alternative to example 3, error handling is also possible without a state change. To achieve this, you configure a sequencer with the start condition "<process status>=1" and assign it a high priority. This sequencer is always executed when the problem occurs and the sequencer that is currently being processed has a lower priority than the sequencer for handling the problem. In this case, do not interconnect the process status to the "LOCKERROR" input as this would mean a change to "Error" state.

Note
With a chart, the address "<SFCName>.I/O" is specified and with a type only "I/O" is specified.

How do I create a sequencer?

You can insert a new sequencer consisting of a start step, a transition, and a final step with the menu commands:

Insert > Sequencer > Before Current Sequencer

or

Insert > Sequencer > At End
How do I move/copy a sequencer?

You can move or copy a sequencer within an SFC window and reinsert it at another position.

Procedure for moving within the current SFC window
1. Select the menu command Edit > Move Sequencer....
   The "Move Sequencer" dialog box opens.
2. Check if the "Create copy" check box is cleared in the dialog box (default: check box cleared).
3. From the list, select the sequencer before which you want to insert the moved sequencer or select the line "(put at end)".
4. Click "OK".

Procedure for copying within the current SFC window
1. Select the menu command Edit > Move Sequencer....
   The "Move Sequencer" dialog box opens.
2. Select the "Create Copy" check box (check mark).
3. From the list, select the sequencer before which you want to insert the copied sequencer or select the line "(put at end)".
4. Click "OK".

The copied sequencer is renamed automatically so that the names of the sequencers in the SFC window are always unique. If the last position of the name is a number, it is incremented, otherwise a free number is appended to the name.

Procedure for copying/moving and inserting outside the current SFC window
1. Select the menu command Edit > Copy Sequencer or Edit > Cut Sequencer.
2. Switch to the other SFC window.
3. Select the menu command Edit > Insert Sequencer.
   The copied/cut sequencer is then renamed and inserted before the current sequencer.

---

Note
Pasting also works within the same SFC window. The copied/cut sequencer is then renamed and inserted before the current sequencer.

How do I delete a sequencer?

You delete the current sequencer as follows:
1. Select the menu command Edit > Delete Sequencer.
2. Click "Yes" to acknowledge the prompt for confirmation.
Notes on configuration

Note the following:

- The names of the steps and transitions must be unique within a sequencer; you can use the same names in different sequencers.

- You can also configure an additional action for each sequencer. Each action consists of the following:
  - **Preprocessing**: actions to be executed in every cycle after the sequencer has started before processing the steps and transitions
  - **Postprocessing**: actions to be executed in every cycle after processing the steps and transitions. This, for example, allows you to make pre-settings or to pass on the results of the sequencer execution.

You configure both parts in the "Sequencer Properties" dialog box. The dialog box provides the "Preprocessing" and "Postprocessing" tabs for this purpose, whose structure corresponds to the processing phases of steps.
Overview of Inserting/Creating SFC Elements

Inserting/creating SFC elements

You select the SFC element you want to insert with the menu commands Insert > Step/Transition, > Simultaneous Branch, > Alternative Branch, > Loop, > Jump or > Text. The cursor changes its appearance and you change to insert mode. As an alternative to the menu commands, you can also click the corresponding icon in the element bar.

When you now move the mouse over the sequencer, the shape of the cursor indicates whether you can insert the selected element (icon of the SFC element and <+> key) or whether you cannot (icon depicting a prohibited sign).

If you move the mouse pointer to a "permitted" insertion point in the sequencer, you will see a horizontal green line.

Within the simultaneous branch (in the vicinity of the upper simultaneous branch or lower simultaneous branch), the vertical green line indicates that you are inserting an additional sequence. If, for example, you insert an alternative branch beside a sequence, an additional step is created before and after the sequence to maintain the correct syntax. If, for example, you insert a simultaneous branch beside a sequence, an additional transition is created before and after the sequence.

After insertion, the inserted SFC elements are highlighted in blue.
11.2.4 How to Create a Sequence

Introduction
When generating a sequence, a transition-step-sequence (TS) or an step-transition-sequence (ST) (see figure) is generated depending on the position.

Procedure
1. Click the step/transition button in the element bar
2. Click the vertical line of the sequencer between a step and transition (or between a transition and step).
3. If you move the cursor to a "permitted" insertion point in the sequencer, you will see a horizontal green line.
4. If you also want to define the length of the sequence, hold down the left mouse button and drag the lasso in the vertical direction.
   The current length that will be inserted (number of ST/TS pairs) is displayed as a number at the starting point of the lasso.

Result
The sequence is inserted at the desired position.
11.2.5 How to Create and Edit a Simultaneous Branch

Introduction

When you create a simultaneous branch, two sequences are generated, each consisting of one step. Depending on the point of insertion, a further transition is added automatically before or after the simultaneous branch to ensure that the syntax is maintained.

Procedure

1. Click the simultaneous branch button in the element bar

2. Then click the position at which the simultaneous branch should be inserted.

   If you keep the left mouse key pressed while entering and drag open a lasso around elements of a sequence (here S5 to S6), the marked elements become part of the left sequence of the generated simultaneous branch.

   If you drag a lasso so that instead of a pure step sequence (here: S5 to S6) a step-transition sequence is captured (here: S5 to T5), due to syntactic reasons an additional step is created (here: S10) in the left sequence and a transition (here: T9) after the simultaneous branch.

3. If you want to expand a simultaneous branch, switch to the desired insertion mode (for example, alternative branch) and click using the positioning cursor at the desired position in the vicinity of the upper or lower branch line.
Editing a simultaneous branch

You can add additional sequences, simultaneous branches or alternative branches to a simultaneous branch, delete them or insert them in a different sequence. You can move sequences within a simultaneous branch or to any other position in the sequencer (except in the return branch of a loop). If you delete the next to last sequence, the remaining sequence is simply integrated in the surrounding structure and the simultaneous branch is eliminated.
11.2.6 How to Create and Edit an Alternative Branch

Introduction

When you create an alternative branch, two sequences are generated, each consisting of a transition. Depending on the point of insertion, a further step is added automatically before or after the alternative branch to ensure that the syntax is maintained.

Procedure

1. Click the alternative branch button in the element bar

2. Then click the position at which the simultaneous branch should be inserted.
   If you hold down the left mouse button and open a lasso around elements of a sequence, these elements become part of the left sequence of the resulting alternative branch.

3. If you want to expand an alternative branch, switch to the desired insertion mode (for example, simultaneous branch) and click the positioning cursor at the desired position in the vicinity of the upper or lower branch line.

Editing an alternative branch

You can add additional sequences to an alternative branch or delete them and also insert them in a different sequence. You can move sequences within the alternative branch or to any other position in the chart. If you delete the next to last sequence, the remaining sequence is simply integrated in the surrounding structure and the alternative branch is eliminated.
11.2.7 How to Create and Edit a Loop

Introduction

When you create a loop, a sequence, which can consist of a single step, and a return path with a transition are generated.

Procedure

1. Click the loop button in the element bar

2. Click the vertical line at the position where the loop should begin.

3. Keep the mouse button pressed and release it on the vertical line at the desired end position.

Result

The loop is created around the elements contained between the start position and end position. The syntax is maintained by adding elements as necessary.

Moving a loop

If you want to move a loop, first select the loop with the elements it contains. Keep the mouse button pressed and place the loop at the desired position on the vertical line of the sequence.

Changing the return jump destination

To change the return jump destination later, select the horizontal line of the arrow tip and holding down the left mouse button, move it to any syntactically correct position in the sequencer above the starting point.

If you drag the arrow point below the starting point of the loop, the starting point will be moved instead of the return jump destination.

Note

Loops leading into or out of alternative or simultaneous branches are not permitted. Due to the block-oriented sequencer topography, only entire chart elements, including alternative and simultaneous branches, can exist within a loop.

The return path of a loop can and must contain only one transition.
11.2.8 How to Create and Edit a Jump

Introduction

When you insert a jump, a transition with an arrow and jump destination information is generated.

```
[Diagram of a jump with arrow and question marks]
```

Procedure

1. Click the jump button in the element bar.

2. Create the jump directly after a step on the vertical line of the sequence:
   - If you want to create a jump with an undefined jump destination, click the vertical line after the step.
     The jump is created. The jump destination is displayed as question marks (???). You can now change the jump destination.
   - If you want to create a jump with a defined jump destination, drag from the jump origin to the desired step.
     The jump is created. The name of the step is entered in the jump destination.
   - If you want to create a jump with several jump destinations, repeat the previous action.

   **Note**
   When a step used as a jump destination is deleted, all jumps referring to it become undefined.
   If the name of a step used as a jump destination is subsequently changed, all the jumps referencing it are automatically adapted.

3. Double-click the jump destination information.
   The "Select Jump Destination" dialog box opens. All the available steps of the chart - except the start step - are shown in a sortable list.

4. Select a step as the new jump destination and click "OK".

Jump to destination

1. Select the jump.
2. Select the shortcut menu command "Go to Jump Destination".
   
   Result: The jump destination is displayed as selected.
   
   You can use the function in the edit and test modes.

Deleting a jump

Select the jump-transition and press the "Del" key.

---

**Note**

Be aware of the possible consequences during execution in the AS when working with jumps to or from a sequence of a simultaneous branch.

Jumps to or from a simultaneous branch should be used with special care: the respective jump always refers to the sequence in the simultaneous branch in which the source or destination is located. All other sequences will continue to be processed regardless of what happens.

**If you jump from one of the sequences, you should make sure that**

- There is a return jump to the same sequence
  
  or
  
  - All other sequences are also exited with a jump.

The user is responsible for using jumps carefully and being aware of the consequences to prevent unexpected runtime behavior in the AS.

**Recommendation:** Avoid using jumps into or out of simultaneous branches.
11.2.9 How to Create and Edit a Text Field

**Introduction**

You can insert, delete, copy and move a text box to any free position in the chart. You cannot move text objects across charts using drag-and-drop.

**Procedure**

1. Click on the text button in the element bar

   abl

2. Click using the positioning cursor at the point in the window where you want to position the text box.
   
   A text box is inserted in the window and opens. The text cursor is active.

3. Enter text in the text box.
   
   The text automatically wraps at the end of the line.

4. Finally, click outside the text box to exit edit mode and to close the text box.

**Note**

When positioning, make sure that the text box does not cover elements of the sequencer topology. If this happens, the unselected text box will be displayed as a frame with a transparent surface (without content). The chart elements below it remain visible.

**Changing the size of a text box**

If you enter more text than can be displayed in the box, the size of the box is not increased automatically; instead the text moves out of the visible area. You can make the entire text visible by increasing the size of the box manually. If you change the width of the box, the length of the text lines is automatically adapted.

**Procedure:**

1. Click on the text box to open it.

2. Grab the hatched frame with the cursor and drag the box until the required size is reached.

**Moving a text box**

To move a text box to another location **within the window**, proceed as follows:

1. **Left click** on the text box.
   
   The text box opens.

2. Grab the text box with the cursor at the non-highlighted point of the frame and drag it to another location within the window.

To move the text box **to another window**, follow the procedure described under "Copying or Cutting and Inserting a Text Box".
Copying or cutting and inserting a text box

1. Open the shortcut menu of the text box.
2. Select the menu command Cut Text Box if you want to move the text box or Copy Text Box if you want to copy it.
3. Switch to the required window.
   This can be the same window or another window of a sequencer.
4. Open the shortcut menu and select the menu command Insert.
   The cursor changes to a hand (with an empty object following cutting, with "+") object after copying).
5. Left click at the desired insertion position.
   The text box is inserted at the cursor position.

Deleting a text box

1. Right click on the text box.
   The shortcut menu opens.
2. Select the menu command Delete Text Box.
   The dialog box with the prompt for confirmation opens.
3. Click "Yes".
   The text box is deleted.
11.3 Managing SFC elements

11.3.1 Selecting SFC elements

11.3.1.1 How to Select with a Mouse Click

**Single selection**

You can select in the following ways:

- You can select steps and transitions by simply left-clicking them.
- You can select sequences by clicking the vertical line between a step and transition. Provided that the sequence is not in a simultaneous branch, alternative branch, or a loop, the entire sequencer is selected.
- You can select sequences by clicking on the upper or lower horizontal line.
- You can select loops by clicking the upper or lower horizontal line of the return path (the entire loop is selected) or on the vertical link (only the return path with the transition is selected).
- You can select jumps by clicking the horizontal line of the jump or the vertical line below the step of the origin of the jump (the origin and the jump are both selected). If you click the jump destination information, the associated transition is also selected.
- You can select the entire sequencer by clicking the vertical link of a sequence containing the start or final step.
- If you click an element, any other elements selected at the time are deselected.
- If you right click, the shortcut menu appears with the currently available menu commands.

**Multiple selection**

If you want to select more than one SFC element, hold down the <Ctrl> key when clicking with the mouse. The clicked SFC element is selected without deselecting elements you have already selected. If you have inadvertently selected an element, you can deselect it by clicking again while holding down the <Ctrl> key.

If you have selected an entire sequence and click a single element while holding down the <Ctrl> key, the single element is deselected and the entire selection effectively becomes a selection of single elements.
11.3.1.2 How to Select with the Keyboard

Selecting with the keyboard

You can select SFC elements with the <Up>, <Down>, <Left> and <Right> keys of the keyboard (single selection). The selection made depends on the currently selected element. If no SFC element is currently selected, when you first press a key, the last selected element is selected again.

- <Up> selects the previous SFC element in the sequence
- <Down> selects the next SFC element in the sequence
- <Left> selects the SFC element to the left in the sequence
- <Right> selects the SFC element to the right in the sequence

If you also hold down the <Ctrl> key, you select the SFC elements without deselecting those already selected (multiple selection).

11.3.1.3 How to Select with the Lasso

Selecting with the lasso

If you drag the mouse while holding down the left mouse button, you open a lasso or frame. All the SFC elements located completely within the lasso are selected when you release the button. SFC elements that were already selected are deselected if they were outside the lasso.

If you also hold down the <Ctrl> key, you select the SFC elements without deselecting those already selected outside the lasso.

If you drag a lasso around a group of selected and unselected elements while holding down the <Ctrl> key, the selected elements are deselected and the unselected elements are selected.
11.3.1.4 How to Select Steps and Transitions for Editing

Selecting for editing steps and transitions

You can edit the properties of steps and transition as follows:

1. Double-click a step or transition.
2. Select the menu command Edit > Object Properties....
   A dialog box with tabs opens. Once this dialog box is open, you can edit additional steps or transitions as follows:
3. Click the following buttons in the dialog box:

   - (previous step or transition)
   - (next step or transition)
   - (step or transition further to the left)
   - (step or transition further to the right)

4. Click the desired step or transition in the SFC.
11.3.2 Copying, moving and deleting SFC elements

11.3.2.1 How to Copy SFC Elements

Overview of copying

You can insert copied elements of a sequencer to a syntactically correct position within the same sequencer or in another sequencer of the same SFC or a different SFC on the same CPU or a different CPU. If necessary, new names are assigned automatically to the copied elements. The copies contain the same actions or conditions as the originals.

If you paste a copied step or a copied transition in an SFC on a different CPU, textual interconnections may be created if there are accesses to objects that have not been copied (for example, blocks in the CFC).

When you copy, the syntax is automatically corrected, for example, by adding an empty step or an empty transition.

Copying with the mouse

In addition to the menu commands Copy and Paste, you can also copy SFC elements with the mouse (exception: text boxes).

Procedure:
1. Select the desired elements and hold down the left mouse button.
2. Press the <Ctrl> key at the same time.
3. Drag the positioning cursor to the desired location in the sequencer in the same window or another window and then release the mouse button (drag-and-drop).

The cursor adopts the shape of a prohibited sign if copying is not permitted at the current position.

Note on copying jumps

Note the following:

- If you copy a sequence that contains a jump and the step of the jump destination, the jump destination is adapted accordingly in the copy.
- If you copy a sequence that contains a jump but the destination of the jump is not within the copied object, the jump destination becomes undefined (???).
Copying text boxes

Follow the steps outlined below to copy text boxes:

1. Open the shortcut menu of the text box.
2. Select the Copy Text Box menu command.
3. Switch to the required window.
   This can be the same window or another window of a sequencer.
4. Open the shortcut menu and select the menu command Insert.
   The cursor changes to a hand (with an empty object following cutting, with "+" object after copying).
5. Left click at the desired insertion position.
   The text box is inserted at the cursor position.

Note
Multiple selected text boxes cannot be copied at the same time.

Copying object properties

Instead of SFC elements, you can also copy and insert the object properties of steps and transitions.

For further information on this subject, refer to the section How to copy object properties of SFC elements (Page 131)
11.3.2.2 How to copy object properties of SFC elements

Object properties of steps and transitions

You can copy the complete object properties of steps and transitions and insert them in other steps and transitions. This also applies to the start and end step.

Procedure

1. Select the SFC element whose object properties you want to copy.
2. In the shortcut menu, select the menu command Copy object properties.
3. Select the SFC element that is to adopt the copied object properties.
4. In the shortcut menu, select the menu command Insert object properties.
   A message will appear that prompts you to confirm this action.
5. Acknowledge with "Yes".
   The selected SFC element will adopt the copied object properties.

Note

The message appears prior to each inserting action. If you tick the box "Do not show this message in the future", the message will not be shown anymore.

If you open the "Customize" dialog box with the menu command "Options > Customize..." in the SIMATIC Manager, you can reactivate the system messages in the "General" tab.
11.3 Managing SFC elements

11.3.2.3 How to Move SFC Elements

Overview of moving

You can paste cut elements of a sequencer to a syntactically correct position within the same sequencer or in another sequencer of the same SFC or a different SFC on the same CPU or a different CPU. If necessary, new names are assigned automatically to the copied elements. The moved elements retain their actions or conditions.

When you insert, the syntax is automatically corrected by adding an empty step or an empty transition as needed.

Moving with the mouse

In addition to the menu commands Cut and Paste, you can also move SFC elements with the mouse. If you move SFC elements, the elements are implicitly cut and pasted again.

Procedure

1. Select the desired elements and hold down the left mouse button.
2. Keeping the mouse button pressed, drag the positioning cursor to the desired location in the sequencer in the same window or another window and then release the mouse button (drag-and-drop).

The cursor adopts the shape of a prohibited sign if copying is not permitted at the current position.

Moving text boxes

To move a text box to another location within the window, proceed as follows:

1. Left click on the text box.
   The text box opens.
2. Grab the text box with the cursor at the non-highlighted point of the frame and drag it to another location within the window.

If you want to move the text box to another window, proceed as follows:

1. Open the shortcut menu of the text box.
2. Select the Cut Text Box.
3. Switch to the required window.
   This can be the same window or another window of a sequencer.
4. Open the shortcut menu and select the menu command Insert.
   The cursor changes to a hand (with an empty object following cutting, with "+" object after copying).
5. Left click at the desired insertion position.
   The text box is inserted at the cursor position.

Note

Multiple selected text boxes cannot be moved at the same time.
11.3.2.4 Deleting SFC Elements

Deleting SFC elements

You can delete selected SFC elements after a prompt for confirmation. The following exceptions and special consideration apply:

- You cannot completely delete the start step or final step. If you delete the start or final step, the parameter assignments for these steps are deleted but not the SFC element itself.

- If you delete only one element from a syntactical unit, the syntax is immediately restored by entering a new element to suit the syntax (this has no parameters assigned). This means that you have only deleted the parameter settings for the object.

- You cannot delete the last step of a sequence in a simultaneous branch. To delete the sequence that now consists of only a single step, you must select the sequence. You select the sequence by clicking the vertical line. The same applies to the alternative branch.

- You can delete a text box by right-clicking and selecting the Delete Text Box command from the shortcut menu. You can delete several text boxes by selecting them (with a lasso, for example) and then right clicking on one of the objects to select the Delete shortcut menu command.
11.4 Editing in the properties dialog

11.4.1 How to edit sequencer properties

Opening the dialog box

1. Select the menu command Edit > Sequencer Properties...
   or
   position the cursor on a sequencer name in the tab at the bottom of the window and select the shortcut menu command Sequencer Properties.... The dialog box of the sequencer properties opens.

2. Specify the properties by formulating the actions and conditions.

   The "Properties" dialog is divided into five tabs for editing the sequencer:
   - "General"
   - "Start condition"
   - "OS Comment"
   - "Preprocessing"
   - "Postprocessing"

"General" tab

You change the name and comment of the sequencer in the "General" tab. The "Number" box contains the sequencer number generated by SFC. This cannot be changed. In the "Priority" box, you can assign the sequencer a priority of 1 to 255. Here, 1 represents the lowest priority and 255 the highest priority. The priority decides which sequencer of an SFC is started when the start conditions of several sequencers are met simultaneously.

"Start Condition" tab

In this tab, you define the conditions for the SFC chart/type that will cause the sequencer to start (for example, "<SFCName>.RUN = Run" starts the sequencer when the SFC chart is in "Run" operating state).

The other editing steps in this tab are identical to those for transition conditions. You can find additional information about this in Section: Formulating the Conditions of a Transition (Page 151).

"OS Comment" tab

Editing steps in this tab are the same as for the OS comments for the transitions. You can find additional information about this in Section: How to Edit OS Comments in a Transition (Page 154).
"Preprocessing" and "Postprocessing" tabs

In these tabs, you can configure the following actions for the SFC chart/type:

- Action that is to be executed in every cycle after the sequencer has started but before the steps and transitions are processed (preprocessing).
- Action that is to be executed in every cycle after the steps and transitions are processed (postprocessing).

The editing steps in this tab are identical to those for formulating actions of the steps. For information about this, refer to the section: How to Edit a Step (Page 136).
11.4.2 Editing the steps

11.4.2.1 How to Edit a Step

Opening the "Properties" dialog of the step
You open the dialog box by double-clicking the step to be edited or by selecting the menu command Edit > Object Properties... for a selected step.

A dialog box opens where you can edit the properties and formulate the actions.

The dialog box is divided into four tabs:
- "General"
- "Initialization"
- "Processing"
- "Termination"

"General" tab

On the "General" tab, you can enter or change the step name, the run time and the comments for the step and the OS.

The number was assigned by SFC when the step was generated and is unique in this sequencer. It is read-only and cannot be modified. The number sequence is consecutive without gaps; in other words, if the step is deleted and a new one is inserted later, the new step is given the number of the previously deleted step.

You can assign a flag to the step by clicking the "Confirmation" check box. This flag determines the behavior of the step during execution in the AS in the "T/T and O" modes. Follow-on transitions after steps with this flag will only become active (enable the next step) once they have been met and confirmed by the operator (as in "T and O" mode). Without these flags, the successor transitions enable the next steps once their conditions are satisfied (as in the "T" mode).

With "Minimum:" You can set the minimum time that a step should remain active regardless of whether the successor transition is already satisfied.

With "Maximum:" You can specify a time for the time monitoring limiting the maximum time that the step can be active.
In the "Comment" and "OS Comment" boxes, you can enter texts, for example, a brief description of the step. The comment for the step can contain up to 80 characters and the OS comment up to 512 characters. The OS comment is used in process control for visualizing the step.

**Note**
The run times are based on the CPU time and not on the number of OB cycles. Cyclic interrupt OBs in the CPU are started at the same intervals, but the time when they are processed can change due to jobs with higher priority, temporary overload of the CPU or shorter run times of the blocks.

**Example:** The configured time can be up to one second longer than the set time (2s) in a 1-second cycle. To maintain a maximum run time of 2 cycles, you will have to set a run time of 1.5 seconds here.

"Initialization", "Processing", "Termination" tabs

The tabs for the processing phases (actions) "Initialization", "Processing" and "Termination" all have the same layout. This is where you configure the statements that control the actions that take place during initial processing, normal processing and termination processing of the step.

The statements are adopted as OS comments if the check box is activated (check mark) in the relevant line.

With the menu command **Options > Edit OS Comment...**, you can later specify in a dialog box how the OS comments should be used in each processing phase:

- Leave unchanged
- Use all statements
- Use no statements

You can also specify how any edits to the OS comments are to apply in this dialog box:

- The entire chart folder
- The current chart
- The selected steps
Documenting the configuration

You can document the configured actions of the step. By clicking "Print" in the Object Properties dialog, you obtain a log of the step with information about the properties and statements for initialization, processing and termination.

Changes to the configuration

If you change the configuration of a step (name, comment, OS comment, attributes, assignments), you can compile changes only (SFC > Compile..., range: Changes menu command) and download while the CPU is in RUN mode (CPU > Download..., Download mode: Changes) without first deactivating the active SFC.

You will find detailed information on editing a step in the sections:
- How to Edit Actions in a Step (Page 139)
- How to edit addresses in a step (Page 141)
- How to copy object properties of SFC elements (Page 131)
11.4 Editing in the properties dialog

11.4.2.2 How to Edit Actions in a Step

Introduction

You enter the statements for actions in a formatted dialog box.

Editing actions

Note

Note that an SFC type can only access its own interface and not external objects.

For each step, you can formulate up to 50 statements per action. Ten of these are visible in the dialog box. You can change the visible section with the scroll bar.

Each statement line consists of the following elements:

- The button with the line number for selecting the line
- The check box that you can use to select the statement as an OS comment
- An edit box for the left (first) address, the operator, and the right (second) address.

You can use the number buttons at the start of each line to select a statement in order to copy it, delete it or insert a previously copied statement before it. Once you have selected a button, you can right-click to access the available menu commands.

In unselected lines, you can use the Copy/Paste Action shortcut menu command to copy the statements of a complete action and paste them into another action. In this way, you can easily copy the statements from the "Initialization" action to the "Termination" action, for example.

If you have placed the text cursor in an address box, the shortcut menu only displays the functions required for editing the contents.

Texts with a yellow background reference objects that no longer exist or do not yet actually exist (block inputs/outputs, charts, runtime groups).

This reference is a textual interconnection that you can make with the menu command Options > Make Textual Interconnection if the interconnection partner actually exists. The textual interconnection is displayed on a yellow background in the line of the address. The same highlighting is used if a previously real interconnection becomes a textual interconnection due to deletion of the interconnection partner.
Textual interconnections that cannot be made are ignored during compilation. A corresponding warning is entered in the log indicating which input/output still has a textual interconnection. An unmade textual interconnection is also tolerated in the download.

**Note**

Interconnections cannot be set up if the target of the interconnection is not unique; in other words, its name occurs more than once. The interconnection is also displayed as a textual interconnection in this case and it cannot be made.

Example: The object name of an SFC is the same as the symbolic name of a DB.

For further information on editing the step, refer to the following sections:

- How to edit addresses in a step (Page 141)
- Valid data types (Page 158)
11.4.2.3 How to edit addresses in a step

Selecting addresses

Note

Note that an SFC type can only access its own interface and not external objects.

Edit or process the addresses for the statements as follows:

1. Drag the inputs/outputs or characteristics from the interface editor or characteristics editor to the address box.
   
   Note: Several inputs/outputs can exist for a characteristic, for example, for setpoints, timers, and block contacts. In this case, a list of available inputs/outputs is displayed before you insert an address and you can select the required I/O.

2. Drag the block inputs/outputs from CFC charts directly to the address box.

3. Click "Browse".
   
   The "Browse" dialog box opens.
   
   The "Browse" dialog has four different tabs:
   
   – "Plant View"
   – "Component View"
   – "Runtime Groups"
   – "Icons"

   When you browse (through CFC charts in the Plant or Component view, for example), all the available objects of the chart folder are found and displayed.

   You limit the list of inputs/outputs by clicking "Filter...". Then, only the inputs/outputs relating to the current configuration are shown. You can find additional information on filters in the section: How to Filter Block Inputs/Outputs (Page 146).

4. Select the desired chart and then select the block and the I/O from it.

5. Click "Apply" to enter your selection in the active address box (or drag it to the address box).
   
   The dialog box remains open until you explicitly close it with the "Close" button or you close the "Object Properties" dialog.

If you make the selection by means of the "Browse" dialog box or using a drag-and-drop operation from the CFC chart, the entries are expanded to include the path of the plant hierarchy (if this exists). The hierarchy path and the chart name are separated by double backslashes ( \ \ ).
Notes

- Accesses to CFC blocks can also be modified in the relevant CFC chart. This modification, however, is restricted to "rewiring" SFC accesses; in other words, moving the access to another block I/O (with <Alt> + Drag-and-Drop).
- Do not write any values to outputs of blocks and charts (CFC and SFC). Generally, these are overwritten again by the processing of the block or chart.

Example: Turning an SFC chart on and off

The statement "<SFC_chart>.INTONOFF := TRUE", activates an SFC chart. The statement "<SFC_chart>.INTONOFF := FALSE" deactivates an SFC chart; that is, its final step is processed before the chart is terminated.

Selecting Value Identifiers

To enable the value identifiers to be displayed in SFC, select the Options > Customize > Layout... menu command and then, in the dialog that opens, check the "Parameters: Value identifier" check box.

If you insert a block I/O with a value identifier in the address box, the value identifier is also entered in the right (empty) address box. If there are several value identifiers for this I/O, you can open the list box with the value identifiers in the right address box and select the desired value identifier for this address from the drop-down list.

Editing addresses

When making textual entries, make sure that names are consistent. A symbol that does not exist in the symbol list (or a referenced symbol that is subsequently renamed) cannot be checked in the editor and is set up as a textual interconnection.

Notes

- When you enter statements, they are checked for consistency to ensure the correct syntactic and semantic formulation. The program, for example, checks if the data types of the logically combined addresses are compatible.
- In the addresses, you can enter accesses to CFC block inputs/outputs whose block does not yet really exist in the CFC chart. These statements are displayed in the statement line on a yellow background and are set up as textual interconnections.

You will find information on textual interconnections in the CFC Help in the section:
Working with textual interconnections
Go to point of use

If you want to see the point of use of an address, place the cursor in the address box and click "Go To". The corresponding chart opens. If the address is an input or output of a block in the CFC chart, the I/O of the relevant block is selected. You can also move to the point of use by double-clicking on the address.

With shared addresses, you jump to HW Config if the address is known there. Otherwise, an error message is displayed.

The "Go To" function cannot be used for runtime groups.
11.4.2.4 Validation Entries for Addresses

Left address

**SFC chart**

The following entries are permitted in the SFC chart for the left address:

- A block input of a block in a CFC chart
  Syntax: `<chart_name>\<block_name>.<IO_name>`

- An SFC chart (switch on/off)
  Syntax: `<chart_name>.INTONOFF`

- An interface I/O of the SFC/CFC chart (own or another SFC chart)
  Syntax: `<chart_name>.<IO_name>`

- A runtime group (on/off)
  Syntax: `<group_name>.EN`

- A shared address, to which write access is permitted
  Syntax: `<symbolic_name>`

- A textual interconnection
  Syntax: `<any characters>` or
  path reference to an object that does not yet exist (syntax as for block I/O)

- Structures

<table>
<thead>
<tr>
<th>Syntax</th>
<th>Structure:</th>
<th>( &lt;\text{I/O}\text{_name}&gt; )</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Substructures:</td>
<td>( &lt;\text{I/O}\text{_name}&gt;.[&lt;\text{Substructure}&gt;...]&lt;\text{Substructure}&gt; )</td>
</tr>
<tr>
<td></td>
<td>Structure element:</td>
<td>( &lt;\text{I/O}\text{_name}&gt;.[&lt;\text{Substructure}&gt;...]&lt;\text{Element}&gt; )</td>
</tr>
</tbody>
</table>

**SFC type**

The following entries are permitted in the SFC type for the left address:

- Interface elements (inputs/outputs, structures, substructures, structure elements)

<table>
<thead>
<tr>
<th>Syntax</th>
<th>Input/output:</th>
<th>( &lt;\text{I/O}\text{_name}&gt; )</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Structure:</td>
<td>( &lt;\text{I/O}\text{_name}&gt; )</td>
</tr>
<tr>
<td></td>
<td>Substructures:</td>
<td>( &lt;\text{I/O}\text{_name}&gt;.[&lt;\text{Substructure}&gt;...]&lt;\text{Substructure}&gt; )</td>
</tr>
<tr>
<td></td>
<td>Structure element:</td>
<td>( &lt;\text{I/O}\text{_name}&gt;.[&lt;\text{Substructure}&gt;...]&lt;\text{Element}&gt; )</td>
</tr>
</tbody>
</table>

- A textual interconnection
  Syntax: `<any characters>` or
  path reference to an object that does not yet exist (syntax as for block I/O)
Right address

The following entries are permitted in the SFC chart for the right address:

**SFC chart**

- A block I/O of a block in a CFC chart
  Syntax: `<chart_name><block_name>.<IO_name>`

- An SFC chart (on/off)
  Syntax: `<chart_name>.BUSY`

- An interface I/O of the SFC/CFC chart (own or another SFC chart)
  Syntax: `<chart_name>.<IO_name>`

- A runtime group (on/off)
  Syntax: `<group_name>.EN`

- A shared address
  Syntax: `<symbolic_name>`

- A textual interconnection
  Syntax: `<any characters>` or path reference to an object that does not yet exist (syntax as for block I/O)

- A constant
  Syntax: depends on data type

  For the data types BOOL, BYTE, INT, DINT, WORD, DWORD, instead of the absolute numeric values, you can also specify their symbolic identifiers (value identifiers).

- Structures

<table>
<thead>
<tr>
<th>Syntax</th>
<th>Structure:</th>
<th><code>&lt;I/O_name&gt;</code></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Substructures:</td>
<td><code>&lt;I/O_name&gt;[&lt;Substructure&gt;...]&lt;Substructure&gt;</code></td>
</tr>
<tr>
<td></td>
<td>Structure element:</td>
<td><code>&lt;I/O_name&gt;[&lt;Substructure&gt;...]&lt;Element&gt;</code></td>
</tr>
</tbody>
</table>

**SFC type**

The following entries are permitted in the SFC type for the right address:

- Interface elements (inputs/outputs, structures, substructures, structure elements)

<table>
<thead>
<tr>
<th>Syntax</th>
<th>Input/output:</th>
<th><code>&lt;I/O_name&gt;</code></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Structure:</td>
<td><code>&lt;I/O_name&gt;</code></td>
</tr>
<tr>
<td></td>
<td>Substructures:</td>
<td><code>&lt;I/O_name&gt;[&lt;Substructure&gt;...]&lt;Substructure&gt;</code></td>
</tr>
<tr>
<td></td>
<td>Structure element:</td>
<td><code>&lt;I/O_name&gt;[&lt;Substructure&gt;...]&lt;Element&gt;</code></td>
</tr>
</tbody>
</table>

- A textual interconnection
  Syntax: `<any characters>` or path reference to an object that does not yet exist (syntax as for block I/O)
### 11.4.2.5 How to Filter Block Inputs/Outputs

#### Procedure

In the "CFC Charts" tab of the "Browse" dialog, you can use a filter to display only the block I/Os that are relevant for assignment in the current address box. In the "Filter – I/Os" dialog box, you can specify the criteria that decide which I/Os of the selected block are displayed or not displayed.

#### Filter criteria

The following filter criteria are ANDed with each other.

<table>
<thead>
<tr>
<th>Filter criterion</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>List boxes</strong></td>
<td></td>
</tr>
<tr>
<td>Name:</td>
<td>In the list boxes, you can enter the text to identify an I/O name or I/O comment. This does not need to be the full name/comment but rather can also be initials (without gaps).</td>
</tr>
<tr>
<td>Comment:</td>
<td></td>
</tr>
<tr>
<td>Visible in CFC chart:</td>
<td>An input/output can be visible in the CFC chart or, although present, invisible (S7_visible := 'false').</td>
</tr>
<tr>
<td>Listed:</td>
<td>Listed means that these I/Os (attribute: S7_edit := 'param' or S7_edit := 'signal' can be edited in a list in the process object view in the SIMATIC Manager without having to open the relevant chart (menu command Options &gt; Process Objects &gt; Select I/Os...).</td>
</tr>
<tr>
<td>Operator control and monitoring:</td>
<td>These are block I/Os intended for operator control and monitoring on the OS (attribute: S7_m_c := &quot;true&quot;).</td>
</tr>
<tr>
<td>Interconnected in CFC chart:</td>
<td>As a practical matter, SFC can only use the I/Os interconnected in CFC for read accesses. If block inputs are write-accessed, these values would be overwritten by the values coming from the CFC interconnection.</td>
</tr>
<tr>
<td>Write access in SFC:</td>
<td>The SFC chart cannot write to one block I/O more than once. These I/Os can therefore be hidden if they have been write-accessed.</td>
</tr>
<tr>
<td><strong>Check boxes</strong></td>
<td></td>
</tr>
<tr>
<td>Inputs (IN) Outputs (OUT) In/outs (IN_OUT)</td>
<td>If you reset a check box, no I/Os of this I/O type are displayed.</td>
</tr>
<tr>
<td>Suitable I/Os only:</td>
<td>'Suitable I/Os only' means that the assignment for this address must be suitable for the entry for the other address.</td>
</tr>
</tbody>
</table>

**Example:** If you have assigned an I/O with data type INT in the first address, only I/Os of data type INT are displayed when you click in the box for the second address.

Filtering is performed only when criteria can be explicitly defined; in other words, if an address is a constant, for example, all I/Os are displayed unfiltered and can be selected for the second address.

You can reset all the changed settings using the "Default" button. The default for the list boxes is <all> and all check boxes are activated ✅.
11.4.2.6 How to access structures

Introduction

In the step properties, you can configure structure assignments. Structures, substructures or structure elements are possible according to the following syntax:

<table>
<thead>
<tr>
<th>Structure:</th>
<th>&lt;I/O_name&gt;</th>
</tr>
</thead>
<tbody>
<tr>
<td>Substructures:</td>
<td>&lt;I/O_name&gt;.[&lt;Substructure&gt;...]&lt;Substructure&gt;</td>
</tr>
<tr>
<td>Structure element:</td>
<td>&lt;I/O_name&gt;.[&lt;Substructure&gt;...]&lt;Element&gt;</td>
</tr>
</tbody>
</table>

You can enter this information directly in the statement lines or by means of the "Browse" dialog box. In the "Browse" dialog box, you can enter the desired structure in the statement line by double-clicking or by selecting the structure and clicking "Apply" or by selecting the shortcut menu command Apply I/O. You apply substructures or structure elements in the "Structure" dialog box.

In the Transition Properties, it is only possible to compare structure elements.

Note on SFC types

The use of structures of I/O type IN_OUT is not permitted. Although SFC tolerates the assignment, this is detected as an error when the S7 program is compiled.

Selecting a structure

1. Select the desired structure in the "Browse" dialog box.
2. Select the menu command Open Structure from the shortcut menu.
   The "Structure" dialog box opens.
   The name of the structure is specified in the title bar. The table of the dialog box contains the same columns as found in the "I/Os" column of the "Browse" dialog box.
3. Double-click the table line or click "Apply".
   The substructure, structure, or structure element is entered in the "Properties" dialog box.

Note

Structures and substructures are not entered in the "Properties" dialog of the transition.
Meaning of the columns in the "Structure" dialog box

Name
Shows the names of the structure elements of the entire structure, for example:

| var01_char |       |
| var04_struct | var02_bool |
|           | var02_int |
|           | var06_struct |
|           | var03_word |
|           | var03_date |
| var01_time |       |

Data type
Shows the data type of the structure element (BOOL, DINT or CHAR) or STRUCT for substructures.

I/O
Shows the I/O type of the structure element or substructure (IN, OUT, IN_OUT).

CFC interconnection
If the structure is interconnected in CFC, this is indicated here by an 'x' (entire column).

SFC access (writing)
An existing (write) access by the SFC to a structure element is indicated by an "x".

Comment
Shows the comment of the structure element, for example: "1=CPU DPV1 mode".
11.4.3 Editing transitions

11.4.3.1 How to Edit the Transition

Opening the "Properties" dialog box of the transition

1. Double-click the transition to be edited or select the menu command Edit > Object Properties.... The dialog box opens.

2. Edit the properties (name, comment), formulate the conditions and enter the OS comment.

The dialog box is divided into three tabs:
- "General"
- "Condition"
- "OS Comment"

"General" tab

In the "General" tab, you can enter or change the name and comment.

The number was assigned by SFC when the transition was generated and is unique in this sequencer. It is read-only and cannot be modified. The number sequence has no gaps. If a transition is deleted and a new one inserted later, the new transition is given the number of the previously deleted transition.
"Condition" tab

In the "Condition" tab, you can combine 2 x 5 and 2 x 3 conditions using three-stage transition logic to form a Boolean expression.

"OS Comment" tab

In the "OS Comment" tab, you can enter a text for every condition. This text will be displayed on the OS during process control. The text of the condition is entered by default.

Documenting the configuration

You can document the configured conditions of the transition. By clicking "Print" in the Object Properties dialog, you obtain a log of the transition with information about the properties and parameters of the conditions.

Changes to the configuration

If you change the configuration of a transition (name, comment, condition, OS comment), you can compile changes only (SFC > Compile..., range: Changes menu command) and download them while the CPU is in RUN mode (CPU > Download..., Download mode: Changes menu command) without having to first deactivate the active SFC.

You will find more information on editing a transition in the sections:
- Formulating the Conditions of a Transition (Page 151)
- How to edit addresses in a transition (Page 152)
- How to Edit OS Comments in a Transition (Page 154)
- How to copy object properties of SFC elements (Page 131)
11.4.3.2 Formulating the Conditions of a Transition

Introduction

You specify the step control conditions for the selected transition in the "Condition" tab.

Note

Note that an SFC type can only access its own interface and not external objects.

Formulating a transition

You formulate the transition as a Boolean expression, which can consist of 2 x 5 and 2 x 3 conditions (expression segments). The conditions are combined using three-stage transition logic.

The Boolean operators are designed as buttons. By clicking the operator, you can change it from "AND (\&)" to "OR (≥1)". To make a "NAND" from an "AND" and a "NOR" from an "OR", click the output of the operator. The negation is displayed by a bolded dot on the output line.

Alternative operation: If you position the cursor over an operator, you can right-click to open the shortcut menu, which displays all the available Boolean operators. After you select the menu command, the operator is changed accordingly.

You will find more information on editing a transition in the sections:

- How to edit addresses in a transition (Page 152)
- Valid data types (Page 158)
11.4.3.3 How to edit addresses in a transition

Selecting addresses

You can edit the addresses or define them in the "Browse" dialog box.

You can find additional information about this in the section: How to edit addresses in a step (Page 141)

The advantage of browsing is that the addresses are then unique. As a third possibility, you can use a drag-and-drop operation to move the block inputs/outputs from CFC charts directly to the box for the address.

Note

Note that an SFC type can only access its own interface and not external objects.

As when selecting addresses for the steps, you can also enter the value identifiers of the inputs/outputs for the transitions.

If you make the selection by means of the "Browse" dialog box or using a drag-and-drop operation from the CFC chart, the entries are expanded to include the path of the plant hierarchy (if this exists). The hierarchy path and the chart name are separated by double backslashes ( \ ).

Texts with a yellow background reference objects that no longer exist or do not yet actually exist (block inputs/outputs, charts, runtime groups).

This reference is a textual interconnection that you can complete during compiling or explicitly using the menu command Options > Make Textual Interconnection if the interconnection partner actually exists. The textual interconnection is displayed on a yellow background in the line of the address. The same display is used if a former actual interconnection becomes a textual interconnection due to subsequent deletion of the interconnection partner.

Textual interconnections that cannot be made are ignored during compilation. A corresponding warning is entered in the log indicating which input/output still has a textual interconnection. An unmade textual interconnection is also tolerated in the download.

Notes

- Accesses to CFC blocks can also be modified in the relevant CFC chart. This modification is, however, restricted to "rewiring" SFC accesses; in other words, moving the access to another block I/O (with <Alt> + Drag-and-Drop).
- Access to structures is possible but is restricted to the structure elements. In the "Browse" dialog, you can open the structure by right-clicking the structure and selecting the shortcut menu command Open Structure and then select the desired structure element.
- Interconnections cannot be set up if the target of the interconnection is not unique; in other words, its name occurs more than once. The interconnection is then displayed as a textual interconnection and cannot be made. Example: The object name of an SFC is the same as the symbolic name of a DB.
When you enter conditions, they are checked for consistency to ensure the correct syntactic and semantic formulation of the conditions. The program also checks if the data types of the logically combined addresses are compatible.

The predefined logic is normally sufficient. If you require more complex formulations, you can create them with blocks in a CFC chart and enter the results that were calculated in the chart as the address in the transition conditions.

Go to point of use

If you want to see the point of use of an address, place the cursor in the address box and click "Go To". The corresponding chart opens. If the address is an input or output of a block in the CFC chart, the I/O of the relevant block is selected. You can also move to the point of use by double-clicking on the address.

With shared addresses, you jump to HW Config if the address is known there. Otherwise, an error message is displayed.

The "Go To" function cannot be used for runtime groups.
11.4.3.4 How to Edit OS Comments in a Transition

Entering an OS comment

In the "OS Comment" tab, you can enter a text for every condition. This text will be displayed on the OS during process control. The text of the condition is entered by default.

You cannot change the Boolean operators in this part of the dialog box; the buttons are only for visualizing the existing logic operations.

If comment lines are labeled with the symbol, the comment is identical to the text of the condition (default).

Notes

- The OS comment for the SFC type and SFC instance can be different. If the SFC type has an I/O that is interconnected in the SFC instance, the interconnection partner is indicated for the instance. If this is an output with multiple interconnections, only one of the interconnections is displayed.
  If the inputs/outputs are not interconnected, the OS comment of the SFC type and SFC instance are identical.
  Example:

<table>
<thead>
<tr>
<th>Interconnected</th>
<th>SFC type</th>
<th>SFC Instance</th>
</tr>
</thead>
<tbody>
<tr>
<td>RUN = TRUE</td>
<td>chartblock.io = TRUE</td>
<td></td>
</tr>
<tr>
<td>Not interconnected</td>
<td>RUN = TRUE</td>
<td>chart:instance.RUN = TRUE</td>
</tr>
</tbody>
</table>

- Provided you do not edit the OS comment, it will be adapted automatically whenever the compare condition is changed. The OS comment is also automatically adapted when the referenced CFC blocks are renamed, copied, moved and deleted.

- If you change the condition and a user-edited comment text is associated with this condition, this comment text is not automatically adapted. In this case, a dialog box appears indicating that you should check the comment text. You can cancel the change in this dialog box by clicking "Cancel".
You can initialize an individual OS comment in the SFC Editor by deleting the OS comment. The text of the compare condition is then used again as the OS comment and from this time onwards is automatically adapted whenever the condition is changed, providing you do not edit the OS comment.

**Alternative action:** You enter the original OS comment (text of the condition) again using the shortcut menu command **Use Default**.

You can edit the OS comments later.

The menu command **Options > Edit OS Comments**... opens a dialog box in which you specify how you want to use the OS comment for the transitions:

- Leave unchanged
- Use all conditions

You can also specify how any edits to the OS comments are to apply in this dialog box:

- The entire chart folder
- The current chart
- The selected steps/transitions
11.4.4 Shared addresses and valid data types

11.4.4.1 Shared addresses

Shared addresses

Shared addresses are connection partners that are outside the CFC/SFC charts. Shared addresses can be read- and write-accessed. Note that the data type of the shared address and of the accessing object (address of a statement or condition in SFC, block I/O in CFC) must match.

You can specify the addresses in symbolic or absolute form.

You can find additional information in the following sections:

- How to perform symbolic addressing  (Page 157)
- Absolute addressing  (Page 156).

11.4.4.2 Absolute addressing

Rules

The address of a value is used for absolute addressing.

Follow these rules:

- The address must not be located in the area reserved for compiling the CFC chart menu command (Options > Settings for Compilation...).
- The address must not be located in a value range that does not exist for the current CPU.
- The address must be compatible with the data type of the accessing object (address of a statement or condition in SFC, block I/O in CFC). If the case of a peripheral input word (PIW), the first interconnection determines the type.
- The data width must accommodate the address and I/O.

Examples

The following examples illustrate how to specify addresses in absolute form:

<table>
<thead>
<tr>
<th>Address</th>
<th>Remark</th>
</tr>
</thead>
<tbody>
<tr>
<td>I5.1</td>
<td>Access to input 5.1</td>
</tr>
<tr>
<td>Q5.1</td>
<td>Access to output 5.1</td>
</tr>
<tr>
<td>M6.7</td>
<td>Access to memory bit 6.7</td>
</tr>
<tr>
<td>MW10</td>
<td>Access to memory word 10</td>
</tr>
<tr>
<td>DB10.DW20</td>
<td>Access to data block 10, data word 20</td>
</tr>
<tr>
<td>DB20.DX2.1</td>
<td>Access to data block 20, bit 2.1</td>
</tr>
</tbody>
</table>
11.4.4.3 How to perform symbolic addressing

Symbolic addressing

With symbolic addressing, you specify the address to be processed as a symbol. Symbols and addresses are assigned in the symbol table. The menu command Options > Symbol Table opens the symbol table where you can add or edit entries.

When you make your entries in the symbol table, remember to adhere to the STEP 7 conventions.

Checking the syntax

You can use the menu command Chart > Check Consistency... to check that all the entries are present in the symbol table before you compile. You can display the log of the consistency check with the menu command Options > Logs....

Examples

Below, you can see several examples of possible entries. The following examples illustrate how addresses can be specified symbolically.

<table>
<thead>
<tr>
<th>Address</th>
<th>Remark</th>
</tr>
</thead>
<tbody>
<tr>
<td>Limitswitch</td>
<td>For example access to an input bit. The absolute address is defined in the symbol table.</td>
</tr>
<tr>
<td>Recipe.setpoint</td>
<td>Access to a data block (recipe). The structure or the type of the data block determines the data block element (value).</td>
</tr>
<tr>
<td>DB17.setpoint</td>
<td>As above, but with absolute addressing of the data block</td>
</tr>
<tr>
<td>Recipe.DW5</td>
<td>As above, but with absolute addressing of the data word</td>
</tr>
<tr>
<td>&quot;I5.1&quot;</td>
<td>Access to the symbol with the name I5.1. To avoid the absolute address with the same name being addressed instead of the symbol, the symbol is enclosed in quotation marks.</td>
</tr>
</tbody>
</table>
### Valid data types

The following data types are permitted for formulating actions and conditions in SFC:

<table>
<thead>
<tr>
<th>Data type</th>
<th>Permitted in steps</th>
<th>Permitted in transitions</th>
</tr>
</thead>
<tbody>
<tr>
<td>BOOL, BO</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>BYTE, BY</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>CHAR, C</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>DATE, D</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>DINT, DI</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>DWORD, DW</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>INT, I</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>REAL, R</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>S5TIME, T5</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>STRING, S</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>STRUCT, ST</td>
<td>Yes</td>
<td>Yes *)</td>
</tr>
<tr>
<td>TIME, TI</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>TIME OF DAY, T</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>WORD, W</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

*) only to structure elements
11.5 Specifying runtime properties

11.5.1 Runtime Properties of an SFC

Runtime properties
The runtime properties of an SFC chart or SFC instance determine how the SFC is included in the chronological execution sequence within the overall structure in the CPU. These properties determine the behavior of the target system with respect to response times, dead times, or the stability of time-dependent structures, such as control loops.

Insertion in the run sequence
Each SFC chart is inserted in a run sequence by default. Specifically, it is inserted in a task that corresponds to an organization block (OB) in S7. SFC charts can be inserted in runtime groups and thereby given the attributes of the runtime group (reduction ratio, phase offset).

An SFC type does not have any runtime properties, since it is not relevant to execution of the program. An SFC type cannot be inserted in the run sequence.

You edit the run sequence with the run sequence editor of CFC.

SFC instances are inserted in runtime groups of the associated CFC chart by default.

For further information on editing the step, refer to the following sections:
- How to Edit the Run Sequence (Page 160)
- Runtime Attributes for Runtime Groups and SFCs (Page 161)
11.5.2 How to Edit the Run Sequence

Editing the Run Sequence
You can edit the run sequence of SFC charts/SFC instances in several ways. The run sequence includes the insertion position of the SFCs in the tasks and the runtime attributes "reduction ratio" and "phase offset" by means of the attributes of the runtime group.

Changing the Run Sequence
1. Select the button in the toolbar
or
select the Edit > Run Sequence menu command.
The SFC starts and the "Run Sequence" window opens. If the catalog also opens in SFC, you can close it.
2. Select the task containing the SFC you want to upgrade in the left window.
3. Select the SFC and select the "Cut" function.
4. Select the new position in the run sequence (task or object in the task) and the select "Insert".
   If you have selected a task, the SFC is inserted at the beginning of the task.
   If you have selected an object within the task, the SFC chart is inserted after the object.
   As an alternative to Cut/Paste, you can also use a drag-and-drop operation to move an SFC from an open task to another task.

Inserting an SFC in Other Tasks
Each SFC (chart-instance) must be inserted in at least two tasks:
- In OB 100 for the startup behavior
- In one cyclic interrupt OB (for example, OB 32) for cyclic operation

Note
You cannot insert the same SFC more than once in the same task. Inserting an SFC in several cyclic tasks is not allowed because this can result in unpredictable behavior. No provision is made for insertion of the SFC in other non-cyclic tasks (except in OB 100).

Removing an SFC from a Task
Select the SFC in the task and delete it by selecting the menu command Delete or by pressing the <Del> key.
The SFC is deleted from the task following a prompt for confirmation.
You will find more detailed information in the section: Runtime Attributes for Runtime Groups and SFCs (Page 161)
11.5.3 Runtime Attributes for Runtime Groups and SFCs

Introduction

You can insert SFCs in runtime groups if they have the "reduction ratio" and/or "phase offset" attributes. You set the attributes in the object properties of the runtime group. All charts of the runtime group then have the same "reduction ratio" and "phase offset".

Inserting and editing a runtime group

You can generate a runtime group in the run sequence editor as follows:

1. Select the menu command Edit > Run Sequence...
   or click the following button

2. Select the insertion position in the run sequence.

3. Select the menu command Insert > Runtime Group....

4. You can enter the name and any desired comment in the "Insert Runtime Group" dialog box. You can also change the default setting of the runtime attributes for the reduction ratio and phase offset here (see information below).

5. Click "OK".

If you want to change the runtime attributes later, select the runtime group in the window of the run sequence and select the menu command Edit > Object Properties.

Note

SFCs can run in different cyclic tasks when they are inserted in runtime groups. From a technological point of view, this enables you to structure the project better, which will result in considerably better performance when configuration changes are made (including reducing the time needed for compilation).

Enable attribute of the SFC chart

The Enable attribute (EN) enables (EN=1) or disables (EN=0) the execution of the SFC chart. As long as EN is set to 0, the SFC chart will not be processed regardless of any other conditions.

You can make the enable attribute dynamic. In this case, the value of a block output or the statement of a step decides whether or not the SFC chart is processed.
Runtime attributes of the runtime group

You can also use the enable attribute to enable and disable a runtime group, same as an SFC chart.

You cannot assign the following attributes to an SFC chart directly; they are assigned by inserting them into a runtime group:

- Scan rate
- Phase offset

The SFC receives the attributes set for this runtime group.

An SFC that is not inserted in a runtime group has the following defaults:

- "Reduction ratio = 1"
- "Phase offset = 0"

If you want SFCs in a CPU to run with different runtime attributes, you must insert these charts in different runtime groups.

- **Scan rate**

  The reduction ratio specifies whether the SFC chart is processed each time the task is executed or only every nth time the task is executed. "n" is an integer (n=2^t, where $0 \leq t \leq 15$). The increments are a multiple of the basic cycle clock of the task.

  **Example:**
  Basic cycle of a cyclic interrupt (OB 33): 500 ms
  Possible clock cycles with reduction ratio: 1 s, 2 s, 4 s, 8 s, 16 s, etc.

  If a chart is not installed in a runtime group, the number 1 is preset; in other words, the SFC chart is processed in each run (every 500 ms).

- **Phase offset**

  Phase offset allows a uniform distribution of load within the CPU. It must be considered in conjunction with "n", the reduction ratio. The SFC chart is processed as often as specified by "n", offset in each case by "m" units of the task cycle. "m" is an integer, where $0 \leq m \leq (n-1)$.

  **Example:**
  Basic cycle of a cyclic interrupt: 500 ms
  Reduction ratio: 16 (i.e., the SFC chart is processed every 8 s)
  phase offset: 3. The SFC chart is thus processed after 1.5 s; 9.5 s; 17.5 s, etc.

  If a chart is not installed in a runtime group, the number 0 is preset; in other words, the SFC chart is processed without phase offset.

**Note**

You should only use reduction ratio and phase offset in the tasks that are executed in defined cycles; in other words, in (cyclic) interrupt tasks. In all other tasks you should use extreme caution, particularly in process interrupt tasks and special tasks. Here, you should not change the default reduction ratio=1 and phase offset=0.
Standard interface and chart I/Os

12.1 Standard interface of the SFC chart

12.1.1 Inputs/Outputs of the SFC Chart Standard Interface

The standard interface of the SFC chart includes the necessary inputs/outputs for controlling the SFC chart from the user program or by means of operator control and monitoring.

For more information on the I/Os, refer to the following sections:
- Standard interface of the SFC chart (Page 163)
- Inputs/Outputs of the SFC Chart Sorted According to Usage (Page 170)

12.1.2 Standard interface of the SFC chart

The following table lists the inputs/outputs of the standard interface for the SFC chart in alphabetical order.

You will find explanations of the table entries in the section: Meanings in the table (Page 169)

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
<th>O&amp;M</th>
</tr>
</thead>
<tbody>
<tr>
<td>ABORT</td>
<td>Automatic command &quot;Abort&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>ABORTED</td>
<td>Operating state &quot;Aborted&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>ABORTING</td>
<td>Operating state &quot;Aborting&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>AUT</td>
<td>Change to AUTO (process mode)</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>BA_ADDSTATE</td>
<td>BATCH: Additional status word</td>
<td>DWORD</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>BA_EN</td>
<td>BATCH: Enable</td>
<td>BOOL</td>
<td>1</td>
<td>I</td>
<td>+</td>
</tr>
<tr>
<td>BA_ID</td>
<td>BATCH: Consecutive batch number</td>
<td>DWORD</td>
<td>0</td>
<td>I</td>
<td>+</td>
</tr>
<tr>
<td>BA_NA</td>
<td>BATCH: Batch name</td>
<td>STRING</td>
<td>' '</td>
<td>I</td>
<td>+</td>
</tr>
<tr>
<td>BA_STATE</td>
<td>BATCH status word</td>
<td>DWORD</td>
<td>0</td>
<td>O</td>
<td>+</td>
</tr>
</tbody>
</table>
### Standard Interface and Chart I/Os

#### 12.1 Standard Interface of the SFC Chart

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
<th>O&amp;M</th>
</tr>
</thead>
<tbody>
<tr>
<td>BUSY</td>
<td>Status &quot;Busy&quot; (= neither &quot;Idle&quot; nor &quot;Completed&quot; nor &quot;Aborted&quot; nor &quot;Stopped&quot;)</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>COMPLETE</td>
<td>Automatic command &quot;Complete&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>COMPLETED</td>
<td>Operating state &quot;Completed&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>COMPLETING</td>
<td>Operating state &quot;Completing&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>CONT</td>
<td>Continuous mode</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>CPU_RESTART</td>
<td>Restart of the CPU</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>CUSEQ</td>
<td>No. of current sequencer</td>
<td>BYTE</td>
<td>0</td>
<td>O</td>
<td>+</td>
</tr>
<tr>
<td>CUSTEP</td>
<td>No. of current step</td>
<td>WORD</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>CUSTEPACTSTATE</td>
<td>Active state of current step</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>CUSTEPCOUNT</td>
<td>Number of active steps</td>
<td>BYTE</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>CUSTEPERRSTATE</td>
<td>Error state of current step</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>CUSTEPHELDSTATE</td>
<td>Held state of current step</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>CUSTEPMAXRT</td>
<td>Max. run time of the current step</td>
<td>TIME</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>CUSTEPMINRT</td>
<td>Min. run time of the current step</td>
<td>TIME</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>CUSTEPRT</td>
<td>Run time of the current step</td>
<td>TIME</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>CUTRANS</td>
<td>Number of the current transition</td>
<td>WORD</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>CUTRANSCOUNT</td>
<td>Number of active transitions</td>
<td>BYTE</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>CUTRANSRESULT</td>
<td>Result of first active transition</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>CYCLEEXEC</td>
<td>Cyclic operation (only in AUTO)</td>
<td>BOOL</td>
<td>0</td>
<td>1) I</td>
<td></td>
</tr>
<tr>
<td>DIS_START_STATE</td>
<td>Reason for start disturbance</td>
<td>DWORD</td>
<td>0</td>
<td>O</td>
<td>+</td>
</tr>
<tr>
<td>ENABORT</td>
<td>Enable &quot;Abort&quot;</td>
<td>BOOL</td>
<td>1</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>ENASTART</td>
<td>Enable &quot;Start in Run&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>ENAUIT</td>
<td>Enable &quot;Change to AUTO&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>ENCOMPLETE</td>
<td>Enable &quot;Complete&quot;</td>
<td>BOOL</td>
<td>1</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>ENHOLD</td>
<td>Enable &quot;Hold&quot;</td>
<td>BOOL</td>
<td>1</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>ENMAN</td>
<td>Enable &quot;Change to MANUAL&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>ENRESET</td>
<td>Enable &quot;Reset&quot;</td>
<td>BOOL</td>
<td>1</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>ENRESTART</td>
<td>Enable &quot;Restart&quot;</td>
<td>BOOL</td>
<td>1</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>ENRESET</td>
<td>Enable &quot;Resume&quot;</td>
<td>BOOL</td>
<td>1</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>ENSTART</td>
<td>Enable &quot;Start&quot;</td>
<td>BOOL</td>
<td>1</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>ENSTOP</td>
<td>Enable &quot;Stop&quot;</td>
<td>BOOL</td>
<td>1</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>ENTARGETSTEP</td>
<td>Enable &quot;Set target steps&quot;</td>
<td>BOOL</td>
<td>1</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>ERRG</td>
<td>Group error (EXT_ERR</td>
<td>OP_ERR</td>
<td>LI_ERR</td>
<td>S_ERRG)</td>
<td>BOOL</td>
</tr>
<tr>
<td>ERROR</td>
<td>Operating state &quot;Error&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>ERROR_COMPLETING</td>
<td>Operating state &quot;Error (Completing)&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>EXEC_ERR</td>
<td>Runtime error, e.g., step error, CPU restart</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>EXT_ERR</td>
<td>External error</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td></td>
</tr>
</tbody>
</table>
## Standard interface and chart I/Os

### 12.1 Standard interface of the SFC chart

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
<th>O&amp;M</th>
</tr>
</thead>
<tbody>
<tr>
<td>HELD</td>
<td>Operating state &quot;Held&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>HELD_ERROR</td>
<td>Operating state &quot;Held (Error)&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>HELDSEQ</td>
<td>No. of held sequencer</td>
<td>BYTE</td>
<td>0</td>
<td>O</td>
<td>+</td>
</tr>
<tr>
<td>HELDSTEP</td>
<td>No. of held step</td>
<td>WORD</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>HELDSTEPCOUNT</td>
<td>Number of held steps</td>
<td>BYTE</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>HELDSTEPERRSTATE</td>
<td>Error status of held step</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>HELDSTEPHELDSTATE</td>
<td>State of the held step</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>HELDSTEPRT</td>
<td>Run time of held step</td>
<td>TIME</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>HELDTRANS</td>
<td>No. of held transition</td>
<td>WORD</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>HELDTRANSRESULT</td>
<td>Result of first held transition</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>HOLD</td>
<td>Automatic command &quot;Hold&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>HOLDING</td>
<td>Operating state &quot;Holding&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>IDLE</td>
<td>Operating state &quot;Idle&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>INSTROUT</td>
<td>Command output (only in AUTO)</td>
<td>BOOL</td>
<td>1 2)</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>INTABORT</td>
<td>Internal command &quot;Abort&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
<td></td>
</tr>
<tr>
<td>INTCOMPLETE</td>
<td>Internal command &quot;Complete&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
<td></td>
</tr>
<tr>
<td>INTERROR</td>
<td>Internal command &quot;Error&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
<td></td>
</tr>
<tr>
<td>INTHOLD</td>
<td>Internal command &quot;Hold&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
<td></td>
</tr>
<tr>
<td>INTOOFF</td>
<td>Internal command &quot;Switch SFC on/off&quot;: 0: Switch off, 1: Switch on</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
<td></td>
</tr>
<tr>
<td>INTRESET</td>
<td>Internal command &quot;Reset&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
<td></td>
</tr>
<tr>
<td>INTRESTART</td>
<td>Internal command &quot;Restart&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
<td></td>
</tr>
<tr>
<td>INTRESUME</td>
<td>Internal command &quot;Resume&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
<td></td>
</tr>
<tr>
<td>INTSTART</td>
<td>Internal command &quot;Start&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
<td></td>
</tr>
<tr>
<td>INTSTOP</td>
<td>Internal command &quot;Stop&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
<td></td>
</tr>
<tr>
<td>IORES1..6</td>
<td>Reserved for internal use</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
<td></td>
</tr>
<tr>
<td>IRES1..5</td>
<td>Reserved for internal use</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>LASTSEQ</td>
<td>No. of last active sequencer</td>
<td>BYTE</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>LASTSTEP</td>
<td>No. of last active step</td>
<td>WORD</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>LI_ERR</td>
<td>Parameter assignment error (e.g. invalid combination at inputs)</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>LI_ERR_STATE</td>
<td>Status word for parameter error</td>
<td>DWORD</td>
<td>0</td>
<td>O</td>
<td>+</td>
</tr>
<tr>
<td>LOCKABORT</td>
<td>External interlock &quot;Abort&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>LOCKCOMPLETE</td>
<td>External interlock &quot;Complete&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>LOCKERROR</td>
<td>External interlock &quot;Error&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>LOCKHOLD</td>
<td>External interlock &quot;Hold&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>LOCKSTOP</td>
<td>External interlock &quot;Stop&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>MAN</td>
<td>Change to MANUAL (operator control mode)</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>I/O</td>
<td>Meaning</td>
<td>Data type</td>
<td>Default</td>
<td>Ty pe</td>
<td>O&amp;M</td>
</tr>
<tr>
<td>-------------</td>
<td>---------------------------------------------------</td>
<td>-----------</td>
<td>---------</td>
<td>-------</td>
<td>-----</td>
</tr>
<tr>
<td>MODE</td>
<td>Processing mode:</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td></td>
<td>0: Cyclic processing in cyclic interrupt OB</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>1: One-time processing in startup OB</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MSG_EVID</td>
<td>Message number (ALARM_8P)</td>
<td>DWORD</td>
<td>2</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>MSG_LOCK</td>
<td>Lock messages:</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td>+</td>
</tr>
<tr>
<td></td>
<td>0: Messages not locked</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>1: Messages locked</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MSG_SUP</td>
<td>Message suppression (ALARM_8P)</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td>+</td>
</tr>
<tr>
<td>NMSG_EVID</td>
<td>Message number (NOTIFY)</td>
<td>DWORD</td>
<td>1</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>OCCUPIED</td>
<td>BATCH: &quot;Occupied&quot; ID</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td>+</td>
</tr>
<tr>
<td></td>
<td>0 = not occupied, 1 = occupied</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>OP_ERR</td>
<td>Operator error</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>OP_ERR_STATE</td>
<td>Status word for operator error</td>
<td>DWORD</td>
<td>0</td>
<td>O</td>
<td>+</td>
</tr>
<tr>
<td>ORES_BY</td>
<td>Reserved for internal use</td>
<td>BYTE</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>ORES1..15</td>
<td>Reserved for internal use</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>QAUTMAN</td>
<td>Current operating mode: 0: MANUAL, 1: AUTO</td>
<td>BOOL</td>
<td>0 4)</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>QBA_EN</td>
<td>BATCH: Enable</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>QBA_ID</td>
<td>BATCH: Consecutive batch number</td>
<td>DWORD</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>QBA_NA</td>
<td>BATCH: Batch name</td>
<td>STRING</td>
<td>&quot; &quot;</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>QDIS_START</td>
<td>&quot;Start&quot; not possible (e.g. LI_ERR, OP_ERR, etc.)</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>QENAUT</td>
<td>Enable &quot;Change to AUTO&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>QENMAN</td>
<td>Enable &quot;Change to MANUAL&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>QEXT_ERR</td>
<td>External error</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>QFORCEMAN</td>
<td>Changeover to MANUAL without enable (= forced manual, for 1 cycle)</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>QOCCUPIED</td>
<td>BATCH: &quot;Occupied&quot; identifier</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>QSCC</td>
<td>Step enabling with operator confirmation</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>QSCT</td>
<td>Step enabling with transition</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>QSCT_TAC</td>
<td>Step enabling with transition and step-specific operator confirmation</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>QSCTAC</td>
<td>Step enabling with transition and Confirmation by operator</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>QSTEP_NO</td>
<td>BATCH: Step number</td>
<td>DWORD</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>READY_TC</td>
<td>&quot;Ready to complete&quot; state</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>RESET</td>
<td>Automatic command &quot;Reset&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>RESTART</td>
<td>Automatic command &quot;Restart&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>RESU_ERROR</td>
<td>Operating state &quot;Resuming (Error)&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>RESUME</td>
<td>Automatic command &quot;Resume&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td></td>
</tr>
</tbody>
</table>
# Standard interface and chart I/Os

## 12.1 Standard interface of the SFC chart

**SFC for SIMATIC S7**

**Programming and Operating Manual, 12/2011, A5E03710074-01**

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Typ</th>
<th>O&amp;M</th>
</tr>
</thead>
<tbody>
<tr>
<td>RESUMING</td>
<td>Operating state &quot;Resuming&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>RUN</td>
<td>Operating state &quot;Run&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>RUNCOUNT</td>
<td>Number of runs in &quot;cyclic operation&quot;</td>
<td>INT</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>RUNHOLD</td>
<td>Response of the RUN sequencer to the &quot;Hold&quot; Command 0: Hold sequencer, 1: Abort sequencer</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>S_ERRCA</td>
<td>Confirm all step errors (only in AUTO)</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>S_ERRG</td>
<td>Group display &quot;Step error&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>SCT</td>
<td>Step enabling with transition (only in AUTO)</td>
<td>BOOL</td>
<td>1 (5)</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>SCT_TAC</td>
<td>Step enabling with transition and step-specific operator confirmation (only in AUTO)</td>
<td>BOOL</td>
<td>0 (5)</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>SELFCOMP</td>
<td>SFC changes automatically from &quot;Run&quot; to &quot;Completing&quot;</td>
<td>BOOL</td>
<td>1</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>SELFRESET</td>
<td>SFC changes automatically from &quot;Completed/Aborted/Stopped&quot; to &quot;Idle&quot; (only in MANUAL)</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>SFC_ADDSTATE</td>
<td>Additional SFC status word</td>
<td>DWORD</td>
<td>0</td>
<td>O</td>
<td>+</td>
</tr>
<tr>
<td>SFC_CONTROL</td>
<td>SFC control word (internal interface)</td>
<td>DWORD</td>
<td>0</td>
<td>IO</td>
<td>+</td>
</tr>
<tr>
<td>SFC_INIT</td>
<td>Initialize SFC</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
<td></td>
</tr>
<tr>
<td>SFC_STATE</td>
<td>SFC status word</td>
<td>DWORD</td>
<td>0</td>
<td>O</td>
<td>+</td>
</tr>
<tr>
<td>SIG_2...8</td>
<td>Generate message 2...8 (ALARM_8P)</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
<td></td>
</tr>
<tr>
<td>START</td>
<td>Automatic command &quot;Start&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>STARTING</td>
<td>Operating state &quot;Starting&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>STEP_NO</td>
<td>BATCH: Step number</td>
<td>DWORD</td>
<td>0</td>
<td>I</td>
<td>+</td>
</tr>
<tr>
<td>STOP</td>
<td>Automatic command &quot;Stop&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>STOPPED</td>
<td>Operating state &quot;Stopped&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>STOPPING</td>
<td>Operating state &quot;Stopping&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>T_OPRQCA</td>
<td>Confirmation of all operator prompts (only in AUTO)</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>T_OPRQG</td>
<td>Group display &quot;Operator prompt at transition&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>TARGETSEQ</td>
<td>Sequencer number for &quot;Set target step&quot;</td>
<td>BYTE</td>
<td>0</td>
<td>IO</td>
<td></td>
</tr>
<tr>
<td>TARGETSTEP</td>
<td>Step number for &quot;Set target step&quot;</td>
<td>WORD</td>
<td>0</td>
<td>IO</td>
<td></td>
</tr>
<tr>
<td>TIMEMON</td>
<td>Time monitoring (only in AUTO)</td>
<td>BOOL</td>
<td>0 (3)</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>TRIG_CPU_RESTART</td>
<td>Start trigger for sequencer after CPU restart</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
</tbody>
</table>
### Key

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Depends on &quot;SFC properties/operating parameters AS/cyclic operation&quot;</td>
</tr>
<tr>
<td>2</td>
<td>Depends on &quot;SFC properties/operating parameters AS/command output&quot;</td>
</tr>
<tr>
<td>3</td>
<td>Depends on &quot;SFC properties/operating parameters AS/time monitoring&quot;</td>
</tr>
<tr>
<td>4</td>
<td>Depends on &quot;SFC properties/operating parameters AS/operating mode&quot;</td>
</tr>
<tr>
<td>5</td>
<td>Depends on &quot;SFC properties/operating parameters AS/step control mode&quot;</td>
</tr>
</tbody>
</table>
12.1.3 Meanings in the table

Explanations of the table

- In the "I/O" column, text in bold print signifies that the attribute S7_visible = 'true' is set. The I/O is visible.
- The following abbreviations are used in the "Type" column
  - I = IN (input)
  - IO = INOUT (in/out)
  - O = OUT (output)
- The following abbreviations are used in the "Attr." column
  - "Q" means that attribute S7_link = 'true' is set. The I/O is interconnectable.
  - "M" means that this is a MESSAGE ID for a message block (e.g., ALARM_8P). Parameters cannot be assigned for the I/O; the ID is assigned by the message server.
  - "B" means operator controllable (only via a faceplate). Write access to this I/O is enabled at the OS. Hidden in the CFC.
- In the "OCM" column, "+" means that attribute S7_m_c = 'true' is set. The I/O can be controlled and monitored by the operator.

You can find the meanings of the individual system attributes in "Help on STEP 7" under the topic:

System Attributes for Block Interfaces
12.1.4 Inputs/Outputs of the SFC Chart Sorted According to Usage

Inputs/outputs of SFC chart

The inputs/outputs of the standard interface for the SFC chart are sorted according to their use and summarized in the following sections:

- Operating modes (SFC inputs/outputs) (Page 198)
- Commands and operating states (SFC inputs/outputs) (Page 200)
- Execution options (SFC inputs/outputs) (Page 208)
- Group displays and group acknowledgements (SFC inputs/outputs) (Page 210)
- Data from sequencers and steps to be processed (SFC inputs/outputs) (Page 210)
- BATCH parameters (SFC inputs/outputs) (Page 212)
- Continuous mode (SFC inputs/outputs) (Page 213)
- Error handling (SFC inputs/outputs) (Page 213)
- Messages (SFC inputs/outputs) (Page 217)
- Control words (SFC inputs/outputs) (Page 218)
- Status words (SFC inputs/outputs) (Page 219)
- System parameters (SFC inputs/outputs) (Page 224)
- Reserves (SFC inputs/outputs) (Page 224)
12.2 Standard interface of the SFC type

12.2.1 Standard Interface of the SFC Type

Standard interface of the SFC type

The standard interface of the SFC type includes the necessary inputs/outputs for the user program for controlling the SFC instances via the user program or for operator control and monitoring of the SFC instances.

Additional information

You can find additional information about the inputs/outputs in the following sections:

- Inputs/outputs of the SFC type standard interface (Page 172)
- Inputs/Outputs of the SFC Type Sorted According to Usage (Page 178)
- "Characteristics" Interface Parameter Assignments (Page 179)
- "Characteristics" Interface Expansions (Page 181)
- Changing the Control Strategy and Setpoints for an SFC Instance (Page 275)
- "Inputs/Outputs" Interface Expansions (Page 178)
### 12.2.2 Inputs/outputs of the SFC type standard interface

**SFC type: Inputs/outputs of the standard interface**

The following table lists the inputs/outputs of the standard interface of the SFC type in alphabetical order.

You will find explanations of the table entries in the section: Meanings in the table (Page 169)

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Preset</th>
<th>Type</th>
<th>O&amp;M</th>
</tr>
</thead>
<tbody>
<tr>
<td>ABORT</td>
<td>Automatic command &quot;Abort&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>ABORTED</td>
<td>Operating state &quot;Aborted&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>ABORTING</td>
<td>Operating state &quot;Aborting&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>AUT</td>
<td>Change to AUTO (process mode)</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>AUX_PR04..10</td>
<td>Associated value 4..10</td>
<td>ANY</td>
<td>0</td>
<td>IO</td>
<td></td>
</tr>
<tr>
<td>BA_ADDSTATE</td>
<td>BATCH: Additional status word</td>
<td>DWORD</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>BA_CONTROL</td>
<td>BATCH control word (internal interface)</td>
<td>DWORD</td>
<td>0</td>
<td>IO</td>
<td>+</td>
</tr>
<tr>
<td>BA_EN</td>
<td>BATCH: Enable</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td>+</td>
</tr>
<tr>
<td>BA_ID</td>
<td>BATCH: Consecutive batch number</td>
<td>DWORD</td>
<td>0</td>
<td>I</td>
<td>+</td>
</tr>
<tr>
<td>BA_NA</td>
<td>BATCH: Batch name</td>
<td>STRING</td>
<td>' '</td>
<td>I</td>
<td>+</td>
</tr>
<tr>
<td>BA_STATE</td>
<td>BATCH status word</td>
<td>DWORD</td>
<td>0</td>
<td>O</td>
<td>+</td>
</tr>
<tr>
<td>BUSY</td>
<td>Status &quot;Busy&quot; (= neither &quot;Idle&quot; nor &quot;Completed&quot; nor &quot;Aborted&quot; nor &quot;Stopped&quot;)</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>COMPLETE</td>
<td>Automatic command &quot;Complete&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>COMPLETED</td>
<td>Operating state &quot;Completed&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>COMPLETING</td>
<td>Operating state &quot;Completing&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>CONT</td>
<td>Continuous mode</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>CONT_T</td>
<td>Max. run time for &quot;Continuous mode&quot; [s]</td>
<td>DINT</td>
<td>0</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>CPU_RESTART</td>
<td>Restart of the CPU</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>CS</td>
<td>AUTO: Prepared control strategy (apply at next &quot;Start&quot;)</td>
<td>INT</td>
<td>0</td>
<td>I</td>
<td>+</td>
</tr>
<tr>
<td>CS_HL</td>
<td>Control strategy &quot;high limit&quot;</td>
<td>INT</td>
<td>0 1)</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>CS_LL</td>
<td>Control strategy &quot;low limit&quot;</td>
<td>INT</td>
<td>0 1)</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>CSP_DEFAULT</td>
<td>Initial value of the prepared control strategy</td>
<td>INT</td>
<td>0</td>
<td>I</td>
<td>+</td>
</tr>
<tr>
<td>CSP_OP</td>
<td>MANUAL: Prepared control strategy by operator (apply at next &quot;Start&quot;)</td>
<td>INT</td>
<td>0</td>
<td>IO</td>
<td>+</td>
</tr>
<tr>
<td>CSSPACCEPT</td>
<td>Control strategy+ setpoints applied (1 cycle long)</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>CUSEQ</td>
<td>No. of current sequencer</td>
<td>BYTE</td>
<td>0</td>
<td>O</td>
<td>+</td>
</tr>
<tr>
<td>CUSTEP</td>
<td>No. of current step</td>
<td>WORD</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>CUSTEPACTSTATE</td>
<td>Active state of current step</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>CUSTEPCOUNT</td>
<td>Number of active steps</td>
<td>BYTE</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
</tbody>
</table>
### Standard interface and chart I/Os

#### 12.2 Standard interface of the SFC type

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Preset</th>
<th>Type</th>
<th>O&amp;M</th>
</tr>
</thead>
<tbody>
<tr>
<td>CUSTEPERRSTATE</td>
<td>Error state of current step</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>CUSTEPHELDSTATE</td>
<td>Held state of current step</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>CUSTEPMAXRT</td>
<td>Max. run time of the current step</td>
<td>TIME</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>CUSTEPMINRT</td>
<td>Min. run time of the current step</td>
<td>TIME</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>CUSTEPRRT</td>
<td>Run time of the current step</td>
<td>TIME</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>CUTCOUNT</td>
<td>Number of the current transition</td>
<td>WORD</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>CUTCOUNT</td>
<td>Number of active transitions</td>
<td>BYTE</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>CUTCOUNTRESULT</td>
<td>Result of first active transition</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>CYCLEEXEC</td>
<td>Cyclic Operation (only in AUTO)</td>
<td>BOOL</td>
<td>0 2) I</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>DIS_START_STATE</td>
<td>Reason for start disturbance</td>
<td>DWORD</td>
<td>0</td>
<td>O</td>
<td>+</td>
</tr>
<tr>
<td>ENABORT</td>
<td>Enable &quot;Abort&quot;</td>
<td>BOOL</td>
<td>1</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>ENASTART</td>
<td>Enable &quot;Start in Run&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>ENAUT</td>
<td>Enable &quot;Change to AUTO&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>ENCOMPLETE</td>
<td>Enable &quot;Complete&quot;</td>
<td>BOOL</td>
<td>1</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>ENCSM</td>
<td>Enable for &quot;prepare control strategy&quot;</td>
<td>BOOL</td>
<td>1</td>
<td>I</td>
<td>+</td>
</tr>
<tr>
<td>ENFORCEMAN</td>
<td>Enable change to MANUAL if ENMAN = 0</td>
<td>BOOL</td>
<td>1</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>ENHOLD</td>
<td>Enable &quot;Hold&quot;</td>
<td>BOOL</td>
<td>1</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>ENMAN</td>
<td>Enable &quot;Change to MANUAL&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>ENRESERVED</td>
<td>Enable &quot;Reset&quot;</td>
<td>BOOL</td>
<td>1</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>ENRESUME</td>
<td>Enable &quot;Resume&quot;</td>
<td>BOOL</td>
<td>1</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>ENSTART</td>
<td>Enable &quot;Start&quot;</td>
<td>BOOL</td>
<td>1</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>ENSTOP</td>
<td>Enable &quot;Stop&quot;</td>
<td>BOOL</td>
<td>1</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>ENTARGETSTEP</td>
<td>Enable &quot;Set target steps&quot;</td>
<td>BOOL</td>
<td>1</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>ERRG</td>
<td>Group error</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>ERROR</td>
<td>Operating state &quot;Error&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>ERROR_COMPLETING</td>
<td>Operating state &quot;Error (Completing)&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>EXEC_ERR</td>
<td>Runtime error, e.g., step error, CPU restart</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>EXT_ERR</td>
<td>External error</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>HELD</td>
<td>Operating state &quot;Held&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>HELD_ERROR</td>
<td>Operating state &quot;Held (Error)&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>HELDSEQ</td>
<td>No. of held sequencer</td>
<td>BYTE</td>
<td>0</td>
<td>O</td>
<td>+</td>
</tr>
<tr>
<td>HELDSTEP</td>
<td>No. of held step</td>
<td>WORD</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>HELDSTEPCOUNT</td>
<td>Number of held steps</td>
<td>BYTE</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>HELDSTEPERRSTATE</td>
<td>Error status of held step</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>HELDSTEPHELDSTATE</td>
<td>State of the held step</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>HELDSTEPRT</td>
<td>Run time of held step</td>
<td>TIME</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>HELDTRANS</td>
<td>No. of held transition</td>
<td>WORD</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>HELDTRANSRESULT</td>
<td>Number of held transitions</td>
<td>BYTE</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>HELDTRANSRESULT</td>
<td>Result of first held transition</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>I/O</td>
<td>Meaning</td>
<td>Data type</td>
<td>Preset</td>
<td>Type</td>
<td>O&amp;M</td>
</tr>
<tr>
<td>--------------</td>
<td>---------------------------------------------------</td>
<td>-----------</td>
<td>--------</td>
<td>------</td>
<td>-----</td>
</tr>
<tr>
<td>HOLD</td>
<td>Automatic command &quot;Hold&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>HOLDING</td>
<td>Operating state &quot;Holding&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>IDLE</td>
<td>Operating state &quot;Idle&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>INSTRROUT</td>
<td>Command Output (only in AUTO)</td>
<td>BOOL</td>
<td>1</td>
<td>3)</td>
<td>I</td>
</tr>
<tr>
<td>INTABORT</td>
<td>Internal command &quot;Abort&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
<td></td>
</tr>
<tr>
<td>INTCOMPLETE</td>
<td>Internal command &quot;Complete&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
<td></td>
</tr>
<tr>
<td>INTERERROR</td>
<td>Internal command &quot;Error&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
<td></td>
</tr>
<tr>
<td>INTHOLD</td>
<td>Internal command &quot;Hold&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
<td></td>
</tr>
<tr>
<td>INTRESET</td>
<td>Internal command &quot;Reset&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
<td></td>
</tr>
<tr>
<td>INTRESTART</td>
<td>Internal command &quot;Restart&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
<td></td>
</tr>
<tr>
<td>INTRESUME</td>
<td>Internal command &quot;Resume&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
<td></td>
</tr>
<tr>
<td>INTSTART</td>
<td>Internal command &quot;Start&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
<td></td>
</tr>
<tr>
<td>INTSTOP</td>
<td>Internal command &quot;Stop&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
<td></td>
</tr>
<tr>
<td>IORES_BY</td>
<td>Reserved for internal use</td>
<td>BYTE</td>
<td>0</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>IORES0..7</td>
<td>Reserved for internal use</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
<td></td>
</tr>
<tr>
<td>IRES1..3</td>
<td>Reserved for internal use</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>LASTSEQ</td>
<td>No. of last active sequencer</td>
<td>WORD</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>LASTSTEP</td>
<td>No. of last active step</td>
<td>WORD</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>LI_ERR</td>
<td>Parameter assignment error (e.g. invalid combination at inputs)</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>LI_ERR_STATE</td>
<td>Status word for parameter error</td>
<td>DWORD</td>
<td>0</td>
<td>O</td>
<td>+</td>
</tr>
<tr>
<td>LOCKABORT</td>
<td>External interlock &quot;Abort&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>LOCKCOMPLETE</td>
<td>External interlock &quot;Complete&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>LOCKERROR</td>
<td>External interlock &quot;Error&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>LOCKHOLD</td>
<td>External interlock &quot;Hold&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>LOCKSTOP</td>
<td>External interlock &quot;Stop&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>MAN</td>
<td>Change to MANUAL (operator control mode)</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>MODE</td>
<td>Edit mode:</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>MSG_ACK</td>
<td>Acknowledge messages (ALARM_8P)</td>
<td>WORD</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>MSG_ERR</td>
<td>Message error (ALARM_8P)</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>MSG_EVID</td>
<td>Message number (ALARM_8P)</td>
<td>DWORD</td>
<td>0</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>MSG_LOCK</td>
<td>Lock messages:</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td>+</td>
</tr>
<tr>
<td>MSG_STAT</td>
<td>Message status (ALARM_8P)</td>
<td>WORD</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>MSG_SUP</td>
<td>Message suppression (ALARM_8P)</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td>+</td>
</tr>
<tr>
<td>NMSG_EVID1</td>
<td>Message number 1 (NOTIFY_8P)</td>
<td>DWORD</td>
<td>0</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>NMSG_EVID2</td>
<td>Message number 2 (NOTIFY_8P)</td>
<td>DWORD</td>
<td>0</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>NMSG_STAT1</td>
<td>Message status 1 (NOTIFY_8P)</td>
<td>WORD</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>NMSG_STAT2</td>
<td>Message status 2 (NOTIFY_8P)</td>
<td>WORD</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
</tbody>
</table>
## 12.2 Standard interface of the SFC type

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Preset</th>
<th>Type</th>
<th>O&amp;M</th>
</tr>
</thead>
<tbody>
<tr>
<td>NSIG_12..16</td>
<td>Generate event message 12..16 (NOTIFY_8P)</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
<td></td>
</tr>
<tr>
<td>OCCUPIED</td>
<td>BATCH: &quot;Occupied&quot; identifier</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
<td>+</td>
</tr>
<tr>
<td>OP_ERR</td>
<td>Operator error</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>OP_ERR_STATE</td>
<td>Status word for operator error</td>
<td>DWORD</td>
<td>0</td>
<td>O</td>
<td>+</td>
</tr>
<tr>
<td>OPTIPNO</td>
<td>Information number for operator</td>
<td>INT</td>
<td>0</td>
<td>O</td>
<td>+</td>
</tr>
<tr>
<td>ORES_BY1..3</td>
<td>Reserved for internal use</td>
<td>BYTE</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>ORES1..24</td>
<td>Reserved for internal use</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>PARAM</td>
<td>Check control strategy + setpoints</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>POSINO</td>
<td>Position text number</td>
<td>INT</td>
<td>0</td>
<td>O</td>
<td>+</td>
</tr>
<tr>
<td>QAUTMAN</td>
<td>Current operating mode: 0: MANUAL, 1: AUTO</td>
<td>BOOL</td>
<td>0 5)</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>QBA_EN</td>
<td>BATCH: Enable</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>QBA_ID</td>
<td>BATCH: Consecutive batch number</td>
<td>DWORD</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>QBA_TA</td>
<td>BATCH: Batch name</td>
<td>STRING[32]</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>QCONT</td>
<td>&quot;Continuous mode&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>QCONT_T</td>
<td>Current run time for &quot;Continuous mode&quot; [s]</td>
<td>DINT</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>QCONT_T.ERR</td>
<td>Max. run time for &quot;Continuous mode&quot; exceeded</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>QCS</td>
<td>Current control strategy</td>
<td>INT</td>
<td>0</td>
<td>O</td>
<td>+</td>
</tr>
<tr>
<td>QCS_0</td>
<td>1: No control strategy</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>QCS_1..32</td>
<td>1: Current control strategy 1 - 32</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>QCSP</td>
<td>Prepared control strategy</td>
<td>INT</td>
<td>0</td>
<td>O</td>
<td>+</td>
</tr>
<tr>
<td>QDIS_START</td>
<td>&quot;Start&quot; not possible (e.g., faulty control strategy and/or setpoints, LI_ERR, OP_ERR, etc.)</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>QENAUT</td>
<td>Enable &quot;Change to AUTO&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>QENMAN</td>
<td>Enable &quot;Change to MANUAL&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>QEXT_ERR</td>
<td>External error</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>QFORCEMAN</td>
<td>Change to MANUAL without enable (= force manual, 1 cycle long)</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>QOCCUPIED</td>
<td>BATCH: &quot;Occupied&quot; identifier</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>QPARAM</td>
<td>Control strategy + setpoints were checked and are ok</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>QREFRESH</td>
<td>BATCH: Read in setpoints/process values again</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>QSCC</td>
<td>Step enabling with operator confirmation</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>QST</td>
<td>Step enabling with transition</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>QST_TAC</td>
<td>Step enabling with transition and step-specific operator confirmation</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>QSTAC</td>
<td>Step enabling with transition and operator confirmation</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>QSTEP_NO</td>
<td>BATCH: Step number</td>
<td>DWORD</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>QSTEP_T</td>
<td>BATCH: Current step run time [s]</td>
<td>DINT</td>
<td>0</td>
<td>O</td>
<td>+</td>
</tr>
</tbody>
</table>
### Standard Interface and Chart I/Os

**12.2 Standard Interface of the SFC Type**

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Pre set</th>
<th>Typ e</th>
<th>O&amp;M</th>
</tr>
</thead>
<tbody>
<tr>
<td>QTAKESP</td>
<td>Adopt setpoints immediately</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>READY_TC</td>
<td>&quot;Ready to complete&quot; state</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>REFRESH</td>
<td>BATCH: Read in setpoints/process values again</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
<td></td>
</tr>
<tr>
<td>RESET</td>
<td>Automatic command &quot;Reset&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>RESTART</td>
<td>Automatic command &quot;Restart&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>RESU_ERROR</td>
<td>Operating state &quot;Resuming (Error)&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>RESUME</td>
<td>Automatic command &quot;Resume&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>RESUMING</td>
<td>Operating state &quot;Resuming&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>RUN</td>
<td>Operating state &quot;Run&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>RUNCOUNT</td>
<td>Number of runs in &quot;cyclic operation&quot;</td>
<td>INT</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>RUNHOLD</td>
<td>Response of the RUN Sequencer to the &quot;Hold&quot; 0: Hold sequencer, 1: Abort sequencer</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>RUNUPCYC</td>
<td>Number of run-up cycles</td>
<td>INT</td>
<td>3</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>S_ERRCA</td>
<td>Confirm all step errors (only in AUTO)</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>S_ERRG</td>
<td>Group display &quot;Step error&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>SCT</td>
<td>Step enabling with transition (only in AUTO)</td>
<td>BOOL</td>
<td>1</td>
<td>6)</td>
<td>I</td>
</tr>
<tr>
<td>SCT_TAC</td>
<td>Step enabling with transition or step-specific operator confirmation (only in AUTO)</td>
<td>BOOL</td>
<td>0</td>
<td>6)</td>
<td>I</td>
</tr>
<tr>
<td>SELCS</td>
<td>Enable control strategies: Bit 0..31: Control strategy 1..32</td>
<td>DWORD</td>
<td>0 1 7)</td>
<td>I +</td>
<td></td>
</tr>
<tr>
<td>SELFCOMP</td>
<td>SFC changes automatically from &quot;Run&quot; to &quot;Completing&quot;</td>
<td>BOOL</td>
<td>1</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>SELFRESET</td>
<td>SFC changes automatically from &quot;Completed/Aborted/Stopped&quot; to &quot;Idle&quot; (only in MANUAL)</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>SFC_ADDSTATE</td>
<td>Additional SFC status word</td>
<td>DWORD</td>
<td>0</td>
<td>O</td>
<td>+</td>
</tr>
<tr>
<td>SFC_CONTROL</td>
<td>SFC control word (internal interface)</td>
<td>DWORD</td>
<td>0</td>
<td>IO</td>
<td>+</td>
</tr>
<tr>
<td>SFC_INIT</td>
<td>Initialize SFC</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
<td></td>
</tr>
<tr>
<td>SFC_STATE</td>
<td>SFC status word</td>
<td>DWORD</td>
<td>0</td>
<td>O</td>
<td>+</td>
</tr>
<tr>
<td>SIG_2..8</td>
<td>Generate message 2..8 (ALARM_8P)</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
<td></td>
</tr>
<tr>
<td>START</td>
<td>Automatic command &quot;Start&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>STARTING</td>
<td>Operating state &quot;Starting&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>STEP_NO</td>
<td>BATCH: Step number</td>
<td>DWORD</td>
<td>0</td>
<td>I</td>
<td>+</td>
</tr>
<tr>
<td>STEP_T</td>
<td>BATCH: Max. step run time [s]</td>
<td>DINT</td>
<td>0</td>
<td>I</td>
<td>+</td>
</tr>
<tr>
<td>STOP</td>
<td>Automatic command &quot;Stop&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>STOPPED</td>
<td>Operating state &quot;Stopped&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>STOPPING</td>
<td>Operating state &quot;Stopping&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>T_OPRQCA</td>
<td>Confirmation of all operator prompts (only in AUTO)</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>T_OPRQG</td>
<td>Group display &quot;Operator prompt at transition&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>TAKESP</td>
<td>Adopt setpoints immediately</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>TARGETSEQ</td>
<td>Sequencer number for &quot;Set target step&quot;</td>
<td>BYTE</td>
<td>0</td>
<td>IO</td>
<td></td>
</tr>
</tbody>
</table>
### 12.2 Standard interface of the SFC type

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Preset</th>
<th>Typ</th>
<th>O&amp;M</th>
</tr>
</thead>
<tbody>
<tr>
<td>TARGETSTEP</td>
<td>Step number for “Set target step”</td>
<td>WORD</td>
<td>0</td>
<td>IO</td>
<td></td>
</tr>
<tr>
<td>TIMEMON</td>
<td>Time Monitoring (only in AUTO)</td>
<td>BOOL</td>
<td>0 4)</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>TRIG_CPU_RESTART</td>
<td>Start trigger for sequencer after CPU restart</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>USTATUS</td>
<td>Status word in VSTATUS (can be set as required by user)</td>
<td>WORD</td>
<td>0</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>VSTATUS</td>
<td>Status word</td>
<td>DWORD</td>
<td>0</td>
<td>O</td>
<td>+</td>
</tr>
</tbody>
</table>

**Key**

1) Depends on the number of control strategies in the characteristics editor
2) Depends on “SFC properties/operating parameters AS/Cyclic Operation”
3) Depends on “SFC properties/operating parameters AS/Command Output”
4) Depends on “SFC properties/operating parameters AS/time monitoring”
5) Depends on “SFC properties/operating parameters AS/operating mode”
6) Depends on “SFC properties/operating parameters AS/step control mode”
7) Depends on “SFC properties/options/control strategy selection”
12.2.3 Inputs/Outputs of the SFC Type Sorted According to Usage

The inputs/outputs of the standard interface for the SFC type are sorted according to their use and summarized in the following sections:

- Operating modes (SFC inputs/outputs) (Page 198)
- Commands and operating states (SFC inputs/outputs) (Page 200)
- Execution options (SFC inputs/outputs) (Page 208)
- Group displays and group acknowledgements (SFC inputs/outputs) (Page 210)
- Data from sequencers and steps to be processed (SFC inputs/outputs) (Page 210)
- BATCH parameters (SFC inputs/outputs) (Page 212)
- Continuous mode (SFC inputs/outputs) (Page 213)
- Error handling (SFC inputs/outputs) (Page 213)
- Messages (SFC inputs/outputs) (Page 217)
- Control words (SFC inputs/outputs) (Page 218)
- Status words (SFC inputs/outputs) (Page 219)
- System parameters (SFC inputs/outputs) (Page 224)
- Reserves (SFC inputs/outputs) (Page 224)

12.2.4 "Inputs/Outputs" Interface Expansions

Valid inputs/outputs

The "Inputs/Outputs" interface editor is available for interface expansions. The following data types are permitted for the inputs/outputs in the IN, OUT and IN_OUT sections:

**INPUT** (IN section):
- BOOL, BYTE, CHAR, WORD, DWORD, INT, DINT, REAL, S5TIME, TIME, DATE, TIME_OF_DAY, STRING

**OUTPUT** (OUT section):
- BOOL, BYTE, CHAR, WORD, DWORD, INT, DINT, REAL, S5TIME, TIME, DATE, TIME_OF_DAY, STRING

**IN_OUT** (IN_OUT section):
- BOOL, BYTE, CHAR, WORD, DWORD, INT, DINT, REAL, S5TIME, TIME, DATE, TIME_OF_DAY, STRING
12.2.5 "Characteristics" interface parameter assignments

12.2.5.1 "Characteristics" Interface Parameter Assignments

"Characteristics" interface parameter assignments

Characteristics are only relevant for the SFC type.

The inputs/outputs of the following characteristics are contained in the standard interface:

- Characteristic: "Control strategies" (Page 179)
- Characteristic for note texts (Page 180)
- Characteristic for position texts (Page 180)

12.2.5.2 Characteristic: "Control strategies"

"Control strategies" characteristic

You will find explanations of the table entries in the section: Meanings in the table (Page 169)

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
<th>O&amp;M</th>
</tr>
</thead>
<tbody>
<tr>
<td>CS</td>
<td>AUTO: Prepared control strategy (apply at next &quot;Start&quot;)</td>
<td>INT</td>
<td>0</td>
<td>I</td>
<td>+</td>
</tr>
<tr>
<td>CS_LL</td>
<td>Control strategy &quot;low limit&quot;</td>
<td>INT</td>
<td>0 1)</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>CS_HL</td>
<td>Control strategy &quot;high limit&quot;</td>
<td>INT</td>
<td>0 1)</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>CSP_DEFAULT</td>
<td>Initial value of the prepared control strategy</td>
<td>INT</td>
<td>0</td>
<td>I</td>
<td>+</td>
</tr>
<tr>
<td>CSP_OP</td>
<td>MANUAL: Prepared control strategy by operator (apply at next &quot;Start&quot;)</td>
<td>INT</td>
<td>0</td>
<td>IO</td>
<td>+</td>
</tr>
<tr>
<td>CSSPACCEPT</td>
<td>Control strategy and setpoints applied (1 cycle long)</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>ENCS</td>
<td>Enable for &quot;prepared control strategy&quot;</td>
<td>BOOL</td>
<td>1</td>
<td>I</td>
<td>+</td>
</tr>
<tr>
<td>QCS</td>
<td>Current control strategy</td>
<td>INT</td>
<td>0</td>
<td>O</td>
<td>+</td>
</tr>
<tr>
<td>QCS_0</td>
<td>1: No control strategy</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>QCS_1...32</td>
<td>1: Current control strategy 1 - 32</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>QCSP</td>
<td>Prepared control strategy</td>
<td>INT</td>
<td>0</td>
<td>O</td>
<td>+</td>
</tr>
<tr>
<td>SELCS</td>
<td>Enable control strategies: Bit 0..31: Control strategy 1..32</td>
<td>DWORD</td>
<td>0 1) 2)</td>
<td>I</td>
<td>+</td>
</tr>
</tbody>
</table>

SFC for SIMATIC S7
Programming and Operating Manual, 12/2011, A5E03710074-01 179
12.2 Standard interface of the SFC type

12.2.5.3 Characteristic for note texts

Characteristic for note texts

Using the assignment of a note text number in a step action, the corresponding note text is displayed in the SFC faceplate.

You will find explanations of the table entries in the section: Meanings in the table (Page 169)

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
<th>O&amp;M</th>
</tr>
</thead>
<tbody>
<tr>
<td>OPTIPNO</td>
<td>Note text number for operator</td>
<td>INT</td>
<td>0</td>
<td>O</td>
<td>+</td>
</tr>
</tbody>
</table>

You will find more detailed information in the section: Changing the Control Strategy and Setpoints for an SFC Instance (Page 275)

12.2.5.4 Characteristic for position texts

Characteristic for position texts

When a position text number is assigned in a step action, the corresponding position text is displayed in the SFC faceplate.

You will find explanations of the table entries in the section: Meanings in the table (Page 169)

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
<th>O&amp;M</th>
</tr>
</thead>
<tbody>
<tr>
<td>POSINO</td>
<td>Position text number</td>
<td>INT</td>
<td>0</td>
<td>O</td>
<td>+</td>
</tr>
</tbody>
</table>

You will find more detailed information in the section: How to configure note texts and position texts (Page 101)
12.2.6 "Characteristics" interface expansions

12.2.6.1 "Characteristics" Interface Expansions

"Characteristics" interface expansion

Characteristics are only relevant for the SFC type.

The inputs/outputs for the following characteristics are not included in the standard interface but can be configured as needed:

- "Setpoints" characteristic (Page 182)
- "Process values" characteristic (Page 195)
- "Control values" characteristic (Page 195)
- "Parameters" characteristic (Page 195)
- "Bit Memory" Characteristic (Page 196)
- "Timers" characteristic (Page 196)
- "Block contacts" characteristic (Page 197)

Note

In the following tables of characteristics, "name" stands for "I/O name". It is not the name of a characteristic.
"Setpoints" characteristic

For detailed information about the inputs/outputs for setpoints, refer to the section:
Meaning and usage of setpoints (Page 191)

You will find explanations of the table entries in the section:
Meanings in the table (Page 169)

"BOOL" data type

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
<th>O&amp;M</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;name&quot;</td>
<td>Setpoint automatic input</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_AI</td>
<td>Process value input</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_AO</td>
<td>Process value output</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_CS</td>
<td>Enable control strategies: Bit 0..31 = control strategy 1..32</td>
<td>DWORD</td>
<td>0 1) 2)</td>
<td>IO</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_EN0OP</td>
<td>Enable operator control of setpoint on &quot;0&quot;</td>
<td>BOOL</td>
<td>1</td>
<td>IO</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_EN1OP</td>
<td>Enable operator control of setpoint on &quot;1&quot;</td>
<td>BOOL</td>
<td>1</td>
<td>IO</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_EN0OPP</td>
<td>Enable operator control of prepared setpoint on &quot;0&quot;</td>
<td>BOOL</td>
<td>1</td>
<td>IO</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_EN1OPP</td>
<td>Enable operator control of prepared setpoint on &quot;1&quot;</td>
<td>BOOL</td>
<td>1</td>
<td>IO</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_ERR</td>
<td>Setpoint error</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>&quot;name&quot;_OP</td>
<td>Setpoint operator input</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_OPP</td>
<td>Prepared setpoint operator input</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_Q</td>
<td>Setpoint output</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_QP</td>
<td>Prepared setpoint output</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td>+</td>
</tr>
</tbody>
</table>

Key

1) Depends on the number of control strategies in the characteristics editor
2) Depends on "<Setpoint>/Properties/Control strategy assignment"
"INT" data type

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
<th>O&amp;M</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;name&quot;</td>
<td>Setpoint automatic input</td>
<td>INT</td>
<td>0</td>
<td>I</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_AI</td>
<td>Process value input</td>
<td>INT</td>
<td>0</td>
<td>I</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_AO</td>
<td>Process value output</td>
<td>INT</td>
<td>0</td>
<td>O</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_CS</td>
<td>Enable control strategies:</td>
<td>DWORD</td>
<td>0</td>
<td>1)</td>
<td>2)</td>
</tr>
<tr>
<td></td>
<td>Bit 0..31 = control strategy 1..32</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>&quot;name&quot;_ENOP</td>
<td>Enable operator control of setpoint</td>
<td>BOOL</td>
<td>1</td>
<td>IO</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_ENOPP</td>
<td>Enable operator control of prepared setpoint</td>
<td>BOOL</td>
<td>1</td>
<td>IO</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_ERR</td>
<td>Setpoint error</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>&quot;name&quot;_HL</td>
<td>Low limit setpoint</td>
<td>INT</td>
<td>0</td>
<td>I</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_OP</td>
<td>High limit setpoint</td>
<td>INT</td>
<td>100</td>
<td>I</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_OPP</td>
<td>Setpoint operator input</td>
<td>INT</td>
<td>0</td>
<td>IO</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_Q</td>
<td>Prepared setpoint output</td>
<td>INT</td>
<td>0</td>
<td>O</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_QP</td>
<td>Prepared setpoint output</td>
<td>INT</td>
<td>0</td>
<td>O</td>
<td>+</td>
</tr>
</tbody>
</table>

Key

1) Depends on the number of control strategies in the characteristics editor
2) Depends on "<Setpoint>/Properties/Control strategy assignment"
## "DINT", "SOURCE", "DEST" and "VIA" data types

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
<th>O&amp;M</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;name&quot;</td>
<td>Setpoint automatic input</td>
<td>DINT</td>
<td>0</td>
<td>I</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_AI</td>
<td>Process value input</td>
<td>DINT</td>
<td>0</td>
<td>I</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_AO</td>
<td>Process value output</td>
<td>DINT</td>
<td>0</td>
<td>O</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_CS</td>
<td>Enable control strategies: Bit 0..31 = control strategy 1..32</td>
<td>DWORD</td>
<td>0 1 2)</td>
<td>IO</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_ENOP</td>
<td>Enable operator control of setpoint</td>
<td>BOOL</td>
<td>1</td>
<td>IO</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_ENOPP</td>
<td>Enable operator control of prepared setpoint</td>
<td>BOOL</td>
<td>1</td>
<td>IO</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_ERR</td>
<td>Setpoint error</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>&quot;name&quot;_HL</td>
<td>High limit setpoint</td>
<td>DINT</td>
<td>DINT: 100, SOURCE, DEST, VIA: 2147483647</td>
<td>I</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_LL</td>
<td>Low limit setpoint</td>
<td>DINT</td>
<td>0</td>
<td>I</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_OP</td>
<td>Setpoint operator input</td>
<td>DINT</td>
<td>0</td>
<td>IO</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_OPP</td>
<td>Prepared setpoint operator input</td>
<td>DINT</td>
<td>0</td>
<td>IO</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_Q</td>
<td>Setpoint output</td>
<td>DINT</td>
<td>0</td>
<td>O</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_QP</td>
<td>Prepared setpoint output</td>
<td>DINT</td>
<td>0</td>
<td>O</td>
<td>+</td>
</tr>
</tbody>
</table>

### Key

1. Depends on the number of control strategies in the characteristics editor
2. Depends on "<Setpoint>/Properties/Control strategy assignment"
### "REAL" data type

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
<th>O&amp;M</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>name</em></td>
<td>Setpoint automatic input</td>
<td>REAL</td>
<td>0.0</td>
<td>I</td>
<td>+</td>
</tr>
<tr>
<td><em>name</em>_AI</td>
<td>Process value input</td>
<td>REAL</td>
<td>0.0</td>
<td>I</td>
<td>+</td>
</tr>
<tr>
<td><em>name</em>_AO</td>
<td>Process value output</td>
<td>REAL</td>
<td>0.0</td>
<td>O</td>
<td>+</td>
</tr>
<tr>
<td><em>name</em>_CS</td>
<td>Enable control strategies:</td>
<td>DWORD</td>
<td>0</td>
<td>1)</td>
<td>2)</td>
</tr>
<tr>
<td></td>
<td>Bit 0..31 = control strategy 1..32</td>
<td></td>
<td></td>
<td>IO</td>
<td>+</td>
</tr>
<tr>
<td><em>name</em>_ENOP</td>
<td>Enable operator control of setpoint</td>
<td>BOOL</td>
<td>1</td>
<td>IO</td>
<td>+</td>
</tr>
<tr>
<td><em>name</em>_ENOPP</td>
<td>Enable operator control of prepared</td>
<td>BOOL</td>
<td>1</td>
<td>IO</td>
<td>+</td>
</tr>
<tr>
<td></td>
<td>setpoint</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><em>name</em>_ERR</td>
<td>Setpoint error</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td><em>name</em>_HL</td>
<td>High limit setpoint</td>
<td>REAL</td>
<td>100.0</td>
<td>I</td>
<td>+</td>
</tr>
<tr>
<td><em>name</em>_LL</td>
<td>Low limit setpoint</td>
<td>REAL</td>
<td>0.0</td>
<td>I</td>
<td>+</td>
</tr>
<tr>
<td><em>name</em>_OP</td>
<td>Setpoint operator input</td>
<td>REAL</td>
<td>0.0</td>
<td>IO</td>
<td>+</td>
</tr>
<tr>
<td><em>name</em>_OPP</td>
<td>Prepared setpoint operator input</td>
<td>REAL</td>
<td>0.0</td>
<td>IO</td>
<td>+</td>
</tr>
<tr>
<td><em>name</em>_Q</td>
<td>Setpoint output</td>
<td>REAL</td>
<td>0.0</td>
<td>O</td>
<td>+</td>
</tr>
<tr>
<td><em>name</em>_QP</td>
<td>Prepared setpoint output</td>
<td>REAL</td>
<td>0.0</td>
<td>O</td>
<td>+</td>
</tr>
</tbody>
</table>

**Key**

1) Depends on the number of control strategies in the characteristics editor

2) Depends on "<Setpoint>/Properties/Control strategy assignment"
### "STRING" data type

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
<th>O&amp;M</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;name&quot;</td>
<td>Setpoint automatic input</td>
<td>STRING</td>
<td>&quot;&quot;</td>
<td>I</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_AI</td>
<td>Process value input</td>
<td>STRING</td>
<td>&quot;&quot;</td>
<td>I</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_AO</td>
<td>Process value output</td>
<td>STRING</td>
<td>&quot;&quot;</td>
<td>O</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_CS</td>
<td>Enable control strategies: Bit 0..31 = control strategy 1..32</td>
<td>DWORD</td>
<td>0 1)</td>
<td>IO</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_ENOP</td>
<td>Enable operator control of setpoint</td>
<td>BOOL</td>
<td>1</td>
<td>O</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_ENOPP</td>
<td>Enable operator control of prepared setpoint</td>
<td>BOOL</td>
<td>1</td>
<td>O</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_ERR</td>
<td>Setpoint error</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>&quot;name&quot;_OP</td>
<td>Setpoint operator input</td>
<td>STRING</td>
<td>&quot;&quot;</td>
<td>O</td>
<td>*)</td>
</tr>
<tr>
<td>&quot;name&quot;_OPP</td>
<td>Prepared setpoint operator input</td>
<td>STRING</td>
<td>&quot;&quot;</td>
<td>O</td>
<td>*)</td>
</tr>
<tr>
<td>&quot;name&quot;_Q</td>
<td>Setpoint output</td>
<td>STRING</td>
<td>&quot;&quot;</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>&quot;name&quot;_QP</td>
<td>Prepared setpoint output</td>
<td>STRING</td>
<td>&quot;&quot;</td>
<td>O</td>
<td></td>
</tr>
</tbody>
</table>

**Key**

1) Depends on the number of control strategies in the characteristics editor
2) Depends on "<Setpoint>/Properties/Control strategy assignment"

*) The parameters are implemented as outputs because no IN_OUT parameters are permitted with the "STRING" data type!
"PI" data type (process input = parameter for input materials)

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
<th>O&amp;M</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>name</em></td>
<td>Setpoint automatic input</td>
<td>REAL</td>
<td>0.0</td>
<td>I</td>
<td>+</td>
</tr>
<tr>
<td><em>name</em>_AI</td>
<td>Process value input</td>
<td>REAL</td>
<td>0.0</td>
<td>I</td>
<td>+</td>
</tr>
<tr>
<td><em>name</em>_AO</td>
<td>Process value output</td>
<td>REAL</td>
<td>0.0</td>
<td>O</td>
<td>+</td>
</tr>
<tr>
<td><em>name</em> B</td>
<td>Setpoint tracking ID</td>
<td>DINT</td>
<td>0</td>
<td>I</td>
<td>+</td>
</tr>
<tr>
<td><em>name</em>_BAI</td>
<td>BATCH process value input</td>
<td>DINT</td>
<td>0</td>
<td>I</td>
<td>+</td>
</tr>
<tr>
<td><em>name</em>_BAO</td>
<td>BATCH process value output</td>
<td>DINT</td>
<td>0</td>
<td>O</td>
<td>+</td>
</tr>
<tr>
<td><em>name</em>_BOP</td>
<td>BATCH operator input</td>
<td>DINT</td>
<td>0</td>
<td>IO</td>
<td>+</td>
</tr>
<tr>
<td><em>name</em>_BOPP</td>
<td>Prepared BATCH operator input</td>
<td>DINT</td>
<td>0</td>
<td>IO</td>
<td>+</td>
</tr>
<tr>
<td><em>name</em>_BQ</td>
<td>BATCH setpoint</td>
<td>DINT</td>
<td>0</td>
<td>O</td>
<td>+</td>
</tr>
<tr>
<td><em>name</em>_BQP</td>
<td>Prepared BATCH setpoint</td>
<td>DINT</td>
<td>0</td>
<td>O</td>
<td>+</td>
</tr>
<tr>
<td><em>name</em>_CS</td>
<td>Enable control strategies: Bit 0..31 = control strategy 1..32</td>
<td>DWORD</td>
<td>0</td>
<td>1) 2)</td>
<td>IO</td>
</tr>
<tr>
<td><em>name</em>_ENOP</td>
<td>Enable operator control of setpoint</td>
<td>BOOL</td>
<td>1</td>
<td>IO</td>
<td>+</td>
</tr>
<tr>
<td><em>name</em>_ENOPP</td>
<td>Enable operator control of prepared setpoint</td>
<td>BOOL</td>
<td>1</td>
<td>IO</td>
<td>+</td>
</tr>
<tr>
<td><em>name</em>_ERR</td>
<td>Setpoint error</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td><em>name</em>_HL</td>
<td>High limit setpoint</td>
<td>REAL</td>
<td>100.0</td>
<td>I</td>
<td>+</td>
</tr>
<tr>
<td><em>name</em>_LL</td>
<td>Low limit setpoint</td>
<td>REAL</td>
<td>0.0</td>
<td>I</td>
<td>+</td>
</tr>
<tr>
<td><em>name</em>_M</td>
<td>&quot;Material&quot; setpoint</td>
<td>STRING[16]</td>
<td>&quot;&quot;</td>
<td>I</td>
<td>+</td>
</tr>
<tr>
<td><em>name</em>_MAI</td>
<td>&quot;Material&quot; process value input</td>
<td>STRING[16]</td>
<td>&quot;&quot;</td>
<td>I</td>
<td>+</td>
</tr>
<tr>
<td><em>name</em>_MAO</td>
<td>&quot;Material&quot; process value output</td>
<td>STRING[16]</td>
<td>&quot;&quot;</td>
<td>O</td>
<td>+</td>
</tr>
<tr>
<td><em>name</em>_MOP</td>
<td>&quot;Material&quot; operator input</td>
<td>STRING[16]</td>
<td>&quot;&quot;</td>
<td>O</td>
<td>+</td>
</tr>
<tr>
<td><em>name</em>_MOPP</td>
<td>Prepared &quot;Material&quot; operator input</td>
<td>STRING[16]</td>
<td>&quot;&quot;</td>
<td>O</td>
<td>+</td>
</tr>
<tr>
<td><em>name</em>_MQ</td>
<td>&quot;Material&quot; setpoint</td>
<td>STRING[16]</td>
<td>&quot;&quot;</td>
<td>O</td>
<td>+</td>
</tr>
<tr>
<td><em>name</em>_MQP</td>
<td>Prepared &quot;Material&quot; setpoint</td>
<td>STRING[16]</td>
<td>&quot;&quot;</td>
<td>O</td>
<td>+</td>
</tr>
<tr>
<td><em>name</em>_OP</td>
<td>Setpoint operator input</td>
<td>REAL</td>
<td>0.0</td>
<td>IO</td>
<td>+</td>
</tr>
<tr>
<td><em>name</em>_OPP</td>
<td>Prepared setpoint operator input</td>
<td>REAL</td>
<td>0.0</td>
<td>IO</td>
<td>+</td>
</tr>
<tr>
<td><em>name</em>_Q</td>
<td>Setpoint output</td>
<td>REAL</td>
<td>0.0</td>
<td>O</td>
<td>+</td>
</tr>
<tr>
<td><em>name</em>_QP</td>
<td>Prepared setpoint output</td>
<td>REAL</td>
<td>0.0</td>
<td>O</td>
<td>+</td>
</tr>
</tbody>
</table>

Key

1) Depends on the number of control strategies in the characteristics editor
2) Depends on "<Setpoint>/Properties/Control strategy assignment"
"PO" data type (process output = parameter for main products, by-products, and waste products)

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
<th>O&amp;M</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;name&quot;</td>
<td>Setpoint automatic input</td>
<td>REAL</td>
<td>0.0</td>
<td>I</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_AI</td>
<td>Process value input</td>
<td>REAL</td>
<td>0.0</td>
<td>I</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_AO</td>
<td>Process value output</td>
<td>REAL</td>
<td>0.0</td>
<td>O</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_B</td>
<td>Setpoint tracking ID</td>
<td>DINT</td>
<td>0</td>
<td>I</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_BAI</td>
<td>BATCH process value input</td>
<td>DINT</td>
<td>0</td>
<td>I</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_BAO</td>
<td>BATCH process value output</td>
<td>DINT</td>
<td>0</td>
<td>O</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_BOP</td>
<td>BATCH operator input</td>
<td>DINT</td>
<td>0</td>
<td>O</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_BOPP</td>
<td>Prepared BATCH operator input</td>
<td>DINT</td>
<td>0</td>
<td>IO</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_BQ</td>
<td>BATCH setpoint</td>
<td>DINT</td>
<td>0</td>
<td>O</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_BQP</td>
<td>Prepared BATCH setpoint</td>
<td>DINT</td>
<td>0</td>
<td>O</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_CS</td>
<td>Enable control strategies: Bit0..31 = control strategy 1..32</td>
<td>DWORD</td>
<td>0 1) 2)</td>
<td>O</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_ENOP</td>
<td>Enable operator control of setpoint</td>
<td>BOOL</td>
<td>1</td>
<td>IO</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_ENOPP</td>
<td>Enable operator control of prepared setpoint</td>
<td>BOOL</td>
<td>1</td>
<td>IO</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_ERR</td>
<td>Setpoint error</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>&quot;name&quot;_LL</td>
<td>Low limit setpoint</td>
<td>REAL</td>
<td>0.0</td>
<td>I</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_HL</td>
<td>High limit setpoint</td>
<td>REAL</td>
<td>100.0</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>&quot;name&quot;_M</td>
<td>&quot;Material&quot; setpoint</td>
<td>STRING[16]</td>
<td>&quot;</td>
<td>I</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_MAI</td>
<td>&quot;Material&quot; process value input</td>
<td>STRING[16]</td>
<td>&quot;</td>
<td>I</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_MAO</td>
<td>&quot;Material&quot; process value output</td>
<td>STRING[16]</td>
<td>&quot;</td>
<td>O</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_MOP</td>
<td>&quot;Material&quot; operator input</td>
<td>STRING[16]</td>
<td>&quot;</td>
<td>O</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_MOPP</td>
<td>Prepared &quot;Material&quot; operator input</td>
<td>STRING[16]</td>
<td>&quot;</td>
<td>O</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_MQ</td>
<td>&quot;Material&quot; setpoint</td>
<td>STRING[16]</td>
<td>&quot;</td>
<td>O</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_MQP</td>
<td>Prepared &quot;Material&quot; setpoint</td>
<td>STRING[16]</td>
<td>&quot;</td>
<td>O</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_OP</td>
<td>Setpoint operator input</td>
<td>REAL</td>
<td>0.0</td>
<td>IO</td>
<td></td>
</tr>
<tr>
<td>&quot;name&quot;_OPP</td>
<td>Prepared setpoint operator input</td>
<td>REAL</td>
<td>0.0</td>
<td>IO</td>
<td></td>
</tr>
<tr>
<td>&quot;name&quot;_Q</td>
<td>Setpoint output</td>
<td>REAL</td>
<td>0.0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>&quot;name&quot;_QP</td>
<td>Prepared setpoint output</td>
<td>REAL</td>
<td>0.0</td>
<td>O</td>
<td></td>
</tr>
</tbody>
</table>

Key

1) Depends on the number of control strategies in the characteristics editor
2) Depends on "<Setpoint>/Properties/Control strategy assignment"
"TKEY" data type

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
<th>O&amp;M</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>name</em></td>
<td>Setpoint automatic input</td>
<td>DINT</td>
<td>0</td>
<td>I</td>
<td>+</td>
</tr>
<tr>
<td><em>name</em>_AI</td>
<td>Process value input</td>
<td>DINT</td>
<td>0</td>
<td>I</td>
<td>+</td>
</tr>
<tr>
<td><em>name</em>_AO</td>
<td>Process value output</td>
<td>DINT</td>
<td>0</td>
<td>O</td>
<td>+</td>
</tr>
<tr>
<td><em>name</em>_CS</td>
<td>Enable control strategies:</td>
<td>DWORD</td>
<td>0 1) 2)</td>
<td>IO</td>
<td>+</td>
</tr>
<tr>
<td></td>
<td>Bit 0 31 = control strategy 1 32</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><em>name</em>_ENOP</td>
<td>Enable operator control of setpoint</td>
<td>BOOL</td>
<td>1</td>
<td>IO</td>
<td>+</td>
</tr>
<tr>
<td><em>name</em>_ENOPP</td>
<td>Enable operator control of prepared setpoint</td>
<td>BOOL</td>
<td>1</td>
<td>IO</td>
<td>+</td>
</tr>
<tr>
<td><em>name</em>_ERR</td>
<td>Setpoint error</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td><em>name</em>_LL</td>
<td>Low limit setpoint</td>
<td>DINT</td>
<td>0</td>
<td>I</td>
<td>+</td>
</tr>
<tr>
<td><em>name</em>_HL</td>
<td>High limit setpoint</td>
<td>DINT</td>
<td></td>
<td>I</td>
<td>+</td>
</tr>
<tr>
<td></td>
<td>DINT: 100, SOURCE, DEST, VIA: 2147483647</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><em>name</em>_OP</td>
<td>Setpoint operator input</td>
<td>DINT</td>
<td>0</td>
<td>IO</td>
<td>+</td>
</tr>
<tr>
<td><em>name</em>_OPP</td>
<td>Prepared setpoint operator input</td>
<td>DINT</td>
<td>0</td>
<td>IO</td>
<td>+</td>
</tr>
<tr>
<td><em>name</em>_Q</td>
<td>Setpoint output</td>
<td>DINT</td>
<td>0</td>
<td>O</td>
<td>+</td>
</tr>
<tr>
<td><em>name</em>_QP</td>
<td>Prepared setpoint output</td>
<td>DINT</td>
<td>0</td>
<td>O</td>
<td>+</td>
</tr>
<tr>
<td><em>name</em>_ID</td>
<td>&quot;Transfer ID&quot; automatic input</td>
<td>STRING[16]</td>
<td>&quot;</td>
<td>I</td>
<td>+</td>
</tr>
<tr>
<td><em>name</em>_IDA</td>
<td>&quot;Transfer ID&quot; process value input</td>
<td>STRING[16]</td>
<td>&quot;</td>
<td>I</td>
<td>+</td>
</tr>
<tr>
<td><em>name</em>_IDQ</td>
<td>&quot;Transfer ID&quot; process value output</td>
<td>STRING[16]</td>
<td>&quot;</td>
<td>O</td>
<td>+</td>
</tr>
<tr>
<td><em>name</em>_IDQP</td>
<td>&quot;Transfer ID&quot; setpoint output</td>
<td>STRING[16]</td>
<td>&quot;</td>
<td>O</td>
<td>+</td>
</tr>
<tr>
<td><em>name</em>_IDOP</td>
<td>Setpoint operator input</td>
<td>STRING[16]</td>
<td>&quot;</td>
<td>O</td>
<td>+</td>
</tr>
<tr>
<td><em>name</em>_IDO</td>
<td>Prepared setpoint operator input</td>
<td>STRING[16]</td>
<td>&quot;</td>
<td>O</td>
<td>+</td>
</tr>
<tr>
<td><em>name</em>_C</td>
<td>&quot;Transfer COUNTER&quot; automatic input</td>
<td>DINT</td>
<td>0</td>
<td>I</td>
<td>+</td>
</tr>
<tr>
<td><em>name</em>_CAI</td>
<td>&quot;Transfer COUNTER&quot; process value input</td>
<td>DINT</td>
<td>0</td>
<td>I</td>
<td>+</td>
</tr>
<tr>
<td><em>name</em>_CAO</td>
<td>&quot;Transfer COUNTER&quot; process value output</td>
<td>DINT</td>
<td>0</td>
<td>O</td>
<td>+</td>
</tr>
<tr>
<td><em>name</em>_CQ</td>
<td>&quot;Transfer COUNTER&quot; setpoint output</td>
<td>DINT</td>
<td>0</td>
<td>O</td>
<td>+</td>
</tr>
<tr>
<td><em>name</em>_CQP</td>
<td>&quot;Transfer COUNTER&quot; prepared setpoint output</td>
<td>DINT</td>
<td>0</td>
<td>O</td>
<td>+</td>
</tr>
<tr>
<td><em>name</em>_COP</td>
<td>Setpoint operator input</td>
<td>DINT</td>
<td>0</td>
<td>IO</td>
<td>+</td>
</tr>
<tr>
<td><em>name</em>_COPP</td>
<td>Prepared setpoint operator input</td>
<td>DINT</td>
<td>0</td>
<td>IO</td>
<td>+</td>
</tr>
</tbody>
</table>
### Key

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1)</td>
<td>Depends on the number of control strategies in the characteristics editor</td>
</tr>
<tr>
<td>2)</td>
<td>Depends on &quot;&lt;Setpoint&gt;/Properties/Control strategy assignment&quot;</td>
</tr>
</tbody>
</table>
12.2.6.3 Meaning and usage of setpoints

Inputs/outputs of setpoints

The following explanations apply to all setpoints regardless of their data type. Specific explanations are indicated as such.

Process values

The process value input is used to read out the actual process value from the plant. The process value can be value from the process or a calculated value. The value is output unmodified on the output.

<table>
<thead>
<tr>
<th>Data type</th>
<th>I/O</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input</td>
<td></td>
<td></td>
</tr>
<tr>
<td>all</td>
<td>..._AI</td>
<td>Actual Value Input</td>
</tr>
<tr>
<td>PI</td>
<td>..._BAI</td>
<td>Tracking ID Actual Value Input</td>
</tr>
<tr>
<td>PI</td>
<td>..._MAI</td>
<td>Material Actual Value Input</td>
</tr>
<tr>
<td>TKEY</td>
<td>..._IDAI</td>
<td>Transfer ID Actual Value Input</td>
</tr>
<tr>
<td>TKEY</td>
<td>..._CAI</td>
<td>Transfer Counter Actual Value Input</td>
</tr>
<tr>
<td>Output</td>
<td></td>
<td></td>
</tr>
<tr>
<td>all</td>
<td>..._AO</td>
<td>Actual Value Output</td>
</tr>
<tr>
<td>PI</td>
<td>..._BAO</td>
<td>Tracking ID Actual Value Output</td>
</tr>
<tr>
<td>PI</td>
<td>..._MAO</td>
<td>Material Actual Value Output</td>
</tr>
<tr>
<td>TKEY</td>
<td>..._IDAO</td>
<td>Transfer ID Actual Value Output</td>
</tr>
<tr>
<td>TKEY</td>
<td>..._CAO</td>
<td>Transfer Counter Actual Value Output</td>
</tr>
</tbody>
</table>
Prepared Setpoints

At the setpoint inputs for AUTO or MANUAL mode, the word that will be used when the SFC instance is next started is "prepared.

You can assign parameters for the MANUAL mode inputs in the "Prepared values" view of the SFC faceplate. The prepared values are sent to the outputs.

<table>
<thead>
<tr>
<th>Data type</th>
<th>I/O</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Input</td>
<td></td>
</tr>
<tr>
<td>all</td>
<td>...</td>
<td>Setpoint Automatic Input</td>
</tr>
<tr>
<td>all</td>
<td>..._OPP</td>
<td>Setpoint Operator Input Prepare</td>
</tr>
<tr>
<td>PI, PO</td>
<td>..._BOPP</td>
<td>Tracking ID Setpoint Operator Input Prepare</td>
</tr>
<tr>
<td>PI, PO</td>
<td>..._B</td>
<td>Tracking ID Setpoint Automatic Input</td>
</tr>
<tr>
<td>PI, PO</td>
<td>..._M</td>
<td>Material Setpoint Automatic Input</td>
</tr>
<tr>
<td>PI, PO</td>
<td>..._MOPP</td>
<td>Material Setpoint Operator Input Prepare</td>
</tr>
<tr>
<td>TKEY</td>
<td>..._ID</td>
<td>Transfer ID Setpoint Automatic Input</td>
</tr>
<tr>
<td>TKEY</td>
<td>..._IDOPP</td>
<td>Transfer ID Setpoint Operator Input Prepare</td>
</tr>
<tr>
<td>TKEY</td>
<td>..._C</td>
<td>Transfer Counter Setpoint Automatic Input</td>
</tr>
<tr>
<td>TKEY</td>
<td>..._COPP</td>
<td>Transfer Counter Setpoint Operator Input Prepare</td>
</tr>
<tr>
<td></td>
<td>Output</td>
<td></td>
</tr>
<tr>
<td>all</td>
<td>..._QP</td>
<td>Valid Setpoint Prepare</td>
</tr>
<tr>
<td>PI, PO</td>
<td>..._BQP</td>
<td>Tracking ID Valid Setpoint Prepare</td>
</tr>
<tr>
<td>PI, PO</td>
<td>..._MQP</td>
<td>Material Valid Setpoint Prepare</td>
</tr>
<tr>
<td>TKEY</td>
<td>..._IDQP</td>
<td>Transfer ID Valid Setpoint Prepare</td>
</tr>
<tr>
<td>TKEY</td>
<td>..._CQP</td>
<td>Transfer Counter Valid Setpoint Prepare</td>
</tr>
</tbody>
</table>
Setpoints that will be applied immediately

A value that will be applied immediately is set on the setpoint inputs for AUTO or MANUAL mode. In AUTO mode, the TAKESP input must also be set.

The inputs of the operating mode MANUAL can be parameterized in the "Current values" view of the SFC faceplate. The current values are sent to the outputs.

<table>
<thead>
<tr>
<th>Data type</th>
<th>I/O</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input</td>
<td></td>
<td></td>
</tr>
<tr>
<td>all</td>
<td>…</td>
<td>Setpoint Automatic Input</td>
</tr>
<tr>
<td>all</td>
<td>…_OP</td>
<td>Setpoint Operator Input</td>
</tr>
<tr>
<td>PI, PO</td>
<td>…_B</td>
<td>Tracking ID Setpoint Automatic Input</td>
</tr>
<tr>
<td>PI, PO</td>
<td>…_BOP</td>
<td>Tracking ID Setpoint Operator Input</td>
</tr>
<tr>
<td>PI, PO</td>
<td>…_M</td>
<td>Material Setpoint Operator Input</td>
</tr>
<tr>
<td>PI, PO</td>
<td>…_MOP</td>
<td>Material Setpoint Operator Input</td>
</tr>
<tr>
<td>TKEY</td>
<td>…_ID</td>
<td>Transfer ID Setpoint Automatic Input</td>
</tr>
<tr>
<td>TKEY</td>
<td>…_IDOP</td>
<td>Transfer ID Setpoint Operator Input</td>
</tr>
<tr>
<td>TKEY</td>
<td>…_C</td>
<td>Transfer Counter Setpoint Automatic Input</td>
</tr>
<tr>
<td>TKEY</td>
<td>…_COP</td>
<td>Transfer Counter Setpoint Operator Input</td>
</tr>
<tr>
<td>Output</td>
<td></td>
<td></td>
</tr>
<tr>
<td>all</td>
<td>…_Q</td>
<td>Active Setpoint</td>
</tr>
<tr>
<td>PI, PO</td>
<td>…_BQ</td>
<td>Tracking ID Active Setpoint</td>
</tr>
<tr>
<td>PI, PO</td>
<td>…_MQ</td>
<td>Material Active Setpoint</td>
</tr>
<tr>
<td>TKEY</td>
<td>…_IDQ</td>
<td>Transfer ID Active Setpoint</td>
</tr>
<tr>
<td>TKEY</td>
<td>…_CQ</td>
<td>Transfer Counter Active Setpoint</td>
</tr>
</tbody>
</table>

Operator Enables (Preparation and Modification of setpoints in MANUAL)

The preparation or modification of the setpoint in MANUAL mode is only possible if the corresponding operator enables are set.

<table>
<thead>
<tr>
<th>Data type</th>
<th>I/O</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input</td>
<td></td>
<td></td>
</tr>
<tr>
<td>BOOL</td>
<td>…_EN0OP</td>
<td>Enable setpoint &quot;0&quot; operator input</td>
</tr>
<tr>
<td>BOOL</td>
<td>…_EN1OP</td>
<td>Enable setpoint &quot;1&quot; operator input</td>
</tr>
<tr>
<td>BOOL</td>
<td>…_EN0OPP</td>
<td>Enable setpoint &quot;0&quot; operator input prepare</td>
</tr>
<tr>
<td>BOOL</td>
<td>…_EN1OPP</td>
<td>Enable setpoint &quot;1&quot; operator input prepare</td>
</tr>
<tr>
<td>all except BOOL</td>
<td>…_ENOP</td>
<td>Enable Setpoint Operator Input</td>
</tr>
<tr>
<td>all except BOOL</td>
<td>…_ENOPP</td>
<td>Enable Setpoint Operator Input Prepare</td>
</tr>
</tbody>
</table>
Checking Limit Values

Modified limit values will only be applied at the appropriate output if the new value is within the defined limits of the setpoint. If this is not the case, the limit value violation is indicated as an error at the \(<sw>\)_ERR output and the output affected remains unchanged.

<table>
<thead>
<tr>
<th>Data type</th>
<th>I/O</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>all except BOOL, STRING</td>
<td>..._LL</td>
<td>Low Limit</td>
</tr>
<tr>
<td>all except BOOL, STRING</td>
<td>..._HL</td>
<td>High Limit</td>
</tr>
</tbody>
</table>

Checking Control Strategy Assignment

The value of the \(<sp>\)_CS input defines the assignment of the setpoint to the existing control strategies. This assignment is necessary for checking and applying setpoint changes and for adapting the SFC faceplate to the currently selected control strategy. Assign parameters for the input \(<sw>\)_CS in the "Object Properties" dialog for a setpoint.
### 12.2.6.4 "Process values" characteristic

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
<th>O&amp;M</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;name&quot;</td>
<td>Process value input</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>INT</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>DINT</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>REAL</td>
<td>0.0</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>STRING</td>
<td>&quot;&quot;</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

You will find explanations of the table entries in the section: [Meanings in the table](Page 169)

### 12.2.6.5 "Control values" characteristic

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
<th>O&amp;M</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;name&quot;</td>
<td>Control value output</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>INT</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>DINT</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>REAL</td>
<td>0.0</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>STRING</td>
<td>&quot;&quot;</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

You will find explanations of the table entries in the section: [Meanings in the table](Page 169)

### 12.2.6.6 "Parameters" characteristic

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
<th>O&amp;M</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;name&quot;</td>
<td>Parameter input</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>INT</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>DINT</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>REAL</td>
<td>0.0</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>STRING</td>
<td>&quot;&quot;</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

You will find explanations of the table entries in the section: [Meanings in the table](Page 169)
### 12.2.6.7 "Bit Memory" Characteristic

"Bit memory" characteristic

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
<th>O&amp;M</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;name&quot;</td>
<td>Bit memory (static VAR area)</td>
<td>BOOL</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>INT</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>DINT</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>REAL</td>
<td>0.0</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>STRING</td>
<td>&quot;&quot;</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Note**

Bit memory is an internal variable that does not appear as a visible I/O on the interface. As a result, for example, you cannot use the "Browse" dialog box or the interface editor to incorporate this variable in the addresses of the step/transition properties. You have to enter the I/O name for the bit memory with the keyboard.

### 12.2.6.8 "Timers" characteristic

"Timers" characteristic

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
<th>O&amp;M</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAMPLE_T</td>
<td>Task sampling time in sec</td>
<td>REAL</td>
<td>0.0</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>&quot;name&quot;_MODE</td>
<td>Operating mode:</td>
<td>INT</td>
<td>2</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td></td>
<td>0: Start timer as pulse &quot;Pulse&quot;</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>1: Start timer as extended pulse &quot;ExtP&quot;</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>2: Start timer with on delay &quot;OnDel&quot;</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>3: Start timer with retentive on delay &quot;RetOn-D&quot;</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>4: Start timer with off delay &quot;Off-D&quot;</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>&quot;name&quot;_TIME0</td>
<td>Time in s</td>
<td>REAL</td>
<td>1.0</td>
<td>IO</td>
<td></td>
</tr>
<tr>
<td>&quot;name&quot;_RESET</td>
<td>Reset</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
<td></td>
</tr>
<tr>
<td>&quot;name&quot;_I0</td>
<td>Input pulse</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
<td></td>
</tr>
<tr>
<td>&quot;name&quot;_QERR</td>
<td>Error</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>&quot;name&quot;_Q0</td>
<td>Output pulse</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>&quot;name&quot;_PTIME</td>
<td>Time remaining in s</td>
<td>REAL</td>
<td>0.0</td>
<td>O</td>
<td></td>
</tr>
</tbody>
</table>

You will find explanations of the table entries in the section: Meanings in the table (Page 169)
12.2.6.9  "Block contacts" characteristic

"Block contacts" characteristic

For more information, refer to the section: Block contacts (Page 103).
### 12.3 SFC inputs/outputs sorted by usage

#### 12.3.1 Operating modes (SFC inputs/outputs)

SFC inputs/outputs of the operating modes

You will find explanations of the table entries in the section: Meanings in the table (Page 169)

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
<th>O&amp;M</th>
</tr>
</thead>
<tbody>
<tr>
<td>ENAUT</td>
<td>Enable &quot;Change to AUTO&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>QENAUT</td>
<td>Enable &quot;Change to AUTO&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>AUT</td>
<td>Change to AUTO (process mode)</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>Operator and display section &quot;AUTO&quot;</td>
<td>Change to AUTO (process mode) with button</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>ENMAN</td>
<td>Enable &quot;Change to MANUAL&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>QENMAN</td>
<td>Enable &quot;Change to MANUAL&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>MAN</td>
<td>Change to MANUAL (operator control mode)</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>Operator and display section &quot;MANUAL&quot;</td>
<td>Change to MANUAL (operator control mode) with button</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>QAUTMAN</td>
<td>Current operating mode: 0: MAN, 1: AUTO</td>
<td>BOOL</td>
<td>0 *)</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>QFORCEMAN</td>
<td>Change to MANUAL without enable (= force manual, for 1 cycle)</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
</tbody>
</table>

**Key**

*) Depends on "SFC properties/operating parameters AS/operating mode"
Switching the operating mode in the interface

<table>
<thead>
<tr>
<th>Previous operating mode:</th>
<th>Enable MANUAL</th>
<th>Enable AUTO</th>
<th>Changeover → MAN → AUTO</th>
<th>Next operating mode:</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 = MANUAL</td>
<td>QAUTMAN</td>
<td>QENMAN</td>
<td>ENAUT QENAUT MAN AUT QAUTMAN</td>
<td></td>
</tr>
<tr>
<td>0</td>
<td>x</td>
<td>x</td>
<td>0 &lt;-&gt; 1 0 &lt;-&gt; 1 0 0 0 0</td>
<td></td>
</tr>
<tr>
<td>0</td>
<td>x</td>
<td>x</td>
<td>0 0 0 1 0 0 0 0</td>
<td></td>
</tr>
<tr>
<td>0</td>
<td>x</td>
<td>x</td>
<td>1 1 0 1 0 1 0 1</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>0 &lt;-&gt; 1</td>
<td>0 &lt;-&gt; 1</td>
<td>x x 0 0 1 0 1 1</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>0</td>
<td>0</td>
<td>x x 1 0 1 0 1 1</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>1</td>
<td>x x 1 0 1 0 1 1</td>
<td></td>
</tr>
</tbody>
</table>

Switching the operating mode via operator input (SFC test mode/SFC visualization)

<table>
<thead>
<tr>
<th>Previous operating mode</th>
<th>Enable MANUAL/AUTO</th>
<th>Changeover → MAN → AUTO</th>
<th>Next operating mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display</td>
<td>Display + &quot;Lock&quot; button</td>
<td>MANUAL button</td>
<td>AUTO button</td>
</tr>
<tr>
<td>MANUAL</td>
<td>Closed + raised</td>
<td>Inactive</td>
<td>Click</td>
</tr>
<tr>
<td>MANUAL</td>
<td>Open + depressed</td>
<td>Inactive</td>
<td>Click</td>
</tr>
<tr>
<td>AUTO</td>
<td>Closed + raised</td>
<td>Click</td>
<td>Inactive</td>
</tr>
<tr>
<td>AUTO</td>
<td>Open + depressed</td>
<td>Click</td>
<td>Inactive</td>
</tr>
</tbody>
</table>

The "padlock" enable button also shows the status of QENMAN or QENAUT.

The QFORCEMAN output is set for one cycle when there is a changeover from AUTO to MAN if no enable was set.
12.3.2 Commands and operating states (SFC inputs/outputs)

SFC inputs/outputs of the commands and operating states

You will find explanations of the table entries in the section: Meanings in the table (Page 169)

"Start" (enables, commands, new operating state)

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Attr.</th>
</tr>
</thead>
<tbody>
<tr>
<td>ENSTART</td>
<td>Enable &quot;Start&quot;</td>
<td>BOOL</td>
<td>1</td>
<td>Q</td>
</tr>
<tr>
<td>ENASTART</td>
<td>Enable &quot;Start in Run&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>Q</td>
</tr>
<tr>
<td>QDIS_START</td>
<td>&quot;Start&quot; not possible (e.g. LI_ERR, OP_ERR, ...)</td>
<td>BOOL</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>START</td>
<td>Automatic command &quot;Start&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>Q</td>
</tr>
<tr>
<td>&quot;Start&quot; control and display section</td>
<td>&quot;Start&quot; button for manual command</td>
<td>BOOL</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>INTSTART</td>
<td>Internal command &quot;Start&quot;</td>
<td>BOOL</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>STARTING</td>
<td>New operating state &quot;Starting&quot; (transitional state)</td>
<td>BOOL</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>RUN</td>
<td>New operating state &quot;Run&quot; (after &quot;Starting&quot;)</td>
<td>BOOL</td>
<td>0</td>
<td></td>
</tr>
</tbody>
</table>

"Hold" (enables, commands, new operating state)

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>ENHOLD</td>
<td>Enable &quot;Hold&quot;</td>
<td>BOOL</td>
<td>1</td>
<td>I</td>
</tr>
<tr>
<td>HOLD</td>
<td>Automatic command &quot;Hold&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
</tr>
<tr>
<td>&quot;Hold&quot; control and display section</td>
<td>&quot;Hold&quot; button for manual command</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
</tr>
<tr>
<td>INTHOLD</td>
<td>Internal command &quot;Hold&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
</tr>
<tr>
<td>LOCKHOLD</td>
<td>External interlock &quot;Hold&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
</tr>
<tr>
<td>HOLDING</td>
<td>New operating state &quot;Holding&quot; (transitional state)</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
</tr>
<tr>
<td>HELD</td>
<td>New operating state &quot;Held&quot; (after &quot;Holding&quot;)</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
</tr>
</tbody>
</table>
### "Resume" (enables, commands)

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>ENRESUME</td>
<td>Enable &quot;Resume&quot;</td>
<td>BOOL</td>
<td>1</td>
<td>I</td>
</tr>
<tr>
<td>RESUME</td>
<td>Automatic command &quot;Resume&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
</tr>
<tr>
<td>INTRESUME</td>
<td>Internal command &quot;Resume&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
</tr>
</tbody>
</table>

### "Resume" in "Held" operating state (new operating state)

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>RESUMING</td>
<td>New operating state &quot;Resuming&quot; (transitional state)</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
</tr>
<tr>
<td>RUN</td>
<td>New operating state &quot;Run&quot; (after &quot;Resuming&quot;)</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
</tr>
</tbody>
</table>

### "Resume" in "Held (Error)" operating state (new operating state)

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>RESU_ERROR</td>
<td>New operating state &quot;Resuming (Error)&quot; (transitional state)</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
</tr>
<tr>
<td>RUN</td>
<td>New operating state &quot;Run&quot; (after &quot;Resuming (Error)&quot;)</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
</tr>
</tbody>
</table>

### "Abort" (enables, commands, new operating state)

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>ENABORT</td>
<td>Enable &quot;Abort&quot;</td>
<td>BOOL</td>
<td>1</td>
<td>I</td>
</tr>
<tr>
<td>ABORT</td>
<td>Automatic command &quot;Abort&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
</tr>
<tr>
<td>INTABORT</td>
<td>Internal command &quot;Abort&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
</tr>
<tr>
<td>LOCKABORT</td>
<td>External interlock &quot;Abort&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
</tr>
<tr>
<td>ABORTING</td>
<td>New operating state &quot;Aborting&quot; (transitional state)</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
</tr>
<tr>
<td>ABORTED</td>
<td>New operating state &quot;Aborted&quot; (after &quot;Aborting&quot;)</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
</tr>
</tbody>
</table>
"Complete" (enables, commands, new operating state)

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>ENCOMPLETE</td>
<td>Enable &quot;Complete&quot;</td>
<td>BOOL</td>
<td>1</td>
<td>I</td>
</tr>
<tr>
<td>COMPLETE</td>
<td>Automatic command &quot;Complete&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
</tr>
<tr>
<td>&quot;Complete&quot;</td>
<td>control and display section</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>INCOMPLETE</td>
<td>Internal command &quot;Complete&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
</tr>
<tr>
<td>LOCKCOMPLETE</td>
<td>External interlock &quot;Complete&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
</tr>
<tr>
<td>SELFCOMP</td>
<td>SFC changes automatically from &quot;Run&quot; to &quot;Completing&quot;</td>
<td>BOOL</td>
<td>1</td>
<td>I</td>
</tr>
<tr>
<td>COMPLETING</td>
<td>New operating state &quot;Completing&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
</tr>
<tr>
<td>COMPLETED</td>
<td>New operating state &quot;Completed&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
</tr>
</tbody>
</table>

"Stop" (enables, commands, new operating state)

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>ENSTOP</td>
<td>Enable &quot;Stop&quot;</td>
<td>BOOL</td>
<td>1</td>
<td>I</td>
</tr>
<tr>
<td>STOP</td>
<td>Automatic command &quot;Stop&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
</tr>
<tr>
<td>&quot;Stop&quot;</td>
<td>control and display section</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>INSTOP</td>
<td>Internal command &quot;Stop&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
</tr>
<tr>
<td>LOCKSTOP</td>
<td>External interlock &quot;Stop&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
</tr>
<tr>
<td>STOPPING</td>
<td>New operating state &quot;Stopping&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
</tr>
<tr>
<td>STOPPED</td>
<td>New operating state &quot;Stopped&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
</tr>
</tbody>
</table>
### "Restart" (enables, commands, new operating state)

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>ENRESTART</td>
<td>Enable &quot;Restart&quot;</td>
<td>BOOL</td>
<td>1</td>
<td>I</td>
</tr>
<tr>
<td>RESTART</td>
<td>Automatic command &quot;Restart&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
</tr>
<tr>
<td>INTRESTART</td>
<td>Internal command &quot;Restart&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
</tr>
<tr>
<td>STARTING</td>
<td>New operating state &quot;Starting&quot; (transitional state)</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
</tr>
<tr>
<td>RUN</td>
<td>New operating state &quot;Run&quot; (after &quot;Held/Held (Error)&quot;)</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
</tr>
</tbody>
</table>

### "Reset" (enables, commands, new operating state)

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>ENRESET</td>
<td>Enable &quot;Reset&quot;</td>
<td>BOOL</td>
<td>1</td>
<td>I</td>
</tr>
<tr>
<td>RESET</td>
<td>Automatic command &quot;Reset&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
</tr>
<tr>
<td>INTRESET</td>
<td>Internal command &quot;Reset&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
</tr>
<tr>
<td>SELFRESET</td>
<td>SFC changes automatically from &quot;Completed/Aborted/Stopped&quot; to &quot;Idle&quot; (only in MANUAL)</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
</tr>
<tr>
<td>IDLE</td>
<td>New operating state &quot;Idle&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
</tr>
</tbody>
</table>

### "Error" (enables, commands)

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Error&quot; control and display section</td>
<td>&quot;Error&quot; button for manual command</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>INTERERROR</td>
<td>Internal command &quot;Error&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
</tr>
<tr>
<td>LOCKERROR</td>
<td>External interlock &quot;Error&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
</tr>
</tbody>
</table>
**Standard interface and chart I/Os**

**12.3 SFC inputs/outputs sorted by usage**

"Error" not in operating state "Completing" (new operating state)

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>ERROR</td>
<td>New operating state &quot;Error&quot; (transitional state)</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
</tr>
<tr>
<td>HELD_ERROR</td>
<td>New operating state &quot;Held (Error)&quot; (after &quot;Error&quot;)</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
</tr>
</tbody>
</table>

"Error" in operating state "Completing" (new operating state)

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>ERROR_COMPLETING</td>
<td>New operating state &quot;Error (Completing)&quot; (transitional state)</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
</tr>
<tr>
<td>COMPLETING</td>
<td>New operating state &quot;Completing&quot; after &quot;Error (Completing)&quot; (transitional state)</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
</tr>
</tbody>
</table>

**Explanations of the commands and operating state changes**

The "Start,..." MANUAL commands are entered from the control and display section by means of the buttons and control word SFC_CONTROL and reset after they have been executed.

Whether or not the buttons are enabled is derived from the status word SFC_STATE and depends on the particular "EN..." enable, the operating mode, and the operating state:

- In AUTO mode, all buttons for the commands are disabled.
- In MANUAL mode, the buttons for the commands are enabled or disabled depending on the enable and the operating state.

The command inputs "START, ....." are evaluated in AUTO mode depending on the "ENSTART, ....." enable. Whether they are permitted depends on the current operating state.

You can find additional information about this in the section: Operating States (Page 247).

The LOCK commands are evaluated in AUTO and MANUAL modes regardless of the enable. Whether they are permitted depends on the current operating state.

The INT commands are evaluated in AUTO and MANUAL modes regardless of the enable. They are used in step actions and reset after they have been executed. Whether they are permitted depends on the current operating state.

Note the special conditions for the "Start" command:

**QDIS_START**

"Start" is possible only when QDIS_START is set to 0 (in IDLE, RUN, COMPLETED, ABORTED).

You can find additional information in the section: Error handling (SFC inputs/outputs) (Page 213)
**ENSTART**

In RUN mode, "Start" is possible only when ENSTART is set to 1 and the following conditions are also met:

**AUTO mode:** CONT = 1 (Continuous mode) and

**READY_TC = 1** (RUN sequencer is completed or after action "READY_TC:= 1")

You can find additional information in the section: Start Requirements of an SFC (Chart/Instance) (Page 266)

---

**Special INT command (for SFC chart only)**

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>INTONOFF</td>
<td>Internal command &quot;Turn SFC off/on&quot;, 1:on, 0: off</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
</tr>
</tbody>
</table>

This command exists to allow compatibility with SFC V5.2 (<SFCname>.EN) and is used in step actions.

**Note**

The I/O INTONOFF is not an available SFC type in V6.1 and higher. It has been changed to a reserve (IORES0). Existing accesses to INTONOFF are converted to textual interconnections.

---

**Enable SFC (INTONOFF=1)**

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>ENSTART</td>
<td>Enable &quot;Start&quot;</td>
<td>BOOL</td>
<td>1</td>
<td>I</td>
</tr>
<tr>
<td>STARTING</td>
<td>New operating state &quot;Starting&quot; (transitional state)</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
</tr>
<tr>
<td>RUN</td>
<td>New operating state &quot;Run&quot; (after &quot;Starting&quot;)</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
</tr>
</tbody>
</table>

---

**Disable SFC (INTONOFF=0)**

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>ENABORT</td>
<td>Enable &quot;Abort&quot;</td>
<td>BOOL</td>
<td>1</td>
<td>I</td>
</tr>
<tr>
<td>ABORTING</td>
<td>New operating state &quot;Aborting&quot; (transitional state)</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
</tr>
<tr>
<td>ABORTED</td>
<td>New operating state &quot;Aborted&quot; (after &quot;Aborting&quot;)</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
</tr>
</tbody>
</table>
Special states

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>READY_TC</td>
<td>&quot;Ready to complete&quot; state</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
</tr>
<tr>
<td>BUSY</td>
<td>Status &quot;Busy&quot; (= neither &quot;Idle&quot; nor &quot;Completed&quot; nor &quot;Aborted&quot; nor &quot;Stopped&quot;)</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
</tr>
</tbody>
</table>

**READY_TC**

With the READY_TC (Ready to complete) output of the standard interface, the SFC provides a signal for synchronization between the SFC and the higher-level controller for the transition from "Run" to "Completing." The SFC sets the READY_TC to "1" if "Run" has finished executing, in other words, the start conditions for a sequencer are not fulfilled or a started sequencer has been executed completely. Regardless of the reason, READY_TC can also be set in increments. This enables the actual SFC execution completion to be signaled. A higher-level controller issues the "Complete" command to the SFC only when the READY_TC output is set.

If "Run" operating state is exited (for example, due to a "Complete", "Hold," or "Error"), READY_TC = 0 is set. If the SFC has been placed in "Hold" state and then resumed, READY_TC is not automatically reset to the previous value; rather, it remains set to 0 because the SFC cannot decide whether the conditions for READY_TC = 1 have been fulfilled again when a resumption occurs. The project engineer is responsible for proper handling of READY_TC in this case.

**BUSY**

BUSY = 1 indicates that the SFC is "busy," i.e., has been started. This signal replaces the signal <SFCname.EN> used for transitions in SFC V5.2 and lower.

**Note**

If several commands are queued simultaneously (for example, external and internal commands), an interconnection error (LI_ERR=1) is usually displayed. The commands will not be executed or only one of the commands will be executed.
Programmed targets steps / "Set target step" enable

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>ENTARGETSTEP</td>
<td>Enable &quot;Set target steps&quot;</td>
<td>BOOL</td>
<td>1</td>
<td>I</td>
</tr>
<tr>
<td>TARGETSEQ</td>
<td>Sequencer number for &quot;Set target step&quot;</td>
<td>BYTE</td>
<td>0</td>
<td>IO</td>
</tr>
<tr>
<td>TARGETSTEP</td>
<td>Step number for &quot;Set target step&quot;</td>
<td>WORD</td>
<td>0</td>
<td>IO</td>
</tr>
</tbody>
</table>

With ENTARGETSTEP, you can enable or disable the manual setting of target steps in MANUAL mode (relevant only in MANUAL, in contrast to other "EN..."). ENTARGETSTEP has no effect on programmed target steps.

With TARGETSEQ and TARGETSTEP, only one target step can be set in an inactive or stopped sequencer. A target step that has already been set is reset.

See also

Behavior when multiple commands are queued (Page 267)
### 12.3.3 Execution options (SFC inputs/outputs)

SFC inputs/outputs of the execution options

You will find explanations of the table entries in the section: [Meanings in the table](Page 169)

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default Typ</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>CYCLEEXEC</td>
<td>Cyclic Operation (only in AUTO)</td>
<td>BOOL</td>
<td>0 2)</td>
<td>I</td>
</tr>
<tr>
<td>&quot;Cyclic Operation&quot; control and display section</td>
<td>Option: Cyclic Operation (only in MANUAL)</td>
<td>BOOL</td>
<td>0 2)</td>
<td></td>
</tr>
<tr>
<td>RUNCOUNT</td>
<td>Number of runs in &quot;cyclic operation&quot;</td>
<td>INT</td>
<td>0</td>
<td>O</td>
</tr>
<tr>
<td>INSTROUT</td>
<td>Command Output (only in AUTO)</td>
<td>BOOL</td>
<td>1 3)</td>
<td>I</td>
</tr>
<tr>
<td>&quot;Command Output&quot; control and display section</td>
<td>Option: Command Output (only in MANUAL)</td>
<td>BOOL</td>
<td>1 3)</td>
<td></td>
</tr>
<tr>
<td>TIMEMON</td>
<td>Time Monitoring (only in AUTO)</td>
<td>BOOL</td>
<td>0 4)</td>
<td>I</td>
</tr>
<tr>
<td>&quot;Time Monitoring&quot; control and display section</td>
<td>Option: Time Monitoring (only in MANUAL)</td>
<td>BOOL</td>
<td>0 4)</td>
<td></td>
</tr>
<tr>
<td>SCT</td>
<td>Step enabling with transition (only in AUTO)</td>
<td>BOOL</td>
<td>1 6)</td>
<td>I</td>
</tr>
<tr>
<td>SCT_TAC</td>
<td>Step enabling with transition and step-specific operator confirmation (only in AUTO)</td>
<td>BOOL</td>
<td>0 6)</td>
<td></td>
</tr>
<tr>
<td>&quot;Step control mode&quot; control and display section</td>
<td>MAN T:: Step enabling with transition or operator confirmation T and O: Step enabling with transition and operator confirmation O: Step enabling with operator confirmation T/T and O: Step enabling with transition and step-specific confirmation by operator</td>
<td>T 6)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>QSCC</td>
<td>Step enabling with operator confirmation</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
</tr>
<tr>
<td>QSCT</td>
<td>Step enabling with transition</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
</tr>
<tr>
<td>QSCT_TAC</td>
<td>Step enabling with transition and step-specific operator confirmation</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
</tr>
<tr>
<td>QSCTAC</td>
<td>Step enabling with transition and operator confirmation</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
</tr>
<tr>
<td>QSCTOC</td>
<td>Step enabling with transition or operator confirmation</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
</tr>
<tr>
<td>RUNHOLD</td>
<td>Response of the RUN sequencer to the &quot;Hold&quot; Command 0: Hold sequencer, 1: Abort sequencer</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
</tr>
</tbody>
</table>
### 12.3 SFC inputs/outputs sorted by usage

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>SELFCOMP</td>
<td>SFC changes automatically from &quot;Run&quot; to &quot;Completing&quot;</td>
<td>BOOL</td>
<td>1</td>
<td>I</td>
</tr>
<tr>
<td>SELFRESET</td>
<td>SFC changes automatically from &quot;Completed/Aborted/Stopped&quot; to &quot;Idle&quot; (only in MANUAL)</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
</tr>
</tbody>
</table>

**Key**

2) Depends on "SFC properties/operating parameters AS/cyclic operation"

3) Depends on "SFC properties/operating parameters AS/command output"

4) Depends on "SFC properties/operating parameters AS/time monitoring"

6) Depends on "SFC properties/operating parameters AS/step control mode"
### 12.3.4 Group displays and group acknowledgements (SFC inputs/outputs)

**SFC inputs/outputs of the group displays and group acknowledgements**

You will find explanations of the table entries in the section: **Meanings in the table**

(Page 169)

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>S_ERRCA</td>
<td>Confirm all step errors (only in AUTO)</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
</tr>
<tr>
<td>S_ERRG</td>
<td>Group display &quot;Step error&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
</tr>
<tr>
<td>T_OPRQCA</td>
<td>Confirmation of all operator prompts (only in AUTO)</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
</tr>
<tr>
<td>T_OPRQG</td>
<td>Group display &quot;Operator prompt at transition&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
</tr>
</tbody>
</table>

"Confirm all" control and display section

Confirm all step errors and all operator prompts with button.

### 12.3.5 Data from sequencers and steps to be processed (SFC inputs/outputs)

**SFC inputs/outputs of the data from sequencers and steps to be processed**

You will find explanations of the table entries in the section: **Meanings in the table**

(Page 169)

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
<th>O&amp;M</th>
</tr>
</thead>
<tbody>
<tr>
<td>CUSEQ</td>
<td>No. of current sequencer</td>
<td>BYTE</td>
<td>0</td>
<td>O</td>
<td>+</td>
</tr>
<tr>
<td>CUSTEP</td>
<td>No. of current step</td>
<td>WORD</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>CUSTEPACTSTATE</td>
<td>Active state of current step</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>CUSTEPCOUNT</td>
<td>Number of active steps</td>
<td>BYTE</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>CUSTEPERRSTATE</td>
<td>Error state of current step</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>CUSTEPHELDSSTATE</td>
<td>Held state of current step</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>CUSTEPMAXRT</td>
<td>Max. run time of the current step</td>
<td>TIME</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>CUSTEPMINRT</td>
<td>Min. run time of the current step</td>
<td>TIME</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>CUSTEPRRT</td>
<td>Run time of the current step</td>
<td>TIME</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>CUTFTRANS</td>
<td>Number of the current transition</td>
<td>WORD</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>CUTFTRANSCOUNT</td>
<td>Number of active transitions</td>
<td>BYTE</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>CUTFTRANSRESULT</td>
<td>Result of first active transition</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>HELDSEQ</td>
<td>No. of held sequencer</td>
<td>BYTE</td>
<td>0</td>
<td>O</td>
<td>+</td>
</tr>
<tr>
<td>HELDSTEP</td>
<td>No. of held step</td>
<td>WORD</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>HELDSTECOUNT</td>
<td>Number of held steps</td>
<td>BYTE</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>HELDSTEPEXPRT</td>
<td>Error status of held step</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>HELDSTEPHELDSSTATE</td>
<td>State of the held step</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
</tbody>
</table>
### Standard interface and chart I/Os

#### 12.3 SFC inputs/outputs sorted by usage

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
<th>O&amp;M</th>
</tr>
</thead>
<tbody>
<tr>
<td>HELDSTEPRT</td>
<td>Run time of held step(s)</td>
<td>TIME</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>HELDTRANS</td>
<td>No. of held transition</td>
<td>WORD</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>HELDTRANSCOUNT</td>
<td>Number of held transitions</td>
<td>BYTE</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>HELDTRANSRESULT</td>
<td>Result of first held transition</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>LASTSEQ</td>
<td>No. of last active sequencer</td>
<td>BYTE</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>LASTSTEP</td>
<td>No. of last active step</td>
<td>WORD</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
</tbody>
</table>

### Note

For step or transition related values (CUSTEPx, CUTRANSx, HELDSTEPx, HELDTRANSx, LASTSTEP) only the value of the first step or the first active transition will be indicated.

The number of active steps/transitions is indicated by xCOUNT.
12.3.6 BATCH parameters (SFC inputs/outputs)

SFC inputs/outputs of the BATCH parameters

You will find explanations of the table entries in the section: Meanings in the table
(Page 169)

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
<th>O&amp;M</th>
</tr>
</thead>
<tbody>
<tr>
<td>BA_CONTROL</td>
<td>BATCH control word</td>
<td>DWORD</td>
<td>0</td>
<td>IO</td>
<td>+</td>
</tr>
<tr>
<td></td>
<td>(internal interface)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>BA_EN</td>
<td>BATCH: Enable</td>
<td>BOOL</td>
<td>1</td>
<td>I</td>
<td>+</td>
</tr>
<tr>
<td>BA_ID</td>
<td>BATCH: Consecutive batch number</td>
<td>DWORD</td>
<td>0</td>
<td>I</td>
<td>+</td>
</tr>
<tr>
<td>BA_NA</td>
<td>BATCH: Batch name</td>
<td>STRING[32]</td>
<td>&quot;</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>BA_STATE</td>
<td>BATCH status word</td>
<td>DWORD</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>OCCUPIED</td>
<td>BATCH: &quot;Occupied&quot; identifier</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>QBA_EN</td>
<td>BATCH: Enable</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>QBA_ID</td>
<td>BATCH: Consecutive batch number</td>
<td>DWORD</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>QBA_NA</td>
<td>BATCH: Batch name</td>
<td>STRING[32]</td>
<td>&quot;</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>QOCCUPIED</td>
<td>BATCH: &quot;Occupied&quot; identifier</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>Q_REFRESH</td>
<td>BATCH: Read in setpoints/process</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td></td>
<td>values again</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>QSTEP_NO</td>
<td>BATCH: Step number</td>
<td>DWORD</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>QSTEP_T</td>
<td>BATCH: Current step run time [s]</td>
<td>DINT</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>REFRESH</td>
<td>BATCH: Read in setpoints/process</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td></td>
<td>values again</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>STEP_NO</td>
<td>BATCH: Step number</td>
<td>DWORD</td>
<td>0</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>STEP_T</td>
<td>BATCH: Max. step run time [s]</td>
<td>DINT</td>
<td>0</td>
<td>I</td>
<td></td>
</tr>
</tbody>
</table>

Key

*) Only for SFC type
**) Only for SFC chart
12.3.7 Continuous mode (SFC inputs/outputs)

**SFC connections for continuous mode**

You will find explanations of the table entries in the section: Meanings in the table (Page 169)

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>CONT</td>
<td>&quot;Continuous mode&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
</tr>
<tr>
<td>CONT_T *)</td>
<td>Max. run time for &quot;Continuous mode&quot; [s]</td>
<td>DINT</td>
<td>0</td>
<td>I</td>
</tr>
<tr>
<td>QCONT *)</td>
<td>&quot;Continuous mode&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
</tr>
<tr>
<td>QCONT_T *)</td>
<td>Current run time for &quot;Continuous mode&quot; [s]</td>
<td>DINT</td>
<td>0</td>
<td>O</td>
</tr>
<tr>
<td>QCONT_T_ERR *)</td>
<td>Max. run time for &quot;Continuous mode&quot; exceeded</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
</tr>
<tr>
<td>ENASTART</td>
<td>Enable &quot;Start in Run&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
</tr>
</tbody>
</table>

**Key**

*) Only for SFC type

For an explanation of the cooperation between user controls and SFCs, refer to the section: Continuous Mode (Page 253)

12.3.8 Error handling (SFC inputs/outputs)

**SFC inputs/outputs of the error handling**

You will find explanations of the table entries in the section: Meanings in the table (Page 169)

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>ERRG</td>
<td>Group error (EXT_ERR</td>
<td>OP_ERR</td>
<td>LI_ERR</td>
<td>S_ERRG)</td>
</tr>
<tr>
<td>EXEC_ERR</td>
<td>Runtime error, e.g., step error, CPU restart</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
</tr>
<tr>
<td>EXT_ERR</td>
<td>External error</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
</tr>
<tr>
<td>LI_ERR</td>
<td>Parameter assignment error</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
</tr>
<tr>
<td>OP_ERR</td>
<td>Operator error</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
</tr>
<tr>
<td>QEXT_ERR</td>
<td>External error (= EXT_ERR)</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
</tr>
<tr>
<td>QDIS_START</td>
<td>&quot;Start&quot; not possible (e.g. LI_ERR, OP_ERR, ...)</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
</tr>
</tbody>
</table>
Calculation of LI_ERR and LL_ERR_STATE

**AUTO**

- Control strategy (SFC type only)
  - The control strategy is checked when QPARAM = 1:
    - Bit 0 - if control strategy high limit is violated (CS > CS_HL)
    - Bit 0 - if control strategy low limit is violated (CS < CS_LL)
    - Bit 0 - if control strategies exist (CS_LL > 0) and the prepared control strategy (CS) is not enabled (SELCS)

- Setpoint (SFC type only)
  - The setpoint is checked when QPARAM = 1:
    - Bit 1 - if setpoint high limit is violated (<setpoint> > <setpoint>_HL)
    - Bit 1 - if setpoint low limit is violated (<setpoint> < <setpoint>_LL)
    - Bit 1 - if setpoint high limit < low limit (<setpoint>_HL < <setpoint>_LL)

- Automatic commands:
  - Bit 2 - more than one command at the same time (e.g., START and HOLD, etc.)
  - Bit 3 - simultaneous changeover to MANUAL and AUTO (MAN = 1 and AUT = 1)

- Execution options:
  - Bit 4 - SCT = 0 and SCT_TAC = 0
  - Bit 4 - SCT = 1 and SCT_TAC = 1

**MANUAL**

- Execution options:
  - Bit 5 - SELFRESET = 1 and "Cyclic Operation" control and display section (neither SELFRESET nor "Cyclic Operation" is executed)

- Internal commands and external interlocks
  - Bit 6 - more than one internal command at the same time (e.g., INTABORT and INTCOMPLETE) (1 cycle)
  - Bit 7 - more than one external interlock at the same time (e.g., LOCKABORT and LOCKCOMPLETE)
  - Bit 8 - internal commands and external interlock at the same time (INT...+LOCK...) (1 cycle)
Command execution and LI_ERR

The following commands are not executed if LI_ERR is set to 1:

**AUTO**
- START (see also QDIS_START), COMPLETE, HOLD, RESUME, RESET

**AUTO + MANUAL**
- INTCOMPLETE, INTHOLD, INTRESUME, INTRESET, INTSTART
- LOCKCOMPLETE, LOCKHOLD

The following commands are also executed if LI_ERR is set to 1:

**AUTO + MANUAL**
- INTERROR, INTSTOP, INTABORT
  - LOCKERROR, LOCKSTOP, LOCKABORT

Calculation of OP_ERR and OP_ERR_STATE (SFC type only)

The following checks in MANUAL mode result in OP_ERR (for one AS execution cycle):

- **Control Strategy**
  - Bit 0 - if control strategy high limit is violated (CSP_OP > CS_HL) (1 cycle)
  - Bit 0 - if control strategy low limit is violated (CSP_OP < CS_LL) (1 cycle)
  - Bit 0 - if control strategies exist (CS_LL > 0) and the prepared control strategy (CSP_OP) is not enabled (SELCS).

- **Setpoints**
  - Bit 1 - if setpoint high limit is violated (<setpoint>_OP > <setpoint>_HL) (1 cycle)
  - Bit 1 - if setpoint low limit is violated (<setpoint>_OP < <setpoint>_LL) (1 cycle)
  - Bit 1 - if setpoint high limit < low limit (<setpoint>_HL < <setpoint>_LL)

Calculation of QDIS_START and DIS_START_STATE

**AUTO**
- Bit 0 (SFC type only) Control strategy and setpoint have not yet been checked (QPARAM = 0) or are bad
- Bit 1 In "Run" mode, the "Start in Run" enable is not set (ENASTART = 0) and/or continuous mode is not set (QCONT = 0)

**MANUAL**
- Bit 2 In "Run" mode, the "Start in Run" enable is not set (ENASTART = 0)
- Bit 3 There is an OP_ERR
AUTO + MANUAL

- Bit 4 There is an LI_ERR
- Bit 5 No "Start" enable (ENSTART = 0)
- Bit 6 There is an external interlock (LOCKERROR, LOCKHOLD, LOCKABORT, LOCKCOMPLETE, LOCKSTOP)
- Bit 7 There is the internal command INTERROR
- Bit 8 (SFC type only) If control strategies are configured but none is selected (QCSP = 0)
- Bit 9 The transition to STARTING has been executed
- Bit 10 An AUTO/MANUAL changeover has just been executed (1 cycle long)
### 12.3.9 Messages (SFC inputs/outputs)

**SFC inputs/outputs of the messages**

You will find explanations of the table entries in the section: **Meanings in the table** (Page 169)

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
<th>O&amp;M</th>
</tr>
</thead>
<tbody>
<tr>
<td>AUX_PR04..10 *)</td>
<td>Associated value 4..10</td>
<td>ANY</td>
<td>0</td>
<td>IO</td>
<td>M</td>
</tr>
<tr>
<td>MSG_ACK *)</td>
<td>Acknowledge messages (ALARM_8P)</td>
<td>WORD</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>MSG_ERR *)</td>
<td>Message error (ALARM_8P)</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>MSG_EVID</td>
<td>Message number (ALARM_8P)</td>
<td>DWORD</td>
<td>0</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>MSG_LOCK</td>
<td>Lock messages: 0: Messages not locked 1: Messages locked</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td>+</td>
</tr>
<tr>
<td>MSG_STAT</td>
<td>Message status (ALARM_8P)</td>
<td>WORD</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>MSG_SUP</td>
<td>Message suppression (ALARM_8P)</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td>+</td>
</tr>
<tr>
<td>NMSG_EVID **)</td>
<td>Message number (NOTIFY)</td>
<td>DWORD</td>
<td>0</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>NMSG_EVID1 *)</td>
<td>Message number 1 (NOTIFY_8P)</td>
<td>DWORD</td>
<td>0</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>NMSG_EVID2 *)</td>
<td>Message number 2 (NOTIFY_8P)</td>
<td>DWORD</td>
<td>0</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>NMSG_STAT1 *)</td>
<td>Message status 1 (NOTIFY_8P)</td>
<td>WORD</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>NMSG_STAT2 *)</td>
<td>Message status 2 (NOTIFY_8P)</td>
<td>WORD</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>NSIG_12..16 *)</td>
<td>Generate event message 12..16 (NOTIFY_8P)</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
<td></td>
</tr>
<tr>
<td>RUNUPCYC *)</td>
<td>Number of run-up cycles</td>
<td>INT</td>
<td>3</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>SIG_2..8 *)</td>
<td>Generate message 2..8 (ALARM_8P)</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
<td></td>
</tr>
<tr>
<td>BA_ID</td>
<td>Associated value 1 (ALARM_8P, NOTIFY, NOTIFY_8P)</td>
<td>DWORD</td>
<td>0</td>
<td>I</td>
<td>+</td>
</tr>
<tr>
<td>BA_NA</td>
<td>Associated value 2 (ALARM_8P, NOTIFY, NOTIFY_8P)</td>
<td>STRING[32]</td>
<td></td>
<td></td>
<td>+</td>
</tr>
<tr>
<td>STEP_NO</td>
<td>Associated value 3 (ALARM_8P, NOTIFY, NOTIFY_8P)</td>
<td>DWORD</td>
<td>0</td>
<td>I</td>
<td>+</td>
</tr>
</tbody>
</table>

**Key**

*) Only for SFC type

**) Only for SFC chart
12.3.10 Control words (SFC inputs/outputs)

SFC inputs/outputs of the control words

You will find explanations of the table entries in the section: Meanings in the table (Page 169)

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
<th>O&amp;M</th>
</tr>
</thead>
<tbody>
<tr>
<td>BA_CONTROL *)</td>
<td>BATCH control word (internal interface)</td>
<td>DWORD</td>
<td>0</td>
<td>IO</td>
<td>+</td>
</tr>
<tr>
<td>SFC_CONTROL</td>
<td>SFC control word (internal interface)</td>
<td>DWORD</td>
<td>0</td>
<td>IO</td>
<td>+</td>
</tr>
</tbody>
</table>

Key

*) Only for SFC type

Use of the inputs/outputs

- SIMATIC BATCH uses BA_CONTROL to send commands to the SFC (in AUTO).
- SFC_CONTROL allows the control and display section to send commands to the SFC (in MANUAL).
12.3.11 Status words (SFC inputs/outputs)

Status words of the SFC inputs/outputs

You will find explanations of the table entries in the section: Meanings in the table (Page 169)

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
<th>O&amp;M</th>
</tr>
</thead>
<tbody>
<tr>
<td>BA_ADDSTATE</td>
<td>Additional BATCH status word</td>
<td>DWORD</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>BA_STATE</td>
<td>BATCH status word</td>
<td>DWORD</td>
<td>0</td>
<td>O</td>
<td>+</td>
</tr>
<tr>
<td>SFC_STATE</td>
<td>SFC status word</td>
<td>DWORD</td>
<td>0</td>
<td>O</td>
<td>+</td>
</tr>
<tr>
<td>USTATUS *)</td>
<td>Status word in VSTATUS (can be set as required by user)</td>
<td>WORD</td>
<td>0</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>VSTATUS *)</td>
<td>Status word</td>
<td>DWORD</td>
<td>0</td>
<td>O</td>
<td>+</td>
</tr>
</tbody>
</table>

Key

*) Only for SFC type

BA_ADDSTATE

<table>
<thead>
<tr>
<th>Bit</th>
<th>Meaning</th>
<th>Source</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Identifier &quot;Self-completing&quot;</td>
<td>SELFCOMP</td>
</tr>
<tr>
<td>1</td>
<td>Identifier &quot;Self-resetting&quot;</td>
<td>SELFRESET</td>
</tr>
<tr>
<td>2</td>
<td>Enable &quot;Start in Run&quot;</td>
<td>ENASTART</td>
</tr>
<tr>
<td>3</td>
<td>Reserved for internal use</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>CPU_RESTART Restart of the CPU</td>
<td>RTS</td>
</tr>
<tr>
<td>6</td>
<td>1 = CPU restart after stop during block processing</td>
<td>RTS</td>
</tr>
<tr>
<td>7</td>
<td>1 = SFC Startup after CPU Restart &gt; Option: Initialize SFC</td>
<td>RTS</td>
</tr>
<tr>
<td>8</td>
<td>1 = SFC block is being processed</td>
<td>RTS</td>
</tr>
</tbody>
</table>
## BA_STATE

<table>
<thead>
<tr>
<th>Bit</th>
<th>Meaning</th>
<th>Source</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Operating state &quot;Idle&quot;</td>
<td>IDLE</td>
</tr>
<tr>
<td>1</td>
<td>Operating state &quot;Run&quot;</td>
<td>RUN / HELD_ERROR **)</td>
</tr>
<tr>
<td>2</td>
<td>Operating state &quot;Completed&quot;</td>
<td>COMPLETED</td>
</tr>
<tr>
<td>3</td>
<td>Operating state &quot;Held&quot;</td>
<td>HELD</td>
</tr>
<tr>
<td>4</td>
<td>Operating state &quot;Aborted&quot;</td>
<td>ABORTED</td>
</tr>
<tr>
<td>5</td>
<td>&quot;Ready to complete&quot; state</td>
<td>READY_TC</td>
</tr>
<tr>
<td>6</td>
<td>Operating state &quot;Stopped&quot;</td>
<td>STOPPED</td>
</tr>
<tr>
<td>7</td>
<td>reserved</td>
<td>-</td>
</tr>
<tr>
<td>8</td>
<td>Identifier &quot;Monitoring time for continuous mode exceeded&quot;</td>
<td>QCONT_T_ERR</td>
</tr>
<tr>
<td>9</td>
<td>Operating state &quot;Starting&quot;</td>
<td>STARTING</td>
</tr>
<tr>
<td>10</td>
<td>Operating state &quot;Resuming&quot;</td>
<td>RESUMING / RESU_ERROR **)</td>
</tr>
<tr>
<td>11</td>
<td>Operating state &quot;Completing&quot;</td>
<td>COMPLETING / ERROR_COMPLETING **)</td>
</tr>
<tr>
<td>12</td>
<td>Operating state &quot;Holding&quot;</td>
<td>HOLDING</td>
</tr>
<tr>
<td>13</td>
<td>Operating state &quot;Aborting&quot;</td>
<td>ABORTING</td>
</tr>
<tr>
<td>14</td>
<td>Operating state &quot;Stopping&quot;</td>
<td>STOPPING</td>
</tr>
<tr>
<td>15</td>
<td>Reserved for S88 &quot;Pausing&quot;</td>
<td>-</td>
</tr>
<tr>
<td>16</td>
<td>Default MANUAL/AUTO mode</td>
<td>SFC properties/ operating parameters AS/ &quot;Mode&quot;</td>
</tr>
<tr>
<td>17</td>
<td>MANUAL/AUTO mode</td>
<td>QAUTMAN</td>
</tr>
<tr>
<td>18</td>
<td>BATCH: Enable</td>
<td>BA_EN/QBA_EN</td>
</tr>
<tr>
<td>19</td>
<td>BATCH: Identifier &quot;Run time exceeded&quot;</td>
<td>QSTEP_T &gt; STEP_T</td>
</tr>
<tr>
<td>20</td>
<td>Group display &quot;Operator prompt transition&quot;</td>
<td>T_OPRQG</td>
</tr>
<tr>
<td>21</td>
<td>BATCH: Read in setpoint/process values again</td>
<td>REFRESH / QREFRESH</td>
</tr>
<tr>
<td>22</td>
<td>Identifier &quot;Start lock&quot;</td>
<td>QDIS_START</td>
</tr>
<tr>
<td>23</td>
<td>ID &quot;Continuous mode&quot; (Continuous)</td>
<td>CONT &amp; RUN &amp; READY_TC</td>
</tr>
<tr>
<td>24</td>
<td>BATCH: &quot;Occupied&quot; identifier</td>
<td>OCCUPIED/QOCCUPIED</td>
</tr>
<tr>
<td>25</td>
<td>Operating state &quot;Error&quot;</td>
<td>ERROR / ERROR_COMPLETING **)</td>
</tr>
<tr>
<td>26</td>
<td>&quot;Execution&quot; error</td>
<td>EXEC_ERR</td>
</tr>
<tr>
<td>27</td>
<td>Group display &quot;Step run time exceeded&quot;</td>
<td>S_ERRG</td>
</tr>
<tr>
<td>28</td>
<td>&quot;Parameter assignment/interconnection&quot; error</td>
<td>LI_ERR</td>
</tr>
<tr>
<td>29</td>
<td>&quot;Operator input&quot; error</td>
<td>OP_ERR</td>
</tr>
<tr>
<td>30</td>
<td>&quot;External&quot; error</td>
<td>EXT_ERR/QEXT_ERR</td>
</tr>
<tr>
<td>31</td>
<td>BATCH: Group error</td>
<td>Bit25-30 ORed</td>
</tr>
</tbody>
</table>
### Key

| *) | Only for SFC type |
|**) | The state that was in effect before the error state is also displayed. |

### SFC_STATE

<table>
<thead>
<tr>
<th>Bit</th>
<th>Meaning</th>
<th>Source</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>&quot;Continuous mode&quot; state</td>
<td>CONT &amp; RUN &amp; READY_TC</td>
</tr>
<tr>
<td>6</td>
<td>&quot;Ready to complete&quot; state</td>
<td>READY_TC</td>
</tr>
<tr>
<td>7</td>
<td>AUTO/MANUAL mode</td>
<td>QAUTMAN (0=MANUAL, 1=AUTO)</td>
</tr>
<tr>
<td>8</td>
<td>Input error</td>
<td>OP_ERR</td>
</tr>
<tr>
<td>9</td>
<td>Interconnection/parameter assignment error</td>
<td>LI_ERR</td>
</tr>
<tr>
<td>10</td>
<td>&quot;AUTO&quot; operator enable</td>
<td>ENAAUT/QENAUT</td>
</tr>
<tr>
<td>11</td>
<td>&quot;MANUAL&quot; enable</td>
<td>ENMAN/QENMAN</td>
</tr>
<tr>
<td>12</td>
<td>&quot;Start&quot; operator enable</td>
<td>ENSTART &amp; *)</td>
</tr>
<tr>
<td>13</td>
<td>&quot;Complete&quot; operator enable</td>
<td>ENCOMPLETE &amp; *)</td>
</tr>
<tr>
<td>14</td>
<td>&quot;Hold&quot; operator enable</td>
<td>ENHOLD &amp; *)</td>
</tr>
<tr>
<td>15</td>
<td>&quot;Resume&quot; operator enable</td>
<td>ENRESUME &amp; *)</td>
</tr>
<tr>
<td>16</td>
<td>&quot;Abort&quot; operator enable</td>
<td>ENABORT &amp; *)</td>
</tr>
<tr>
<td>17</td>
<td>&quot;Stop&quot; operator enable</td>
<td>ENSTOP &amp; *)</td>
</tr>
<tr>
<td>18</td>
<td>&quot;Restart&quot; operator enable</td>
<td>ENRESTART &amp; *)</td>
</tr>
<tr>
<td>19</td>
<td>&quot;Reset&quot; operator enable</td>
<td>ENRESET &amp; *)</td>
</tr>
<tr>
<td>20</td>
<td>&quot;Error&quot; operator enable</td>
<td>*)</td>
</tr>
<tr>
<td>21</td>
<td>Adopt default operating parameters when SFC starts</td>
<td>SFC properties/operating parameters AS/ &quot;Use default operating parameters...&quot;</td>
</tr>
</tbody>
</table>
Standard interface and chart I/Os
12.3 SFC inputs/outputs sorted by usage

<table>
<thead>
<tr>
<th>Bit</th>
<th>Meaning</th>
<th>Source</th>
</tr>
</thead>
<tbody>
<tr>
<td>22</td>
<td>Group display &quot;Operator prompt&quot;</td>
<td>T_OPRQG</td>
</tr>
<tr>
<td>23</td>
<td>Group display &quot;Step error&quot;</td>
<td>S_ERRG</td>
</tr>
<tr>
<td>24-26</td>
<td>Control mode bit 0..2</td>
<td>0: QSCT 1: QSCTOC 2: QSCTAC 3: QSCC 4: QSCT_TAC</td>
</tr>
<tr>
<td>27</td>
<td>CPU restart after stop with active SFC</td>
<td>CPU-RESTART (consistent data)</td>
</tr>
<tr>
<td>28</td>
<td>CPU restart after stop during module processing</td>
<td>CPU-RESTART (inconsistent data)</td>
</tr>
<tr>
<td>29</td>
<td>Command Output</td>
<td>MANUAL: Control and display section &quot;Command Output&quot; AUTO:INSTRUT</td>
</tr>
<tr>
<td>30</td>
<td>Cyclic operation</td>
<td>MANUAL: Control and display section &quot;Cyclic Operation&quot; AUTO:CYCLEXEC</td>
</tr>
<tr>
<td>31</td>
<td>Time monitoring</td>
<td>MANUAL: Control and display section &quot;Time Monitoring&quot; AUTO:TIMEMON</td>
</tr>
<tr>
<td>*)</td>
<td>Depending on the operating state (see: Operating state logic for SFC (SFC OSL) (Page 248))</td>
<td></td>
</tr>
</tbody>
</table>

USTATUS (SFC type only)

<table>
<thead>
<tr>
<th>Bit</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>0-15</td>
<td>User-assigned</td>
</tr>
</tbody>
</table>
### VSTATUS (SFC type only)

<table>
<thead>
<tr>
<th>Bit</th>
<th>Meaning</th>
<th>Source</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Operating state &quot;Idle&quot;</td>
<td>IDLE</td>
</tr>
<tr>
<td>1</td>
<td>Operating state &quot;Starting / Run&quot;</td>
<td>RUN / STARTING / RESU_ERROR</td>
</tr>
<tr>
<td>2</td>
<td>Operating state &quot;Completing / Completed&quot;</td>
<td>COMPLETED / COMPLETING / ERROR_COMPETING</td>
</tr>
<tr>
<td>3</td>
<td>Operating state &quot;Held / Error&quot;</td>
<td>HELD / HOLDING / ERROR / HELD_ERROR</td>
</tr>
<tr>
<td>4</td>
<td>Operating state &quot;Aborted&quot;</td>
<td>ABORTED / ABORTING</td>
</tr>
<tr>
<td>5</td>
<td>Operating state &quot;Ready to complete&quot;</td>
<td>READY_TC</td>
</tr>
<tr>
<td>6</td>
<td>Operating state &quot;Stopped&quot;</td>
<td>STOPPED / STOPPING</td>
</tr>
<tr>
<td>7</td>
<td>reserved</td>
<td>-</td>
</tr>
<tr>
<td>8</td>
<td>Operating state &quot;Error&quot;</td>
<td>ERROR / ERROR_COMPETING</td>
</tr>
<tr>
<td>9</td>
<td>Transitional state &quot;...ING&quot;</td>
<td>&quot;...ING&quot; / ERROR</td>
</tr>
<tr>
<td>10</td>
<td>MANUAL/AUTO mode</td>
<td>QAUTMAN (0 = MANUAL, 1 = AUTO)</td>
</tr>
<tr>
<td>11</td>
<td>ID &quot;Continuous mode&quot; (Continuous)</td>
<td>CONT &amp; RUN &amp; READY_TC</td>
</tr>
<tr>
<td>12</td>
<td>SFC group error</td>
<td>ERRG</td>
</tr>
<tr>
<td>13</td>
<td>free</td>
<td>-</td>
</tr>
<tr>
<td>14</td>
<td>free</td>
<td>-</td>
</tr>
<tr>
<td>15</td>
<td>free</td>
<td>-</td>
</tr>
<tr>
<td>16-31</td>
<td>USTATUS Bit 0-15</td>
<td>-</td>
</tr>
</tbody>
</table>
12.3.12  System parameters (SFC inputs/outputs)

SFC inputs/outputs of the system parameters

You will find explanations of the table entries in the section: Meanings in the table (Page 169)

Special

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>MODE</td>
<td>Edit mode:</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
</tr>
<tr>
<td></td>
<td>0: Cyclic processing in cyclic interrupt OB</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>1: One-time processing in startup OB</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SFC_INIT</td>
<td>Initialize SFC</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
</tr>
</tbody>
</table>

- The MODE parameter is preset by the SFC code generator for insertion of the SFC instance in the startup OB or cyclic interrupt OB and must not be modified.
- The SFC_INIT parameter is used to initialize the SFC instance for test purposes and must not be used.

12.3.13  Reserves (SFC inputs/outputs)

SFC inputs/outputs of the reserves

The reserve parameters fill offset gaps and are intended for future expansions and must therefore not be used!

You will find explanations of the table entries in the section: Meanings in the table (Page 169)

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
<th>Attr.</th>
<th>O&amp;M</th>
</tr>
</thead>
<tbody>
<tr>
<td>SFC chart</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IORES1..6</td>
<td>Reserved for internal use</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
<td></td>
<td></td>
</tr>
<tr>
<td>IRES1..5</td>
<td>Reserved for internal use</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ORES_BY</td>
<td>Reserved for internal use</td>
<td>BYTE</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ORES1..15</td>
<td>Reserved for internal use</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SFC type</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IORES_BY</td>
<td>Reserved for internal use</td>
<td>BYTE</td>
<td>0</td>
<td>IO</td>
<td></td>
<td></td>
</tr>
<tr>
<td>IORES1..7</td>
<td>Reserved for internal use</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
<td></td>
<td></td>
</tr>
<tr>
<td>IRES1..3</td>
<td>Reserved for internal use</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ORES_BY1..3</td>
<td>Reserved for internal use</td>
<td>BYTE</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ORES1..24</td>
<td>Reserved for internal use</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
13 Compiling SFC charts and SFC types

13.1 Overview of compiling charts, types, and instances

Compiling

When compiling (scope: entire program), all charts, SFC types, and SFC instances of the current chart folder are converted to the source language and then compiled. If you have modified an SFC chart, SFC type or SFC instance, you have the option of compiling the changes only.

When you compile, first all SFC types then all SFC instances and then all SFC charts are compiled. Finally, the CFC charts are compiled.

The SFC type is compiled only if a compilation-relevant change in the type has been made since the last compilation.

A function block type containing the I/Os defined in the interface and the configured sequencers is generated from the SFC type provided with an interface. As with the SFC chart, an action FC and a transition FC are also generated.

During compilation, a consistency check is performed automatically. You can start this test regardless of the compiling process using the menu command SFC > Check Consistency.

Logs are created during the consistency check and when compiling and downloading. You can view the logs in the SIMATIC Manager with the menu command Options > Charts > Logs... and in the SFC and CFC with the menu command Options > Logs....

After compilation, you can download the user program to the target system and perform testing and commissioning.

CPU comparison

Select the menu command CPU > Compare if you want to compare the time stamp of the most recent changes before downloading.

A dialog box opens listing the date and time of the following changes:

- Last download-relevant change
- Last compilation
- Compilation of the loaded program

If the time stamp of the last download-relevant change is older than the last offline program change, this has no effect on the execution of the program in the CPU. You do not need to download the program again.

If the time stamp of the "Last compilation" is older than the time stamp of the most recent modification relevant to the download, you must compile the charts and download them to the CPU so that they match.
If the time stamp of the "Compilation of the loaded program" is older than the time stamp of
the "Last compilation," you must download the user program from the PC or programming
device to the CPU so that they match.

Additional information

You can find additional information about compiling in the following sections:
- Settings for Compiling/Downloading (Page 227)
- How to compile (Page 228)
- Overview of the Blocks Generated during Compilation (Page 229)
- Consistency check (Page 231)
- Logs (Page 301)
13.2 Settings for Compiling/Downloading

Making the settings

Select the menu command **Options > Customize > Compile/Download…**.

A dialog box opens in which you can find information about the resources related to compiling:

- You can specify which warning limits are to apply so that possible dangers are detected before you download.
- You can specify which resources should remain unused during compilation of the current chart folder. This can be useful, for example, if you want to solve an automation task partly with charts and partly by programming (for example, STL, LAD or SCL programs) and when you have functions (FCs) or data blocks (DBs) from other sources in your user program.
- You can see the statistics showing how many resources (DBs, FCs) are available for compiling and how many are already being used.
- You can specify whether an image of the loaded program will be generated for the comparison. The image is created as an XML document and assigned to the program. With it you can determine which differences exist between the data to be loaded and the loaded data exist prior to reloading.

**Note**

If you work only with CFC and SFC in your program, you can leave the default compilation settings unchanged.
13.3 How to compile

Compiling the chart folder

1. Select the menu command SFC > Compile.... A dialog box opens where you can select the relevant radio button to specify compilation of the "Entire program" (all objects are compiled) or "Changes" (only the objects changed since the last compilation are compiled).

   A dialog box for configuring the compilation settings opens.

2. Select whether to compile the "Entire program" or "Changes".

3. Optional: Deactivate the check box "Generate Module Driver" if for example your hardware is still incomplete for this compiling process. This deactivation only applies for this compile, for the next compile the check box is reactivated.

4. Optional: Activate the check box "Generate SCL Source" if you want to view a certain part of the program, for reasons of better understanding for example or for troubleshooting in the SCL code.

   An SCL source file will be generated and saved in the source folder only if the check box is selected. This source file is not needed for compiling the program.

   The deactivated check box is only valid for one compile; at the next compile it is deactivated again.

5. Click "OK". The dialog box closes and the compilation starts.

Result

The charts of the current program (chart folder) are checked for consistency and then compiled. The messages from the consistency check are written to a log file. If "errors" and "warnings" occur, you can jump to the relevant SFC by double-clicking the message.

During compilation, a dialog box with a progress bar is displayed. You can stop the compilation at any time by clicking "Cancel".

Viewing and printing logs

Select the menu command Options > Logs... to view and print messages from the consistency check or compilation.

Note

You can also perform a consistency check without compiling. To do so, select the menu command SFC > Check Consistency....

You will find more detailed information in: Consistency check (Page 231) .
13.4 Overview of the Blocks Generated during Compilation

Introduction

Understanding the following relationships can be helpful if you want to control the use of resources in the CPU.

Overview

The structure you have configured in SFCs is mapped to the S7 objects function block, function (FC) and data block (DB). All charts (CFC and SFC) of a chart folder are always compiled.

Each SFC in the chart folder is mapped as follows during compilation:

<table>
<thead>
<tr>
<th>SFC chart</th>
<th>1 instance DB + n sequencer DBs + 2 FCs</th>
</tr>
</thead>
<tbody>
<tr>
<td>SFC type</td>
<td>1 FB + 2 FCs</td>
</tr>
<tr>
<td>SFC instance</td>
<td>1 instance DB + n sequencer DBs</td>
</tr>
</tbody>
</table>

In order for the SFC charts/SFC instances to be executed in the AS, the following blocks are also present in the block folder (depending on the configuration):

<table>
<thead>
<tr>
<th>Object name</th>
<th>Symbolic name</th>
<th>For Chart (C) / Type (T)</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>FB 245</td>
<td>@SFC_BZL</td>
<td>C / T</td>
<td>Operating state logic</td>
</tr>
<tr>
<td>FB 246</td>
<td>@SFC_ESM</td>
<td>C / T</td>
<td>Sequencer execution</td>
</tr>
<tr>
<td>FB 300</td>
<td>@SFC_RTS</td>
<td>P (V6.0 and higher)</td>
<td>Runtime system</td>
</tr>
<tr>
<td>FB 300</td>
<td>@SFC_INTP</td>
<td>P (up to V5.x)</td>
<td>Runtime system</td>
</tr>
<tr>
<td>FC 240</td>
<td>@SFC_OPI</td>
<td>T</td>
<td>Auxiliary block for INT setpoint</td>
</tr>
<tr>
<td>FC 241</td>
<td>@SFC_OPDI</td>
<td>T</td>
<td>Auxiliary block for DINT setpoint</td>
</tr>
<tr>
<td>FC 242</td>
<td>@SFC_OPR</td>
<td>T</td>
<td>Auxiliary block for REAL setpoint</td>
</tr>
<tr>
<td>FC 243</td>
<td>@SFC_OPB</td>
<td>T</td>
<td>Auxiliary block for BOOL setpoint</td>
</tr>
<tr>
<td>FC 244</td>
<td>@SFC_OPS</td>
<td>T</td>
<td>Auxiliary block for STRING setpoint</td>
</tr>
<tr>
<td>FC 250</td>
<td>@SFC_INDCALL</td>
<td>P</td>
<td>Auxiliary block for block calls</td>
</tr>
<tr>
<td>SFB 35</td>
<td>ALARM_8P</td>
<td>C / T</td>
<td>Messages with associated values for 8 signals</td>
</tr>
<tr>
<td>SFB 36</td>
<td>NOTIFY</td>
<td>P</td>
<td>Messages without acknowledgement display</td>
</tr>
<tr>
<td>SFB 31</td>
<td>NOTIFY_8P</td>
<td>T</td>
<td>Messages without acknowledgement display for 8 signals</td>
</tr>
</tbody>
</table>
If a "time" characteristic exists, the following block is also required:

<table>
<thead>
<tr>
<th>FB 5</th>
<th>TIMER_P</th>
<th>T</th>
<th>Pulse generator</th>
</tr>
</thead>
</table>

When you create a new SFC chart or SFC type, the required blocks are automatically copied to the block folder. For an SFC type, an additional copy of FB 247 is created (FB number is the first available number, for example, FB 1025).

Furthermore, additional FCs are required in order to call the blocks processed in the CFC according to the configured run sequence, as follows:

- One FC for each OB used
- One FC for each runtime group

DBs are used by the CFC as follows:

- An instance DB is created for each inserted block of a block type (FB).
- Pool DBs are created for storing interim results of FCs, for example. One pool DB is required per data type. When the maximum length (4 Kbytes) is reached, another DB is created.

The quantity of FCs and DBs available varies according to the CPU. You must allocate these as follows:

- FCs for block types
- FCs and DBs for the structures created with the STL, LAD and SCL programming languages
- FCs and DBs for compiled charts

**Calculation of SFC resources**

The section "Notes on Usage" in the SFC Readme contains an Excel file "SFC resources" that you can use to calculate your approximate system resource requirements.
13.5 Consistency check

Scope of the check

Prior to the actual compilation, the system automatically performs the following consistency checks:

- Check to determine whether the block types in the user program match the types imported in the CFC
  Inconsistencies can occur if block types in the user program have been changed or deleted following the block type import into the CFC.

- Check to determine whether symbolic references to shared addresses are entered in the symbol table
  Inconsistencies can occur if the relevant entries have not yet been made in the symbol table or if they have been changed or deleted.

- Check to determine whether the interconnected data blocks (DBs) are present in the user program
  Inconsistencies can occur if data blocks in the user program have been subsequently changed or deleted.

- Check to determine whether in/out parameters or block outputs of type "ANY", "STRING", "DATE_AND_TIME" or "POINTER" have been assigned (i.e., interconnected)
  Check to determine whether all blocks accessed by conditions and instructions from the SFC are present

You can also perform this consistency check without compiling, for example, if you want to check whether there is any point at all in compiling.

Procedure

1. To do so, select the menu command Chart > Check Consistency.
   All charts of the current folder are checked. When the check is completed, the result is shown in the "Logs" dialog box.

2. You can also read or print the log at a later time.

3. In SFC, select the menu command Options > Logs..., or in the SIMATIC Manager, select the menu command Options > Chart > Logs....

Additional information pertaining to the logs is available under: Logs (Page 301)
13.5 Consistency check
14.1 How to download programs

Introduction

In order to commission graphically generated charts/types for a CPU, the program must first be compiled and downloaded to the target system. The charts are downloaded to the CPU to which the user program containing the current chart folder is assigned.

Note

Programs created with SFC must always be downloaded to the CPU from SFC or CFC, since only this download function guarantees the consistency of the configuration data with the CPU data. The same download function is also used if you select the menu command CPU > Compile and Download Objects… in the SIMATIC Manager.

On the other hand, copying blocks in the "Offline Block Folder" to insert them in the "Online Block Folder" is not permitted.

Change log

The download to the CPU is - similar to working in test mode - a secure, logged function for S7 if SIMATIC Logon Service is installed and access protection and change logging are activated.

In addition to the change log of the SIMATIC Manager, in the ES the actions and the time stamp can be listed in the ES log when loading, if the current chart folder is activated for the ES log. Activate the selected chart folder in the dialog box of the object characteristics in the tab "ES Log".

For further information on this subject, refer to the CFC manual or the CFC online help under: The change log

Requirements for downloading

Before you can download, the following requirements must be met:

- There must be a connection between the CPU and your programming device or PC.
- Edit mode is set.
- The program is compiled.

Procedure

1. Select the Edit > Object Properties... menu command.
   The "Download" dialog box opens.
2. Select the download mode to specify if the "Entire program" or only "Changes" are to be downloaded to the CPU. You can also select the entire program in a "Download to test CPU".

3. Click "OK" to download the program.

If you have made download-relevant changes in the configuration and have not compiled since you made the changes, you will be prompted to compile before you download. If the compilation is free of errors, the download will be started automatically when the compilation is complete.

**Downloading the entire program**

The following is performed with the "Entire program" download mode:

- The CPU is set to "STOP" after a prompt for confirmation.
- All blocks in the CPU are deleted.
- All charts in the current chart folder are downloaded to the CPU.

**Notes on downloading the entire program**

- Compiling the entire program does not necessarily mean that a complete download is necessary. If the program was already downloaded to the CPU prior to compiling, it is possible to download the changes only.
- If you cancel a full download, no download of changes is possible until a full download has been completed. Reason: The blocks were deleted on the CPU prior to the download.

**Downloading changes**

In the "Changes" download mode with CPU in "RUN-P" mode, you can download changes in your configuration to the AS without having to change the CPU to STOP mode. With this type of download, you only download changes that have been made since the last download.

**Notes on downloading changes**

- If the sequencer topology has been changed in the SFC charts/SFC types, for example, steps or transitions have been added, deleted, copied, moved or jump destination has been changed, and if the modified sequencer is active in the AS, these charts or all instances of the type must be disabled. Disabling before the download and enabling after the download is handled by the download program following positive acknowledgment of a prompt. Otherwise, the download is aborted.
  
  If you perform the download with the SIMATIC Manager function "Compile and Download Objects", the SFCs are not automatically disabled. In this case, the download will not be performed and an error message is entered in the log.

- Modifications to the interface of the SFC type are transferred to the SFC instances immediately. For this reason, the SFC instances must be disabled during the downloads and execution must be suspended in the CPU. Disabling before the download and enabling after the download is handled by the download program following positive acknowledgment of a prompt. Otherwise, the download is aborted.
14.1 How to download programs

- For changed SFC charts/types/instances (SFC properties, sequencer properties, object properties of the step/transitions) whose sequencer topology have not changed, you can download the changes to the CPU in the RUN after compilation without having to deactivate the changed SFC.

- If you have not changed the SFC itself, but only the objects that are accessed (for example, a symbol in the symbol table, runtime groups, block I/O), you do not have to disable the SFC before downloading changes.

- Following a download of changes, a disabled SFC with the "Autostart: on" property is not started automatically but must be started again by the operator (MAN) or using the external view/SFC instance (AUTO).

You can find information about status transitions when deactivating the SFC under: Reaction of the SFC at deactivation before downloading changes only (Page 237)

Notes on H CPUs

- If the H CPU is in solo mode, for example, due to the failure of a CPU, and a CPU failover has taken place, when there is an online access, (in this case, downloading changes), a selection dialog box opens. In this dialog box, you can select the required CPU. This dialog box does not appear in redundant mode.

- If you download program changes to a CPU that is operating in solo mode and then perform a "switchover with modified configuration" using the menu command CPU > Operating Mode..., these changes are lost and you can only download the entire program.

Remedy: Download in redundant mode. In this case, you must make sure that the operating mode remains unchanged until the download is complete.

Note on F systems

Downloading changes in programs with a modified F component requires the entry of an F password. Without this legitimating, downloading is aborted.

Including user data blocks when downloading changes

The "Also download user data blocks" option is used as the default setting and is only relevant for downloading changes. All blocks, even user data blocks, are always downloaded when the entire program is downloaded.

If this check box is selected when you download changes, the following functions are performed for data blocks that are not in the SFC area:

- The data blocks are included in the download if the time stamp is different or data blocks have been added.

- The data blocks are deleted in the CPU if they do not exist in the S7 program.

If you want the user data blocks to be ignored when downloading changes, clear this check box. This can have the following consequences:
14.1 How to download programs

- If a user data block exists in the S7 program but does not exist in the CPU, downloading will be aborted with an error message.

- You receive a warning under the following conditions:
  - When the user data block is present in the CPU but is no longer present in the S7 program
  - When the user data block in the S7 program differs from the one in the CPU.

Correct execution of the program is then the user’s responsibility.

**Note**

Note that there is no absolute guarantee that the CPU will be prevented from changing to STOP mode when you download changes.

You will find more information on this subject in the CFC documentation under: System Support for Avoiding Causes of CPU STOP

**Downloading a modified program to a test CPU**

In the "Download to test CPU (Entire program)" download mode, you can download a modified program to a different CPU or to PLCSIM for testing purposes without losing the ability to download changes to the original CPU.

The entire program is downloaded to the test CPU (or to PLCSIM) without loss of the download identifiers and without the comparison time stamp being written to the ES data management.

You will find detailed information about downloading to the test CPU in the CFC online help under: Downloading a Modified Program to a Test CPU

**Displaying modifications before loading**

The "Show Changes" function is only available if the Version Cross Manager (VXM) add-on package is installed and if an image of the downloaded program was generated.

**Generating an image of the downloaded program**

Assuming you have selected "Generate image of downloaded program for comparison" in the "Settings for Compilation/Download" dialog box, the image will be generated as an XML document and assigned to the program following a successful download operation.

**Comparing programs**

If you generated an image of the downloaded program, you can click "Show Changes" in the "S7 Download" dialog box to run a comparison between the XML file and the program you now want to download before it is actually downloaded.

The VXM is then called and runs the comparison. The comparison will enable you to see which data have changed in relation to the program that was downloaded previously. You can then decide whether or not to download the latest version.
14.2 Reaction of the SFC at deactivation before downloading changes only

Status transitions at SFC deactivation

<table>
<thead>
<tr>
<th>Old state</th>
<th>Action</th>
<th>New state</th>
</tr>
</thead>
<tbody>
<tr>
<td>Starting</td>
<td>Running sequencer is aborted</td>
<td>Aborting</td>
</tr>
<tr>
<td>Running</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
<tr>
<td>Completing</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
<tr>
<td>Error (completing)</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
<tr>
<td>Completed</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
<tr>
<td>Holding</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
<tr>
<td>Held</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
<tr>
<td>Resuming</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
<tr>
<td>Error</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
<tr>
<td>Held (error)</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
<tr>
<td>Resuming (error)</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
<tr>
<td>Stopping</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
<tr>
<td>Stopped</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
<tr>
<td>Aborting</td>
<td>Wait until sequencer is completed (running sequencer is not aborted!)</td>
<td>Aborted</td>
</tr>
<tr>
<td>Idle</td>
<td>Running sequencer is aborted</td>
<td>Idle (loader can load)</td>
</tr>
<tr>
<td>Completed</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
<tr>
<td>Stopped</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
<tr>
<td>Aborted</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
</tbody>
</table>

Example 1

A sequencer is running with the "Error" state and this sequencer should be loaded. The following sequences occur:

<table>
<thead>
<tr>
<th>Old state</th>
<th>Action</th>
<th>New state</th>
</tr>
</thead>
<tbody>
<tr>
<td>Error</td>
<td>Running sequencer is aborted</td>
<td>Aborting</td>
</tr>
<tr>
<td>Aborting</td>
<td>Wait until sequencer is completed (running sequencer is not aborted!)</td>
<td>Aborted</td>
</tr>
<tr>
<td>Aborted</td>
<td>Running sequencer is aborted</td>
<td>Idle (loader can load)</td>
</tr>
<tr>
<td>Idle</td>
<td>Running sequencer is aborted</td>
<td>Idle</td>
</tr>
</tbody>
</table>
Example 2

A sequencer is running with the "Aborting" state and this sequencer should be loaded. The following sequences occur:

<table>
<thead>
<tr>
<th>Old state</th>
<th>Action</th>
<th>New state</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aborting</td>
<td>Wait until sequencer is completed (running sequencer is not aborted!)</td>
<td>Aborted</td>
</tr>
<tr>
<td>Aborted</td>
<td>Running sequencer is aborted</td>
<td>Idle</td>
</tr>
<tr>
<td>Idle</td>
<td>Running sequencer is aborted</td>
<td>Idle (loader can load)</td>
</tr>
</tbody>
</table>

Note

A sequencer is running in the "Aborting" state, cannot be deactivated by the loader if user confirmation is required by the configured step control mode.

Example 3

A sequencer is running with the "Idle" state and this sequencer should be loaded. The following sequences occur:

<table>
<thead>
<tr>
<th>Old state</th>
<th>Action</th>
<th>New state</th>
</tr>
</thead>
<tbody>
<tr>
<td>Idle</td>
<td>Running sequencer is aborted</td>
<td>Idle (loader can load)</td>
</tr>
</tbody>
</table>

You can find additional information about the effects of a modified SFC type under: Configuration changes in the SFC type (Page 78)
15.1 Sequential control systems in the AS

Requirements

- The SFC created with the SFC Editor has been specified with the following:
  - The sequencers (start condition and pre/postprocessing) and their sequencer topologies
  - The action functions of the steps
  - The conditions of the transitions
  - The runtime properties
- The program has been compiled and its blocks have been downloaded to the AS.

Changing the state of the sequential control system

After the program has been downloaded to the AS, the sequential control system is in a defined state. You specify this defined state with the SFC Editor (default setting: "Idle"). By assigning start conditions and processing sequences for the sequencers, different sequences are executed in the AS depending of the SFC status.

You can change the runtime behavior as follows.

- You can change operating parameters with the SFC Editor for testing and commissioning or on the OS.
  Example: the switch from "Transition (T)" to "Confirmation by operator (O)" step control mode
  or
- Switch the time monitoring from "off" to "on".

In order to achieve a desired operating state, for example, the SFC is influenced using commands that are input by the operator or are applied by the program.
Interaction with basic automation

The sequential control system in the AS relates to the basic automation using the action and transition functions. With parameter control, there are also relationships to the parameter data.

Each SFC is assigned a certain runtime behavior. The basic automation, including the blocks located in CFC charts, may have a different runtime behavior from that of the SFC chart. This can be controlled by placing the external view of an SFC chart in the CFC chart. In the same way, an SFC instance is controlled by the blocks placed in the CFC chart.

The structure of the runtime system allows the sequential control system and the blocks of the basic automation to run in different cycles, thereby reducing the cycle load. In the same way, SFCs can be inserted in runtime groups and can thus be given different reduction ratios / phase offsets.
15.2 Specifying the runtime behavior

15.2.1 Runtime behavior of the sequential control system

Basics of runtime behavior

The behavior of a sequential control system depends on operating parameters "Operating state", "Operating mode", and "Step control mode" and the execution options.

You can set the operating parameters when testing and commissioning or on the OS (SFC Visualization). Exception: The "Autostart" parameter can only be set in the properties dialog box for the SFC chart, SFC type or SFC instance in the "AS Operating Parameters" tab.

The default settings for the operating parameters are as follows:

<table>
<thead>
<tr>
<th>&quot;Defaults&quot; group</th>
<th></th>
<th>&quot;Start options&quot; group</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step control mode</td>
<td>T</td>
<td>Transition (process-driven)</td>
</tr>
<tr>
<td>Operating mode</td>
<td>MANUAL</td>
<td>Operator mode</td>
</tr>
<tr>
<td>Command output</td>
<td>On</td>
<td></td>
</tr>
<tr>
<td>Cyclic operation</td>
<td>Off</td>
<td></td>
</tr>
<tr>
<td>Time monitoring</td>
<td>Off</td>
<td></td>
</tr>
<tr>
<td>Autostart</td>
<td>Off</td>
<td></td>
</tr>
<tr>
<td>Use default operating parameters when SFC starts</td>
<td>Off</td>
<td></td>
</tr>
</tbody>
</table>

The following operating state is set after the CPU starts:

<table>
<thead>
<tr>
<th>State</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Idle</td>
<td>(if Autostart = off)</td>
</tr>
<tr>
<td>Starting</td>
<td>(if Autostart = on)</td>
</tr>
</tbody>
</table>

You will find more information on the AUTO/MAN changeover in the section: Operating modes (Page 242)
15.2.2 Operating modes

SFC operating modes

The operating mode decides whether the running of the program is controlled by the operator or automatically controlled by the AS program. SFC recognizes the following operating modes:

- **AUTO (Process mode)**
  The execution is controlled by the AS program.
  The program uses the parameter assignment and interconnections of inputs in the external view of the SFC chart or SFC instance set that you specified in the CFC chart to perform control.

- **MANUAL (operator mode)**
  Execution is controlled by operator commands or by changing the execution options, such as commissioning or SFV.

You can enable the changeover from MANUAL to AUTO or AUTO to MANUAL with an operator input in test mode or in SFC Visualization or in the interface of the chart (external view) or the SFC instance. The ENAUT and ENMAN inputs/outputs are provided for this.

For further information on the inputs/outputs, refer to the section *Operating modes (SFC inputs/outputs)* (Page 198)

15.2.3 Step Control Modes

Overview

The various step control modes change the behavior of the SFC when passing control from active steps to successor steps.

You can change the step control mode in all operating states. The individual step control modes are mutually exclusive. SFC recognizes the following step control modes:

<table>
<thead>
<tr>
<th>Code for the step control modes</th>
<th>Control using...</th>
</tr>
</thead>
<tbody>
<tr>
<td>T</td>
<td>Transition</td>
</tr>
<tr>
<td>T or O</td>
<td>Transition or confirmation by operator</td>
</tr>
<tr>
<td>T and O</td>
<td>Transition and confirmation by operator</td>
</tr>
<tr>
<td>O</td>
<td>Confirmation by operator</td>
</tr>
<tr>
<td>T/T and O</td>
<td>Step-specific confirmation by operator</td>
</tr>
</tbody>
</table>
Step control modes

T
Transition:
The sequential control system is process-driven (running automatically). When a transition is fulfilled, control is passed by disabling the predecessor steps and enabling the successor steps.

Step control mode "T" is possible in MANUAL mode (operator mode) or AUTO mode (process mode).

T or O
With transition or confirmation by operator:
The process or the operator controls the runtime of the sequential control system. An operator prompt is set for each successor transition of an active step, and the next step is enabled after operator input is made. If the transition is fulfilled before the operator input, the next step is enabled without operator input (automatically).

Step control mode "T or O" is only possible in MANUAL mode (operator mode).

T and O
With transition and confirmation by operator:
The process and the operator control the runtime of the sequential control system. When the successor transition of an active step is fulfilled, an operator prompt is set and the next step is enabled only after operator input has been made.

Step control mode "T and O" is only possible in MANUAL mode (operator mode).

O
Confirmation by operator:
Only the operator controls the runtime of the sequential control system. The transitions do not need to be fulfilled. An operator prompt is set for all successor transitions of each active step, and the next step is enabled after the operator input.

Step control mode "O" is only possible in MANUAL mode (operator mode).

T/T and O
Step-specific confirmation by operator:
The "Confirmation" label is set or reset on a step-specific basis in the "Properties" dialog box for the step. The sequential control system runs in the following modes:

- **Process-controlled** in steps without the "confirmation" option.
  Each completed transition following a step without this identifier passes on control without operator intervention (corresponds to "T").

- **Controlled by the operator** for steps with the "Confirmation" option.
  When an active step with the "Confirmation" option becomes true, the system prompts the operator to acknowledge the next step and then continues the sequencer (corresponds to "T and O").
Step control mode "T /T and O" is possible in MANUAL mode (operator mode) or AUTO mode (process mode).

**Note**
In step control modes "O" and "T or O", the **minimum run time** of the step can be overridden by the operator.
15.2.4 Execution Options

Introduction

You use the execution options to specify the behavior of the sequential control system. The individual execution options can be combined.

You can set the execution options in the "AS Operating Parameters" tab of the "Properties" dialog box. You open the dialog box with the menu command SFC > Properties....

Execution options of the SFC

- Command output
  - If "Command Output: on" is set, the actions of active steps are processed; If "Command Output: off" is set, they are not processed.
  - During commissioning, or if errors occur, blocking the command output in conjunction with suitable step control modes ("C", "T or C") can bring the sequential control system to a defined state without affecting the process.
  - If command output is off, the minimum run time of a step has no effect.
  - Changing the command output first takes effect after transition to the next step. Therefore, either all actions or no actions of a step are executed.

- Cyclic operation
  - If "Cyclic Operation: on" is set, execution is resumed automatically with "Starting" state after "Completed" state.
  - A sequencer that is to be processed in "Completed" state is exited again immediately in cyclic operation. Only the start step and final step are processed.
  - If you are working in MANUAL mode and using SFC inputs/outputs for state control, SELFRESET = 0 must be set in cyclic operation.
  - If you are working in AUTO mode, PARAM = 1 must be set (so that start disable QDIS_START = 0 can be set).
  - If "Cyclic Operation: Off" is set, the sequential control system remains in "Completed" state.
  - If there is no command to exit the state, "Completed" is always processed cyclically.
  - This behavior applies to all operating states that can be exited only by means of commands.

Information on the operating states can be found in section Operating state logic for SFC (SFC OSL) (Page 248)
15.2 Specifying the runtime behavior

- **Time monitoring**
  If "Time Monitoring: on" is set, after a step has been enabled the active time ("Current run time") of the step is continuously compared with the monitoring time ("Maximum run time") and a step error is reported if the time is exceeded.
  If "Time Monitoring: off" is set, there is no comparison of the active time and monitoring time.

- **Autostart**
  When an SFC has the property "Autostart: on", the SFC goes immediately to "Starting" state after a restart in the CPU without any operator intervention. An automatic start does not occur after downloading changes (CPU does not go to STOP). The SFC must be restarted by the operator or via the program (for example, from the external view in the CFC).
  If "Use default operating parameters when SFC starts : on" is set, all the defaults/options set in the runtime properties that, for example, have been changed in test mode are effective again when the SFC chart starts.
  The setting for "Autostart" can only be changed in the SFC > Properties > "Operating Parameters AS" dialog box.
15.2.5 Operating states

15.2.5.1 Operating States

Operating state of the sequential control system

The operating state of the sequential control system indicates the current execution status and the operating behavior. For example, you can see if operator intervention is necessary for continued operation or which commands are available for switching to a different operating state.

You can influence the operating state as follows:

- In operator mode (MANUAL) using commands in test mode and in SFC Visualization.
- In process mode (AUTO) using interconnections with the external view of the SFC chart or with the SFC instance.

Operating state logic

The operating state logic of SFC (SFC OSL) describes the following:

- The possible states of an SFC chart or an SFC instance
- The transitions that are possible in a particular state
- The events that bring about a state change

In addition to the SFC OSL, there is also a separate simpler operating state logic, i.e., the sequencer OSL, for the sequencers configured in an SFC. It describes the following:

- The possible states of a sequencer
- The transitions that are possible in a particular state
- The events that bring about a state change

The relationship between SFC OSL and sequencer OSL results from the possibility of being able to execute one (of several) sequencers of the SFC in every state of the SFC OSL.

You will find more information on operating states in the sections:

- Operating state logic for SFC (SFC OSL) (Page 248)
- Operating state logic for sequencers (sequencer OSL) (Page 256)
- Commands (Page 264)
15.2.5.2 Operating state logic for SFC (SFC OSL)

Changing the operating states

The current operating state of the SFC OSL can be changed through the following events:
- Commands (e.g., Start, Resume, Hold, etc.) in "MANUAL" or "AUTO" mode
- External signals (inputs of the SFC or commands from another SFC, for example)
- Internal signals (commands of own sequencers, from test mode or SFC Visualization).
- Implicit state change

The operating state logic of an SFC is defined by the diagram of the state changes.

You can find additional information about this in the section: Diagram of the State Changes for SFC OSL (Page 254)

Notes on diagram

The SFC OSL contains some state changes that have been retained in order to ensure compatibility with older projects. These are displayed with dashed blue lines in the diagram.

The numbers in the diagram are the identifiers for the individual operating states whose meaning is listed in the following tables.

Operating states (SFC OSL)

<table>
<thead>
<tr>
<th>No.</th>
<th>State</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Idle</td>
<td>Initial state; waiting for Start command.</td>
</tr>
<tr>
<td>2</td>
<td>Starting</td>
<td>Start processing after Start command.</td>
</tr>
<tr>
<td>3</td>
<td>Run</td>
<td>Normal processing after completion of the start processing.</td>
</tr>
<tr>
<td>4</td>
<td>Completing</td>
<td>Completion of processing after a Complete command or implicit completion.</td>
</tr>
<tr>
<td>5</td>
<td>Error (Completing)</td>
<td>Error processing during completion of processing.</td>
</tr>
<tr>
<td>6</td>
<td>Completed</td>
<td>Completion of processing is finished; waiting for Reset or Start command.</td>
</tr>
<tr>
<td>7</td>
<td>Holding</td>
<td>Hold processing after Hold command.</td>
</tr>
<tr>
<td>8</td>
<td>Held</td>
<td>Hold processing has completed; waiting for Resume command.</td>
</tr>
<tr>
<td>9</td>
<td>Resuming</td>
<td>Resume processing after Resume command.</td>
</tr>
<tr>
<td>10</td>
<td>Error</td>
<td>Error processing following error.</td>
</tr>
<tr>
<td>11</td>
<td>Held (Error)</td>
<td>Error processing is complete and no more errors are present; waiting for Resume command.</td>
</tr>
<tr>
<td>12</td>
<td>Resuming (Error)</td>
<td>Resume processing after Resume command.</td>
</tr>
<tr>
<td>13</td>
<td>Aborting</td>
<td>Abort processing after Abort command.</td>
</tr>
<tr>
<td>14</td>
<td>Aborted</td>
<td>Abort processing is complete; waiting for Reset or Start command.</td>
</tr>
<tr>
<td>15</td>
<td>Stopping</td>
<td>Stop processing after Stop command.</td>
</tr>
<tr>
<td>16</td>
<td>Stopped</td>
<td>Stop processing is complete; waiting for Reset command.</td>
</tr>
</tbody>
</table>
The following tables describe the transitions between the states (Source State No. / Destination State No.) as well as their triggers.

X = Possible from several states.

### State changes using commands (SFC OSL)

<table>
<thead>
<tr>
<th>Source/Target</th>
<th>Command MANUAL (AUTO)</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>X/2</td>
<td>START</td>
<td>Triggers start of processing by changing to the &quot;Starting&quot; state.</td>
</tr>
<tr>
<td>3/4</td>
<td>COMPLETE</td>
<td>Triggers completion of processing by changing to the &quot;Completing&quot; state</td>
</tr>
<tr>
<td>2/7 3/7</td>
<td>HOLD</td>
<td>Triggers holding of processing by changing to the &quot;Holding&quot; state</td>
</tr>
<tr>
<td>8/9 11/12</td>
<td>RESUME</td>
<td>Triggers resumption of processing by changing to the &quot;Resuming&quot; or &quot;Resuming (error)&quot; state</td>
</tr>
<tr>
<td>X/10 4/5</td>
<td>ERROR</td>
<td>Triggers error processing by changing to the &quot;Error&quot; or &quot;Error (Completing)&quot; state</td>
</tr>
<tr>
<td>X/13</td>
<td>ABORT</td>
<td>Triggers abortion of processing by changing to the &quot;Aborting&quot; state</td>
</tr>
<tr>
<td>X/15</td>
<td>STOP</td>
<td>Triggers stop processing by changing to the &quot;Stopping&quot; state</td>
</tr>
<tr>
<td>X/2 X/1</td>
<td>RESTART</td>
<td>Triggers start of processing by changing to the &quot;Starting&quot; state.</td>
</tr>
<tr>
<td></td>
<td>RESET</td>
<td>Changes to the &quot;Idle&quot; state</td>
</tr>
</tbody>
</table>
Behavior of the sequential control system in the AS

15.2 Specifying the runtime behavior

State changes using external signals (SFC OSL)

The external signals are inputs of the SFC that enable other blocks (for example, interlock blocks) to influence the transitions between states of the OSL.

However, the external signals work only within the limits of the OSL. Therefore, provision must be made for the state change in the state logic in order for this state change to occur.

<table>
<thead>
<tr>
<th>Source/ Target</th>
<th>External signal</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>3/4</td>
<td>LOCKCOMPLETE</td>
<td>Triggers completion of processing by changing to &quot;Completing&quot; state</td>
</tr>
<tr>
<td>2/7 3/7</td>
<td>LOCKHOLD</td>
<td>Triggers holding of processing by changing to &quot;Holding&quot; state</td>
</tr>
<tr>
<td>X/10 4/5</td>
<td>LOCKERROR</td>
<td>Triggers error processing by changing to &quot;Error&quot; or &quot;Error (Completing)&quot; state. The error processing is executed completely and the state then changes to &quot;Held (Error)&quot;. If an error is pending, the state changes back to &quot;Error&quot; immediately.</td>
</tr>
<tr>
<td>X/13</td>
<td>LOCKABORT</td>
<td>Triggers abortion of processing by changing to &quot;Aborting&quot; state</td>
</tr>
<tr>
<td>X/15</td>
<td>LOCKSTOP</td>
<td>Triggers stop processing by changing to &quot;Stopping&quot; state</td>
</tr>
</tbody>
</table>

State changes using internal signals (SFC OSL)

Internal signals are SFC internal commands that are set in steps to cause a state change in the SFC. The signals are checked by the OSL and reset automatically after a state change.

The internal signals only work within the limits of the OSL. Therefore, provision must be made for the state change in the state logic in order for this state change to occur.

<table>
<thead>
<tr>
<th>Source/ Target</th>
<th>Command</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>X/2</td>
<td>INTSTART</td>
<td>Triggers start of processing by changing to the &quot;Starting&quot; state.</td>
</tr>
<tr>
<td>3/4</td>
<td>INTCOMPLETE</td>
<td>Triggers completion of processing by changing to the &quot;Completing&quot; state</td>
</tr>
<tr>
<td>2/7 3/7</td>
<td>INTHOLD</td>
<td>Triggers holding of processing by changing to the &quot;Holding&quot; state</td>
</tr>
<tr>
<td>8/9 11/12</td>
<td>INTRESUME</td>
<td>Triggers resumption of processing by changing to the &quot;Resuming&quot; or &quot;Resuming (error)&quot; state</td>
</tr>
<tr>
<td>X/10 4/5</td>
<td>INTERROR</td>
<td>Triggers error processing by changing to the &quot;Error&quot; or &quot;Error (Completing)&quot; state</td>
</tr>
<tr>
<td>X/13</td>
<td>INTABORT</td>
<td>Triggers abortion of processing by changing to the &quot;Aborting&quot; state</td>
</tr>
<tr>
<td>X/15</td>
<td>INTSTOP</td>
<td>Triggers stop processing by changing to the &quot;Stopping&quot; state</td>
</tr>
</tbody>
</table>
### Implicit state changes (SFC OSL)

The states "Starting", "Completing", "Holding", "Resuming", "Error", "Resuming (Error)", "Aborting", and "Stopping" are transitional states. When a transitional state has been completely executed - in other words, there is no start condition fulfilled for a sequencer or a started sequencer has been completely executed - the state changes to the successor state defined in the OSL (implicit change).

The "Run" state is also treated as a transitional state if SFC input SELFCOMP=1 is set (default for chart and type). Otherwise, the "Run" state can only be exited explicitly with the "Complete" command.

#### Note

Switching from SELFCOMP=0 to SELFCOMP=1 only has an effect when the "Run" and "Ready to Complete" state have not yet occurred.

Transitional states can, of course, also be exited due to an external problem or with the "Abort" and "Stop" commands. In this case, the appropriate change is executed, and not the implicit change.

<table>
<thead>
<tr>
<th>Source/Target</th>
<th>Command</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>X/2</td>
<td>INTRESTART</td>
<td>Triggers start of processing by changing to the &quot;Starting&quot; state.</td>
</tr>
<tr>
<td>X/1</td>
<td>INTRESET</td>
<td>Changes to the &quot;Idle&quot; state</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Source/Target</th>
<th>SFC Status</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>2/3</td>
<td>Sequencer finished</td>
<td>Start processing finished; change to &quot;Run&quot;</td>
</tr>
<tr>
<td>3/4</td>
<td>Sequencer finished</td>
<td>Normal processing finished; change to &quot;Completed&quot; (prerequisite: external signal SELFCOMP=1)</td>
</tr>
<tr>
<td>4/6</td>
<td>Sequencer finished</td>
<td>Completion of processing finished; change to &quot;Completed&quot;</td>
</tr>
<tr>
<td>7/8</td>
<td>Sequencer finished</td>
<td>Hold processing finished; change to &quot;Held&quot;</td>
</tr>
<tr>
<td>x/3</td>
<td>Sequencer finished</td>
<td>Resume processing finished; change to &quot;Run&quot;</td>
</tr>
<tr>
<td>13/14</td>
<td>Sequencer finished</td>
<td>Abort processing finished; change to &quot;Aborted&quot;</td>
</tr>
<tr>
<td>15/16</td>
<td>Sequencer finished</td>
<td>Stop processing finished; change to &quot;Stopped&quot;</td>
</tr>
</tbody>
</table>
State control using SFC inputs/outputs (SFC OSL)

SELFCOMP, SELFRESET, RUNHOLD and CONT are configurable inputs of the SFC and influence the behavior of the OSL.

SELFCOMP is effective in "MANUAL" and "AUTO" modes.

<table>
<thead>
<tr>
<th>Source/Target</th>
<th>External Signal</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>3/4</td>
<td>SELFCOMP</td>
<td>SELFCOMP=1 (SFC self-completing): SFC changes by implication from the &quot;Run&quot; state to the &quot;Completing&quot; state after normal processing is completed. SELFCOMP=0 (SFC not self-completing): SFC remains in the &quot;Run&quot; state until the &quot;Complete&quot; command is issued. If there is a state change using the &quot;Complete&quot; command, normal processing is aborted if it was not yet completed.</td>
</tr>
</tbody>
</table>

SELFRESET is effective only in "MANUAL" mode.

<table>
<thead>
<tr>
<th>Source/Target</th>
<th>External Signal</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>X/1</td>
<td>SELFRESET</td>
<td>SELFRESET=1: In the &quot;Completed&quot;, &quot;Aborted&quot; and &quot;Stopped&quot; states, SFC makes an automatic and immediate change to &quot;Idle&quot; state. The result is that a sequencer is started and immediately aborted in the above states. SELFRESET=0: If the &quot;Completed&quot;, &quot;Aborted&quot; and &quot;Stopped&quot; states have been completely processed, the SFC remains in the corresponding state until the &quot;Reset&quot; or &quot;Start&quot; command is issued (does not &quot;Start&quot; when &quot;Stopped&quot;). Note: In cyclic operation, SELFRESET = 1 must not be set. This causes an error (LI_ERR).</td>
</tr>
</tbody>
</table>

RUNHOLD is effective in "MANUAL" and "AUTO" modes.

<table>
<thead>
<tr>
<th>Source/Target</th>
<th>External Signal</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>3/7</td>
<td>RUNHOLD</td>
<td>RUNHOLD=1: When there is a change from &quot;Run&quot; to &quot;Holding&quot;, the previous sequencer is aborted and the new sequencer is started. RUNHOLD=0: When there is a change from &quot;Run&quot; to &quot;Holding&quot;, the previous sequencer is held and the new sequencer is started.</td>
</tr>
</tbody>
</table>

CONT

You will find more information on CONT in the section: Continuous Mode (Page 253)
15.2.5.3 Continuous Mode

CONT status flag

In AUTO mode, you can use the additive status flag (CONT input and QCONT output) to allow cooperation between a user control system (or SIMATIC BATCH) and SFC. It allows you to restart an SFC without having to first switching it off. The OSL of the SFC remains in "Run" state and sets output QCONT = 1 if RUN = 1 and READY_TC = 1. If QCONT = 1 is set, QCONT_T_ERR = 0 is set. Commands are executed regardless of the status flag.

The SFC can be restarted when READY_TC = 1 is set. This is set by the SFC after processing the final step of the sequencer to be processed in "Run" state. If the same SFC is restarted or aborted, status flag QCONT = 0 is set.

If the SFC has not been restarted within a configured time (CONT_T # 0 s), the error output QCONT_T_ERR = 1 is set. This output allows individual reactions to the error.

You will find more information on the continuous mode in the sections:
- Start Requirements of an SFC (Chart/Instance) (Page 266)
- Continuous mode (SFC inputs/outputs) (Page 213)
15.2.5.4 Diagram of the State Changes for SFC OSL

State changes for SFC OSL

Key
### Behavior of the sequential control system in the AS

#### 15.2 Specifying the runtime behavior

<table>
<thead>
<tr>
<th>States that are exited through events</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transition states that are implicitly exited</td>
</tr>
<tr>
<td>States applied from OSL for SFC V5.x</td>
</tr>
<tr>
<td>Events: Commands / Conditions / External Signals / Internal Signals</td>
</tr>
<tr>
<td>Event: Error</td>
</tr>
<tr>
<td>Results applied from OSL for SFC V5.x</td>
</tr>
<tr>
<td>Implicit transitions that are triggered from SFC, if the active sequencer has been processed to completion or if there is not sequencer to process.</td>
</tr>
</tbody>
</table>
15.2 Specifying the runtime behavior

15.2.5.5 Operating state logic for sequencers (sequencer OSL)

Overview

The sequencer OSL controls processing of sequencers.

The operating state logic of the sequencer is defined by the diagram of the state changes. You can find additional information about this in the section: Diagram of the State Changes for Sequencer OSL (Page 258)

The sequencer OSL is executed independent of the SFC-OSL when a sequencer is processed. This means that the sequencer has a state which differs from the SFC state. For example, the state of the SFC OSL can be "Holding", whereas the state of the sequencer OSL is "Run" (due to the processing of the sequencer to the "Holding" state). The processing of the sequencer OSL is subordinate to the SFC OSL. This means that the state change in the SFC OSL usually effects the state change in the sequencer OSL.

States of the sequencer OSL

<table>
<thead>
<tr>
<th>No.</th>
<th>State</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Idle</td>
<td>Initial state; waiting for Start command</td>
</tr>
<tr>
<td>2</td>
<td>Run</td>
<td>Normal processing</td>
</tr>
<tr>
<td>3</td>
<td>Completed</td>
<td>Normal processing finished; waiting for Start command</td>
</tr>
<tr>
<td>4</td>
<td>Held</td>
<td>Waiting for Resume command</td>
</tr>
<tr>
<td>5</td>
<td>Aborted</td>
<td>Waiting for Start command</td>
</tr>
</tbody>
</table>

State changes by means of commands (sequencer OSL)

The commands for the sequencer OSL are internal commands of the SFC runtime system.

The following tables describe the transitions between the states (Source State No. / Destination State No.) as well as their triggers.

<table>
<thead>
<tr>
<th>Source/Target</th>
<th>Command</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>X/2</td>
<td>Start</td>
<td>Triggers sequencer execution by changing to the &quot;Run&quot; state.</td>
</tr>
<tr>
<td>2/4</td>
<td>Hold</td>
<td>Holds sequencer execution by changing to the &quot;Held&quot; state.</td>
</tr>
<tr>
<td>4/2</td>
<td>Resume</td>
<td>Resumes sequencer execution by changing to the &quot;Run&quot; state.</td>
</tr>
<tr>
<td>4/2</td>
<td>Restart</td>
<td>Restarts sequencer execution by changing to the &quot;Run&quot; state.</td>
</tr>
<tr>
<td>X/5</td>
<td>Cancel</td>
<td>Aborts sequencer execution by changing to the &quot;Aborted&quot; state.</td>
</tr>
</tbody>
</table>

X = Possible from several states.
Implicit state changes (sequencer OSL)

The "Run" state is a transitional state. An implicit state change to "Completed" state occurs if "Run" and, thus, the sequencer including the final step has been processed completely.

"Run" can, of course, also be exited by means of the "Abort" and "Hold" commands. In this case, the appropriate transition triggered by the command is executed and not the implicit transition.

<table>
<thead>
<tr>
<th>Source/Target</th>
<th>Sequencer status</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>2/3</td>
<td>Completed</td>
<td>Sequencer execution is complete</td>
</tr>
</tbody>
</table>
15.2.5.6 Diagram of the State Changes for Sequencer OSL

State changes for sequencer OSL

```
1  Idle
   Start

2  Running
   Start
   Completed

3  Completed
   Start

4  Held
   Hold
   Resume
   Restart

5  Aborted
   Abort

Key:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>⬤</td>
<td>States that are changed due to commands/operations</td>
</tr>
<tr>
<td>➞</td>
<td>Operator commands</td>
</tr>
<tr>
<td>➞</td>
<td>Implicit transitions triggered by the SFC</td>
</tr>
</tbody>
</table>
```
15.3 Processing the SFC in the AS

15.3.1 Executing an SFC

Introduction
In the following description of the basic principles of cyclic operation of an SFC, it is assumed that the SFC contains several sequencers with user-defined start conditions.

How it works
The SFC is executed based on the input signals pending in the SFC interface and the internal status of the SFC. After an entire chart folder has been downloaded to the automation system, all the SFCs are in "Idle" state or "Starting" state if Autostart = 1 is set. The following is checked:

- The operating mode, commands, and external and internal signals are checked. This determines the state that the SFC should take based on the input signals.
- All start conditions of the sequencers are checked. This determines which sequencer is to be processed based on the preceding checks.

SFC status unchanged
If the SFC status is unchanged, the sequencer whose start condition is fulfilled and has the highest priority of all sequencers with a fulfilled start condition is executed. If there are several sequences with a fulfilled start condition and the same priority, then the sequencer with the tab furthest left in the editor is executed (similar to the processing of alternative branches). If the sequencer that was processed up to now is different from the sequencer that is to start processed now, the previous sequencer is aborted and the new sequencer starts.

The start condition triggers the start of a sequencer. While the sequencer is being processed, it is not necessary for the start condition to remain fulfilled. The sequencer is processed until it is completed or until a sequencer with a higher priority and fulfilled start condition has to be processed or the sequencer is aborted or held due to a state change.

In the "Idle," "Completed," "Aborted," "Stopped," "Held," "Held (Error)," "Error," and "Run" states (when SELFCOMP=0), sequencers are processed until you exit the state by means of a command. A sequencer can, therefore, be repeated any number of times when the corresponding start condition is fulfilled and no command is pending. To prevent this behavior, you can configure the final transition of the sequencer with an unfulfilled condition. This causes the sequencer to "hang" at this transition and to exit only following a command.
Behavior of the sequential control system in the AS

15.3 Processing the SFC in the AS

SFC status changed

If the SFC status has changed, the SFC processes the previous sequencer and the new sequencer according to the state change that has taken place:

When a status transition from "Run" to "Holding" is performed, the active sequencer is held or aborted (depending on RUNHOLD) and the new sequencer is started.

If the previous sequencer has been completely processed, the state changes from "Resuming" or "Resuming (Error)" to "Run." The new sequencer is resumed or started (depending on RUNHOLD) at the change from "Resuming" and is started at the change from "Resuming (Error)".

If there is an implicit state change, the change is executed when the sequencer of the first transitional state has been processed completely and is therefore terminated. If there is no sequencer with a fulfilled start condition, the implicit change is executed immediately and the new sequencer starts.

With all other state changes resulting from commands, external or internal signals, the previous sequencer is aborted if it has not yet been processed completely and the new sequencer starts.

Notes on status changes

- When a sequencer is held, the running step is held immediately after the processing phase. The following when resuming the sequencer:
  - When the transition is fulfilled, the step is resumed after the processing phase.
  - When the transition is not fulfilled, the resumption occurs with the processing phase of the step.
- When a sequencer aborts, the active steps are always processed completely followed by the final step. The completion of the active steps and the initialization or processing of the final step are processed in one cycle.
- A sequencer can be processed in an SFC even if the SFC has not received a start command. This is then the case when, for example, in the status "Idle" the start condition of one or several sequencers is fulfilled or sequencers exist, whose starting conditions are indicated independently of states.

Coordination of sequencers and target steps

You can influence the start behavior of a sequencer that will become active in the future by setting a target step for this sequencer in step actions of the current sequencer (for example <SFCName>.TARGETSEQ:=2; <SFCName>.TARGETSTEP:=5). This corresponds to setting a target step manually during testing and commissioning; however, the difference in this case is that all other target steps of the sequencer including those set manually are reset. This means that you can specify the required start step for the sequencer to be started at any time.

TARGETSEQ = 0 is set when the step action has been executed.

Note that target steps cannot be set in simultaneous branches.

Example: By setting <SFCName>.TARGETSEQ:=2 and <SFCName>.TARGETSTEP:=0, all the target steps in the sequencer with number 2 are cleared.
A target step is taken into account when a sequencer starts or resumes and is then deleted. Since the required execution and the target step both generally depend on the prior execution of the SFC, you can query the last active sequencer and the last active step in a transition condition (for example `<SFCName>.LASTSEQ:=3; <SFCName>.LASTSTEP:=2`) to set different target steps depending on the result of the query.

Sequences and steps are identified by their number. These are displayed in the "Properties" dialog boxes and can be used to configure target steps.

**Cooperation between operator control or SIMATIC BATCH and SFC**

If an SFC instance is being used by SIMATIC BATCH, the following process occurs:

- SIMATIC BATCH sets the input OCCUPIED = 1.
- The SFC sets the output QOCCUPIED = 1 and the occupied code (bit 24) for BA_STATE.
- OCCUPIED and QOCCUPIED are set with SFC = 0 for a reset (transition to "Idle"). When OCCUPIED is deleted by SIMATIC BATCH itself, the QPARAM = 0 output is also set. This means that any pending, incorrect setpoint is no longer checked, i.e. an error is not displayed (LI_ERR = 0).
15.3.2 Processing an SFC after CPU stop and restart

Startup characteristics

When the CPU goes into the stop state, the running sequencer stops at the step it is currently processing. When the CPU is restarted, the SFC is initialized and the data valid before the stop occurred is lost. The property of the SFC is the default state.

If you want the SFC to retain its state when the CPU restarts, you need to set the AS operating parameter defaults correspondingly (Chart > Properties > tab: AS Operating Parameters > SFC Startup after CPU Restart > Option: Retain SFC state).

The operator can decide how the SFC should continue execution based on the SFC and process state. It may be necessary to switch from AUTO to MANUAL.

Another factor to be considered is whether the CPU went to stop during block processing or processing was completed. If the first case is true, the data are inconsistent. The following procedure needs to be performed as a result:

Procedure after restart

Requirement: The SFC is in the "Idle" state or a sequencer is active in the "Idle" state.

<table>
<thead>
<tr>
<th>CPU stop occurs during block processing (data are inconsistent)</th>
<th>Command</th>
<th>Processing</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reset</td>
<td>SFC continues in the &quot;Idle&quot; operating state, whereby all sequencers are initialized.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>CPU stop does not occur during block processing (data are consistent)</th>
<th>Command</th>
<th>Processing</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resume</td>
<td>SFC resumes in the current operating state</td>
<td></td>
</tr>
<tr>
<td>Cancel</td>
<td>SFC aborts according to the OSL</td>
<td></td>
</tr>
<tr>
<td>Stop</td>
<td>SFC stops according to the OSL</td>
<td></td>
</tr>
</tbody>
</table>

The "Resume" command is always allowed regardless of the operating state, but the "Abort" and "Stop" commands are only permitted when they conform to the state changes of the operating state logic. You can find additional information about this in the section: Operating state logic for SFC (SFC OSL) (Page 248)

The state symbols are displayed and the "CPU_RESTART" and "EXEC_ERR" outputs are set until one of the commands is executed (Resume, Abort, Stop, Reset).
You can use the TRIG_CPU_RESTART output for the start condition of the sequencers that should be executed after the CPU restart. This output is only set by the system and must be reset by a configured actions (such as step action TRIG_CPU_RESTART = 0).

**Note**
After the CPU restart, the ENRESUME, ENABORT, ENSTOP and ENRESET are not considered for the buttons Resume, Abort, Stop and Reset.

**Display in test mode**
In test mode, the steps for a CPU stop and after a CPU restart are accordingly identified.

<table>
<thead>
<tr>
<th>Step Description</th>
<th>Symbol</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU stop</td>
<td>![Symbol]</td>
</tr>
<tr>
<td>CPU restart and SFC with consistent data</td>
<td>![Symbol]</td>
</tr>
<tr>
<td>CPU restart and SFC with inconsistent data</td>
<td>![Symbol]</td>
</tr>
</tbody>
</table>

The symbols for "CPU restart and SFC with consistent data" and "CPU restart and SFC with inconsistent data" are also displayed in the operator control and display section.

**Additional information**
You will find more information on this subject in the following sections:
- States of the Steps and Transitions (Page 288)
- Display in Test mode (Page 284)
15.3.3 Commands

Introduction

Regarding the commands for changing the operating mode, there is a distinction between commands for "MANUAL" and "AUTO" modes.

Commands for "MANUAL" mode

In "MANUAL" mode, you can set or modify the operating states using the buttons of the operator interface in SFC test mode or in SFC Visualization (you can find information about this in the "MANUAL commands for the SFC" table below). The ability for the operator to issue commands depends on the operating state and the command enables "EN.....".

Commands for "AUTO" mode

In "AUTO" mode, depending on the command enables "EN....", the commands are issued using the interface inputs "START, ....." by assigning parameters or interconnecting to a higher-level automatic controller.

Commands for both operating modes

Regardless of the operating mode and the command enables, you can issue interlock commands via the "LOCKCOMPLETE, ....." interface inputs.

Regardless of the mode and the command enables, you can issue the commands via the (IN_OUT) "INTSTART, ....." interface inputs in the object properties of the steps. These commands are reset after they have been executed; in other words, when the state changes.

You can find additional information about this in the section: Commands and operating states (SFC inputs/outputs) (Page 200) under "Explanations of the commands and operating state changes".

Note

The commands arranged as buttons in the control section of the online window (Test mode) are effective for the SFC chart or SFC instance only and not for sequencers.
**MANUAL commands for the SFC**

<table>
<thead>
<tr>
<th>Button</th>
<th>Command</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>🎃</td>
<td>Start</td>
<td>Triggers start of processing by changing to the &quot;Starting&quot; state.</td>
</tr>
<tr>
<td>🎃</td>
<td>Hold</td>
<td>Triggers holding of processing by changing to the &quot;Holding&quot; state.</td>
</tr>
<tr>
<td>🎃</td>
<td>Resume</td>
<td>Triggers resumption of processing by changing to the &quot;Resuming&quot; or &quot;Resuming (Error)&quot; state.</td>
</tr>
<tr>
<td>✗</td>
<td>Cancel</td>
<td>Triggers abortion of processing by changing to the &quot;Aborting&quot; state.</td>
</tr>
<tr>
<td>🎃</td>
<td>Exit</td>
<td>Triggers completion of processing by changing to the &quot;Completing&quot; state.</td>
</tr>
<tr>
<td>🎃</td>
<td>Stop</td>
<td>Triggers stop processing by changing to the &quot;Stopping&quot; state.</td>
</tr>
<tr>
<td>🎃</td>
<td>Restart</td>
<td>Triggers restart of processing by changing to the &quot;Starting&quot; state.</td>
</tr>
<tr>
<td>🎃</td>
<td>Reset</td>
<td>Changes to the &quot;Idle&quot; state.</td>
</tr>
<tr>
<td>🎃</td>
<td>Error</td>
<td>Triggers error processing by changing to the &quot;Error&quot; or &quot;Error (Completing)&quot; state.</td>
</tr>
</tbody>
</table>

The effect of commands are graphically illustrated in the following section: [Diagram of the State Changes for SFC OSL](Page 254)
15.3.4 Start Requirements of an SFC (Chart/Instance)

General requirements

An SFC is started only when the requirements for starting are fulfilled. The start enable must be set (ENSTART = 1) and the SFC must be in a state in which starting is permitted. The following conditions must also be met:

- There is no interlock error (LI_ERR = 0).
- None of the signals INTERERROR, LOCKERROR, LOCKCOMPLETE, LOCKHOLD, LOCKABORT or LOCKSTOP is active at the same time.
- There is no operator error in MANUAL mode (OP_ERR = 0).

If you are using control strategies for an SFC instance, you must have selected one of the defined control strategies (CS=<defined control strategy>). With CS=0 or CS>CS_HL, it is not possible to start the SFC instance. If you have not configured any control strategies, the CS, CS_LL, CS_HL inputs/outputs are assigned the value 0 during compilation and must not be modified.

If you are using setpoints, you must specify them within the respective limits. Otherwise it is not possible to start the SFC instance.

With an SFC instance in AUTO mode, you must have set the parameter transfer (PARAM=1) before starting. The transferred control strategies and setpoints are then checked and the start disable reset (QDIS_START=0) if the parameters are valid. The start disable remains set until a PARAM is set by a parameter transfer. Following a successful start, the start disable remains until the next parameter transfer.

If one of the conditions above is not fulfilled, the start disable (QDIS_START=1) is set and the start is not executed. The "Start" button is not enabled in this case.

Starting in the "Run" state

To be able to start in "Run" state, you must have set the additional start enable (ENASTART=1) and deactivated the self termination (SELFCOMP=0).

In AUTO mode, you must have also activated continuous mode (CONT=1).

The start condition of the sequencer that is to be processed in the "Run" state must also ensure that the sequencer has not already been processed completely (READY_TC=0). This prevents the sequencer from being repeated cyclically under certain circumstances because the start condition is satisfied.

Example of the start condition:

RUN=TRUE AND READY_TC=FALSE.

When an SFC starts, the finished ID is reset (READY_TC=0) and after complete execution of the sequencer in "Run" state it is set again (READY_TC=1).
Restart in the "Held / Held (Error)" state

ENSTART = 1 and ENRESTART = 1 must be set to be able to restart in the "Held / Held (Error)" state.

You will find more information on simultaneous pending commands in the sections:

- Behavior when multiple commands are queued (Page 267)
- Continuous Mode (Page 253)

15.3.5 Behavior when multiple commands are queued

Behavior when multiple commands are queued

If several commands are queued simultaneously (for example, external and internal commands), an interconnection error (LI_ERR=1) is usually displayed. The commands will not be executed or only one of the commands will be executed.

Additional information

For more information on this subject, refer to the section

- Start Requirements of an SFC (Chart/Instance) (Page 266)
15.3.6 Processing the SFC elements

15.3.6.1 Runtime Phases of a Step

Runtime phases

Each step is divided into three phases (actions):

- Initialization: Action for initial processing
- Processing: Action for cyclic processing
- Termination: Action for final processing

The following figure shows the runtime phases of a step in conjunction with a successor transition: On the left are the elements of the sequencer topology and on the right the corresponding runtime phases.
15.3.6.2 Executing a Step and Transition

**Processing steps and transitions**

The **Start step** is activated without checking conditions and its actions are performed when the sequential control system is started.

A (normal) **step** has the states "active" and "inactive". A step becomes active after the preceding transition passes control to it. The actions are then triggered and controlled. A step becomes inactive after the successor transition is fulfilled.

If there is an abort, the completion of processing of the previously active step is still executed and the initialization of the final step is activated (overlapping in the same cycle).

A **transition** has the states "FALSE" and "TRUE". The state of the successor transition of the active step is checked. If a successor transition is fulfilled and the step enabling condition is true, the previous step is disabled and the next step is enabled. The transition is not checked in relation with the step control mode until any configured minimum run time has expired.

The actions of the **final step** are performed once only.

When the chart progresses from one step to the next, the termination action is executed in the same cycle as the first action (initialization or processing) of the next step.

This allows the "non-latching behavior" specified in IEC 1131 - 3 to be achieved.
Behavior of the sequential control system in the AS

15.3 Processing the SFC in the AS

Example:

In step S4, the processing phase opens a valve and the termination phase closes it again. If the same valve is opened again in the first action of the next step (S5), the overlapping of the two actions (both in one cycle) means that the valve is not closed.

Special situations

The example in the schematic shows the time behavior when all three actions of a step are configured.

Other combinations are also possible:

- If no "initialization" action is configured, the "processing" action begins immediately when the step is enabled.
- If no "termination" action is configured, the step is disabled immediately as soon as the transition is fulfilled.

The minimum time that a step is active depends on the number of configured actions. This is one or two actions with a normal step, and up to three actions with a final step.

If a minimum run time is set for the step, the step remains active for at least this time even if the transition condition is fulfilled earlier.
15.3.6.3 Executing a Simultaneous Branch

Executing a Simultaneous Branch

Simultaneous branches are executed in a single cycle, and the parallel sequences run independently of one another.

The transition after the simultaneous branch becomes true when all steps at the end of the sequencers are active and the conditions are fulfilled.
15.3.6.4 Executing an Alternative Branch

Executing an Alternative Branch

The sequencer that is executed in an alternative branch is the one whose transition condition is fulfilled first.

If several conditions are fulfilled at the same time, the transition that is located furthest left in the sequencer topology is activated.

Note

An alternative branch cannot contain an unprogrammed transition at the start of a sequencer. Reason: Unprogrammed transitions are always set to TRUE by default, and are thus automatic fulfilled. This means that they are always fulfilled before a programmed transition.
15.3.6.5 Executing a Loop

Processing a loop

The figure below shows the runtime phases of a loop: On the left are the elements of the sequencer topology and on the right the corresponding runtime phases.

15.3.6.6 Executing a Jump

Processing a jump

The jump is executed when the transition of the jump is satisfied.

<table>
<thead>
<tr>
<th>Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Successor transition</td>
</tr>
<tr>
<td>2</td>
<td>Jumps</td>
</tr>
<tr>
<td>3</td>
<td>Alternative branch</td>
</tr>
</tbody>
</table>
Example on the left in the figure: If there is more than one jump following the origin of a jump (S4), then – similar to processing in an alternative branch - the jump whose transition is fulfilled first is executed. If several transitions are fulfilled at the same time, the transition that is located furthest left is activated.

Example on the right in the figure: If an alternative branch follows instead of a successor transition (such as T4 in the left configuration) in the sequencer, all the transitions of the alternative branch (T5 and T7) are queried before the transitions of the jumps.
15.4  Changing the control strategy and setpoints

15.4.1  Changing the Control Strategy and Setpoints for an SFC Instance

Introduction

You can change the control strategy and/or setpoints before restarting an SFC instance or change the setpoints and apply them immediately.

Changing control strategy and setpoints

There are two mechanisms for changing the control strategy and/or setpoints:

1. **Changing the control strategy and/or setpoints and applying them at the next start**

   In **AUTO mode**, proceed as follows:

   Use the PARAM and START inputs/outputs. The CS inputs for the control strategy and <setpoint> for the setpoints are assigned the new values and then PARAM input = 1 is set. The QPARAM output signals that a change of control strategy and/or setpoints at the next start has been requested; the output is reset after the start. When the SFC instance starts, the control strategy and/or setpoints are applied.

   In **MANUAL mode**, follow the steps outlined below:

   Set the appropriate enables for changing the control strategy ENCSP or the setpoints <setpoint>_ENOPP, to allow changes to be performed. This enables the corresponding input options in the faceplate for SFC instances.

   The inputs CSP_OP for the control strategy and <setpoint>_OPP for the setpoints are assigned the new values. You can do this in CFC Test mode directly in the SFC instance or in the faceplate of the SFC instance in the "Prepared values" tab. The control strategy and/or setpoints are applied when the start is executed.

   If the values are valid, they are displayed at the outputs QCSP for the control strategy and <setpoint>_QP for the setpoints in both modes. If the limits for the control strategy or setpoints are exceeded, this is displayed at the corresponding outputs <setpoint>_ERR. Invalid values are not applied to the outputs QCSP or <setpoint>_QP. After the start, the current control strategy is displayed at the QCS output and the current setpoints at the <setpoint>_Q outputs (QCS = QCSP, "sw"_Q = "sw"_QP).
2. Changing setpoints and applying them immediately

This mechanism cannot be used to change the control strategy.

In **AUTO mode**, proceed as follows:

Use the TAKESP input/output. The inputs `<setpoint>` for the setpoints are assigned the new value and the TAKESP input is set. The setpoints are adopted immediately if the TAKESP input is set and no error has been found in the setpoints (high/low limit). The QTAKESP output signals that an immediate change of setpoints was requested.

The PARAM signal must always be set when setpoint changes are made because the setpoints are checked and adopted in the prepared values only when PARAM is set. Only checked values are applied at START or TAKESP.

In **MANUAL mode**, follow the steps outlined below:

You must set the appropriate enables for changing the setpoints `<setpoint>_ENOP` to allow changes to be made. This enables the corresponding input options in the faceplate for SFC instances.

The `<setpoint>_OP` inputs for the setpoints are assigned the new values. You can do this in CFC Test mode directly in the SFC instance or in the faceplate of the SFC instance in the "Current values" tab. The setpoints are applied immediately.

**Note on Working in the Faceplate:** The control of setpoints must be enabled on the "Current values" page. The "Current setpoints" can be used page' property must be selected in the "@pg_@sfc_type_actualsp.pdl" faceplate subimage.

You can find additional information on this in the online help of SFC Visualization.

Assuming the values are valid, they are displayed at the `<setpoint>_Q` outputs for the setpoints in both modes. If the limits for the control strategy or setpoints have been exceeded (error case), this is displayed at the corresponding outputs `<setpoint>_ERR`. Invalid values are not applied at the `<setpoint>_Q` outputs.

**Summary**

In both mechanisms, the output CSSPACCEPT indicates whether or not the requested changes were applied. This output is set after applying the control strategy and/or setpoints by the SFC instance at the relevant outputs. The CSSPACCEPT output is set for one processing cycle (for 1.) or remains set until the TAKESP request is reset (for 2.).

Output LI_ERR indicates whether or not an error occurred when attempting to apply value changes with the result that the values could not be completely applied. If LI_ERR is set, QDIS_START is not reset and a start and, thus, the adoption of the control strategy and/or setpoints is prevented (for 1.).
15.4 Changing the control strategy and setpoints

15.4.2 Tracking the Control Strategy and Setpoints in AUTO Mode

Tracking the control strategy and setpoints

"Tracking" involves writing back of the current control strategy and setpoint values to the corresponding operator inputs (only in AUTO mode). As a result, the setpoints of the last active control strategy used is immediately available at the next start.

<table>
<thead>
<tr>
<th>Control strategy tracking:</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>MANUAL</td>
<td>At start if CSP_DEFAULT &gt; 0 : CSP_OP = CSP_DEFAULT</td>
</tr>
<tr>
<td>AUTO</td>
<td>If CSP_DEFAULT &gt; 0 : CSP_OP = CSP_DEFAULT</td>
</tr>
<tr>
<td></td>
<td>If CSP_DEFAULT = 0 : CSP_OP = QCSP</td>
</tr>
</tbody>
</table>

Setpoint tracking:

| <Setpoint>_OP | = | <Setpoint>_Q |
| <Setpoint>_OPP | = | <Setpoint>_QP |
15.4 Changing the control strategy and setpoints
Testing and commissioning sequential control systems

16.1 Operator control and monitoring during testing

Overview

Debug functions are integrated in the SFC Editor for the following tasks to provide support for commissioning:

- Monitoring the work process of the sequential control system in the AS
- Influencing the operating modes
- Changing setpoints

Test modes

You can start test mode in either of the following test operating modes:

- Process mode
- Laboratory mode

You can select the test operating mode while in edit mode using the menu commands in the "Debug" menu. You cannot switch once you are in test mode.

In process mode, the communication for the online dynamic display of the SFC charts and SFC instances is restricted to keep the load on the CP and bus to a minimum. If overload occurs in this test operating mode, a message is displayed indicating that the limit of the bus load has been reached. In this case, stop the testing of the SFCs that are not absolutely necessary for the test.

In laboratory mode, communication for the online dynamic updates of the SFCs is unrestricted. Use laboratory mode to perform convenient and efficient testing and commissioning.

Setting the test environment

With the menu command Debug > Test Settings..., you can open a dialog box in which you can change the monitoring cycle for the current program (default: 2 s).

The cycle time is uniformly stored with the CFC in the chart folder. This means that the same monitoring cycle is valid for both applications (SFC and CFC).

Note

If the cycle time is changed in the SFC chart, this affects charts/instances with dynamic properties. A change in CFC affects only newly registered SFC charts/instances.
Requirements

- The sequential control system (chart or instance) to be tested including the necessary basic automation functions (CFC charts) have been compiled without errors and downloaded to the CPU.

- The chart is open in SFC or SIMATIC Manager, the SFC instance is open in the CFC chart.

Note

With S7, loading into the CPU - and working in test mode - are functions that are logged if the SIMATIC Logon Service is installed and the access protection and change log are activated.

You will find information on this subject in the CFC documentation under: Change Log and ES Log

Activating test mode

Select the icon from the toolbar or select the Debug > Test Mode menu command. You change from edit mode to test mode.

You can switch back to edit mode at any time during testing.

Note

Make sure that the sequential control system is not waiting for operator input when you switch to edit mode.

The mode switch always relates to the currently active SFC. The overview display of this SFC is dynamically and cyclically updated.

After you have switched to test mode, the current state of the sequential control system is displayed. This does not mean that a sequential control system that has already started can necessarily be monitored or controlled from the start. For example, this is the case with sequential control systems that are started immediately after they are downloaded to the AS without requiring any operator command (autostart).

Note

If the H CPU is being operated in solo mode, for example, due to CPU failure, and a CPU failover has taken place, if there is online access (here: Activate Test Mode), a selection dialog box is displayed. In this dialog box, you can select the required CPU. In redundant operation, this dialog box does not appear.

Note

Update ("F5" key) not possible in test mode.
Operator control and monitoring

You operate and monitor the sequential control system in the overview display of the SFC. Here, you can change the operating states, operating modes, step control modes, and the execution options as required.

Open the properties if you wish to see and/or modify the values of the individual steps.

If you double-click on a step or a transition, a dialog box appears similar to the object properties dialog box in edit mode.

The actions of the steps can be viewed in two different modes, i.e. the tabs exist twice. In normal view, the interconnecting information is displayed, in the additional view the OS comment is also shown. In the Object Properties of the transition, you will see in the formulated condition in the "Current Cond." tab and the OS comment of the current condition in the "OS Comment" tab.

You can also open the object properties for the step and transition at the same time. To do this, select the required transition and double-click a step to open both dialog boxes (or in the opposite order: select a step and double-click a transition). The step and transition do not need to be associated in order to be able to see both dialog boxes at the same time.

A selected element in the sequencer is indicated by a blue background.

Tooltips for steps and transitions

Instead of opening the object properties to get specific information, you can also do the following:

- **Step**: If you position the mouse pointer on a step, the name, number, run times, comments and acknowledgement information are displayed.
- **Transition**: If you position the mouse pointer on a transition, the name, number, run times and comments are displayed.

Acknowledging in the sequencer and in the object properties dialog

If a button is displayed for operator prompt acknowledgement or error acknowledgement for the monitored step or transition in the sequencer, the object properties dialog box also has the corresponding button or buttons added to it.

In case of a step runtime error, the step is returned to the state which it had before the error occurred (active = "green", for example) after the error has been acknowledged.

Acknowledgement information

In the object properties of the step you can assign parameters for acknowledgement information. In step control mode "Step-specific confirmation by operator (T/T and O)", this acknowledgement information is displayed at the associated acknowledgement button for an operator prompt. The text can be positioned as required using the mouse pointer, it remains connected with the button over a connecting line.
Changes during testing (SFC chart only, not SFC instance)

The step attributes (confirmation, minimum/maximum run time, constant in assignments) and transition attributes (constant in conditions) that can be modified in test mode are adopted in the AS and in the ES data management when the change is made and do not require recompilation and download.

Note

If you want to modify existing SFC instances, you must exit test mode and then change the corresponding SFC type. After compiling and downloading the changes, all the instances are automatically adapted.

Changing characteristics during testing (SFC instance only)

The "Control strategy" and "Setpoint values" characteristics can be changed as described in the section: Changing the Control Strategy and Setpoints for an SFC Instance (Page 275).

You can influence the "process values", "parameters", "timers" and "block contacts" characteristics in test mode of the CFC at the corresponding I/Os of the SFC instance if the I/Os are not already interconnected with blocks.

The "control values" and "bit memory" characteristics cannot be modified in test mode.

Trace

In test mode, you can use the Debug > Trace menu command to specify that the active sequencer is always displayed automatically. If this menu command is not set, the explicitly selected sequencer is displayed.

Note

When tracing is activated, you can only open the object properties of a step or transition that is currently active. If you open object properties of a step or transition that is not active, a dialog box appears asking if you wish to disable the tracing.
Testing a single sequencer

If you cannot test a single sequencer without its functions affecting other sequencer, you can use the following procedure:

1. Copy the sequencer to a separate SFC chart or SFC type.
2. Adapt the start conditions (for example, RUN = TRUE).
3. If the sequencer is in an SFC type: Generate an SFC instance.
   After starting, the sequencer is executed immediately.
4. After making any necessary corrections and testing again, copy the sequencer back to the original SFC chart or SFC type.

You will find more information on test mode in the sections:

Display in Test mode (Page 284)
Properties of a step during testing (Page 290)
Properties of a transition during testing (Page 292)
Properties of a sequencer during testing (Page 294)
16.2 Display in Test mode

Layout of the SFC window

The window of the SFC chart or SFC instance in test mode has an extra control and display section at the bottom edge of the window compared to edit mode. All operator inputs relate to the chart or the instance (not to the sequencer).
The following elements are shown in the control and display section (from left to right):

- **First row:**
  - Symbol and name of the SFC mode
  - Status display and name of the active sequencer
  - Status display and name of the held sequencer
  - Box with drop-down list for displaying and changing the step control modes

- **Second row:**
  - The current operating mode (MANUAL/AUTO)
  - Status flag "Continuous mode" for bumpless switching to AUTO mode (for example, to avoid an SFC having to be switched off before it is restarted). This is displayed when output QCONT = 1.
  - Status display "Ready to complete", when the SFC is not self-completing (SELFCOMP = 0) and is waiting in the run state for the "Complete" command (display, when READY_TC=1).

<table>
<thead>
<tr>
<th>The display</th>
<th>at a CPU restart with consistent data</th>
</tr>
</thead>
<tbody>
<tr>
<td>or</td>
<td>at a CPU restart with inconsistent data</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>The display</th>
<th>for an interconnection error (or empty box)</th>
</tr>
</thead>
<tbody>
<tr>
<td>for an operator error (or empty box)</td>
<td></td>
</tr>
<tr>
<td>for a step error (or empty box)</td>
<td></td>
</tr>
<tr>
<td>for an operator prompt (or empty box)</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>The button</th>
<th>for the group acknowledgment</th>
</tr>
</thead>
</table>

- **The buttons:**
  - For selecting "MANUAL" or "AUTO" mode
  - For enabling changeover to "AUTO". After the changeover enable, the icon changes to 

![AUTO icon]
Testing and commissioning sequential control systems

16.2 Display in Test mode

- The buttons of the Commands (Page 264):

<p>| | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>![Start]</td>
<td>![Hold]</td>
<td>![Resume]</td>
</tr>
<tr>
<td>![Cancel]</td>
<td>![Exit]</td>
<td>![Stop]</td>
</tr>
<tr>
<td>![Restart]</td>
<td>![Reset]</td>
<td>![Error]</td>
</tr>
</tbody>
</table>

- The check boxes for enabling and disabling the execution options "Command Output", "Cyclic Operation", and "Time Monitoring".

Operator prompt

An operator prompt (not with "T") is displayed by the button beside the transition icon. After clicking this button or and continuing execution, the operator prompt disappears.

When an acknowledgement was configured for the step, this is displayed in the step control mode "Step-specific acknowledgement by operator (T/T and O)" at the associated acknowledgement button. The text can be positioned as required using the mouse pointer, it remains connected with the button over a connecting line.

Runtime error

The button is only displayed when a runtime error is displayed for the current step. You click this button (or ) to acknowledge the pending errors. After acknowledgment, the appearance of the step returns to the state it had before the error occurred (active = "green", for example).

Display of the states

In test mode of the SFC, both the SFC and the sequencers with their start conditions are made dynamic. The name and status of the SFC and the name and status of the sequencer that is currently being executed are displayed in the title bar of the SFC window. The start condition and the execution of the sequencer are also displayed.

The various states of the sequential control system, the sequencer, the steps and the transitions are visualized by different colors or icons.

In addition to the color frame of the steps, a status display also appears. The icon of the status display is therefore an additional visualization of the current operating state in the chart in case the colors cannot be clearly distinguished. You cannot change the colors of the state indicators.

You will find more information on displaying the states in the sections:
- Icons for Operating States (Page 289)
- States of the Steps and Transitions (Page 288)
Display of the CPU operating mode

The operating mode of the CPU is displayed in the status bar (right information box): green + RUN, red + STOP. Test mode is also indicated: (Laboratory) or (Process).

Display of the sequencer

If the SFC contains more than one sequencer, the following is displayed based on the setting in the "Debug" menu:

- The active sequencer is always displayed automatically (menu command Debug > Trace set)
- The explicitly selected sequencer is displayed (menu command Debug > Trace not set).
### States of the Steps and Transitions

<table>
<thead>
<tr>
<th>Step state</th>
<th>Step color</th>
<th>Symbol</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inactive, not executed</td>
<td>Gray</td>
<td></td>
</tr>
<tr>
<td>Inactive, executed</td>
<td>Dark green</td>
<td>✓</td>
</tr>
<tr>
<td>Run</td>
<td>Light green</td>
<td>▶</td>
</tr>
<tr>
<td>Held</td>
<td>Yellow</td>
<td>II</td>
</tr>
<tr>
<td>Error</td>
<td>Red</td>
<td>❌</td>
</tr>
<tr>
<td>CPU stop</td>
<td>Red</td>
<td>▽</td>
</tr>
<tr>
<td>(not with &quot;inactive, not executed&quot;)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>After CPU restart</td>
<td>Magenta</td>
<td>II</td>
</tr>
<tr>
<td>(consistent data)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>After CPU restart</td>
<td>Magenta</td>
<td>▼</td>
</tr>
<tr>
<td>(inconsistent data)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Transition state</th>
<th>Transition color</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inactive</td>
<td>Gray</td>
</tr>
<tr>
<td>Fulfilled</td>
<td>Dark green</td>
</tr>
<tr>
<td>Unfulfilled</td>
<td>Dark red</td>
</tr>
</tbody>
</table>
### 16.4 Icons for Operating States

<table>
<thead>
<tr>
<th>Symbol</th>
<th>State</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Aborting</td>
<td>Processing after Abort command.</td>
</tr>
<tr>
<td></td>
<td>Aborted</td>
<td>Cancellation processing is complete; waiting for Reset or Start command.</td>
</tr>
<tr>
<td></td>
<td>Run</td>
<td>Processing after ending the processing in the &quot;Starting&quot; state.</td>
</tr>
<tr>
<td></td>
<td>Held</td>
<td>Cancellation processing in &quot;Held&quot; is complete; waiting for &quot;Resume&quot;, &quot;Abort&quot;, or &quot;Stop&quot; command.</td>
</tr>
<tr>
<td></td>
<td>Held (Error)</td>
<td>Error processing is complete no more errors pending; waiting for &quot;Resume&quot;, &quot;Abort&quot;, or &quot;Stop&quot; command.</td>
</tr>
<tr>
<td></td>
<td>Holding</td>
<td>Processing after &quot;Hold&quot; command.</td>
</tr>
<tr>
<td></td>
<td>Completing</td>
<td>Processing after &quot;Complete&quot; command or after implicit complete.</td>
</tr>
<tr>
<td></td>
<td>Completed</td>
<td>Processing in &quot;Completing&quot; state is complete; waiting for &quot;Reset&quot;, &quot;Start&quot;, &quot;Abort&quot;, or &quot;Stop&quot; command.</td>
</tr>
<tr>
<td></td>
<td>(empty) Idle</td>
<td>Processing in initial state; waiting for &quot;Start&quot; command.</td>
</tr>
<tr>
<td></td>
<td>Error</td>
<td>Processing after &quot;Error&quot; command.</td>
</tr>
<tr>
<td></td>
<td>Error (Completing)</td>
<td>Processing after &quot;Error&quot; command in &quot;Completing&quot; state.</td>
</tr>
<tr>
<td></td>
<td>Resuming</td>
<td>Processing after command &quot;Resume&quot; or &quot;Start&quot;.</td>
</tr>
<tr>
<td></td>
<td>Resuming (Error)</td>
<td>Processing after command &quot;Resume&quot; or &quot;Start&quot;.</td>
</tr>
<tr>
<td></td>
<td>Stopped</td>
<td>Processing in &quot;Stopping&quot; state completed, waiting for command &quot;Start&quot; or &quot;Reset&quot; or Abort.</td>
</tr>
<tr>
<td></td>
<td>Starting</td>
<td>Processing after command &quot;Start&quot; or &quot;Restart&quot;.</td>
</tr>
<tr>
<td></td>
<td>Stopping</td>
<td>Processing after command &quot;Stop&quot;.</td>
</tr>
</tbody>
</table>

Only operating states displayed in **bold** letters apply to sequencers.
16.5 Properties of a step during testing

Tabs of the "Properties" dialog

The "Properties" dialog box of the step is divided into 7 tabs:

- **"General" tab**
  
  The "Name" box has a frame, its color corresponds to the state of the step and is updated continuously. All colors that occur are listed in the following table: [Default Colors](Page 62).
  
  If you select the "Confirmation" check box, you set a flag that is evaluated in the "T/T and C" step control mode (step-specific confirmation by operator). This can only be modified in the SFC chart. The sequential control system runs as follows:
  
  - **Process-driven** for steps without the "Confirmation" option.
    Each fulfilled successor transition of a step without the "Confirmation" option enables the next step without operator intervention (corresponds to "T").
  
  - **Controlled by the operator** for steps with the "Confirmation" option.
    When an active step with the "Confirmation" option becomes true, the system prompts the operator to acknowledge the next step and then continues the sequencer (corresponds to "T and O").

  If you select the "Target step" check box, the current step is selected as the target step (shown in the sequencer by: ![Target symbol] to the left of the step). This option can only be modified for the SFC chart and the SFC instance if they are not in the sequencer "Run" state.

  Setting the target step means that:
  
  - The inactive sequencer starts at the selected target step instead of at the start step when it is next processed.
  
  - The held sequencer resumes at the target step when the continuation follows proper processing of the interrupted steps.

  The target step marker is valid only for the next "Start" or "Resume" command. When these commands are executed or when the CPU is restarted, the target step marker is cleared.

  You can also select several steps as the target step. The user is responsible for selecting the target steps in a proper way so as to ensure their processing without the formation of blockades or loops. You will find detailed information on this topic in: [Executing an SFC](Page 259)

**Note**

Please note the following:

- If you use "programmed target steps", the target steps sent by the operator in the corresponding sequences are deleted.

- Target steps set in "MANUAL" mode are not deleted when there is a changeover to "AUTO".

- Setting or deleting target steps is possible only when ENTARGETSTEP = 1 is set.
In the "Run times" area, you can change the "Minimum" and "Maximum" parameters for SFC charts. If you click in the edit box, an additional dialog box opens in which you can enter a new time. Any changes you make are entered in the ES data management when you click "OK" and take effect in the next processing cycle in the AS.

You can use the "Current", "Minimum" and "Maximum" boxes to monitor the run time.

If no values were configured for the runtimes (time = 0), the individual boxes display "--.--".

In the box "Comment" you will see the comment of the step.

In the "Acknowledgement information" box, you see the text displayed to the operator as information in the mode "Step-specific acknowledgement by the operator (T/T and O)".

The information appears in test mode or in the SFC visualization on the corresponding acknowledgement button. The text can be positioned anywhere in the window but remains linked to the button with a connection line.

- "Initialization", "Processing", "Termination" tabs

On the left next to the first address there is a box displaying the current value of the address. The box on the right next to the second address contains the configured value that you can change (only in the SFC chart). If you click in the box, you open the "Change Value" dialog box, in which you can enter the new value.

After you close the dialog box, the changed value is written to the ES data management (and in the CPU) and becomes effective in the next processing cycle.

- Register "OS comment" (initialization), (processing), (termination)

In these registers you can see the initialization, processing, or termination actions. The middle column does not show the interconnection information, however, as it does in the Initialization, Processing and Termination tabs. Here it shows the configured OS comment. All other details are the same.

**Buttons**

If a time error occurs in the time monitoring of a step and the button for acknowledging the step runtime error is displayed next to the affected step, the button is also displayed in the dialog box. This allows you to acknowledge the error from the dialog box.

**Note**

When a step runtime error occurs, the step is returned to the state that it had before the error occurred (for example, active = "green") after the error has been acknowledged.

You can use the "Go To" button of an SFC chart to jump from the current address box to its point of use, for example, to the block in the CFC chart or to the I/O address in HW Config (not possible for an SFC instance).
16.6 Properties of a transition during testing

Tabs of the "Properties" dialog

The "Properties" dialog box of the transition has four tabs:

- **General**
  The "Name" box has a frame; its color corresponds to the state of the transition and is updated continuously. All colors that occur are listed in the following table: Default Colors (Page 62).

- **Current Cond.**
  This tab shows the current state of the conditions.

- **OS Comment**
  This tab shows the current values and the state of the transition logic, as shown on the "Current Cond." tab. The difference to the "Current Cond." tab here is that there is a column with the OS comments instead of columns with the formulated conditions. All other details are the same.

- **Last Cond.**
  This tab shows the state of the conditions of the previous processing cycle.

- **Cond. after Error**
  This tab shows the state of the conditions that led to an error

"Current Cond." tab

There are boxes with the current value of the address on the left next to the first address and on the right next to the second address. In the SFC chart, you can change the content of both boxes (not possible with an SFC instance). If you click in one of the boxes, the "Change Value" dialog box opens where you can enter the new value for the address.

After you close the dialog box, the changed value is written to the ES data management (and to the CPU) and becomes effective in the next processing cycle.

The results of the Boolean logic operations for the conditions are visualized as colored connecting lines of varying thickness.

- A wide, green line means "fulfilled".
- A thin, red line means "unfulfilled".
- A thin, black line means "inactive".

"Last Cond." and "Cond. after Error" tab

The content of these tabs is not automatically updated; they therefore have an additional "Update" button. The state of the transition is entered here as it was at the time when the object properties were opened. You can display the current state in a permanently open dialog box by clicking "Update". The values of the addresses cannot be changed.
Buttons

If an operator prompt is displayed for the monitored transition in the sequencer and the button is displayed beside the transition, the dialog box also has the button added to it. This allows you to acknowledge the operator prompt from the dialog box.

You can use the "Go To" button of an SFC chart to jump from the current address box to its point of use, for example, to the block in the CFC chart or to the I/O address in HW Config (not possible for an SFC instance).
16.7 Properties of a sequencer during testing

Tabs of the "Properties" dialog

The "Properties" dialog box of the sequencer is divided into 7 tabs:

- **General**
  The "Name" box has a frame; its color corresponds to the state of the transition and is updated continuously. All colors that occur are listed in the following table: Default Colors (Page 62).

  The "Comment" box displays the configured comment for this sequencer.

  You can see the priority of the sequencer in the "Priority" box. The priority decides which sequencer of a chart is started when the start conditions of several sequencers are met simultaneously.

- **Start Condition**
  Each line represents a condition. Of the maximum 16 conditions, 2 x 5 are visible on the first page and 2 x 3 on the second page. You can move to the second page by clicking "Arrow" on the last operator.

  There are boxes with the current value of the address on the left next to the first address and on the right next to the second address. The values can only be changed for the SFC chart.

- **OS Comments (Start Condition)**
  The difference to the "Start Condition" tab here is that there is a column with the OS comments instead of columns with the formulated conditions. All other details are the same.

- **Preprocessing**
  This tab contains the actions for preprocessing of the current sequencer. The values can only be changed for the SFC chart.

  Each line represents one statement. Up to 50 statements are possible. The section of displayed statements can be moved with the scroll bar at the right of the window.

  Each statement consists of a left address, an operator, and a right address.

  There are boxes with the current value of the address on the left next to the first address and on the right next to the second address. If you click in one of the boxes, the "Change Value" dialog box opens where you can enter the new value for the address. After you close the dialog box, the changed value is written to the CPU and takes effect in the next processing cycle. A constant in the right address box is also written to the ES data management.

- **OS Comments (Preprocessing)**
  The difference to the "Start Condition" tab here is that there is a column with the OS comments instead of columns with the formulated conditions. All other details are the same.
- **Postprocessing**
  This tab shows the actions for postprocessing of the current sequencer. The values can only be changed for the SFC chart. The structure of the tab is identical to the "Preprocessing" tab (see relevant section).

- **OS Comments (Start Condition)**
  In contrast to the "Start Condition" tab, this has a column with the OS comments instead of columns with the formulated conditions. All other details are the same.
Testing and commissioning sequential control systems

16.7 Properties of a sequencer during testing
17 Documenting programs

17.1 Documenting SFCs

Overview

The documentation of SFC charts/types/instances includes the following:

- Printout of the SFC in a variety of layouts
- Parameter assignments
- Properties
- Chart reference data

Specifying the page layout

If you want to change the layout, proceed as follows:

1. Select the menu command SFC > Page Setup....
   A dialog box opens.
2. Select the paper format (e.g., "A4", "A4 with margin") in the drop-down list box.

Previewing the printout

1. Select the menu command SFC > Print Preview...
   The pages to be printed are displayed on the screen.
2. Check the layout.
   You can start the printout from this preview.

Printing an SFC

1. Click the button
in the toolbar or
select the menu command SFC > Print....
A dialog box opens.

2. Here, you make settings for the print scope and the layout:

   Print What:
   - Properties
   - Interface inputs/outputs
   - External view (for SFC chart) or characteristics (for SFC type/instance)

   Sequencers:
   - Properties
   - Normal size
   - Overview (you can select either normal size or overview, but not both).
   - Steps/transitions

   Options (only with "Normal size"):
   - Alternative branch aligned left
   - Comment/text
17.2 Chart reference data

Starting the application

1. Select the menu command Options > Chart Reference Data...
or click the button

The chart reference data are opened with an empty window.

2. In the "View" menu, select the list containing the information you want to display or click the corresponding icon in the toolbar.
The list with the current reference data opens.

You do not need to close the window with the chart reference data if you want to continue working in SFC. You can view the generated lists while continuing your work in SFC.

Chart reference data

You can display and print the following chart reference data:

- **Run Sequence**
The graphical display shows the entire run sequence of a CPU.

- **Cross-References Chart Element -> Address**
The list displays all shared addresses used in the project and the elements which access them.

- **Cross-References SFC > Chart Element**
The list shows all existing accesses from SFC charts to the inputs/outputs of CFC chart elements.

- **Cross-References Chart Element > Runtime Group**
The list displays all points at which CFC and SFC charts reference runtime groups.

- **Block Interconnections**
The list displays all block interconnections in the project.

- **Accesses in SFC Types**
The list displays all read and write accesses within an SFC type.

- **Block Types**
The list displays the block types used and the points (CFC chart) at which they are used.

- **S7 Resource Allocation**
The list shows the assignment between CFC configuration objects and S7 resources.

- **Local Data**
The list displays all the OBs in the program along with the calculated local data requirements and the local data size of the individual priority classes configured offline and actually existing online.

- **Block Call Hierarchy**
The graphical display shows the call hierarchy of all blocks in the current program.
Textual Interconnections
The list shows all textual interconnections (path reference to the interconnection target) with the chart name and chart element of the interconnection source.

Statistics
The graphical display shows the quantity of utilized CFC and SFC objects and S7 resources, the time stamp of the current program and the process objects of the project.

You will find a detailed description of the lists and the meanings of the columns in the CFC online help “Chart Reference Data” in the section: Display of Chart Reference Data

Export
You can save the generated lists as a file in CSV format (for use in Microsoft EXCEL, for example) by selecting the menu command Reference Data > Create Export File...
17.3 Logs

Saving and printing logs

The menu command Options > Logs... opens a dialog box with several tabs. The tabs are only available when the corresponding functions have been previously executed.

Saving the log file and printing always relates to the currently open tab.

Tabs

"Compile" tab
List of the messages that occurred during compilation (including the compiler messages); for example, if the project contains a program but no station. Example message: "The program is not assigned to an actual CPU."

"Check Consistency" tab
List of the messages that occurred during the consistency check.

"Download" tab
List of the messages that occurred during a download, for example, if the download was free of errors: Example message: "0 errors and 0 warnings found".

"ES Log" tab
Log of all protected actions (download, test mode). This requires that the SIMATIC Logon Service is installed.

"Step Processing" tab
After checking the SFC runtime behavior with the menu command Options > Check Step Processing, this tab lists the steps that use the same address in the terminating action of one step and in the initializing action or processing action of the next step. The log shows how many SFC charts were checked and how many accesses were found and the SFC charts with an unchanged runtime behavior.

"Convert Format" tab
After converting charts of older versions to V5.1 or later, the charts that no longer have the same properties are listed here. These include, for example, SFC charts that had the attributes "scan rate" and "phase offset" in the old version. The information includes the insertion location (task) and the values for the scan rate and phase offset for every chart affected.
Example: "SFC1: Task OB32 scan rate 4 phase offset 2"

"Make Textual Interconnections" tab
The menu command Options > Make Textual Interconnections is used to make all textual interconnections that are assigned to a specific interconnection partner in the current chart folder. The textual interconnections made with this action are displayed along with error messages indicating the textual interconnections that could not be made for one reason or another.
17.4 Defining Footers

Overview

The menu command SFC > Footers... opens a dialog box where you can enter the text to be displayed in the footers on every printed page.

With the DOCPRO add-on package, you can print the SFC chart/type together with footer data. A distinction is made between global data and specific data (local data) for footers.

You can enter the global data for the project using DOCPRO or SIMATIC Manager; the specific data must be entered with the SFC Editor. Remember that the specific data overwrites the entries of the global data for the particular SFC.

You can enter specific data even if you have not installed the DOCPRO add-on package. These data are saved and can be printed later when DOCPRO is available for print jobs.

Specific footer data

You can enter the SFC-specific footer data in the active tabs "Part 1" to "Part 4" and "Available Fields". These include document type, date created, document number, dates of changes or free texts.

Keywords in footers

In the global footers, you can enter keywords that will be replaced by current texts in the printout. Below, you can see the available keywords and their meaning:

<table>
<thead>
<tr>
<th>Keyword</th>
<th>Designation</th>
<th>Meaning</th>
<th>DOCPRO key</th>
</tr>
</thead>
<tbody>
<tr>
<td>$$CNS$$</td>
<td>Name</td>
<td>Name as entered in the properties.</td>
<td>$54</td>
</tr>
<tr>
<td>$$CC$$</td>
<td>Comment</td>
<td>Comment text as entered in the properties.</td>
<td>$60</td>
</tr>
<tr>
<td>$$A$$</td>
<td>Author</td>
<td>Name as entered in the properties.</td>
<td>$55</td>
</tr>
<tr>
<td>$$DC$$</td>
<td>Date created</td>
<td>Date as entered in the properties.</td>
<td>$56</td>
</tr>
<tr>
<td>$$DM$$</td>
<td>Last modified</td>
<td>Date as entered in the properties.</td>
<td>$57</td>
</tr>
<tr>
<td>---------</td>
<td>---------------------</td>
<td>---------</td>
<td>------------</td>
</tr>
<tr>
<td>$$CH$$</td>
<td>Project path</td>
<td>Path, as entered in the properties</td>
<td></td>
</tr>
<tr>
<td>$$PP$$</td>
<td>Storage location of project</td>
<td>Where the project is physically stored, as entered in the properties.</td>
<td>$54</td>
</tr>
</tbody>
</table>
Using DOCPRO keys

If you are using DOCPRO V5.1 and create new projects, you can define the keys using DOCPRO keys. This means that you do not have to enter the keywords in SFC in the footers; these are, however, still supported. You still have to make the entries in older projects.

---

**Note**

If you print other objects (for example STL blocks or the DOCPRO content directory) with the keywords used in SFC, the keywords themselves appear in the printout for these objects and not the replacement. This problem no longer exists if you use DOCPRO keys.

---

When using DOCPRO keys, you must change the standard layout in DOCPRO. You can replace the default footers with specific footers in the "Modify Layout" dialog box. You can find information about this in the DOCPRO online help or in the *DOCPRO manual: Creating Documentation in Conformance with Standards*.

The keys for "project path" and "Location of the project" (in the lower part of the table) must continue to be used since there are no DOCPRO keys for them.
18.1 Parameter Control

Parameter control

In addition to fixed sequential control systems, parameter controls are also used in batch processes. Parameter controls are sequential control systems with variable parameters.

These variable parameters are compiled in a shared data block (recipe data block). You can give the recipe data block a symbolic name, for example, "RecParDB".

The variables of the recipe data block are values assigned to the parameters of the basic automation during configuration.

For further information about parameter control, refer to the sections:
- How to configure the runtime (Page 306)
- Execution with Different Parameter Sets (Page 307)
- Example of a Recipe Data Block (Page 309)
18.2 How to configure the runtime

Procedure

You configure the runtime of the parameter control with the SFC Editor. The procedure is similar to the configuration of the sequential control system. You assign the values from the recipe data block to the parameters of the basic automation in the "Object Properties" dialog box.

Example: Configuration of a step

The following data is entered in the basic automation (example) from the example recipe data block (Page 309) "RecParDB" in the "Object Properties" dialog for the step:

\[
\begin{align*}
\text{ctrllr}_1.w & := \text{"RecParDB".etmp} \\
\text{ctrllr}_4.w & := \text{"RecParDB".etmp}
\end{align*}
\]

Example: Configuration of a transition

In the "Object Properties" dialog box for the transition, a recipe parameter is used to specify the sequencer of an alternative branch that is to be executed:

Transition: Querying recipe data

Reg. figure:

<table>
<thead>
<tr>
<th>Condition in T2</th>
<th>&quot;RezParDB&quot;.altzwg</th>
</tr>
</thead>
<tbody>
<tr>
<td>Condition in T3</td>
<td>&quot;RezParDB&quot;.altzwg</td>
</tr>
<tr>
<td>Condition in T4</td>
<td>&quot;RezParDB&quot;.altzwg</td>
</tr>
</tbody>
</table>

\[
\begin{align*}
\text{Condition in T2} & : \text{"RezParDB".altzwg} = 1 \\
\text{Condition in T3} & : \text{"RezParDB".altzwg} = 2 \\
\text{Condition in T4} & : \text{"RezParDB".altzwg} = 3
\end{align*}
\]
18.3 Execution with Different Parameter Sets

Changing on the OS

If you change the content of the recipe data block, parameter control can also run with different parameter sets. You change the parameters on the OS.

Examples

The examples below show the various ways in which you can change the content of the recipe data block.

- You can integrate the variables of the recipe data block as modifiable variables in the OS process pictures and specify the current values of the variable on the OS before starting the parameter control.
- You store various recipe parameter sets in the AS. The alternative statement of a recipe parameter set for the recipe data block can result in an alternative branch in the "T and O or "O" step control mode.

```
Step: Alternative application of recipe data from different data blocks
Reg. figure:

<table>
<thead>
<tr>
<th>Instruction in Par1</th>
<th>&quot;RezParDB&quot;.chbez := &quot;RezParDB1&quot;.chbez</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>&quot;RezParDB&quot;.ansmg := &quot;RezParDB1&quot;.ansmg</td>
</tr>
<tr>
<td>Instruction in Par2</td>
<td>&quot;RezParDB&quot;.chbez := &quot;RezParDB2&quot;.chbez</td>
</tr>
<tr>
<td></td>
<td>&quot;RezParDB&quot;.ansmg := &quot;RezParDB2&quot;.ansmg</td>
</tr>
<tr>
<td>Instruction in Par3</td>
<td>&quot;RezParDB&quot;.chbez := &quot;RezParDB3&quot;.chbez</td>
</tr>
<tr>
<td></td>
<td>&quot;RezParDB&quot;.ansmg := &quot;RezParDB3&quot;.ansmg</td>
</tr>
</tbody>
</table>
```
In the OS process picture, you have included the modifiable variables "Batch ID" and "Amount". By calling an appropriate user block in the parameter control, the parameters in the recipe data block "RecParDB" are adapted relative to a standard batch.

Step: Activate a user block for adapting amounts

Reg. figure:

| Instruction in ANW | ANW.EN | := 1 |
### 18.4 Example of a Recipe Data Block

Recipe block "RecParDB"

The table contains an example of a "RecParDB" recipe block.

<table>
<thead>
<tr>
<th>Tag name</th>
<th>Type</th>
<th>Value</th>
<th>Designation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bantam</td>
<td>STRING[8]</td>
<td>'ch_4711'</td>
<td>Batch name</td>
</tr>
<tr>
<td>vol</td>
<td>INT</td>
<td>2000</td>
<td>Amount in liters</td>
</tr>
<tr>
<td>reapr</td>
<td>INT</td>
<td>3</td>
<td>Reactor pressure in bar</td>
</tr>
<tr>
<td>etmp</td>
<td>INT</td>
<td>90</td>
<td>External temp in deg. C</td>
</tr>
<tr>
<td>itmp</td>
<td>INT</td>
<td>125</td>
<td>Internal temp. in deg. C</td>
</tr>
<tr>
<td>tott</td>
<td>INT</td>
<td>110</td>
<td>Total reaction time in min.</td>
</tr>
<tr>
<td>stvol</td>
<td>INT</td>
<td>1000</td>
<td>Standard amount in liters</td>
</tr>
<tr>
<td>altseq</td>
<td>INT</td>
<td>3</td>
<td>Alternative sequence</td>
</tr>
</tbody>
</table>

END_STRUCT
Configuring parameter controls

18.4 Example of a Recipe Data Block
19.1 Configuring SFC calls

Tasks

You can use the SFC to perform the following tasks:

- Configuring hierarchical SFC chart calls

  or

- Coordinating processing of multiple SFC charts in the automation system

Configuring hierarchical SFC chart calls

You configure hierarchical SFC chart calls in the SFC coordination chart ("SFC Coord" chart controls "SFC Slave1" and "SFC Slave2") as follows:

- Configure the preceding transition to the next step (to coordinate SFC Coord with SFC Slave1; in other words, SFC Coord waits for the termination of SFC Slave1, if this is still running). Enter the condition in the "Properties" dialog box of the transition:
  SFC Slave1.BUSY = OFF

- Configure the step for activating SFC Slave1. Enter the statement in the "Initialization" tab of the "Properties" dialog box for the step:
  SFC Slave1.INTONOFF := ON

- Configure the successor transition for the step above (to coordinate SFC Coord with SFC Slave1, in other words SFC Coord waits for termination of SFC Slave1). Enter the condition in the "Properties" dialog box of the transition:
  SFC Slave1.BUSY = OFF

SFC Slave2 is now controlled by SFC Coord.

No special configuration is necessary for SFC Slave1 and SFC Slave2.

Coordinating the SFC charts

You coordinate multiple SFC charts (SFC Chart1 and SFC Chart2) using data cells (such as bit memory, data block elements) that are set in SFC Chart1 (statement in a step) and read in SFC Chart2 to enable the next step (condition in a transition).
19.2 Converting Older Projects

Using the new SFC runtime system

Before the new functions of the SFC runtime system can be used, the data is converted the first time you write to projects of an earlier version and the FB 300 SFC runtime system is replaced following a prompt for confirmation.

You then compile and download the program as follows:

1. Select the menu command SFC > Compile....
   The program is compiled.

2. Select the menu command CPU > Download... and then "Download: Changes" with the automation system in RUN (or STOP) mode.
   The program is downloaded. Switch off all active charts in the corresponding dialog box.

3. Switch all active charts back on in the corresponding dialog box.

For additional information on converting older projects to SFC of the current version, refer to the manuals for PCS 7 Software Updates.

SFC control block

When V5.x ES data are converted to ≥ V6.x ES data, the SFC control block (SFC_CTRL) is eliminated and replaced by the external view of the SFC chart. All the positioned SFC control blocks are deleted and replaced in each case by the external view of the SFC chart that displays the interface of the SFC chart as a block. The settings of the SFC control block parameters and its interconnections are applied to the external view. The runtime behavior of the SFC chart is not changed.

The position in the run sequence is now also no longer important (in the past it was necessary to ensure that SFC_CTRL was installed before the SFC chart in the run sequence).

Control strategies and/or setpoint changes for projects created with SFC < V6.1 SP1

To make control strategy and/or setpoint changes effective, the block FB 245 must be copied from the SFC library to the block folder prior to the change followed by compilation of the entire program and download of the changes.

For further information, refer to the section: Changing the Control Strategy and Setpoints for an SFC Instance (Page 275)
**System attributes on standard interface**

When older projects are converted, the system attributes of the block connections of the standard interface are transferred from FB247 or FB300 of the current SFC Library. During this process, the attributes for the block connections of SFC charts or block connections of the standard interface of SFC types / SFC instances that have been changed by the user are lost. In block connections, attributes of parameters that were created by the characteristics editor or interface editor are retained.

Possible procedure when you want to accept attribute changes at the standard interface during conversion:

- **SFC type**
  
  In FB247 (@SFC_TYPTEMPLATE) in the current SFC Library, change the attributes that were changed on the standard interface of SFC types.
  
  Note that this changes the attributes for all SFC types and SFC instances following the conversion.

- **SFC chart**
  
  In FB300 (@SFC_RTS) in the current SFC Library, change the attributes that were changed on the standard interface of SFC charts.
  
  Note that this changes the attributes for all SFC charts following the conversion.

---

**Note**

You must change the attributes again after every installation of SFC for SIMATIC S7.
Tips & Tricks

19.2 Converting Older Projects
Index

"Operator control" menu,

A

Absolute addressing, 156
Accessing, 61, 147
  Help with keyboard, 61
  To structures, 147
Adapting, 89, 91, 93
  Chart properties, 89
  Instance properties, 93
  Type properties, 91
Addresses, 144
  Valid entries, 144
Addressing, 156, 157
  Absolute, 156
  Symbolic, 157
ALARM_8P, 95
Alternative branch, 43, 120, 272
  Creating, 120
  in the AS, 272
Attributes
  for characteristics, 104
  Attributes, 104

B

BATCH parameters, 212
  SFC inputs/outputs, 212
Bit memory, 98
Block contacts, 98, 102, 103
Block I/O, 146
  Filtering, 146
Blocks, 229
  Generated during compilation, 229

C

Change, 61, 100
  Control strategies subsequently, 100
Changes to the configuration, 74, 78, 81
  of the SFC chart, 74
  of the SFC instance, 81
  of the SFC type, 78
Changes to the interface, 78
Changes to the topology, 78
Changing, 48, 275
  Display size in the SFC, 48
  the control strategy and setpoints for an SFC
  instance, 275
  Window section, 61
Characteristic, 179, 180, 182, 195, 196, 197
  Bit memory, 196
  Block contacts, 197
  Control strategies, 179
  Control values, 195
  Note texts, 180
  Parameters, 195
  Position texts, 180
  Process values, 195
  Setpoints, 182
  Timers, 196
Characteristics, 97, 98, 102, 104
  Attributes, 104
  Inputs/outputs, 102
Characteristics editor, 97
Characteristics interface expansions [SFC
  inputs/outputs], 181
Characteristics interface parameter assignments, 179
Chart properties, 89
  Adapting, 89
Chart reference data, 299
  Documenting, 299
Commands, 200, 264
  During execution in the AS, 264
  Priorities, 264
  SFC inputs/outputs, 200
Commands and operating states, 200
Commissioning, 279, 290, 292, 294
Common features, 33
  SFC chart and SFC type, 33
Comparison, 33
  SFC chart and SFC type, 33
Compiling, 227, 228
  Settings, 227
  SFC chart, 225
  SFC instance, 225
  SFC type, 225
Configuration, 72, 75, 79, 311
  SFC calls, 311
Index

SFC chart, 72
SFC instance, 79
SFC type, 75
Configuration limits of the SFC, 27
Messages in the SFC, 95
Note text, 101
SFC instance, 22
SFC Instance, 71
SFC type, 20, 70
Simultaneous branch, 118
Text box, 124

D
Data backup, 63
Data from sequencers and steps to be processed (SFC inputs/outputs), 210
Data types, 158
for SFC, 158
Valid, 158
Deleting, 87, 133
SFC chart, 87
SFC element, 133
SFC instance, 87
SFC type, 87
Diagram, 254, 258
of the state changes for sequencer OSL, 258
of the state changes for SFC OSL, 254
Dialog boxes, 54, 59
Layout, 54
Operator control, 59
Differences, 33
SFC chart and SFC type, 33
Display, 284
in test mode, 284
Display size in the SFC, 48
Changing, 48
Documentation, 297, 299, 301, 302
Chart reference data, 299
Footers, 302
Logs, 301
SFCs, 297
Documenting SFCs, 297
Downloading, 227, 233
Programs, 233
Settings, 227

E
Edit, 134
Sequencer properties, 134
Editing, 121, 122, 124, 136, 149, 160
Jump, 122
Loop, 121
Project structure, 65
Sequence, 117
Sequencer topology, 111
SFC, 67
SFC chart, 17, 69
Index

Transition, 149
Editing steps/transitions, 128
Selecting, 128
Elements, 50
User interface, 50
Example, 309
Recipe data block, 309
Execution options, 208, 245
SFC inputs/outputs, 208
External view, 34
SFC chart, 34

F
Filtering, 146
Block I/O, 146
Footer, 302
Defining, 302

G
Generated blocks, 229
SFC, 229
Getting started, 15
Group acknowledgements, 210
SFC inputs/outputs, 210
Group displays, 210
SFC inputs/outputs, 210

H
Handling, 67, 69
Charts, 69
SFC, 67
Help, 61
opening with keyboard, 61
How it works, 306
Configuring, 306

I
I/O groups, 102
Inputs/outputs, 102, 170, 178
for characteristics, 102
SFC chart, 170, 178
Inputs/outputs of the standard interface, 172
SFC type, 172
Inserting/creating, 116
SFC elements, 116
Instance properties, 93

Adapting, 93
Interface editor, 97
Interface expansions for inputs/outputs, 178
Introduction, 11
SFC, 11

J
Jump, 45, 122, 273
Creating, 122
Editing, 122
in the AS, 273

K
Keyboard, 56

L
Layout, 54
Dialog box, 54
LI_ERR, 213
Loop, 44, 121, 273
Creating, 121
Editing, 121
in the AS, 273

M
MANUAL commands, 264
Meaning and usage of inputs/outputs for setpoints, 191
Memory requirements, 229
Menu, 58
Messages, 217
SFC inputs/outputs, 217
Messages in the SFC, 95
Configuring, 95
Migration from older projects, 312
Moving, 84, 85, 86, 132
SFC chart, 84
SFC element, 132
SFC instance, 86
SFC type, 85
Multiuser engineering, 48

N
Navigating, 48
in the SFC, 48
Note texts, 98, 101, 180
Index

Characteristics, 180
Configuring, 101
NOTIFY, 95

O
Object properties, 131
Copying, 131
OCCUPIED, 259
OP_ERR, 213
Opening, 82, 83
  SFC chart/SFC type, 82
  SFC instance, 83
Operating modes, 198, 242
  SFC inputs/outputs, 198
Operating state logic, 256
  for sequencers, 256
Operating state logic for SFC, 248
Operating states, 200, 247
  S7, 247
  SFC inputs/outputs, 200
Operator control, 58, 59
  Dialog boxes, 59
  Menu, 58
Operator control and monitoring during testing, 279
Operator input, 55, 56
  With the keyboard, 56
  With the mouse, 55
OSL, 248, 256
  for sequencers, 256
  for SFC, 248
OSL for sequencers, 258
  Diagram, 258
OSL for SFC, 254
  Diagram, 254
Overview
  Blocks generated during compilation, 229
Overview, 229

P
Parameter control, 305, 307
  Configuring the runtime, 306
  Example of a recipe data block, 309
  Execution with different parameter sets, 307
Parameter sets, 307
  Different, 307
Parameters, 98
Position texts, 98, 101, 180
  Characteristics, 180
  Postprocessing, 36, 112
Preprocessing, 36, 112
Printing, 301
  Logs, 301
Priority, 264
  Commands, 264
Process values, 98
Processing, 259, 262, 269, 271, 272, 273
  Alternative Branch in the AS, 272
  Jump in the AS, 273
  Loop in the AS, 273
  Sequencer, 259
  Sequencers, 262
  SFC, 259, 262
  SFC after a CPU stop, 262
  Simultaneous Branch in the AS, 271
  Step and transition in the AS, 269
Programmed target steps, 200
Programs, 233
  Downloading, 233
Project structure, 65
  Creating, 65
Properties, 290, 292, 294
  Sequencer during testing, 294
  Step during testing, 290
  Transition during testing, 292
Purpose
  Note text, 101
  Position text, 101
Q
QDIS_START, 213
R
Recipe data block, 309
Reserves, 224
  SFC inputs/outputs, 224
Resources needed, 229
Run Sequence, 160
  Editing, 160
Runtime attributes, 161
Runtime behavior, 241
Runtime phases, 268
  Step, 268
Runtime properties, 159
  SFC, 159
S
Saving, 301
Index

Introduction, 11
Navigating, 48
Operating principle, 15
Parameter control, 305
Runtime properties, 159
Type/instance concept, 75

SFC calls, 311
Configuration, 311
SFC chart, 11, 17, 28, 34, 69, 72, 74, 82, 84, 87, 163, 170, 178, 225
Changes to the configuration, 74
Compiling, 225
Configuration, 72
Copying/moving, 84
Creating, 17, 69
Deleting, 87
External view, 34
Inputs/outputs, 170, 178
Opening, 82
Selection criteria, 11
Standard interface, 163
Standard interface I/Os [alphabetical order], 163

SFC chart and SFC type, 33
Compared, 33
SFC chart/instance, 266
Start, 266
SFC Editor, 47
start, 47
working, 47
SFC element, 39, 40, 41, 42, 43, 44, 45, 132, 133
Deleting, 133
Moving, 132
SFC elements, 116, 129
Copying, 129
Inserting/creating, 116
SFC inputs/outputs, 179, 181, 198, 200, 208, 210, 212, 213, 217, 218, 219, 224
BATCH parameters, 212
Characteristics interface expansions, 181
Characteristics interface parameter assignments, 179
Commands and operating states, 200
Continuous mode, 213
Control words, 218
Data from sequences and steps to be processed, 210
Execution options, 208
Group displays + group acknowledgements, 210
Messages, 217
Operating modes, 198
Reserves, 224
Status words, 219

Logs, 301
Saving/printing logs, 301
Documenting, 301
Printing, 301
Saving, 301
Selecting, 60, 126, 127, 128
Text with keyboard, 60
when editing steps/transitions, 128
with the keyboard, 127
with the lasso, 127
with the mouse, 126
Selection criteria, 11
SFC chart, 11
SFC type, 11
Sequence, 41, 117
Creating, 117
Sequence path elements, 37
Sequencer, 11, 36, 41, 61, 134, 259
Copying/moving, 112
Creating, 112
Deleting, 112
Editing sequencer properties, 134
Keyboard shortcuts, 61
Processing, 259
Sequencer OSL, 256
Sequencer template, 112
Sequencer topology, 111
Creating, 111
Sequencers, 259
Sequential control system, 109, 111, 116, 117, 118, 120, 121, 122, 124, 126, 127, 128, 129, 131, 132, 133, 134, 136, 139, 141, 149, 151, 152, 154, 159, 160, 161
Copy, 141
Sequential Control System, 11
Sequential control systems in the AS, 239
Setpoints, 98
Settings, 227
Compiling/downloading, 227
and other target systems, 26
and plant hierarchy, 26
Configuration limits, 27
Configuring, 67
Creating, 67
Handling, 67
in the STEP 7 environment, 25

SFC for SIMATIC S7
Programming and Operating Manual, 12/2011, A5E03710074-01
Index

System parameters, 224
Troubleshooting, 213
SFC instance, 11, 22, 30, 79, 81, 83, 85, 87, 225, 275
Changes to the configuration, 81
Changing control strategy and setpoints, 275
Compiling, 225
Configuration, 79
Copying/moving, 86
create, 22
Deleting, 87
Opening, 83
SFC instance, 71
Creating, 71
SFC OSL, 248, 254
SFC processing after a CPU stop, 262
SFC type, 11, 20, 30, 70, 75, 82, 85, 87, 171, 172, 225
Compiling, 225
Configuration, 75
Copying/moving, 85
Creating, 20, 70
Deleting, 87
Inputs/outputs of the standard interface, 172
Opening, 82
Selection criteria, 11
Standard interface, 171
SFC types, 92
Updating, 92
Shared addresses, 156, 157
Shortcut keys, 56
for menu commands, 56
Shortcuts, 57
for menu commands, 57
Simultaneous branch, 42, 118, 271
Creating, 118
in the AS, 271
Standard interface, 163, 171
of the SFC chart, 163
of the SFC type, 171
Start, 47, 266
SFC chart, 266
SFC Editor, 47
SFC instance, 266
Start conditions, 36, 112
Sequencer, 36
Status words, 219
BA_STATE, 219
SFC_STATE, 219
USTATUS, 219
VSTATUS, 219
Step, 39, 136, 141, 147, 268
Access to structures, 147
Editing, 136
Editing actions, 139
Editing addresses, 141
Editing general properties, 139
Runtime phases, 268
STEP 7, 25
Step and transition, 269
in the AS, 269
Step control modes, 242
Structures, 147
Symbolic addressing, 157
System attributes [parameters], 104
System attributes for parameters, 169
System parameters, 224
SFC inputs/outputs, 224

T
Target step, 259, 290
Target steps, 200
Programmed, 200
TARGETSEQ, 200, 259
TARGETSTEP, 200, 259
Test mode, 284
Display, 284
Text, 41, 60
Selecting with keyboard, 60
Text box, 124
Creating, 124
Editing, 124
Timers, 98
Tips & Tricks, 311
Trace, 279
Tracking, 277
Control strategies and setpoints, 277
Transition, 40, 147, 149, 152
Access to structures, 147
Editing, 149
Editing addresses, 152
Editing OS comments, 154
Formulating conditions, 151
Troubleshooting, 213
SFC inputs/outputs, 213
Type properties, 91
Adapting, 91
Type/instance concept, 75
of the SFC, 75

U
User interface, 50, 54, 55, 56, 57, 58, 59, 60, 61
Elements, 50
Using the keyboard, 56, 58, 59, 60, 61

V
Valid data types, 158
Valid entries for addresses, 144

W
Window section, 61
Changing, 61
Working, 47
with the SFC Editor, 47
Working with SFC, 15
principle, 15